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NOTICE TO USERS OF THE BONE ASSESSMENT PRODUCT

DESCRIPTIONS NOT INTENDED FOR DIAGNOSTIC PURPOSES. The descriptions and narratives in this
Operator's Guide and other written materials provided to Licensee with this Bone Assessment Product are inten-
ded to provide a foundation for use of the Bone Assessment Product along with host computer and printer.
Actual printout images and any depictions of these images in the Operator's Guide and accompanying written
materials are not intended for diagnostic purposes.

X-RAY DEVICE REGISTRATION. The Bone Assessment Product is an x-ray device that emits small

amounts of radiation to acquire bone density and / or other information. Although the dose is very small, some
countries and all states in the United States require registration of such devices, regardless of dose. It is the pur-
chaser’s responsibility to contact the government agency responsible for x-ray devices and to comply with any
specific information concerning device registration and operation for the area in which the system is to be oper-
ated.

CHANGES IN SPECIFICATIONS FOR BONE ASSESSMENT PRODUCT. All specifications for the Bone
Assessment Product are subject to change without notice.

Copyright © 2007-2020 Norland, Fort Atkinson, W1 USA.

Contents of this Operator's Guide and other written materials provided to Licensee with the Bone Assessment
Product may not be reproduced by any means whatsoever without prior written permission from Norland. All
products mentioned in this Operator's Guide and related written materials are trademarked or copyrighted by
their manufacturers.

All Norland Products are covered by U.S. and other patents and/or patents pending. All product names are
trademarks of Norland. All trademarks and the rights of the trademarks owned by the companies referred to in
this Operator's Guide and other written materials provided to Licensee with the Bone Assessment Product are
acknowledged.

WARRANTY FOR BONE ASSESSMENT PRODUCT

The Bone Assessment Product manufactured by Norland is warranted against defects in material and work-
manship for twelve (12) months from date of installation. During the warranty period, Norland will repair or
replace (at its option) a Bone Assessment Product proven to be defective. Warranty repairs may be performed
on site, at the factory, or at a Norland-approved service center without charge, provided the Bone Assessment
Product was not subjected to misuse, theft, neglect, fire, Acts of God, lightning strikes, or deterioration caused
by chemicals that are not used for normal unit operation. Any modifications of the Bone Assessment Product in
any manner, including but not limited to relocation or installation of the Bone Assessment Product without prior
Norland Customer Service authorization, shall void all associated warranties or service contracts. Prior to pre-
paid return of products for repair, the Bone Assessment Product must have a Return Authorization Number
(obtainable from Norland Customer Service) attached to it.

BEYOND THE WARRANTIES STATED ABOVE, THERE ARE NO OTHER WARRANTIES OF ANY KIND,
EXPRESS, IMPLIED OR STATUTORY (INCLUDING, WITHOUT LIMITATION, TIMELINESS,
TRUTHFULNESS, SEQUENCE, COMPLETENESS, ACCURACY, FREEDOM FROM INTERRUPTION),
ANY IMPLIED WARRANTIES ARISING FROM TRADE USAGE, COURSE OF DEALING, OR COURSE
OF PERFORMANCE, OR THE IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR USE OR PURPOSE. LICENSEE’S EXCLUSIVE REMEDY FOR BREACH OF WARRANTY
OR BREACH OF CONTRACT, NEGLIGENCE OR PRODUCTS LIABILITY SHALL BE THE REPAIR OR
REPLACEMENT OF DEFECTIVE OR DAMAGED GOODS.
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NOTICE TO USERS OF THE BONE ASSESSMENT PRODUCT

DESCRIPTIONS NOT INTENDED FOR DIAGNOSTIC PURPOSES. The descriptions and narratives in this
Operator's Guide and other written materials provided to Licensee with this Bone Assessment Product are inten-
ded to provide a foundation for use of the Bone Assessment Product along with host computer and printer.
Actual printout images and any depictions of these images in the Operator's Guide and accompanying written
materials are not intended for diagnostic purposes.

X-RAY DEVICE REGISTRATION. The Bone Assessment Product is an x-ray device that emits small

amounts of radiation to acquire bone density and / or other information. Although the dose is very small, some
countries and all states in the United States require registration of such devices, regardless of dose. It is the pur-
chaser’s responsibility to contact the government agency responsible for x-ray devices and to comply with any
specific information concerning device registration and operation for the area in which the system is to be oper-
ated.

CHANGES IN SPECIFICATIONS FOR BONE ASSESSMENT PRODUCT. All specifications for the Bone
Assessment Product are subject to change without notice.

Copyright © 2007-2020 Norland, Fort Atkinson, W1 USA.

Contents of this Operator's Guide and other written materials provided to Licensee with the Bone Assessment
Product may not be reproduced by any means whatsoever without prior written permission from Norland. All
products mentioned in this Operator's Guide and related written materials are trademarked or copyrighted by
their manufacturers.

All Norland Products are covered by U.S. and other patents and/or patents pending. All product names are
trademarks of Norland. All trademarks and the rights of the trademarks owned by the companies referred to in
this Operator's Guide and other written materials provided to Licensee with the Bone Assessment Product are
acknowledged.

WARRANTY FOR BONE ASSESSMENT PRODUCT

The Bone Assessment Product manufactured by Norland is warranted against defects in material and work-
manship for twelve (12) months from date of installation. During the warranty period, Norland will repair or
replace (at its option) a Bone Assessment Product proven to be defective. Warranty repairs may be performed
on site, at the factory, or at a Norland-approved service center without charge, provided the Bone Assessment
Product was not subjected to misuse, theft, neglect, fire, Acts of God, lightning strikes, or deterioration caused
by chemicals that are not used for normal unit operation. Any modifications of the Bone Assessment Product in
any manner, including but not limited to relocation or installation of the Bone Assessment Product without prior
Norland Customer Service authorization, shall void all associated warranties or service contracts. Prior to pre-
paid return of products for repair, the Bone Assessment Product must have a Return Authorization Number
(obtainable from Norland Customer Service) attached to it.

BEYOND THE WARRANTIES STATED ABOVE, THERE ARE NO OTHER WARRANTIES OF ANY KIND,
EXPRESS, IMPLIED OR STATUTORY (INCLUDING, WITHOUT LIMITATION, TIMELINESS,
TRUTHFULNESS, SEQUENCE, COMPLETENESS, ACCURACY, FREEDOM FROM INTERRUPTION),
ANY IMPLIED WARRANTIES ARISING FROM TRADE USAGE, COURSE OF DEALING, OR COURSE
OF PERFORMANCE, OR THE IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR USE OR PURPOSE. LICENSEE’S EXCLUSIVE REMEDY FOR BREACH OF WARRANTY
OR BREACH OF CONTRACT, NEGLIGENCE OR PRODUCTS LIABILITY SHALL BE THE REPAIR OR
REPLACEMENT OF DEFECTIVE OR DAMAGED GOODS.
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SOFTWARE LICENSE AGREEMENT

PLEASE READ THIS SOFTWARE LICENSE AGREEMENT CAREFULLY BEFORE USING THE
SOFTWARE. BY USING THE SOFTWARE, YOU ARE AGREEING THAT THIS SOFTWARE LICENSE
AGREEMENT FORMS A LEGALLY BINDING CONTRACT BETWEEN YOU AND NORLAND AND THAT
THIS AGREEMENT CONSTITUTES A “WRITING SIGNED BY YOU” UNDER ANY APPLICABLE LAW
OR REGULATION. ANY RIGHTS NOT EXPRESSLY GRANTED HEREIN ARE RESERVED BY
NORLAND. IF YOU DO NOT AGREE TO THE TERMS OF THIS LICENSE, DO NOT USE THE
SOFTWARE AND RETURN THE BONE ASSESSMENT PRODUCT TO NORLAND.

1. DEFINITIONS. The word “Software” means the software in object code form and any documentation which
you have received from Norland in connection with the Norland Bone Assessment Product, whether incor-
porated into the Product or not. The phrase “Claims or Losses” means any and all liabilities, obligations,
losses, damages, penalties, claims, actions, suits, costs, judgments, settlements, and expenses of
whatever nature, whether incurred by or issued against an indemnified party or a third party, including,
without limitation: (a) indirect, special, punitive, consequential or incidental loss or damage (including, but
not limited to, trading losses, loss of anticipated profits, loss by reason of shutdown in operation or increased
expenses of operation, or other indirect loss or damage) and (b) administrative costs, investigatory costs, lit-
igation costs, and auditors’ and attorneys’ fees and disbursements (including in-house personnel). The word
“Licensee” or “you” shall mean you, the individual or entity which has purchased the Bone Assessment
Product and accompanying Software, and has agreed to this License by using the Software and has not
returned the Bone Assessment Product to Norland.

2. LICENSE; INTELLECTUAL PROPERTY RIGHTS. Norland grants to Licensee a nonexclusive, royalty-
free, non-transferable license during the term of the Agreement to receive and use the Software solely in con-
nection with Licensee's use of the Bone Assessment Product. The Software is licensed only for the internal
use of Licensee and its employees. Licensee may not sell, lease, furnish, redistribute, retransmit, or oth-
erwise permit or provide access to the Software to any other person. Licensee will not engage in the oper-
ation of any illegal business or use or permit anyone else to use the Software, or any part thereof, for any
illegal purpose. Licensee shall take reasonable security precautions to prevent unauthorized persons from
gaining access to the Software. Licensee acknowledges that Norland retains proprietary rights in the Soft-
ware. In the event of any misappropriation or misuse, in addition to its right to damages Norland shall have
the right to obtain injunctive relief. Licensee agrees not to decompile, disassemble or reverse engineer the
Software.

3. NORLAND’S WARRANTIES/DISCLAIMER OF WARRANTIES. The Software is designated for use with
the Norland Bone Assessment Product and is warranted to execute its programming instructions when prop-
erly installed in that product. Accessory products, including software, not manufactured by Norland carry the
warranties of their respective manufacturers. Norland does not warrant that the operation of the Software
shall be uninterrupted or error free. BEYOND THE WARRANTIES STATED IN THIS SECTION, THERE
ARE NO OTHER WARRANTIES OF ANY KIND, EXPRESS, IMPLIED OR STATUTORY (INCLUDING,
WITHOUT LIMITATION, TIMELINESS, TRUTHFULNESS, SEQUENCE, COMPLETENESS,
ACCURACY, FREEDOM FROM INTERRUPTION), ANY IMPLIED WARRANTIES ARISING FROM
TRADE USAGE, COURSE OF DEALING, OR COURSE OF PERFORMANCE, OR THE IMPLIED
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR USE OR PURPOSE.

4. NORLAND'’S LIMITATION OF LIABILITY.

a. Under no circumstances, including negligence, shall Norland shall be liable to Licensee or any other per-
son for indirect, special, punitive, consequential or incidental loss or damage (including, but not limited to
trading losses, loss of anticipated profits, loss by reason of shutdown in operation or increased
expenses of operation, cost of cover, or other indirect loss or damage) of any nature arising from any
cause whatsoever, even if Norland has been advised of the possibility of such damages. In no event
shall Norland’s total liability to you or any other person for all damages exceed fifty dollars ($50).

b. Norland shall not be liable to Licensee or any other person for any unavailability, interruption, delay,
incompleteness, or inaccuracy of the Software.
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c. The Parties acknowledge that the terms of this section reflect a reasonable allocation of risk and lim-
itation of liability.

5. FORCE MAJEURE. Notwithstanding any other term or condition of this Agreement, Norland or Licensee
shall not be obligated to perform or observe their respective obligations undertaken in this Agreement (except
for obligations to make payments hereunder and regulatory obligations) if prevented or hindered from doing
so by any circumstances found to be beyond their control.

6. LICENSEE INDEMNITY. Licensee will indemnify and hold harmless Norland and its employees, officers,
directors, and other agents from any and all Claims or Losses imposed on, incurred by or asserted as a result
of or relating to: (a) any noncompliance by Licensee with the terms and conditions hereof; or (b) any third-
party actions related to Licensee’s receipt and use of the Software, whether authorized or unauthorized
under the Agreement.

7. ENFORCEMENT. Norland may enforce the terms of this Agreement against Licensee itself or against any
person, whether or not Licensee is a party to such action. In any action there shall be available injunctive
relief or damages, with the prevailing party being awarded costs and attorneys’ fees (including in-house coun-
sel).

8. TERMINATION In the event of (a) Licensee breach or (b) where directed to do so by any person in its reg-
ulatory authority, Norland may terminate this Agreement at any time immediately upon written notice to
Licensee provided by Norland.

9. MISCELLANEOUS. Except as otherwise provided herein, no provision of this Agreement may be amended,
modified, or waived, unless by an instrument in writing executed by a duly authorized officer of the party
against whom enforcement of such amendment, modification or waiver is sought. No failure on the part of
Norland or Licensee to exercise any right, power or privilege under this Agreement shall operate as a waiver
thereof, nor shall any single or partial exercise of such right, power or privilege preclude any other or further
exercise thereof or the exercise of any other right, power or privilege under this Agreement. If any of the pro-
visions of this Agreement, or application thereof to any person or circumstance, shall to any extent be held
invalid or unenforceable, the remainder of this Agreement, or the application of such terms or provisions to
persons or circumstances other than those as to which they are held invalid or unenforceable, shall not be
affected thereby and each such term and provision of this Agreement shall be valid and enforceable to the
fullest extent permitted by law.

10. SURVIVAL. The terms of this relating to intellectual property and indemnification shall survive termination of
this Agreement.

11. GOVERNING LAW AND FORUM. Each party hereby irrevocably and unconditionally submits for itself and
its property, to the jurisdiction of any New York State court or federal court of the United States of America
sitting in New York County and to any other court in any jurisdiction in which an action is brought against a
party to this agreement by a third party asserting a claim against which Norland is entitled under this agree-
ment to be indemnified. In any action or proceeding arising out of or relating to this agreement or for recog-
nition or enforcement of any judgment, all claims in respect of any such action or proceeding may be heard
and determined in any such New York State court or by such federal or other court. A final judgment in any
such action or proceeding shall be conclusive and may be enforced in other jurisdictions by suit on the judg-
ment or in any other manner provided by law.

Each party irrevocably and unconditionally waives, to the fullest extent it may legally and effectively do so, any
objection that it may have or hereafter have to the laying of venue of any suit, action or proceeding arising out of
or relating to this agreement in any New York State or federal court sitting in New York County or such other
court. Each party irrevocably waives to the fullest extent permitted by law, the defense of an inconvenient
forum to the maintenance of such action or proceeding in any such court.
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Infroduction

Congratulations on purchasing the Norland Dual Energy X-ray Absorptiometry (DXA)
Bone Densitometer. Expect the Bone Densitometer to be a valuable aid to the phys-
ician in the estimation of bone density and soft tissue, the assessment of fracture risk
and trend analysis of patient results.

ISO 13485 Certified: Norland’s Quality Management System is certified to ISO
13485:2003. Norland is dedicated to providing a quality product, on time delivery, and
exceptional customer service.

m Caution: State law requires all scans to be prescribed by a physician.

Caution: Federal law restricts this device to sale by or on the order of a phys-
i{ ! \ ician.

CE Mark: This product is CE marked for sales in the European
Community and other markets requiring this mark. The contact
information for our European Representative is listed in the "Cus-
tomer Service Contact Information" on page 1-3.

This chapter discusses the following.

Indications forUse ... . 1-2
X-Ray Device Registration ... ... .. 1-2
Customer Service Contact Information ... ... .. ... 1-3
About This Manual ... ... 1-4
SyMbOIS LISt L 1-6

CHAPTER 1
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1-2 Introduction

Indications for Use

The Norland Bone Densitometer is a prescription device used to perform non-invasive estimates of bone min-
eral density (BMD). It performs DXA scans of the AP Spine, Hip, Forearm, Lateral Spine, Research, Small Sub-
ject, and Whole Body (XR-800).

The scan provides the BMD (g/cmZ2), BMC (g), and the Area (cm2) values. These values are then compared to
sex and ethnic matched reference populations to provide the T-Score, % Young Reference, Z-Score, % Age
Matched, and the Short Term and Long Term change values. Included in this calculation is the sSBMD (mg/cm2)
values, where applicable.

The Norland Bone Densitometer also performs a soft tissue assessment and provides values for the Lean
Mass, Fat Mass, % Total Fat, and the % Soft Tissue Fat for the Whole Body, Research and Small Subject
scans. It also provides Siri and Brozek (underwater weighing) % Fat equivalent values.

The bone density measurements from the Norland Bone Densitometer can be an aid to physicians in determ-
ining a patient’s risk of fractures.

Contraindications

Caution: Do not perform a x-ray bone density scan on a pregnant subject. X-rays may be harmful to
developing fetuses.

A bone density study should not be performed within 10 half-lives of a radionuclide uptake procedure. The sys-
tem detectors may misinterpret residual emissions from recent radionuclide uptake procedures as energy gen-
erated by the Norland x-ray source.

Special scanning techniques are required when scanning patients with prosthetic devices, implants, or other
sub-dermal metallic objects. Some examples are hip prosthetics, pins, or staples. Refer to the section on
"Include/Exclude” on page 12-45 for details.

Scanning patients with external opaque (metal and plastic) objects, jewelry, buttons, zippers, rivets, buckles,
pens, keys etc. can affect the results if they are in the scanning region.

X-Ray Device Registration

Caution: The Norland Bone Densitometer is an x-ray device that emits small amounts of radiation to
acquire bone and soft tissue information. Although the dose is very small, some countries and all
states in the United States require registration of such devices, regardless of dose.

It is the purchaser’s responsibility to contact the appropriate government agency and comply with their reg-
ulations. Norland’s Customer Service can provide assistance in finding the appropriate government agency.
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Customer Service Contact Information

All requests for replacement parts, service or product related information should be directed to one of the fol-
lowing worldwide locations. To help the Norland representatives provide prompt and efficient service, please
have the serial number of the instrument available. See the figure on page 18-16 (of the Technical Reference
chapter) for the label location. The figure on page 18-18 (Scanner Labels) shows the Identification Label,
which has the instrument serial number on it.

Norland Customer Service

Norland

W6340 Hackbarth Road

Fort Atkinson, WI 53538 USA

Phone (Toll Free) 1-888-741-0413

Phone (International) +1-920-563-8456

Fax +1-920-542-4274

Email norland@swissray.com

E Authorized European Representative

Swissray Medical AG
Turbistrasse 25-27
CH-6280 Hochdorf, Switzerland

Phone +4141 914 1212

Manufacturer

Fax +4141 914 1201
Norland
W6340 Hackbarth Road

Fort Atkinson, WI 53538 USA

Support Website

Software updates and Operator's Guides can be
accessed from:

http://support.norland.com

Operator's Guide
435D109 Rev. Z
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About This Manual

This manual was originally drafted, approved, and supplied in the English language. A copy of this document
can be obtained by contacting Norland.

This manual contains information and operating procedures for bone densitometry acquisition and analysis
using the Norland DXA Bone Densitometer. The operator should become familiar with the Operator's Guide
prior to patient scanning.

The original software disk is located in the back of this manual. Store the software disk in a safe place. Soft-
ware updates are provided free of charge under initial warranty (12 month period after date of installation) and in
conjunction with extended warranty contracts. Installation instructions will accompany any software upgrade.

Chapter 1, Introduction: presents an overview of this Operator's Guide. Customer Service contact inform-
ation is also included here.

Chapter 2, General Information: discusses some of the features of the Norland DXA Bone Densitometer.
System radiation safety precautions and safety features are discussed in detail. (NOTE: additional information
on radiation safety is found in the Technical Reference chapter.) The chapter goes on to discuss the system
components, which includes the scanner unit, the computer, the windows software, and the accessories. A
Quality Assurance program is reviewed. The patient comparison section talks about trend comparison and ref-
erence set comparison. The five different Reports are examined: Bone Exam Report; Bone Exam Report - 1
Page; Combined Report; Patients Letter; and the Referral Letter. Print-outs of the sample Reports are also
included here.

Chapter 3, Installation and Setup: contains the information for installing and setting up the windows soft-
ware, drivers, microphone and databases. Next is the login instructions and an intensive examination of the five
software menu commands: File, Edit, Calibration, Tools, and Help. Scanner and operating settings are made at
this time.

Chapter 4, Basic Operation: discusses the basic patient scanning procedure. The steps for starting up the
system are next. The daily System Quality Assurance Calibration procedure is discussed in detail as well. The
QA results window is analyzed next. The chapter goes on to explain how to prepare a new patient database
record, as well as how to edit an existing patient’s record. Next, the Patient Demographics window is dis-
cussed in detail. And finally, the chapter wraps up with how to back up the system and shut it down.

Chapter 5, Scanning AP Spine and Chapter 6, Scanning Hip: discusses scanning the AP Spine and the
Hip. The chapters start out with the scan specifications. Tips on maintaining high quality scans are given next.
General patient scanning cautions are given. Next are the actual scan procedures, beginning with the checklist,
patient information update, patient positioning procedures, marking the scan region, and starting the actual
Measure scan. Scan Analysis and Results are discussed at the end, along with instructions on how to generate
and print a Report.

Chapter 7, Scanning Forearm: discusses scanning the Forearm. The chapter starts out with the scan spe-
cifications. Tips on maintaining high quality scans are given next. General patient scanning cautions are given.
Next are the actual scan procedures, beginning with the checklist, patient information update, patient pos-
itioning procedures, marking the scan region, and starting the actual Measure scan. Scan Analysis and Results
are discussed at the end, along with instructions on generating and printing a Report.

Chapter 8, Scanning Lateral Spine: discusses the scan procedure to estimate bone mineral in the lumbar
spine using a lateral projection. The chapter starts out with the scan specifications. Tips on maintaining high
quality scans are given next. General patient scanning cautions are given. Next are the actual scan procedures,
beginning with the checklist, patient information update, patient positioning procedures, marking the scan
region, and starting the actual Measure scan. Scan Analysis and Results are discussed at the end, along with
instructions on generating and printing a Report.

Chapter 9, Scanning Whole Body: this option quantifies bone mineral for a subject’s entire body. The chapter
starts out with the scan specifications. Tips on maintaining high quality scans are given next. General patient
scanning cautions are given. Next are the actual scan procedures, beginning with the checklist, patient inform-
ation update, patient positioning procedures, marking the scan region, and starting the actual Measure scan.
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Scan Analysis and Results are discussed at the end, along with instructions on generating and printing a
Report.

Chapter 10, Research & Small Subject Scan: as options, these two types of scans are very similar, and are
therefore combined into one chapter. The Norland software quantifies bone mineral in any user-defined region of
a patient or subject anywhere within the scanner’s active scanning area. The subject of a Research or Small
Subject scan could be human, animal, or an inanimate object. Initial setup, patient/subject positioning, scan pro-
cedures and result analysis are also discussed. Instructions to generate and print a Report are included at the
end of the chapter.

Chapter 11, Soft Tissue Composition: this option estimates the lean and fat composition of the soft tissue in
the Whole Body, and special regions of Research and Small Subject scans. It works in conjunction with the
Whole Body, Research, and Small Subject scans to provide lean and fat soft tissue mass values in addition to
the bone density values. The chapter discusses Tissue Composition Standards, Soft Tissue Composition and
Results. Instructions to generate and print a Report are included at the end of the chapter.

Chapter 12, Additional Techniques: discusses audio dictation, ImageMail, and FolderMail. The chapter also
includes, Special Region Cursors, Include\Exclude, the Ruler Tool, Reanalyzing Scan Data, Comparison
Image, Analyzing Saved Scan Data and other scan techniques. Database management, as well as Reference
Set maintenance is also detailed in this chapter.

Chapter 13, Ten Year Fracture Risk: contains information about generating Ten Year Fracture Risk Assess-
ment reports.

Chapter 14, DICOM Interface: contains information on using this feature. DICOM (Digital Imaging and Com-
munications in Medicine) is a global IT standard that is used in hospitals to “control” medical images and
derived structured documents as well as to manage related workflow.

Chapter 15, Data Extract: contains information about exporting patient and scan information to a format that
can be imported into a spreadsheet or database program.

Chapter 16, General Maintenance: contains routine maintenance information. This typically involves basic
cleaning and operational checks. Corrective scan procedures and system maintenance are also detailed in this
chapter.

Chapter 17, Troubleshooting: contains basic troubleshooting procedures to assist the operator.

Chapter 18, Technical Reference: contains a Technical Reference guide. Equipment specifications and
other regulatory information will be found in this chapter. Labels are discussed in detail.

Chapter 19, Reference Data Sets: contains information about the Norland Reference Data Sets, including
the data collection process and criteria. A listing of the values of each Reference Data Set is also included in
this chapter.

The Index is included at the end of the Operator's Guide.
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Symbols List

A Indicates information, general caution or possible safety hazard.

. Indicates helpful notes or additional procedure steps.

Indicates radiation from laser positioning aid.

ON/OFF Power Switch

Turn the scanner ON and OFF by depressing the power switch located on the right side of the scanner table
base (all models).

Power
Switch

Figure 1-1: Power Switch location
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Scanner Arm Touch Pad Symbols

READY @

Figure 1-2: Scanner Touch Pad

HALT

o
The Radiation exposure and arm movement can be terminated by the operator at any time by pressing
the HALT button on the Scanner Arm Touch Pad.

The laser is turned ON and OFF by pressing the LASER button on the Scanner Arm Touch Pad.
When the laser is ON, the indicator next to the button is illuminated yellow.

The MARK button is used to identify and mark the scan area.

The READY indicator illuminates green to indicate that the x-ray source is energized.

3 L XY
X-RAY a

The X-RAY indicator illuminates yellow only when the shutter is open and the x-ray beam is access-
ible. The X-RAY indicator extinguishes after the end of a scan when the shutter has closed.

. . . . The four arrow buttons are used to manually move the scanner arm and to pos-

ition it when marking the scan area.
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General Information

The Norland DXA Bone Densitometer uses a technique known as Dual Energy X-Ray
Absorptiometry (DXA) to perform non-invasive estimates of bone mineral density
(BMD) in specific regions of the body. The bone density estimates from the Norland
DXA system can be used to aid the physician in diagnosing and managing osteo-
porosis, as well as an aid in assessing risk of fracture.

Information on radiation safety and some of the operational characteristics of the Nor-
land system are on the following pages.

Sample printouts of the reports are included throughout this chapter.

This chapter discusses the following.

Radiation Safety Precautions . . ... ... 2-2
Radiation Safety Features ... ... . ... .. 2-3
Scanner Features .. 2-3
System COMPONENES . . ... L 2-5
Quality Assurance Program ... 2-8
Patient CompariSOoNn ... ... L 2-8
SCaN REPOMS .. 2-12
Sample SCan RepPOMS . ... ... 2-17
Quality Assurance RepOMS . ... .. 2-30

CHAPTER 2

D10 Fev 2 NORLANLDO



2-2 General Information

Radiation Safety Precautions

Radiation safety is an important consideration whenever working with x-ray devices. The Norland system
emits very little radiation to the patient or scatter radiation to the operator, however certain precautions should
be followed to ensure a safe environment for operators and patients.

Stay Out of the Beam

The Norland unit produces a narrow x-ray
beam, which cannot be seen or felt, that
passes from the x-ray source in the table
through the scan subject to the detectors in
the scanner arm. Although the Norland x-ray
system produces a much lower powered
beam in comparison to more traditional x-ray
devices, do not expose any part of your body
to it unnecessarily. Refer to "Position of X-ray
Beam" on page 18-12 in the Technical Refer-
ence chapter for a diagram of the x-ray beam
location.

Avoid Scatter Radiation

As the beam passes through the patient,
some of it is scattered in all directions. This
scatter radiation is specified to be less than
0.1 mRem per hour three feet from the beam,
and is only present when x-rays are being emit-
ted, such as during the scan. Although this
amount of scatter radiation is relatively low,
minimize exposure wherever possible. Oper-
ators should position themselves three (or
more) feet from the scanner whenever the
x-ray beam is present.

State Requirements

All states (of the US) have regulations for x-
ray devices that apply to the owners of bone densitometers. You are strongly encouraged to contact your
state’s department of Radiation Control for details.

Control General Access

Whenever possible, the scanner should be placed in a controlled environment that is not accessible by the pub-
lic. In general, if this is not possible, keep the public at least six feet from the beam during the scan process.
State regulations may vary therefore it is important to comply with the specific regulation in your state.

Caution: For patient and operator safety, position the back of the scanner (open area under the tab-
letop) within a few inches of the wall to prevent unauthorized access to the interior of the device.
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Radiation Safety Features
Exposure Control

The exposure is controlled solely by the operator. The operator must click the button on the com-
puter screen to initiate the exposure.

The exposure can be terminated by the operator at any time by clicking the button in the Scan tab

window, or by pressing the button on the Scanner Arm Touch Pad.

Note: TO RESTART: To resume scanning after the HALT button has been pressed, turn the scanner
power switch OFF and back ON again. Leave the computer power ON to retain the current study.
When scanning is resumed, the scanner arm will return to its origin position. ENSURE THAT THE
PATIENT IS NOT IN THE SCANNER ARM PATH!

Technique Factors
The technique factors (loading factors) are the operating parameters that determine the radiation exposure to
the patient. Tube voltage and tube current are fixed, highly regulated, and not subject to line conditions. They
are not controlled by the operator. Exposure time depends on the scan type and the size of the scan area.
Communication Watchdog

The Norland scanner includes a 'watchdog' circuit which monitors data collection communication during the
scan. If communication fails, the exposure is terminated.

Exposure Indicators

READY @
The green READY indicator - on the Scanner Arm Touch Pad illuminates to indicate that the x-ray source
is energized.

X-RAY 4sb
The yellow X-RAY indicator -_is illuminated only when the beam shutter is open and the x-raP/ source is
energized. The X-RAY indicator extinguishes after the end of a scan when the beam shutter has closed and the

beam is not present. To prevent inadvertent x-ray exposure, the x-ray source will be automatically dis-
abled if the shutter malfunctions.

Radiation Shielding

System leakage and scatter radiation levels are very low and special shielding is not required. Room shielding
is not necessary and the operator does not have to be behind a barrier during the scan. At the typical distance of
3 feet from the beam, the radiation level is <0.1 mRem/hour. Norland recommends that operators position them-
selves at least three feet from the beam during the scan or as indicated by local state x-ray regulations.

Audible Indicator

An audible indicator sounds at the end of each scan. DO NOT DISCONNECT your computer speakers or turn
the sound level down too low. FDA regulations require this sound be heard.

Scanner Features

Some of the innovative features used in the Norland system are described in the following sections.
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Dual Energy X-Ray Absorptiometry (DXA)

Dual Energy X-ray Absorptiometry (DXA) is a method of estimating bone mineral utilizing a pencil beam x-ray
beam filtered to provide the two distinct energy peaks necessary to distinguish bone from soft tissue.

SimulCountTMensures a more accurate measure of BMD. Dual Nal scintillation crystals are used to sep-
arately detect the two x-ray energies.

The technique for separating x-ray output into two distinct energy levels is known as K-edge filtration. In K-edge
filtering, a rare earth element is placed in the beam path and x-rays are sharply attenuated at energy levels par-
ticular to that element. Norland uses samarium as the filter material because it produces energy peaks at
46.8keV and 80keV, which have proven to be most effective at differentiating between soft tissue and bone tis-
sue.

Dynamic Filtering

DynaFluxTMis another Norland innovation that is complementary to its pencil-beam design. Norland has
developed a method of optimizing the photon count rate for varying patient thickness by automatically selecting
the proper samarium filter combination. This filter selection feature prevents starvation or saturation of the
detector assembly.

QuikScanTM Technology
All Norland central DXA bone densitometers incorporate our exclusive QuikScanTM technology. QuikScanT™

technology incorporates a combination of mechanical, hardware, and software improvements that have res-
ulted in a reduced patient dose and scan time, while maintaining optimum precision and accuracy.
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System Components

The Norland Bone Densitometer consists of a Scanner Unit and a Control/Analysis Computer with a color
printer.

Scanner Unit

The Scanner Unit is a specially constructed table that accommodates the patient in a supine position. The tab-
letop is cushioned and upholstered with a highly durable antimicrobial fabric that can be removed for cleaning.
Referto Cleaning Scanner Exterior on page 16-2 and Cleaning Table Top Pad on page 16-2 for special instruc-
tions.

The radiation source is an x-ray tube with heavy K-edge filtering. The x-ray tube is mounted within a lead-shiel-
ded chamber, which has an electrically operated shutter across the beam exit path. The beam is aligned with
the detector assembly in the scanner arm. The x-ray source is specially designed for densitometry and has a
low operating temperature and long life.

Figure 2-1: XR-800 Scanner Figure 2-2: XR-600 Scanner

Scanner Arm Touch Pad

The Scanner Arm contains the Scanner Arm Touch Pad. The operator uses the buttons on this touch pad to
position the scanner arm directly over anatomical landmarks to define the desired scan area. The up and down
arrows move the x-ray source/detector assembly along the X-axis (across the patient table, from front to back).
The left and right arrows move the scanner arm along the plane of the patient table (the Y-axis). The MARK but-
ton is used to identify and mark the scan coordinates for scanning patients and Phantoms. Refer to "Exposure
Indicators" on page 2-3 for information on the READY and X-RAY indicators. Refer to "Exposure Control" on
page 2-3 for information on the HALT button. The laser button is discussed in theLaser Positioning Aid section
below.

Figure 2-3: Scanner Arm Touch Pad
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Laser Positioning Aid

A low-power laser located in the scanner arm indicates the exact position of the x-ray beam. The laser beam is
aligned with the narrow x-ray beam in the table and serves as an aid in marking or defining anatomical land-

L:jf“ "
marks. The laser is turned ON and OFF by pressing the LASER button on the Scanner Arm Touch Pad.
When the laser is ON, the indicator next to the laser button is illuminated.

Although it is a low-power laser, the following precautions should be noted:

CAUTION

LASER RADIATION
DO NOT STARE INTO BEAM

1.0 MILLIWATT MAXIMUM
650 NANOMETER OUTPUT
CLASS Il LASER PRODUCT

» Do not stare into the beam.

» Do not allow the laser to shine into your eyes. If the laser light does briefly shine into your eyes, it may startle
you, but will not cause immediate damage.

» Do not allow shiny objects to reflect laser light into your eyes.

Computer/Controller

The Norland Bone Densitometer is controlled by a desktop PC. The computer is designed and configured to
operate the Norland Bone Densitometer system and should not be used for any other purpose. The computer
is certified as an X-Ray Controller at Norland's manufacturing facility, as required by the FDA.

Software

The Norland Bone Densitometer software conforms to a Windows style design for ease of use and familiarity.
Features of the Norland software include menu driven operation for system calibrations, scan data collection,
scan analysis and patient file management.

Accessories
The Norland system comes complete with the accessories listed in the next four sections.

QA Calibration Standard

The 77-step QA Calibration Standard (EmpiriCAL ™) is an exclusive combination of layered plastic and metal
material used for system calibration. It is equipped with handles and labeled with characterization values estab-
lished at the factory.

QC Phantom

The anatomically correct QC Phantom provides an accurate representation of the human spine bone density
and soft tissue distribution. Each phantom (unique for each system) has a serial number and includes a label
listing the assigned Bone Mineral Density (BMD), Bone Mineral Content (BMC), and BMD Standard Deviation
(BMD SD) values as determined by factory characterization. Depending on your options, the Phantom may
alsoinclude Fat, Fat SD, Lean, and Lean SD values. Referto Cleaning QC Phantom on page 16-2 for special
instructions.
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Patient Positioning Aids

Patient positioning aids are provided for special positioning of the patient during spine, hip, lateral, and forearm

procedures.

Table 2-1: Patient Positioning Aids

Positioning Aid

Part Number

Description

Hip Sling 433A134 Used to orient the patient's legs in a position best suited for
accurate and precise hip scans.

Leg Separator Block 388D550 Used with hip sling to achieve proper abduction.

Leg Rest Block 433D132 Used to raise the legs to straighten the spine.

Forearm Positioning Fixture * 435A094 Used to position patient’s forearm. Includes the elbow and
hand pads.

Lateral Positioning Blocks * 433A265 Used to properly position the patient’s body for a lateral scan.

Includes the rib cage support, back rest block, limb blocks,
and head support pillow.

* These aids may or may not be included depending on your options.

Operator's Guide
435D109 Rev. Z
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Quality Assurance Program

Norland equipment is configured to assist facilities in establishing an effective Quality Assurance
Program.

Precision and accuracy of bone mineral density assessments are dependent on an effective Quality
Assurance Program.

Norland strongly recommends performing patient scans on the Norland system only after successful
completion of the daily Quality Assurance calibration. The calibration compensates for spectral shifts
in the x-ray source, slight differences in the interface circuitry and other factors.

Chapter 4, Basic Operation, contains a step by step procedure for performing the daily system quality assur-
ance calibrations. Refer to the "Daily Calibration Procedure" on page 4-6 for details. The procedure consists of:

» scanner stabilization

» parts damage check and positioning
» ascan of the QA Calibration Standard
» ascan of the QC Phantom

» diagnostic tests

» and calibration verification

Once the calibration routine is initiated, it proceeds automatically until all data is collected and the results of the
QA Calibration Standard and the QC Phantom scans are displayed.

QA results should be printed and kept in a paper log file for quick reference.

Norland software will automatically display an Alert pop-up dialog box when more than 24 hours has elapsed
since the last calibration. Norland strongly recommends performing a daily calibration before scanning patients.
Sample pop-up:

Norland Alert

lthas been 3 days since vour last calibration. Maorland
strongly recommends performing a daily calibration
& before scanning patients!

Figure 2-4: QA Alert pop-up

It is not necessary to calibrate the system on a day that the Norland Bone Densitometer will not be used to
scan patients.

Patient Comparison

Patient scan results are compared to reference populations or to previous scans for comparisons for diagnosis.
Much has been written on the use of bone mineral analysis techniques.a b ¢

@Ross, P.D., Davis, J. W. Vogel, J. M., and Wasnich, R. D.: “A Critical Review of Bone Mass and the Risk of Fractures in Osteoporosis”. Cal-
cified Tissue International 46:149-161, 1990.

PMelton 111, J. L., Eddy, D. M., Johnson Jr., C. C.: “Screening for Osteoporosis”. Annals of Internal Medicine. 112:516-528, 1990.
C*Assessment of Fracture Risk and its Application for Postmenopausal Osteoporosis”, WHO Technical Reports Series, No. 843.
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Trend Comparison

Assessment of the rate of change in bone mineral density provides the clinician with the best information regard-
ing whether the patient is losing or gaining bone mineral. If previous assessments have been made of the
patient, the current assessment may be compared with past scans to determine the rate of change.

Statistical reasoning is required to interpret scan results. Differences in two serial assessments of a patient
that are close in value could simply be due to random variation. In order to have 95% confidence (p<0.05) that a
change in value represents a change in actual BMD, the change must be at least:

24/2 x % X BMD value

The above equation would be valid for two scans of the same anatomical site on one patient from the same Nor-
land unit. The Coefficients of Variation (C.V.) furnished for each measurement type are valid for subjects hav-
ing well defined bones and non-calcified soft tissue. The following table shows an example of the above
equation using manufacturer C.V. values.

AP Spine Change Femoral Neck Change
C.V.of 0.9%a C.V. of 1.4%b
If the first value is 1.0 g/cm?2 If the first value is 1.0 g/cm?2
then change must be then change must be 0.039
0.025g/cm2. g/lcm2,

Note: C.V.’s for individual facilities may be different from manufacturer specified C.V.’s, depending
on operator technique and experience.

Precision

Precisionis the degree to which the same value is obtained when a measurement is repeated. In vivo precision
in the Norland Bone Densitometer is the degree to which the device presents the same bone mineral value
when a measurement is repeated at the same anatomical site on the same subject.

Factors affecting precision are:

» inherent instrumentation errors

» operator technique

» the in vivo nature of the measurement

All precision specifications given in this guide and on the Norland outputs assume:
» a properly operating instrument

» astationary scan subject

» an experienced operator

» proper and consistent positioning and analysis techniques

Precision can be improved by averaging a number of repeated measurements. Then the precision of the mean
value is improved by a factor of the square root of the number of measurements. This technique is used with
phantoms for evaluating instrument accuracy.

8As specified in Table 5-2, on page 5-2.
bAs specified in Table 6-2, on page 6-2.
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Accuracy

Accuracy is the degree to which a measurement value reproduces the actual value of the quantity being meas-
ured.

Although the accuracy of a single measurement includes the imprecision of that measurement, it is customary
to specify instrumental accuracy with the imprecision effect removed. This is called “accuracy of the mean”
because taking the mean or average of many measurements minimizes the imprecision. The accuracy spe-
cifications for the Norland Bone Densitometer are stated in terms of accuracy of the mean.

Several manufacturers have adopted phantoms fabricated of calcium hydroxyapatite and epoxy. The cal-
ibration of each Norland instrument is based on hydroxyapatite phantoms constructed to specifications
described by White (White, D. R., Martin, R.J., and Darlinson, R.: “Epoxy resin based tissue substitutes.” Brit.
J. Radiol. 50, 814-821, 1977).

Standard Deviation (S.D.)

Standard Deviationis used to specify precision. In a normal (or bell-curve) distribution, 68% of all the estim-
ations lie within one standard deviation of the mean, and 95% of all measurements lie within two standard devi-
ations of the mean.

Coefficient of Variation (C.V.)

Coefficient of Variation is used to specify precision. It is the standard deviation expressed as a percent of the
measured quantity. The coefficient of variation is the standard deviation divided by the mean.

Reference Set Comparison

The patient's Bone Mineral Density (BMD) estimate can be compared to a reference population that is clinically
free of bone disease and matches the patient's sex, ethnic background, and age. This variance of the patient's
BMD value relative to the mean of the reference population is graphed and expressed as a standard deviation.
Norland software contains many reference sets for comparisons and facilities can create their own reference
sets based on local populations.

Reference Set upgrades are provided free of charge and are usually distributed as they become available.

Reference sets are displayed as a chart containing the average BMD value of the reference population for the
prescribed anatomy. Many reference charts are color coded to assist with Fracture Risk Assessment. A
sample chart is displayed in Figure 2-5.

The middle line represents the average value for BMD for the ages included in the chart. The dashed lines
above and below the middle line are (+2) and (-2) standard deviations from the mean value.
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L2-L4 morland 4500 C

1.411

1,315
1214 Low Risk
L (Green)
1027
ool
= Medium Risk Medium R|Sk
(Yellow)
High Risk
(Red)

AGE

Figure 2-5: Fracture Risk Reference Set Chart (sample)

Norland incorporates the WHO (World Health Organization) criteria in plotting a patient's fracture risk assess-
ment (see table below).

Table 2-2: World Health Organization Risk Factor Criteria

Low Risk Represents the range of values determined by WHO to be 'normal' (having
(Green) adequate bone mineral). The BMD T-Score values in this region are within 1 SD of
the young adult reference mean value. A patient whose value is plotted in this
region has no identifiable risk of fracture.

Medium Risk Represents the range of values determined by WHO to be 'osteopenic' (having low
(Yellow) bone mineral). The BMD

T-Score values in this region range are more than 1 SD below the young adult mean
value but less than 2.5 SD below the mean value. A patient whose value is plotted
in this region may be developing a tendency to fracture.

High Risk Represents the range of values determined by WHO to be 'osteoporotic' (having

(Red) severely reduced bone mineral). The BMD T-Score values in this region are more
than 2.5 SD below the young adult mean. A patient whose value is plotted in this

region has a high spontaneous fracture probability.
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Scan Reports

Five different types of Reports can be generated for each scan: the Bone Exam Report, the Bone Exam Report
- 1 Page, the Combined Report, the Patient Letter, and the Referral Letter. In addition, the Ten Year Fracture
Risk Report can be generated for Hip Scans (if enabled), and the Body Composition Report can be generated
for Whole Body Scans (if enabled). The next section discusses how to generate these Reports. A discussion of
each Report is also included in this chapter with a sample of each for reference.

Generating a Report
Reports may be generated two different ways:
Follow these steps to generate a Report from Scan Results:

. Feport .
After a scan has been performed, analyzed, and saved, click i to generate a report using the cur-
rently selected report template.

Follow these steps to generate a Report from Stamp View or Filmstrip View:

1. Make sure that the scanned image is being viewed as a thumbnail in the Stamp View or the Filmstrip View.
Click (to highlight) the thumbnail view of the scan.

2. Click Tools > Report > Select Template... or click the m button to open the “Report Con-
figuration” dialog box.

Fir Edi  Celbration [Took| Help

Fide Tock
Calibration Details

Sendt Tox '

s
Report ' Generate New
Audin Dictation rarsh Exitin

Log Files +
Scan Quakty lssues iditor
FRecommers datior Edito

Select Template...

3. When the Report Configuration dialog box opens, click a Report Template to highlight it (Bone Exam
Report - 1 Page was selected here). See "Sample Scan Reports" on page 2-17 for examples of the report

template selections. Click .

Report Configuration

Choose a Default Report Template

Bone Exam Report - 1 page j Done

Ten Year Fracture Risk Report

Note: The selected Report Template will remain the default until it is changed. The currently selected
Report Template is always displayed at the bottom of the IlluminatusDXA window.

4. Click Tools > Report > Generate New or click the button.
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File Edit Calibration |Tools | Help

Initialize Scanner

Service Tools >
File Tools

Calibration Details

Send To: >

DICOM Interface

Mail /
Report > Generate New

Audio Dictation Finish Existing/Make Addendum

View Selected

Log Files »

Scan Quality Issues Editor

Recommendations Editor

Select Template...

5. The Report is immediately generated and opens up in the window, as shown. At this point, the operator can
type in their comments and recommendations, Lock it, Saveit, Printit, Exportit to a PDF file (ora DICOM
file) and Closeit.

F.)d Report Type: Bone Exam Report - 1 page - 5/21/2015 - Creating Ne l |

File

Name: Lastname, Firstname A. Sex: Female Height: 51"
in: PaentiD Ethnic: ‘Caucasian Weight: 110
DOB: 2/19/1968 Age: 34 years

LI H AP Spine on: S/6/2002 1:51:17 PM

L2-L4 Norland 4/00 L2 Norland 4/00 c
1.411

% 3

VounzRef (%) 811  Dats  Valse VounzRef (%) 7735  Dats  Valse
T-Score 128 07/19/00 0.821 T-Score 151 07/19/00 0.819
AgeMatch (%) 823 07/20099 0.862 Ag=Match (%) 777 07/20099 0.850
ZScorz 118 0723870894 ZScors 148 07/23/97 0.878

Bons imag= not for diagnosis.

Manuzl Cursor Placement

Arsa  Lensth Width T- VownzRef Z- As=Match ST Changs ST Chanze LT Chanz= LT Chane=
< P s e P i, P P

| Resion BMD (ziem?) BMC ()

; Lock I Save | Print | EgDDFlPDFl ExpurlD\COMl Close

The buttons and their functions are explained next.

=

: Click to lock a report, which prevents it from being deleted. It can still be edited.

Sane

: Click to save a report without printing. It will appear on the Reports tab.

Print

: Click to automatically save and print a report.

Export POF

: Click to create and save the report in a PDF format. Browse to the appropriate directory, type ina

| Click 9o

. . 5
file name and click ‘ =7

Export Dicam

: Click to create a DICOM compatible report (active only when DICOM option is enabled).

When done reviewing the Report, click and then . The Report is saved, attached to the

scan, and a new tab is created - called Reports.
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The “Reports” Tab

As mentioned previously, once a Report is generated and saved, it can be viewed from the “Reports” tab. It can
be modified, viewed and re-printed at any time.

1. From the Stamp view, click the Reports tab to see the Report list (shown here).

M 1lluminatus DXA 4.1.0: Smith, Jane 123-456-7890: 6/29/2005

File Edit Calbration Tools Help

Scan Results ]

Scans lepgrtg

Scan Results ]

1 4 Br20/2006 234 P B/21
148 Br20/2006 4:20 P B/21
16 Bf20/2006 5.02 P B/21
17 Br20/2006 5:04 PM B2l

Fle Edt Calbrsbon Took Help
Scany Reports |

i a3 | 3 Combingd Fupon
B20FI006 2:34 PM Bone Exam Report 1
s GOI00R 430 FW E4IUZ006 430 M Fatient Laner Lafi Hip 0
s B20C00E 502 FM BOONO08 4,02 M Faben Letier LenHg [ AgmrsRalor
:I L B2072006 504 PM GINZ006 505 PM Patient Letier Lot Hp o Administrator

All of the Reports generated will appear in this list along with the date they were created. Double clicking on any
of the Report names will open the Report for viewing.

» Toview and print any saved Report, double-click on it.
» Todelete a Report, click on the Report to select it. Press <Ctrl>+<Delete>. (NOTE: a locked Report can-

not be deleted.) When the “Confirm” pop-up appears, click fes

Are you sure ol wank ko delete this report?

» To modify a Report that is not locked, click on Tools > Report > Complete Report to open it.
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File Edt Calbration Help

Initialize Scanner
Service Tools 13
File Tools

Calibration Details
Send Ta: 3

DICOM Inkerface

Mail

Gererats Mew
Audio Dictation

View Selected
Log Files

scan Quality Issues Editor
Recommendations Editor

Select Template. ..

» To modify a locked Report, click on Tools > Report > Make Addendum. Make any edits to the Comments

field as necessary. Click ’?I then m

Flle Edit Calibration mﬁ Help

Initialize Scanner

Service Toals 3
File Tools

Calibration Details
Send To: 3

DICOM Interface

Mail

Generate Mew

Wiew Selected

Scan Qualty Issues Editor
Recommendations Editar

Select Template, .,

M Report Type: Bane Exam Repart
Fie

M Heseach, $2an Ethie: Comanien
. Haret Heghe

Age. 3 ey Wt 8
Sex: Femate

Flesnarch e B/2SI006 416 PM

Duw  BMD
DEZANS 0295

Bars image st for dingrotis

Bugics BMDigha’) BMC(g) Amafem?) Lengthiem) Wilthiem) LeownMusig) FuMuoig) Todcom YoungBef (%) Zdeom g Mutch(%) 5T Chinge (39 5T Change (Wi LT Chungs (%) LT Chungn (34}
Capd B2 1211 4148 1230 143 e ey sasas N B8 . o [

S Digomabon's (v bon ibcammation on CVs
0.0 mren 1 Oren, i swns, 1380 eon, Reve, 41,002 31 Call ORS00 5.0 8348

Comments

(Type commenta bere.

wer | g | e | Eponrer | emenocou
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Editing the Patient Letter or Referral Letter

The information from Bone History and Osteoporosis Medication fields in the Demographics screen will be lis-
ted in the Referral Letter.

Scan Quality Issues and Recommendations can be added to either report using a checklist.
» To edit the Scan Quality Issues checklist click on Tools > Report > Scan Quality Issues Editor.

File Edit Calibration

Initialize Scanner

Service Tools 3

File: Toals
Calibration Details

Send To: 3

DICOM Interface

Mail

Generate Mew
Camplets Report
Vigw Selected

Audio Dictation

Log Files

Recommendations Editor

Select Template...

» To edit the Recommendations checklist click on Tools > Report > Recommendations Editor.

File Edit Calibration

Initiglize Scanner

Service Tools 3
File Taols
Calibration Details

Send To: 3

DICOM Interface

Mail
Generate hew
Audio Dictation Complste Repart
T ViewSelected
Log Files »
Scan Quality Issues Editar

Recommendations Editor

Select Template.

» Create a new entry by entering the information in the first line of the dialog box.

W Recommendations Manager

Managing Racammendations:
Aod Heplaze Delete Soit | ﬂ ﬂ
exerise

calcum supplemant

Ok LCancel
» Click add Click OK ] It will now be included in the drop-down list as a selection.
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Sample Scan Reports
The Bone Exam Report

The results of the Analysis function include image displays, graphical displays and numeric information and are
typically printed as a two page report. This report is referred to as the “Bone Exam Report”. An example of a
Bone Exam Report is included in this section.

The first page of the Bone Exam Report displays the basic patient information (as entered in the Patient Demo-
graphics window by the operator when preparing the patient record).

Next, the Report includes an image of the scanned region. The BMD is displayed in chart form to the right.

Following the graphs, the BMD, BMC, and Area quantities are displayed in numeric terms in the form of a table.
Quantities of bone mass are reported as Bone Mineral Density (BMD), Bone Mineral Content (BMC), and Area.
The BMD is BMC divided by Area, and is expressed in milligrams per square centimeter.

This complete table includes the scan data, reference and/or trend information for the measured region(s), and
basic scan conditions. Detailed numeric results for the region(s) scanned are displayed here. The T-Score and
Z-Score values are displayed in the table, as well.

The last line of the table in the Report (for AP Spine and the Hip scans only) includes the Total sBMD report.
The units are in mg/cm2 for the region of interest. Quantities of bone mass are reported as Bone Mineral Dens-
ity (BMD), Bone Mineral Content (BMC), and Area. The BMD is BMC divided by Area, and is expressed in
grams per square centimeter. The Committee for Standards in DXA instituted correlation equations for AP
Spine (1995) and Hip (1997).

Whole Body scans (an option) additionally provide the lean and fat composition of the soft tissue (presented in
grams). Total body fat percent and underwater weighing equivalents are also displayed.

Furthermore, sSBMD and NHANES lll is only used for female Caucasian Total Hip Scans. The sBMD (standard
Bone Mineral Density) values provide the physician with T-score and Z-score results for the total Hip scans that
are derived from accepted reference data sets, including NHANES Ill. More detail about this topic may be
found in the Reference Data Sets chapter.

Next, a “Comments” area is located at the bottom of page 1. This part of the Report is a text entry area that is
filled in when the Report is generated. Once a Report is saved, the comments fields can be added to or
changed later by Text can also be added (or changed) later by selecting Tools > Report > Complete Report
and then entering the text.

File Edit Calibration

File Tools
Calibration Details
Send To: 4

Mail

| Wiew Selected

| LogFiles »
1 Scan Qualiy Issues Editar
Recommendations Editor

Select Template. ..

The second page of the Bone Exam Report contains all of the patient personal data and specific scan para-
meter information. This includes scan type, resolution, and speed. It also contains the reference and trending
charts and specific data. The text entered in the “Comments” portion of the Patient Demographics window
prints out below the patient personal data.
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1: A Sample “Bone Exam Report”

A sample 2-page Bone Exam Report is included here for reference.

User-entered comments when the report was generated.

5/7/2015 10:05:29 AM Norland at Swissmy Page 1
W6340 Hackbarth Road Fort Atkinson, Wi 53538 USA (888) 741-0413
Name: Lastname, Firsiname Sex: Female Height: 51"
1D: PatientiD Ethnic: Caucasian Weight: 110
DoB: 2191968 Age: 34 years
| I H AP Spine on: 5/6/2002 1:51:17 PM
@ -L4 Norland 4/00
Young Ref. (%) 81.1 Date Value
T-Score -1.28  07/19/00 0.821
. Age Match (%) 813 O7/20/99 0,862
Z-Score =119 07/23/97 0.894
Bone image not for diagnosis.
Manual Cursor Placement
” Arca Length  Width T-  YoungRel. Z- Age Maitch ST Change ST Change LT Change LT Change
Region BMD(gfon?) BMC (g) (cm?) {cm) (cm)  Scorc (%) Score (%) (%) (%alyr) (%) (%fyr)
L2-14 08942 39.17 43.80 9.75 12.0 -1.28 I =119 R®23 BY 4.9 0.0 0.0
L2 08503 11.86 1394 330 12.0 -1.51 77.5 =1.49 frir i 4 39 2.2 =3.1 =117
L3 0.9006 13.22 14.68 i3 120 -1.25 808 -1.21 81.3 10.4 5K 21 0.4
L4 0.9284 14.09 1517 3135 12.0 -0.91 B3R {180 873 12.0 6.7 9 0.2
:;;:rl} 962 3mglem® 42150mg  43.80 9.75 12.0 -1.28 811 =119 2.2 B9 4.9 3.7 1.3
STO CVs for L2-L4 BMD: 1.0 BMC: 1.5 See Guide for other CV's.
1.5mm X 1.5 mm, 130 mmis, 12.00 cm, Rev. 3.9.4/2.1.0 Calib. 05/06/02 S/N 3840
Comments:

NORLANGD.

Figure 2-6: Page 1 of the Bone Exam Report
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6712015 10:05:29 AM

Norland at Swissray

W6340 Hackbarth Road Fort Atkinson, WI 53538 USA (888) 741-0413

Page 2

L2 Norland 4/00
1.42

115
-1.51
77.7
=149

Young Rel (%)
T-Score
Age Maieh (%)
£-Score

Total sBMD Norland 4/00
1520,

1320

Young Ref. (%)

1.1
-1.28
822
-1

T-Score
Age Match (%)
Z-Score

Date
07/19/00 0.819
07/20/99 0850
07/23/97 0878

Value

C

Date Value
O7/19/00 883 8
0720099 928.0

0723797 NiA

L3
1.45,

125
1.05
0.85

Young Rell (%) 808
T-Score
Age Match (%5) 81.3
Z-Score

60

AGE
Date Value
G719/00 0816
07/20099 0 883
07/23/97 0,882

-1.25 T-Score

-1.21 Z-Score

1.401

1.201

1.001
o

0.801
5 0.601

Age Match (%)

Name Lastname, Firstname 1] PaticntlD
Ethnic Caucasian
Address DOB 21191968
Telephone Age 34 vears
History non-traumatic bone fracture and primary ostcoporosis Meno Year
Treatment Sex Female
Medications  Actonel, Fosamax and Vitamin D Height 3
Commenis Weight 1
Scan Information
Scan Type: AP Spine Resolution: 15215
Analysis Date: 52172005 5:22:02 AM Speed: 130 mm/s
Calibration Date: 0506102 Width: 120
Technologist: Host/Scanner: 394210
Physician: Analysis/Revision: 394
Detailed Results
c Norland 4100  C | L4  Morand4mo

20 40

Young Rel (%) 858

-0.91
7.3
BRI

& 8

AGE

Date
O7/19/00 0,829
0720099 D834
07/23/97 01L.920

Value

NORLANLG

Figure 2-7: Page 2 of the Bone Exam Report
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2: A Sample “Bone Exam Report - 1 Page”

The information from the 2-page Bone Exam Report is condensed down to form this one page report, with
basic patient information and reference graphs for all regions of interest, as shown next:

§/7/2015 10:06:10 AM Norland at Swissray Page 1
WE340 Hackbarth Road Fort Atkinson, WI 53538 USA (888) 741-0413
Name: Lastname, Firstname Sex: Female Height: 51
1D: PatientlD Ethnic: Caucasian Weight: 110
DoB: 2119/1968 Age: 34 years
| H AP Spine on: 5/6/2002 1:51:17 PM
L2-L4 Noriand 4/00 C L2 Norland 4/00 c
1.411 1.42
1211 1.22
1.011 1.02
S o1 2 082
“ os11 @ pe2
20 40 60 20 40 60
AGE AGE
Young Ref. (%) 81.1 Date Value Young Ref. (%) 77.5 Date Value
T-Score -1.28  07/19/00 0.821 T-Score -1L51 071900 0.819
m Age Match (%) 823 07/20/99 0,862 Age Match (%) 77.7 O7/20/99 0,850
Z-Score =119 O7/23/97 0,894 Z-Score -1.49 O7/23/97 0,878
Bone image not for diagnosis,
Manual Cursor Placement
; Area Length Width T-  Young Rel. Z-  Age Match ST Change ST Change LT Change LT Change
Reg BMD (g/em?®) BMC
gen (g/om’) (@ {em?) {em) (em)  Score (%) Score (%) (%) (Yalyr) (%) (alyr)
LZ2-L4 0.8942 39.17 43 840 9.75 12.0 =1.28 811 =119 2.3 x9 4.9 0.0 0.0
L2 08503 11.86 13.94 330 12.0 -1.51 775 -1.49 77.7 39 22 =3l -0.7
L3 09006 13.22 14.68 3.30 12.0 -1.25 808 -1.21 Rl.3 10,4 58 2.1 0.4
L4 09284 14.0%9 15.17 3.15 1200 -0.91 B3 8 =080 7.3 12.0 6.7 0.9 0.2
Total
962 3mglem® 42150mg 43 .80 9.75 120 -1.28 811 119 $2.2 89 4.9 37 1.3
sBMD
L3 Noriand 4/00 C L4 Norland 4/00 Cc Total sBMD Noriand 4/00 c
o 0.85 o 0.801 o 1020|
z 2
o @
0.45 = . . 520!
20 40 60 80 20 40 60 &0 20 40 60 80
AGE AGE AGE
Young Ref. (%) B0.8 Date Value Young Rel (%) 838 Date Value Young Ref. (%) 81.1 Date Value
T-Score -1.23 071900 0.816 T-Score -0.91 071900 0,829 T-Score -1.28 O7/19/00 8838
Age Match (%) 81.3 07/20/99 0.883 Age Match (%) 87.3 07/20/99 0,854 Age Match (%) 82.2 07/20/99 928.0
Z-Score =121 07/23/97 0.882 Z-Score 080 07/23/97 0.920 2-Score -1.19 07/23/97 N/A
STD CVs for L2-L4 BMD: 1.0 BMC: 1.5 See Guide for other CVs.
1.5 mm X 1.5 mm, 130 mm/s, 12.00 cm, Rev. 3.9.4/2.1.0 Calib. 05/06/02 S/N 3840

Figure 2-8: The Bone Exam Report - 1 Page
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3: A Sample “Combined Report”

The physician has the option to combine the results of two different bone scans of a single visit into a one page
Combined Report, as shown next:

DoB: 211911968

5712015 10:06:34 AM Norland at Swissray Page 1
WE&340 Hackbarth Road Fort Atkinson, WI 53538 USA (888) 741-0413
Name: Lastname, Firsiname Sex: Female Height: 51
10: PatientiD Ethnic:  Caucasian Weight: 110

Age: 34 years

AGE

AP Sping on 5/6/2002 1:51:17 hM
L

c

L2-L4 Norland 400
1411
o 0911
=
o
20 40 60

Lef Hip on 3/6/2002 1:56:29 PM
[

Bone image not for diagnosis.
Manual Cursor Placement

Bone image not for diagnosis.

Young Rel (%) B1.1 Young Rel (%) 71.7

Fem Neck Horland 4/00 c

AP Spine on 5/6/2002 1:31:17 PM

Region  BMD (glem?®) BMC (g)

L2-14 8942 39.17
L2 08503 L1 86
L3 .96 13.22
L4 09284 14.09

Total

962 3mg/em? |
SBMD $62 3mglem® 42150mg

T-Score =1.2% 1215, T-Score -2.39
Age Match (%) 323 1.015| Age Match (%) 76.1
Z-Score -1.19 o 0.815) | Z-Score -1.90
Date Value E 0.615 Date Value
gg 0719100 0821 20 40 80 BCI 07/19/00 0.726
072099 0.862 AGE 07720099 0,755
0723197 0894 07/23/97 0.769

Area Length  Width T- Young Rel. Z-  Age Maich ST Change ST Change LT Change LT Change

{em®} {em}) (em)  Score (o) Score (%) (%) (%alyr) (%) (%afyr)
4380 9.75 12.0 -1.2% &1l =119 82.3 59 4.4 (LAY [IX1]
13.94 330 120 -1.51 77.5 -1.49 77.7 39 12 -3 -0.7
14.68 330 12.0 -1.25 LR -1.21 813 1.4 58 I | 0.4
1517 315 120 -0.91 B5 8 -0, 80 87.3 12.0 6.7 e 0.2
4380 9.75 12.0 -1.28 811 =119 82,2 89 4.9 3T 1.3

Left Hip on 5/6/2002 1:56:29 PM

Region  BMD (glem® BMC (g)

Fem
07078 3.458
Neck :
Troch 06256 1.299
Total 423 ompfem® 26844
SBMD Sa.Umgiem” L mg

Area Length  Width T-  Young Rel. Z- Age Match ST Change 5T Change LT Change LT Change

{em?) {em}) (em}  Score (%) Score (%) (] (Yalvr) (%o} (%alyr)
4 886 150 -2.39 7.7 =190 6. 2.4 -4 -7.9 =1.7
167 -1.48 79.5 =104 847 24 L3 13.5 18
32.22 =100 R7.1 =091 BE.2 1.9 L1 =37 -1.3

STD CVs for L2-L4 BMD: 1.0 BMC:
mm, 130 mm/s, 12.00 cm, Rev.

1.5 See Guide for other CVs. L3 mm X 1.5 §TD CVs for Neck BMD: 1.2 BMC: 1.7 See Guide for other CVs, 1.0 mm X 1.0
3.9.4/2.1.0 Calib. 05/06/02 S/N 3840 mm, 180 mm/s, 900 cm, Rev. 3.9.4/2.1.0 Calib. 05/06/02 §/N 3840

NORLANLG

Figure 2-9: The Combined Report

Operator's Guide
435D109 Rev. Z

NORLANLG



2-22 General Information

4: A Sample “Patient Letter”

The Patient Letter is a 2 or 3 page Report that is sent to a patient from the primary physician. Patient Letters
can be generated for a single scan or a combination of two different scans from the same visit. “Scan Quality
Issues” and “Recommendations” can be selected from a checklist.

Norland at Swissray

W6 340 Hackbarth Road Fort Atkinson, WI53538 USA (888) 7410413

Patient Beport - Bone Dengity Test

Patient Mame: Lastname, Firsthame Patient ID: Patierntl D
DOE: 2191 463 Gender: Female
Age: 34 vears Referred By:

Test Date: 562002 156 28 PM

Dear Firstname Lastname,
This iz the result of vour recent Bone Density Test

AP Spineon 54200215117 Phd

L2-L4] L2 L3 L4

Density {gierm)?| 0.8942 | 0.2503 | 0.9008 | 0.9284

T-Score A28 |45 |42 |03

Z-Score 19 | -148 1121 | 080

Left Hip an 5&/2002 1:56:24 Phd

Ferm MNeck | Troch | Total sBMD

Density (gfem)?| 07072 0.6256 | 833 .0mgiem?

T-Score -2.39 148 | -1.00
Z-Score -1.90 104 103
Bl CORP LR S0 Fem Neck
0779, . :
Scan Diate: BRI Change Bazeline * | .
0758 1 T
4 072347 0.789 gbm? o 0739 :
2 075048 0.75500m? -0.013g4m3(-1.7%) 00138 £m3(-1.7%) & o718 : : : . : :c
S i H i i :
P 2. 5 21 t t t t t
3 0749400 0.726gkm? -0.030g4m3(-4.0%) -0.043 &m?([-5.6%) A R S R
4 05A6A2 0.708gkm? -0.018g4m3(-2.4%) -0.061g&m?([-7.9%)] AGE

Given the documentend precision of these studies, changes that exceed the limit of Least Sigrificant
Change of 0.02%g/km?= (4 0% may indic2e a signific art change between the studies being
compared.

Figure 2-10: Page 1 of the Patient Letter
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Norland at Swissray

W6340 Hackbarth Road Fort Atkinson, Wi 53538 USA (888) 741-0413

Your test was performed using the Norland DXA Bone Densitometer, serial number 3840, This system uses the industry
standard dual energy x-ray absorptiometry (DXA) technique to estimate your bone density non-invasively. Your test includes
values called the T-score and the Z-score. The T-score compares the current study to bone density of a young healthy
population and the Z-score compares the current study to an age and gender matched reference population.

Your T-score can be evaluated according fo the criterion established by the World Health Organization (WHO) as follows:

If your T-score is: | You may be:
-1 or above | Mormal (adequate bone density)
between -1and -25 | Osteopenic (reduced bone density)

below -2.5 | Osteoporofic (severely reduced bone density)

The WHQO criterion are especially useful when assessing the condition of postmenopausal women, men over 65 years of age
and men between 50 and 65 years of age with risk factors that may lead to excessive bone loss.

Although very useful, this test is not the sole determinant of your bone health. There are other factors to consider, which we
can discuss if you wish. Examples of other risk factors for bone loss which need to be considered in a general assessment
include genetic influences such as a family history of osteoporosis, environmental factors which may originate from nutrition
or physical activity, the influence of endogenous hormones or chronic disease, failure to achieve peak bone mass in youth
and a hisfory of excessive aging related bone loss.

In reviewing your Bone Density Test, my specific recommendations are:

A follow-up consultation for this test within 2 months.

A repeat Bone Density Test in 24 months.

Further recommendations include exercise and calcium supplement.

Finally, a review of this study indicates that skeletal damage may technically limit the usefulness of these study
interpretafions.

Please feel free to call with any questions you may have.

Sincerely,

Figure 2-11: Page 2 of the Patient Letter:
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5: A Sample “Referral Letter”

General Information

The Referral Letter is a 2 or 3 page Report sent to the referring physician from the facility that did the scan.
Referral Letters can be generated for a single scan or a combination of two different scans from the same visit.

“Scan Quality Issues” and “Recommendations” can be selected from a checklist.

Norland at Swissray

W6340 Hackbarth Road Fort Atkinson, W153538 USA (888) 7410413

Referral Report - Bone Density Test

Patient Marme: Lastname, Firstname Patient 1D: PatientlD
DoOE: 201941 958 Gender: Female
Age: 34 years Referred By:

Test Date: 582002 1:56:29 PM

Address:

Dear,

Thank you for referring Firstname Lastname to our practice. Qur records indicate a history of non-traumatic bone fracture and
primary osteoporosis. This patient indicates usage of the following medications: Actonel, Fosamax and Vitamin 0.

The results of the Bone Density Test performed on Firstname Lastname are as follows:

AP SpingonS&2002 15147 PM

L2-141L2 L3 L4

Density (g/om)? | 0.8942 | 0.8503 | 0.9006 | 0.9284

T-Score 128 1451 [125 |09

Z-Seore 118 |48 |12 | 080

Left Hip on 5&:2002 1:56:28 Phd

Fem Meck | Troch | Total sBMD

Density (g/em)? | 0.7078 0.6256 | 833.0mglem?

T-Score 2.39 -1.48 | -1.00
Z-3core -1.80 04 | 091
EMD COMP 8 RS0 Fem Neck
0.779, .
5 Diate BhD: Ch Easeli ; 1 :
can ange azeline 0759 : .
1 OTR34T 0763 g4m7 o 0.739 : : :
= . | . |
2 072049 0755947 00130k 78] 00130671 7%) @ 0719 : : - : =
- 4 4 £l 0,699 ; s
3 OTHSN0 0.726g4m? -0.030g k2 -4.0%] 00930607 (-5 6%) R S R
4 0506/M2 0.708g4m? -0.018g4m7[-2 4%) 006194 (-7 8%) AGE

Giver the documented precision of these studies, changesthat exceed the limit of Least Sigrificant
Change of 0.0230/0m= (4.0%) may indicate a significant change between the studies being compared.

Figure 2-12: Page 1 of the Referral Letter
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Norland at Swissray

W&340 Hackbarth Road Fort Atkinson, Wi 53538 USA (888) 741-0413

This test was performed using the Norland DXA Bone Densitometer, serial number 3840. This system uses the industry
standard dual energy x-ray absorptiometry (DXA) technique to estimate bone density non-invasively. This test includes
values called the T-score and the Z-score. The T-score compares the current study to bone density of a young healthy
population and the Z-score compares the current study to an age and gender matched reference population. The T-score
can be evaluated according to the criterion established by the World Health Organization (WHO) as follows:

lfthe T-scoreis. | The sublect may be:

-1 or above | Normal (adequate bone density)
L befween-1and-25 | Osteopenic {reduced bone density)
below -25 | Osteoporolic (severely reduced bone density)

The WHO criterion are especially useful when assessing the condition of postmenopausal women, men over 65 years of age
and men between 50 and 65 years of age with risk factors that may lead to excessive bone loss.

Although very useful, this test is not the sole determinant of bone health. There are other risk factors which need fo be
considered in a general assessment such as a family history of osteoporosis, environmental factors which may originate

from nutrition or physical activity, the influence of endogenous hormones or chronic disease, failure to achieve peak bone
mass in youth and a history of excessive aging related bone loss.

In reviewing this Bone Density Test, my specific recommendations are;

That you explain these test results to your patient in light of their overall medical history.

Perform a repeat Bone Density Test in 2 months.

Further recommendations include exercise and calcium supplement.
Finally, a review of this study indicates that patient positioning may technically limit the usefulness of these study
interpretations.
Please feel free to call with any questions you may have.

Sincerely,

Figure 2-13: Page 2 of the Referral Letter
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General Information

6: A Sample “Ten Year Fracture Risk Report”

A Ten Year Fracture Risk Report assess the patient's probability of a future fracture. This report can only be
generated for hip scans and is only available when the Ten Year Fracture Risk option is enabled.

Norland at Swissray

W6340 Hackbarth Road Fort Atkinson, WI 53538 USA (888) 741-0413

Ten-Year Fracture Risk Report

Patient Name: *Hip.good left Patient ID: Left Hip
DOB: 11/9/1926 Gender: Female
Age: 68 years Referred By:

Test Date: 11/6/1995

On 11/6/1995, left *Hip.good underwent a DXA-based analysis using the Norland DXA Bone Densitometer, serial number 6746. The DXA-
study included a study of the proximal femur allowing a Ten-Year Fracture Risk Analysis. The Ten-Year Fracture Risk Analysis is based on
research camied out by the World Health Organization allowing a review of the patient's sex, age, Femur Neck T-score and a review of risk
factors known to relate to Fracture Risk to arrive at a population based estimate of a Ten-Year Hip Fracture Risk.

While evaluating left *Hip.good we were able to establish that she has a history consistent with the following Risk Factors:

Glucocorticoids—A report of exposure to oral glucocorticoids or exposure to oral glucocorticoids for over three months at a daily dose of 5mg
or more is considered an indicator of risk. The presence of this factor is graded as a High Risk Indicator.

Parent Fractured Hip-The presence of a hip fracture—-in the absence of significant trauma-in a parent is cause for increased risk. The
presence of this factor is graded as a Moderate Risk Indicator.

Rheumatoid Arthritis—A report indicating the patient has a confirmed diagnosis of rheumatoid arthritis is considered an indicator of risk, The
presence of this factor is graded as a Moderate Risk Indicator.

Secondary Osteoporosis-—A report indicating the patient may have any of the following conditions (Insulin Dependant Diabetes,
Osteogenesis Imperfecta in Adults, Long-Standing Untreated Hyperthyroidism, Hypogonadism, Premature Menopause (<45 years),
Chronic Malnutrition, Malabsorption or Chronic Liver Disease) and is considered to have an indicator of risk. The presence of this factor is
graded as a Moderate Risk Indicator.

NORLANG.

Figure 2-14: Page 1 of the Ten Year Fracture Risk Report
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Norland at Swissray

W6340 Hackbarth Road Fort Atkinson, W1 53538 USA (888) 741-0413

Patient Name: *Hip.good left Patient ID: Left Hip
DOB: 11/9/1926 Gender: Female
Age: 68 years Referred By:

Test Date: 11/6/1995

The history taken on left *Hip.good ranslates to a Risk Factor Score of ( 0 Low 3 Moderate and 1 High).

Ten Year Hip Fracture Risk
Risk from Factors

Fracture Risk{%)

T-Score

The Ten-Year Fracture Risk is assessed by considering the Norland Femur Neck T-score, Age and the Risk Factor Score. Review of this
data indicates that left *Hip.good has an estimated Ten-Year Hip Fracture Risk of 34% and an estimated Ten-Year Major Osteoporotic
Fracture Risk of 57%. The Ten Year Fracture Risk was calculated using the UK Caucasian Female dataset.

The Ten-Year Fracture Risk Assessment estimates from epidemiologic data the risk of a hip fracture within the next ten years and is intended
to aid the clinician in assessing how to best proceed with interpreting a T-score based treatment strategy. In general, when interpreting data
from a Ten-Year Hip Fracture Risk report, a risk of greater than 3% justifies raising the aggressiveness of the T-score based treatment
strategy. As Guidelines have not been developed for the interpretation of Ten-Year Major Osteoporotic Fracture Risk, that information is
provided for informative purposes only. The Assessment assumes a BMI of 24 as used in the FRAX™ Paper Charts. Lower BMIs may
indicate an increased risk of fracture by a factor of up to three depending on age and number of risk factors.

NORLANGD

Figure 2-15: Page 2 of the Ten Year Fracture Risk Report

D10 Fev 2 NORLANLDO



2-28

General Information

7: A Sample “Body Composition Report”

A Body Composition Report assesses the soft tissue and bone of a Whole Body scan to produce Body Fat
Percentage results. This report can only be generated for Whole Body scans and is only available when the
Body Composition Reports option is enabled.

5/7/2015 10:09:16 AM

Norland at Swissray

Page 1

WE340 Hackbarth Road Fort Atkinson, Wi 53538 USA (888) 741-0413

Bone-Tissue Composite

Siri UWE Fat % 195
Brozek UWE Fat % 193

Name: Whole Body, Example Sex: Male Height: 67

D: 313 Ethnic: Caucasian Weight: 170

DOB: 929/1978 Age: 33 years Technologist: P F, Brown, RT

Scan Date:  5/11/2012 3:02:00 PM Physician:  Dr. J. Hibbert, MD
Total Fat % 242 Total BMD (g/em?) 1.036

Total BMC (g) 3049
Total Area (em?) 2943

Soft Tissue Fat % 252 Total Lean (g) 56880
TBMC/FFM %0 5.1 Total Fat (g) 19126
BMD (g/em®)  BMC (g)  Area{cm®)  Lean Mass (g} Fat Mass (g}
Total 1.036 3049 2043 SHRE0 19126
Head 1.893 4839 255.6 2774 1420
Chest 0.9724 632.7 630.6 14767 5648
Mideilf 1.273 44.64 35.07 3259 1507
Pelvis 1.255 339.7 270.7 8120 3049
Left Leg 1.073 557.7 5199 101591 2385
Right Leg 1064 524.7 493.2 10297 2589
Left Arm 0.6752 254.5 3770 3847 1424
Right Arm 06216 2116 340.5 3224 1105
Total Total
—— _";’J -

AGE

Date Value
11712710 20.3
D4/ 17709 19.8
10711/04 13.9
907/95 12.6

20 25 30 35 20 25 30 35

ST FAT %
s8RRE
©hooh th en on

AGE

Date Value
1/12/10 26.14
04/17/09 25.53
11104 19.51
90793 1830

Age

Siri UWE Fat Table

10

15 20 25
Siri UWE Fat %

30 35 40 45

STD CV: Total BMC=0.9, Lean=0.93, Fat=1.4; See Guide for other CVs. Images not for diagnosis
6.5 mm X 13.0 mm, 260 mmy's, 66.95 cm, Rev. 4.4.0/2.3.1 Cahb. 05/11/12, §/N 8500

NORLANG

Figure 2-16: Page 1 of the Body Composition Report with trended results
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5/7/2015 10:08:16 AM Morland at Swissray Page 2
W6340 Hackbarth Road Fort Atkinson, WI 53538 USA (888) 741-0413
Name: Whole Body, Example Sex: Male Height: 67
1D: 313 Ethnic: Caucasian Weight: 170
DOB: 9/29/1978 Age: 33 years Technologist: P.F. Brown, RT
Scan Date:  5/11/2012 3:02:00 PM Physician:  Dr. J. Hibbert, MD
| I H | I H
Current Scan: Baseline Scan: Current Scan: Baseline Scan:
Fat % Lean %
Total Total
k1
0 20243 ' *%C Date Value g Dz Date Value
4 Pt -
3 15213 H 11/12/10 19777 5 11712710 55873
i Y 04/17/09 19031 g 04/17/09 55517
x i ! \ i
20 o5 45 3% 10/11/04 12825 20, 56 30 a5 10/11/04 52900
AGE 09/07/95 11068 AGE 09/07/95 49399
ST Change (%) ST Change (%o/yr) LT Change (%) LT Change (%/yr)
Total BMD (g/em?) 1.036 23 1.5 75 0.5
Total BMC (g) 3049 26 1.7 9.3 0.6
Total Lean {g) SGRE0 1.8 1.2 16.9 1.0
Total Fat (g) 19126 -3.3 =22 62.3 3.7
STD CV: Total BMC=0.9, Lean=0.93, Fat=1.4; See Guide for other CVs. Images not for diagnosis n ,g HA 'g
6.5 mm X 13.0 mm, 260 mm/s, 66.95 cm, Rev. 4.4.0/2.3.1 Calib. 05/11/12, /N 8500 ﬁ‘ -

Figure 2-17: Page 2 of the Body Composition Report with trended results
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Quality Assurance Reports

Following are sample Quality Assurance Reports.

As described later in this manual, daily system calibrations should be performed daily prior to patient scanning
to ensure quality bone density estimates.

During the procedure, the QA Calibration Standard is measured first. Next, the QC Phantom is scanned. Your
system will have either a clear or a black phantom, depending on its model or options.

Upon completion of this process, the operator is asked to print the results. These reports, labeled “QC Res-
ults” should be filed in a calibration log file as described in section "View and Print Calibration Results Reports
on page 4-14. Reports may also be saved electronically either in PDF or DIiCOM format.

Please note that if the Clear Phantom is used, just one QC Results Report will be printed:
» BMD Precision

If the Black Phantom is used, three QC Results Reports will be printed

» BMD Precision

» Fat Precision

» Lean Precision

NORLANLDO B3D109 Rov-7
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Sample Reports: Quality Assurance Report - BMD

2-31

Norland at Swissray
VW6 340 Hackbarth Road Fort Atkinson, W 53538 USA  (888) 7410413

QC Results

Haost: 4.5.0 Last QA Completed
Calibration: 450 051215 14:52
Scanner: 231

Scanner SN 8113

Calibration Standard S/N: 5783

K1 0.46329 k2 0.00335
k3. -0.02573 K4: 3.00266
KE: 1.81217

Discriminator(FH,FLIH IL): 1441 239 1466173

BMD Precizion

sD
[=]
L
L
*
L &
L
&
= &
&

Flecscccsscccmancassassssmesccssacasssmesocssccassasassssscssmesssscsssssenccssasssasad

DEC 15 JAN 15 FEB 15 MAR 15 APR 15

15 JuL
Wonths
BMD Accuracy
[ ]peroscconoscmoscoon00000005000005600555 0058 600055 EE0E 500 IES OOMESEED 05EOEEDERE DR OSc oD S d
ROt
=i HboococosscsomennoosccossssoossscooossmosssoossomnosscooosconoommEsoscoossEscoosEcooossaad]
T T L T T T 1T TT T m mT T T T T TT T
DEC 15 JAN 15 FEB 15 MAR 15 APR 15 MAY 15 JUN 15 JuL

ACCURACY: OK

Munilhs
Phantom LastQC Last 16 QCs
Ink 8601 Date: 05/1215
BrD: 0.540 BEMD: 0 828 Mean: 0.834
BrD S0: 0.0 BMC: 4998 Cw:0.583
FRECISION: Ok

Figure 2-18: QC Results - BMD

Operator's Guide
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General Information

Sample Reports: Quality Assurance Report - Fat

Norland at Swissray
VW6 340 Hackbarth Road Fort Atkinson, W 53538 USA  (888) 7410413

QC Results

Haost: 4.5.0 Last QA Completed
Calibration: 450 051215 14:52
Scanner: 231

Scanner SN 8113

Calibration Standard S/N: 5783
T1:-14.84049 T2:0R1442
T3: 1543945 T4: 037549
Ta: 22308321

Discriminator(FH,FLIH IL): 1441 239 1466173

Fat Precizion

ACCURACY: OK

2 __________________________________________________________________________________________
®
8 ]
R
DEC 15 JAN 15 FEB 15 MAR 15 APR 15 MWAY 15 JUN 15 JUL
Months
Fat Accuracy
- SR
—H S
20 S =
|
DEC 15 JAN 15  FEB 15 MWAR 15 APR 15 MAY 15 JUN 15 JUL
Munilhs
Phantom LastQC Last 16 QCs
D g&01 Date: 0512415
Fat: 4391 Fat: 431.68 Mean: 437 .29
Fat 50 12.000 Cy:1.13
FRECISIOMN: O

Figure 2-19: QC Results - Fat (an option)
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Sample Reports: Quality Assurance Report - Lean

Norland at Swissray

WW6340 Hackbarth Road  Fort Atkinson, W1 53538 USA  (888) 7410413

QC Results
Haost: 4.5.0 Last QA Completed
Calibration: 450 051215 14:52
Scanner: 231
Scanner SN 8113

Calibration Standard S/N: 5783
T1:-14.84049 T2:0R1442
T3: 1543945 T4: 037549
Ta: 22308321

Discriminator(FH,FLIH IL): 1441 239 1466173

Lean Pecision

SD
{-
[
L
L]
o
e

Flecscccsscccmancassassssmesccssacasssmesocssccassasassssscssmesssscsssssenccssasssasad

DEC 15 JAN 15 FEB 15 MAR 15 APR 15 MWAY 15 JUN 15 JUL
Months

Lean Accuracy

R —

< looooooonosamaneocacasanmanosonananacmontossasacsosasacsocosanmEaoacancooopansaoonooanag

DEC 15 JAN 15  FEB 15 MWAR 15 APR 15 MAY 15 JUN 15 JUL

Munilhs
Phantom LastQC Last 16 QCs
Ink 8601 Date: 05/1215
Lean: G064 Lean: BO4.94 Mean: BO1.85
Lean S0:  10.000 v 071
FRECISION: Ok

ACCURACY: OK

Figure 2-20: QC Results - Lean (an option)
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Installation and Setup

The first part of this chapter includes the installation instructions for the Norland Illu-
minatus DXA software. The installation of the microphone and speakers is also dis-
cussed. Uninstalling the software concludes the installation section.

Instructions for logging on to the system follows next.

A through examination of the software completes this chapter. The five main menu
commands: File, Edit, Calibration, Tools, and Help are discussed in detail. Numerous
software screen shots are reproduced here for reference. Instructions for setting the
scanner parameter default settings are also included.

This chapter discusses the following.

Software Installation Instructions ... .. 3-2
Uninstalling the Software .. ... ... 3-8
Logging into the llluminatus DXA Software ... ... ... ... . ... 3-11
Examining the Software ... .. 3-12
Database Navigator Window ... ... 3-13
Menu Commands Overview .. ... 3-15
File Command ... . L 3-16
Edit Command .. .. 3-17
Calibration Command ... ... .. 3-46
Tools CommaNnd ... 3-47
Help Command . ... ... L 3-51

CHAPTER 3
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3-2 Installation and Setup

Software Installation Instructions

Installing the llluminatusDXA Software

This procedure assumes that the computer has been set up and is running. If you will be connecting to a net-
work, you will need to know your SMTP domain name before beginning the installation. You can get it from your
IT person.

1. Itis recommended to reboot the computer prior to installing the software to ensure all programs have been
properly closed.

2. Insert the software installation CD into the drive, or run the stand-alone software installation program.

3. Select the installation language, then click OK.

Installer Language >
@ Please select a language.
English w
Cancel

4. The Welcome window appears. Click to continue.

[A7] MurninatusDXA Setup o X

Welcome to llluminatusDXA Setup

Setup will guide you through the installation of
TlluminatusDXA.

It is recommended that you cose all other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your
camputer.,

Click Mext to continue.,

5. Select the components to install. The llluminatusDXA program is required. The Example Scan Data option
will install an example patient database of each scan type for training purposes. Adobe Acrobat Reader may
also be installed. On software upgrades the Update NORMALS.FIL File option may be selected to update

the Reference Data Sets. Click et to continue..

NORLANLD, 535109 Rev- 7



Installation and Setup
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IE‘ lluminatusDXA Setup

Choose Components

Choose which features of luminatusDXA you want to install.

)

Check the compaonents you want to install and uncheck the components you don't want to

install. Click Mext to continue.

Select components to install:

Space required: 453.0 MB

TliuminatusDXA
[ Example Scan Data
Install Acrobat Reader

Description
WOUF oUse
nponent ko

see its description,

Mullsoft Install System +3.03

< Back

e

6. Norland recommends that you keep the default Destination Folder. (If you do not, certain files will not be cre-

ated correctly and the software will not be able to find them.) Click .

@ MluminatusDXA Setup

Choose Install Location

Choose the folder in which to install HluminatusDXA.

e X

)

Setup will install luminatusDXA in the following folder. To install in a different folder, didk
Browse and select another folder. Clidk Install to start the installation.

Destination Folder

C: \luminatusDXA

Browse...

Space required; 453.0 MB
Space available: 444.0 GB

Mullsaft Install Swskerw3.03

< Back

| Cancel

7. The application and any selected options will be installed.

Operator's Guide
435D109 Rev. Z
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IE‘ lluminatusDXA Setup =
Installing
Please wait while HluminatusDXA is being installed. E’

Extract: iDXA.exe... 100%

Show details

Mullsoft Install System +3.03

< Badk Mext > Cancel

8. The Sentinel HASP drivers will be automatically installed on the first installation. Click OK when completed.

@ lluminatusDXA Setup --
Installing
Please wait while TluminatusDXA is being installzd. @

Execute: "C:\lluminatusDXAYhinstall.exe™ 4 -fi 4p

Show details |

Sentinel Run-time Envirenment Inst...

Please wait ......

Mullsaft Install Systenm v3.03

< Badk Next > Cancel

9. If the Acrobat Reader option was selected, follow the installation prompts to install Acrobat Reader.

10. After all features have been installed, click to complete the installation.
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IE‘ lluminatusDXA Setup =

Completing llluminatusDXA Setup

TlluminatusDX A has been installed on your computer.

Click Finish to dose Setup.

11. Pluginthe Aladdin USB HASP key (that came with the software) into a USB port. Wait for the red light in the
HASP key to illuminate.

12. Installation of the software is now complete.
13. Remove the installation CD (if used) and store in a safe place.

The next few pages discuss some other set up instructions that should be completed before you actually log
into the Bone Density software:

» "Configuring Backup for Windows 10" below to configure the Windows Backup if the computer was not
provided by Norland.

» "Installing the Microphone" on the next page
See "Logging into the llluminatus DXA Software" on page 3-11 when ready.

Configuring Backup for Windows 10

Computers provided by Norland with Windows 10 include the EaseUS Todo Backup program to automatically
perform a backup of the llluminatusDXA software and data on a daily schedule. To configure the EaseUS
backup program on a computer not provided by Norland, follow the steps below. (The EaseUS program may be
used on any system running Windows XP or newer.)

1. Obtain the latest version of the EaseUS Todo Backup program from the vendor. Install the program with
default settings.
2. Insert aflash drive to be used for backup into an available USB port.

To allow the backup program to utilize the full capacity of the USB drive, drives should be formatted with an
NTFS filesystem.

Open the EaseUS Todo Backup program.

Select “File Backup”.

Deselect all default folders from the tree.

Under the Computer branch, check the box next to C:\llluminatusDXA.
For the Destination Folder, browse to your USB flash drive.

Change the Plan Name to Norland Backup.

w

© o N Ok
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3-6 Installation and Setup

Note: Backup encryption is highly recommended when using removable backup drives. The
EaseUS backup program may be configured to use password-based encryption. If the option is used,
store your encryption password in a safe place. An encrypted backup cannot be restored without the
password.

10. Click the Schedule button and change the settings to:
» Schedule Type: Daily
» Time: 7:00pm
» Backup Method: Full Backup
» Click Save
11. Save the backup job settings.
12. Forthe Norland Backup job, click Backup, and select Full Backup to run the backup.
13. Allow the backup to complete. When finished, close the backup program.

Configuring Backup for Windows 7

Computers provided by Norland with Windows 7 are configured to automatically perform a backup of the lllu-
minatusDXA software and data on a weekly schedule. To configure the backup on a Windows 7 computer not
provided by Norland, follow the steps below.

For Windows XP computers, the DXA Backup icon is installed by the IlluminatusDXA software. No other con-
figuration is necessary. Refer to "System Backup for Windows XP" on page 1.
Insert a flash drive to be used for backup into an available USB port.
Click the Start menu, All Programs, Maintenance, and select Backup and Restore.
Click “Set up backup”.
Select the flash drive (“Removable Disk”) to be used for backup. Click Next.
When prompted for what to backup, select “Let me choose...” and click Next.
Click the arrow next to Local Disk (C:) to expand the tree.
Check the box for the IlluminatusDXA folder to select all contents. Click Next.
Click “Change schedule”.
Check the box for “Run backup on a schedule”.
Change the schedule settings to:
» How often: Weekly
» What day: Monday
»  What time: 7:00 pm
11. Click OK.
12. Click “Save settings and run backup”.
13. Allow the backup to complete. When finished, close the Backup and Restore window.

© 0N O wWwDN =

—
©

Installing the Microphone
Follow these instructions to install the microphone and speakers (if not already done).

1. Plug the microphone connector into the mic jack on the computer.
2. Click Start > Control Panel.
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3. Click on Sounds and Audio Devices.

4. Click the Audio tab. Then click the Sound Recording M button.

Sounds and Multimedia Properties
Sounds Audio ] Hardware |
~ Sound Playback
'Qﬂ‘ Prefened device:
i | SoundMéx Digital Audio =l
Volume | Advanced |
 Sound Recording
Preferred device:
4 [SoundMiex Digial Audio =]
e |
~ MIDI Music Playback
% Preterred device:
ot IMicvnsnft GS Wavetable S'w Synth :]
Volume | About |
™ Use only preferred devices
ok | cancel | appy |

5. Click the Microphone “Select” check-box then adjust the slide bar to the middle setting.

EE Recording Control =101 x|
Options  Help

CD Player Microphone Line In
Balance: Balance: Balance:
{2 o P Al
Volume: Wolume: Volume:

[T Select [V Select [~ Select

[SoundMaX Digital Audio

6. Click the IE] to close the dialog box.
7. Click to apply the changes and close the window.

8. Close the Control Panel dialog box (click IE or File > Close).
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Uninstalling the Software
Follow these instructions to uninstall the llluminatus DXA software, if necessary.

Reboot the computer to confirm all programs have been closed.
Remove the HASP USB key.

Click Start > Control Panel.

Double-click on Add or Remove Programs.

Moo=

5. Scroll down to select /fluminatus DXA and click L= #19&/Remove ] The following window opens.

Illuminatus DXA - InstallShield Wizard

Preparing Setup

InstaliSHild | cancal |

6. Click to select Remove and click .

Illuminatus DXA 4.4.0 Setup

& progranm,

IinstallShield | ek | hews | | Conca |
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7. Inthe “Confirm Uninstall’ dialog box, click L2

Confirm Uninstall

Do wou wank to completely remove the selected application and all of its components?

L Ok J[ Cancel ]

8. When the following window opens, decide if you want to completely remove your patient Databases (click

), or leave them installed (click ).

m Caution: Selecting Yes will permanently delete all of your patient data and scanner setup files. ]

Question

\‘p Do wou want to completely remaove all vour settings and Database koo?

InstaliShield Cancef

10. Upon completion, the following window opens. Select Yes to restart the computer now or select No to restart
later.

D10 Fev 2 NORLANLD,



3-10 Installation and Setup

Illuminatus DXA 4.4.0 Setup

Maintenance Complete

ed performing mainten

computer ater

InstaliShield | cBack n Finish | | Cancel r

1. cioc |
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Logging into the llluminatus DXA Software

Notice the three new icons on the desktop: llluminatus DXA, DXA Backup and DXA Utilities. Now that the
Norland llluminatus DXA Bone Densitometer software is installed, open it up!

1. Confirm that the HASP key is plugged into the USB port.

2. Double-click the icon on the desktop labeled llluminatus DXA to start the software.
OR. .. click on Start > Programs > Norland > llluminatus DXA.

3. Firsttime login: The following window pops up (after the initial splash screen) when logging in for the first

time. Click |

Database Creation Successful E|

Successfully created new database:
Chilluminatusd:xaldbligdb. wmd

4. Atthe Login window, enter the user’'s Login name (click the drop-down arrow, if necessary) and then type the
Password. The default password is norland.

NORLANL.

Login: |norland - | Password: Login | Cancel ‘

5. Click and wait while the software initializes the Scanner.

D10 Fev 2 NORLANLDO



3-12 Installation and Setup

Examining the Software

Norland Bone Densitometry devices are controlled by menu driven software that follows a Windows based
design. The main software window is called the Database Navigator window. All Norland program actions are
initiated by moving a mouse pointer to the menu bar located along the top of the window or the navigation but-
tons along the bottom of the window.

Hot keys are also available by pressing the <Alt> key and then the underlined letter, i.e. <F> for “File”.

[ Numinatus DXA450 o — — _ - — . [E=REeE
File Edit Calibration Tools Help
Database: IC\db\Examples j
Patient Visit List
Category: Search:
Quick Search: [FatienHame EN
Patient ID | Patient Name - | Visit Date | ScanType | Anabeed |
Fracture “Spine. fracture -
AP SPINE *Spine.good
Off Center “Spine. off center
Osteoparotic “Spine.asteo
IMPROPER &P “Spine. poor start/end
Spins “Spine. poor condtion
AngldCursars “Spine. scoliosis
Too High “Spine. start too high
Shart “Spineton shart
DFWE Aafhole Body
Gluteus Ahbdominal, Soft Tissue | |
K104111 Adams, Helen
Dual Hip Dual. Hip
K11-6654 JOHNSOM, BETTY
Ki11212 Jones, Mildred
[= PatientlD Lastname, Firstname
77
Scan Left Hip Yes E
Scan AP Spine Tes
Scan Left Forearm e
Wisit 7/19/2000
Visit 742011939 I
Wisit 7/23/1997
Manua Manwual, Patient
Manual 2 Marual, Patient | |
Manual3 Manual, Patient
NoSling Mo Rotation, Hip -
I
i ﬂl <« Logout Hew Patient »> Demographics »» Stamp Yiew >
Administrator | I |Report Template: Bone Exam Report Scanner Present

Figure 3-1: Example Database Navigator Window
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Database Navigator Window

The Norland Bone Densitometer main window is referred to as the Database Navigator window in this
manual. It is shown below.

All the visits pertaining to one patient are grouped together and sorted under that patient’s name and ID number.
This is described in detail in this section.

[ Nluminatus DXA 450 e — —— [E=gEE =)
File Edit Calibration Tools Help
Database: |[CidbiExamples -
Patient Visit List
Category: Search:
Quick Search: [Patiert Name = A
Patient ID | Patient Name + | visit Date Scan Type Analyzed |
Fracture *Spine. fracture a
AP SPINE *5pine.good
Off Center “Spine. off center
Osteparotic *Spine.osten
IMPROPER AP “Spine. poor start/end
Spine “Spine. poor.condition
AngldCursors *Spine. scoliosis
Tao High “Spine. start too high
Shark “Spine.too shart
DF WE Afhole Body
Gluteus Ahdominal, Soft Tissue |
K10-1111 Adams, Helen
Dual Hip Dual, Hip
K11-6654 JOHNSOM, BETTY
K111212 Jones, Mildred
= PatientiD Lastname, Firstname
R 7 S N
Scan Left Hip Tes E
Scan AP Spine e
Scan Left Foream Yes
Wizt 7/A19/2000
Wigit 7/20/1933 I
Wisit 7/23/1997
Manuall Manual, Patient
Manual 2 Marual, Palient [
Manual3 Manwual, Patient
MNoSling Mo Ratation, Hip -
I
Il Delete | << Logout New Patient »> Demographics »» Stamp View >»
Administrator Report Template: Bone Exam Report |Scanner Present

Log D . . .
Logs out the current user account in the host software and goes to the login window.

Displays a blank Patient Demographics window. It is used for inputting information on a new

Displays the current patient demographics window of the currently selected patient.

Displays the “Stamp View” of all the scans available for the currently selected visit. The Stamp
View button will be grayed out (not click-able) if a scan is not available forthat patient.

Delete

Deletes the entire Patient file that is highlighted, or the visit that is highlighted. Follow the instruc-
tions in the window that pops up.
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3-14 Installation and Setup

Database Navigator Window Description

The menu bar is located along the top of the window. Click on a menu name to reveal a drop-down list of com-
mand names. The commands are: File, Edit, Calibration, Tools, and Help.

£ IMuminatus DXA 4.0.0.27

File Edit Calibration Tools Help

These commands perform functions in the system software. They are described in detail in this chapter.
The Database field has a drop-down arrow that lets the operator select from different database files.

Database |CilluminatusDxA 5

The Quick Search feature of the window has two categories: Quick Search by Patient ID and Quick Search
by Patient Name (viewed in the Category drop-down list).

Patient Visit List
Category: Search:
Quick Search: [Patient Name =1 |

atient |0
IS Paticrt Name

The operator simply selects the search Category (ID or Name) and types the first few characters. The search is
interactive, and will return all values beginning with the characters you are typing as each key is pressed.

The Patient Visit List Tree: As mentioned earlier, the Patient Database now has all the visits pertaining to one
patient grouped together and sorted under that patient’s name and ID number.

Patient Visit List

Category: Search:
Quick Search: [Fatient Name =l [d

Patient ID [ Patient Mame » [ isit Date Scan Type Analyzed
= 123456789 Black, SueG.

Visi 3162004

Visi 372004

isit 318/2004

Visit 232004

Visi 3/30/2004

Visi B/18/2004

124356721 Elue, Gail .

546378567 Brown, Ida M,

EEHEEEA

®H &

¥
Click onthe expand ( = ) button next to a patient ID number and the database will branch out into visits. Click
the plus sign next to a visit, and it branches out into the scans done during that visit.
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Menu Commands Overview

As mentioned earlier, when you click any one of the menu names along the top of the Database Navigator win-
dow, a list of commands “drop” down.

Edit Calibration Tools Help

Mew Patient

Database 3
Reference Sets

Import FolderMail...

Logout

Exit

Some commands are grayed out due to one of the following reasons:

» The option is not valid for the current operation.

» The option is already in effect.

The five different Menu commands are described in detail next: File, Edit, Calibration, Tools, and Help.

D10 Fev 2 NORLANLDO



3-16 Installation and Setup

File Command

To view the File commands, click on File in the Database Navigator window. Move the pointer down to highlight
the command of interest and click on it. The highlighted command will execute.

[File | Edit Calibration Tools Help
Mew Patient

Databaze r
Reference Sets
Import FolderMail...

Logout

Exit

Quick Descriptions: File drop-down list

New Patient: displays the Patient Demographics window for inputting patient information. The steps for cre-
ating a New Patient record are in Chapter 4, Basic Operation, under "Creating a New Record for a New
Patient" on page 4-21.

Database: provides access to all the database functions, including Add to List and Remove from List of an Act-
ive Database, as well as Create, Import, and Export. These selections are discussed in Chapter 12, Addi-
tional Techniques, under "Database Management" on page 12-14.

Reference Sets: displays the Reference Set window. Right click on any entry in that window to Edit or Delete a
reference. Reference Set details are explained in Chapter 12, Additional Techniques, under "Working with
Reference Sets" on page 12-26.

Import FolderMail: opens a browser dialog box to import a patient’s folder that was received via e-mail (you
must have a FolderMail e-mail attachment file to be imported). The extension is .IQF. The steps for Import
FolderMail are in Chapter 12, Additional Techniques, under "How to Import FolderMAIL to a Database" on
page 12-13.

Logout: Terminates the current session, and returns the user to the login window.
Exit: Closes all open dialog boxes, closes any open databases, and finally terminates the application.
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Edit Command

To view the Edit commands, click on the Edit menu in the Database Navigator window.

File | Edit | Calibration Teools Help

User Preferences

Scanner Preferences
Advanced Preferences

Users and Groups

Quick Descriptions: Edit drop-down list
User Preferences

Main Settings tab: displays dialog box for changing login name and password, e-mail address, and the width
and height of the Stamp View thumbnail. See details in "User Preferences Command" on page 3-19.

Scanner Preferences

Displays four different tabbed dialog boxes for setting Site information, Scanning parameters, Analysis para-
meters, and Service Information (for calibration setup). See details on "Scanner Preferences Command" on
page 3-20.

The Site tab includes fields for the facility name and address and the scanner identification information. The
available options are displayed once the Options Authorization Code (OAC) is entered. See "Site Tab Setup "
on page 3-21.

The Scanning tab includes an area for each scan type. Each scan type has its own parameters that can be
edited by the operator. The “Restore Factory Defaults” button restore the original factory settings. See "Scan-
ning Tab Setup " on page 3-22.

The Analysis tab includes an area for each scan type. Each scan type has its own parameters that can be
edited by the operator. The “Restore Factory Defaults” button restore the original factory settings. See "Ana-
lysis Tab Setup " on page 3-30.

The Service tab displays the Scanner, Calibration Standard and QC Phantom serial numbers. It also describes
various values for the Calibration Standard and QC Phantom. See "Service Tab Setup" on page 3-38.
Advanced Preferences

Displays a few different tabbed dialog boxes. The tabs of interest are described next. See "Advanced Prefer-
ences Command" on page 3-39 for all the details.

Customer Info tab: this is where you enter the Business name and address information.

Printing tab: allows the operator to set the print margins when printing Reports.

Directories tab: this is where the various paths are set.

Network tab: allows the administrator to enter E-mail information, the machine location and SMTP Server host
name (as well as other things).

Users and Groups

The User Editor dialog box contains two tabs - a Users tab and a Groups tab. See "Users and Groups Com-
mand" on page 3-44.
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3-18 Installation and Setup

Users > Main Settings: displays the dialog box for changing login name and password, e-mail address, and the
width and height of the Stamp View thumbnail.

Users > User's Groups: contains the Group List.
Users > Additional Settings: has Security Privileges settings.
Groups tab: contains the Group List.
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User Preferences Command
File | Edit | Calibration Teools Help

User Preferences

Scanner Preferences
Advanced Preferences

Users and Groups

Clicking on the User Preferences selection displays tabbed windows that lets the current user change their
login and e-mail information. The width and height of the Stamp View thumbnail (that is displayed in the Stamp
View window) can be set here, also.

Click on Edit > User Preferences to open the following windows:

N User Editor, N User Editor &| i User, Editor

Users ]Gruups] USE"S ]Gruups] USE"S ]Gruups

o < c ] o< e =] o[ olle =]

ser's Groups } Additional Settings ] Main Settings  User's Groups ]Addrtiuna\ Seftings } hain Settings } User's Groups  Addtional Settings ]

Security Privieges

Login Groups for this user Group List [~ Can Yerify Reports
|nnr|and Users Administrators
Y — Achministrators = Users
Guests

| Clinicians

@
Confirm Passward
Full Mame

|Narland

Phong Mumber

tlE-Ma\I Address

|nor|and@swwssray.cum

Thurnbnsil Width Thumbnail Height
[190 ras

ey ‘ Edit ‘ ‘ Remove Edit Edit |

Cloze Close Cloze

A Note: An e-mail address must be entered in the “E-Mail Address” box to enable the FolderMAIL option. ]
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Scanner Preferences Command
File | Edit | Calibration Teools Help

User Preferences

Scanner Preferences
Advanced Preferences

Users and Groups

The Scanner Preferences selection displays four different tabbed dialog boxes for setting Site information,
Scanning parameters, Analysis parameters, and Service Information.

# Scanner Preferences |Z|
Site | Scanning I Analysiz I Service I
- Facility Scanner
N I " Eclipse € XB-36 € Ewcell ) XF-46
C XR-E000 £ XF-B00
Address I
Scanner 5/M IBDDD
I Hasp 5/M 54643380
City I State Serial Port IEDM‘I VI
— Optian
OaC  |aB97-1bef-d0id
v Farearm ¥ Research [~ whole Body
¥ Ten'ear Fracture Risk ¥ Small Subject [¥ Taotal Body EMD Adrea
[~ DICOM ¥ Solt Tizsue Calibration v ‘whole Body with Soft Tissue
¥ Lateral Spine ¥ Solt Tizsue Composition I work Station
Print Hasp 5/M Save Lloze

Figure 3-2: The Scanner Preferences selection window

Most of the scanner parameters will be set during installation prior to applications training. Settings will be dis-
cussed with the operator during the training to ensure a complete understanding. The scanner preferences can
be customized to suit each facility’s needs. However, when the needs of the facility change, the system can

easily be reconfigured.

The changed parameters become the default condition for subsequent procedures when they are set from the
Scanner Preferences window. They remain the default settings until changed by the operator.

NORLANLD
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Site Tab Setup

The Site tab is accessed by clicking on Edit > Scanner Preferences. Then click the Site tab.

The Site tab allows the operator to enter the site and scanner identification information. The available software
options are displayed once the Options Authorization Code (OAC) is entered by the installer.

» Enter the Scanner Serial Number.

» To use a serial port other than COM1, make the appropriate selection.

» If you have been provided with an OAC code for your scanner, enter it in the OAC box.

» Click to store the scanner settings and OAC.

#I Scanner Preferences |Z|
Site | Scanning I Analysiz I Service I
- Facility Scanner
N I " Eclipse  ©XB-36 € Ewcell ) XF-46
C XR-E000 £ XF-B00
Address I
Scanner 5/M IBDDD
I Hasp 5/M 54643380
City I State Serial Port IEDM‘I VI
— Optian
OaC  |aB97-1bef-d0id
v Farearm ¥ Research [~ whole Body
¥ Ten'ear Fracture Risk ¥ Small Subject [¥ Taotal Body EMD Adrea
[~ DICOM ¥ Solt Tizsue Calibration v ‘whole Body with Soft Tissue
¥ Lateral Spine ¥ Solt Tizsue Composition I work Station
Print Hasp 5/M Save Lloze

Figure 3-3: The Site tab preferences window
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Scanning Tab Setup

The Scanning tab is accessed by clicking on Edit > Scanner Preferences. Then, click the Scanning tab.

Here, the operator can set several scan preferences. The scanning preferences available include: AP Spine,
Hip, Forearm, Whole Body, Lateral Spine, and Research/Small Subject.1 They are described in the next few
sections.

The default parameters for all the scanning operations are set and reset here. These setup options are typically
reviewed and modified during system installation or during training. The different parameters are described in
the next few sections.

Scanner Preferences >
Site  Scanning l.&nal}lsis] Service]

AP Spine “Wwhole Bochy
Rezolution [mm) i~ 1.0%1.0 f« 15%15

Scan Width [cm] 12.0

Regolution/Speed | B5% 13 0mm  260mmsec j

W Auto Center [ Force mark points or-asis Lateral Spine
Scout Meazure

ScanSpeed [Standard  130mmisec v Riesalution [rm] 1EX30 1.0%10

Hip Scan 'width [cm) 14.25 10

Scout Measure s )
Reesolutian (mm)] 1.0X40  1.0%1.0 TP (=SS S B
Scan Width [cm) 12 3 Scan Speed |Standald 30 mmdsec j
Scan Length [cm ) 12 9
(+ Standard ‘width " Extended width Research/Small Subject
Scout teasure

ScanSpeed [Standerd S0 mmisec <] Resolution {mm) [30%a0 «| [1ox10 ~]

Forearm Scan Spaed [mm/sec) |50 [

Scout Meazure
Rezalution [mm) 1010 1.0x1.0 Scanwidth [cm] 138 100
Sean Width [om) ] a v Scout Scan [+ Force initial scan on-axis
Scan Length [cm ) Up to Prosimal 1.0 Maximum deagrees to snap final scan on-axiz |15
" Digtal ¢ Prowimal ¢ Both
Research Scan Typpe Mame  |Research
Scan Speed |ngh Speed 20 mmdzec ﬂ Sm Subject Scan Type Name ’W
[ Digable Patient Positioning Instructions
i RBestore Factory Defaults | Save | Close

Figure 3-4: The Scanning tab preferences window

Disable Patient Positioning Instructions

When checked, this option will disable the instructions for patient positioning that appear prior to scanning the
patient. However, this is not recommended unless the operator is well versed in patient positioning.

1Forearm, Whole Body, Lateral Spine, and Research/Small Subject are not available on some models.
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Preferences: AP Spine Scan

The following figure shows the default AP Spine Scan parameters. The default settings should be effective for
most scanning situations.

—AF Spine
R esalution [mrm)  1.0x1.0 * 15%15

Scan Width [cm): 12

[v AutoCentering [~ Force mark paints on-axis

Scan Speed !Standard 130 mmdzec _'J

Figure 3-5: The default AP Spine Scan Parameters

Bestore Factary D efaultz
= Y and

Note: WHAT TO DO: To restore the default Scan parameters, click

K22 | This will restore the defaults for all scan types.

(. J

N

Note: WHAT TO DO: To change the default Scan parameters, access the Scanner Preferences win-
dow from the main Database Navigator window as described next.

If it is not already open, click on Edit > Scanner Preferences > Scanning tab.
Locate the AP Spine scan parameters in the window (shown above).

Select and change any of the scan parameters, such as resolution, scan width, or speed.

CIick‘ seve ‘and| Liese I at the bottom of the window. These settings now become the
default settings until changed again.

PARAMETER DESCRIPTIONS:

» Scan Resolution: the (data point size) x (scan line size) in millimeters.
The scan resolution is 1.0 x 1.0mm or 1.5 x 1.5mm [default].

» Scan Width: displays the width of the scan in centimeters.
The Scan Width is 12-cm [default], unless Auto Centering fails, in which case the Scan Width is auto-
matically set to 14-cm.

» Auto Centering: when checked [default] (enabled), it centers the image in the region of interest despite
small variances in actual patient orientation. For more information see "Auto Centering Mode" on page 12-66.

» Force mark points on-axis: when checked (enabled), it forces the scanner to move on the X & Y axis only
(will not allow scanning on a diagonal). When not checked (disabled) [default], it straightens the image in the
region of interest despite small variances in actual patient orientation. To achieve the highest quality AP
Spine scans, this feature should be DISABLED (unchecked). For more information see "Force Mark Points
On-Axis" on page 12-67.

» Scan Speed: The scan speed for a High Precision scan is 65mm/sec.

The scan speed for Standard scan is 130mm/sec. [default]
The scan speed for High Speed scan is 260mm/sec.
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Preferences: Hip Scan

The following figure shows the default Hip Scan settings. The default settings should be effective for most scan-
ning situations.

Hip
Scout Meazure
R ezalutian [mm] 1.0% 4.0 1.0%1.0
Scan Width [cm] 12 9
Scan Length [cm | 12 9

¥ Standard ‘Width (" Extended width

Scan Speed |Standard 90 mmdzec ﬂ

Figure 3-6: The default Hip Scan Parameters

Note: WHAT TO DO: To restore the default Scan parameters, click Hestore Factow Defaults and

Cloze

. This will restore the defaults for all scan types.

. J

N

Note: WHAT TO DO: To change the default Scan parameters, access the Scanner Preferences win-
dow from the main Database Navigator window as described next.

If it is not already open, click on Edit > Scanner Preferences > Scanning tab.
Locate the Hip scan parameters in the window (shown above).

Select and change any of the scan parameters, such as resolution, scan width, or speed.

Click‘ seve ‘and| — I at the bottom of the window. These settings now become the
default settings until changed again.

A

PARAMETER DESCRIPTIONS:

» Resolution: fixed for the Hip Scan

» Scan Width: displays the width of the scan in centimeters.
Scout Scan: Standard Width 12 cm [default]
Extended Width 16 cm (used for larger patients)
Measure Scan: Standard 9 cm [default]
Extended Width 12 cm (used for larger patients)

» Scan Length:Scout Scan fixed length = 12 cm
Measure Scan fixed length=9 cm
» Standard Width / Extended Widthbuttons: (see Scan Width above).

» Scan Speed: The Scout Scan speed is fixed at 180mm/sec.
The MeasureScan speed for High Precisionis 45mm/sec.
The MeasureScan speed for Standardis 90mm/sec [default].
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Preferences: Forearm Scan

The following figure shows the default Forearm1 Scan parameters. The default settings should be effective for
most scanning situations.

Faorearrm
Scout Measzure
Fezolution [mm] 1.0=1.0 1.0x1.0
Scan width [cm) g 8
Scan Length [cm ] Ip to Proximal 1.0

" Digtal (" Proximal  « Bath

Scan Speed |High Speed 20 mmizec j

Figure 3-7: The default Forearm Scan Parameters

Fiestore Factony Defaults
= Y and

Note: WHAT TO DO: To restore the default Scan parameters, click

E%% | This will restore the defaults for all scan types.

~N

Note: WHAT TO DO: To change the default Scan parameters, access the Scanner Preferences win-
dow from the main Database Navigator window as described next.

If it is not already open, click on Edit > Scanner Preferences > Scanning tab.
Locate the Forearm scan parameters in the window (shown above).
Select and change any of the scan parameters, such as resolution, scan width, or speed.

Click‘ seve ‘and| Llos2 I at the bottom of the window. These settings now become the
default settings until changed again.

(.

PARAMETER DESCRIPTIONS:

» Resolution: is fixed

» Scan Width: both Scout Scan and Measure Scan - operator defined [default setting is 8 cm]

» Scan Length: The Scout scan length is “Up to proximal”
The Measure scan lengthiis 1.0 cm

» Regions: Distal / Proximal / Both: operator may elect to scan the Distal or Proximal forearm only, or Both
the Distal and Proximal forearm

» Scan Speed: The Scout scan speed is fixed at 45mm/sec
The Measure scan speed for High Precisionis 2mm/sec

The Measure scan speed for Standardis 8mm/sec
The Measure scan speed for High Speedis 20mm/sec [default]

1Forearm scan is not available on some models.
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Preferences: Whole Body Scan

The following figure shows the default Whole Body1 Scan parameters. The default settings should be effective
for most scanning situations.

Whole Body
|7 Rezolution/Speed |B.5% 13.0mm  260mm/zec j

Figure 3-8: The default Whole Body Scan Parameters

Fiestore Factony Defaults
= Y and

Note: WHAT TO DO: To restore the default Scan parameters, click

Close

. This will restore the defaults for all scan types.

(. J

N

Note: WHAT TO DO: To change the default Scan parameters, access the Scanner Preferences win-
dow from the main Database Navigator window as described next.

If it is not already open, click on Edit > Scanner Preferences > Scanning tab.
Locate the Whole Body scan parameters in the window (shown above).
Select and change any of the scan parameters, such as resolution, scan width, or speed.

Click‘ Save ‘and| Llose Iat the bottom of the window. These settings now become the

default settings until changed again.

(.

PARAMETER DESCRIPTIONS:

» Speed / Resolution: There are 6 possible combinations of speeds and resolutions. They are listed below.
The default setting is 6.5 X 13.0mm @ 260mm/sec.

YWhole Body
R ezalutionsS peed |E.5 # 13.0mm 2B0rmm/ sec ﬂ

£.5 2 13.0mm 2E0mmsec
6.5 % 13.0mm 130mm/ sec
4.5% 9.0mm 2B0mm/zec
4.5% 9.0mm 130mm/ sec
2.8 7.8mm 200mm.zec
2.8% 7.9mm 100 sec

1Whole Body Spine Scan is not available on some models.

NORLANLDO B3D109 Rov-7



Installation and Setup 3-27

Preferences: Lateral Spine Scan

The following figure shows the default Lateral Spine1 Scan parameters. The default settings should be effective
for most scanning situations.

— Lateral Spine

Soout keasure
R ezalution 1530 1.0 1.0
Scan Width [em) [14.25 |10

[¥ Snap Measure Scan on-axis

Scan Speed IStandard 30 mmdzec j

Figure 3-9: The default Lateral Spine Scan Parameters

Note: WHAT TO DO: To restore the default Scan parameters, click festore Factory Defauls and

Cloze

. This will restore the defaults for all scan types.

.

Note: WHAT TO DO: To change the default Scan parameters, access the Scanner Preferences win-
dow from the main Database Navigator window as described next.

If it is not already open, click on Edit > Scanner Preferences > Scanning tab.
Locate the Lateral Spine scan parameters in the window (shown above).
Select and change any of the scan parameters, such as resolution, scan width, or speed.

Click‘ Save ‘and| Llose ‘at the bottom of the window. These settings now become the
default settings until changed again.

(.

PARAMETER DESCRIPTIONS:

» Resolution: fixed

» Scan Width: Scout Scan width - operator defined [default setting is 14.25 cm]
Measure Scan width - operator defined [default setting is 10 cm]
A Measure Scan width of 8 cm is recommended for most female patients
A Measure Scan width of 9 cm is recommended for most male patients

» Snap Measure Scan on-axis: box should be checked (enabled) [default] to force scans on axis

» Scan Speed: The Scout scan speed is fixed at130mm/sec
The Measure scan speed for High Precisionis 15mm/sec
The Measure scan speed for Standardis 30mm/sec [default]
The Measure scan speed for High Speedis 60mm/sec

1Lateral Spine scan is not available on some models.
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Preferences: Research/Small Subject Scan

Prior to starting a Research or Small Subject study, the scan parameters should be defined. The desired pre-
cision and detail of a scan, the scan length, and the time to scan completion influence the scan parameter selec-
tions.

In order to maintain precision and accuracy, always use the same scan parameters for serial scans.
The following figure shows the default Research/Small Subject Scan preferences.

Fesearch{Small Subject

Scout M eazure
Resolution 130%30 | [1.0%1.0 +|
Scan Speed [mm/zec] |EEI.EI |EEI.EI
Scan Width [cm] 138 10
[w ScoutScan [v Force intial zoan on-asiz

M aximum degrees to snap final scan on-axis |15

Reszearch Scan Type Mame |Hesearch

Sm Subject Scan Type Mame |Sm Subject

Figure 3-10: The default Research/Small Subject Scan Parameters

Fiestore Factony Defaults
= Y and

Note: WHAT TO DO: To restore the default Scan parameters, click

E%% | This will restore the defaults for all scan types.

(. /

~N

Note: WHAT TO DO: To change the default Scan parameters, access the Scanner Preferences win-
dow from the main Database Navigator window as described next.

If it is not already open, click on Edit > Scanner Preferences > Scanning tab.
Locate the Research/Small Subject scan parameters in the window (shown above).

Select and change any of the scan parameters, such as resolution, scan width, or speed.

Click‘ seve ‘and| Llos2 I at the bottom of the window. These settings now become the
default settings until changed again.

PARAMETER DESCRIPTIONS:
» Resolution: values refer to point resolution (pixel size) x line spacing

» Scan Speed: entered in mm/sec
Minimum for Scout and Measure scans is 1.0mm/sec
Maximum for Scout and Measure scans is 260.0mm/sec

1Research and/or Small Subject are not available on some models.
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Note: If the Scan Speedis too fast for the chosen Resolution, the following message will appear at
the beginning of a scan:

Norland Alert -

Scan speed is too fast for selected point resolution.
Decrease scan speed of choose a larger point
resalution.

If this occurs, the Scan Speed must be reduced or the Resolution must be increased.
» Scan Width: entered in centimeters.
Minimum for Scout and Measure scans is 2 x point resolution
Maximum for Scout and Measure scans is 255 x point resolution

Note: If the Scan Widthis too large for the chosen Resolution, the following message will appear at
the beginning of a scan:

Too many points per scan line. Decrease the scan
width and/or choose a larger point resolution.

If this occurs, the Scan Width must be reduced or the Resolution must be increased.

» Scout Scan: when enabled, provides image to assist in defining the Measure scan region
» Force initial scan on-axis: forces end point of initial scan to be on same Y-axis as the start point

» Maximum degrees to snap final scan on-axis: This field defines the maximum degree of rotation of the
cursor box at the scan progress screen (following a scout scan) that will result in an on-axis scan. On-axis
scans are faster than off-axis scans.

Rotation of the cursor box to an angle greater than or equal to the Maximum degrees setting will result in

scan data collection at that angle. Rotation of the cursor box to an angle less than the Maximum degrees set-
ting will result in an on-axis scan.

On-axis scans are scans taken with the start and end points on the same y-axis.

If the Maximum degrees to snap final scan on-axis is set to 15, then Force on Axis will correct scout view dis-
play for scout scans that are up to 15 degrees off axis.

» Scan Type Name: operator-defined; default is “Research” or “Small Subject”
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Analysis Tab Setup

The Analysis tab is accessed by clicking on Edit > Scanner Preferences in the main Database Navigator win-
dow. Then, click the Analysis tab.

The Analysis tab allows the operator to set several scan-specific analysis preferences. The analysis pref-
erences available include: AP Spine, Hip, Forearm, Whole Body, Lateral Spine, and Research/Small Subject.1

The default parameters for all the analysis operations are set and reset here. These setup options are typically
reviewed and modified during system installation or during training. The different parameters are described in
the next few sections.

Scanner Preferences *
Site ] Scanning lSerwce]

AP Spine Whole Body

Analysiz Mode * Standard ™ Angulated ™ High Dengity Paint E xclusion

Region &+ Prompt L1-L4 & L2-14 v Soft Tissue Comection

[ High Density Paint Exclusion e e

Lateral Spine

Hip
Femaral Meck Length [cm] 1.0 & 15 [~ High Density Point Exclusion
I High Density Paint Exclusion Research/Small Subject

) (e B SR [ High Denszity Point Exclusion

[ Wards Region Jv Soft Tigsue Comection
[~ Regional B-alue

[v Fat Mass Adjustment

Forearm
[ High Density Paint Exclusion
Mandible

Image Enhancement [ High Density Paint Exclusion

[~ Show Original Image

Bestore Factory Defaults Save Lloze

Figure 3-11: The Analysis tab preferences window

Preferences: Image Enhancement

When the “Show Original Image” option is unchecked (disabled), all scan images will use the enhanced display.

1Forearm, Whole Body, Lateral Spine, and Research/Small Subject are not available on some models.
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Preferences: AP Spine Analysis

The following figure shows the default AP Spine Analysis parameters. The default settings should be effective
for most scanning situations.

AF Spine
Analysiz Mode f* Standard " Angulated
Region ¢ Prompt ¢ L1-L4 O L2-L4

[ High Denzity Paoint E xclusion

Figure 3-12: The default AP Spine Analysis Parameters

Festare Factary Detaults
= Y and

Note: WHAT TO DO: To restore the default Analysis parameters, click

Cloze

. This will restore the defaults for all scan types.

A\

Note: WHAT TO DO: To change the default Analysis parameters, access the Scanner Preferences
window from the main Database Navigator window as described next.

If it is not already open, click on Edit > Scanner Preferences > Analysis tab.
Locate the AP Spine analysis parameters in the window (shown above).

Select and change any of the analysis parameters (see Parameter Descriptions below).

Click‘ seve ‘and| Lo I at the bottom of the window. These settings now become the
default settings until changed again.

.

PARAMETER DESCRIPTIONS:

» Analysis Mode: refers to the cursors.
»  The Standard option displays the cursors in the horizontal plane.
»  The Angulated option allows the cursors to be positioned at whatever angle is necessary to line up on
the vertebral gaps, such as would be needed for patients with angled spines. See "Angulated Curs-
ors" on page 12-68.

» Region: refers to the default region of interest for analysis. Select “Prompt” to make the selection each time
ascanis analyzed. If “L1-L4” or “L2-L4” are selected it will be the default region of interest for all AP Spine
scans.

» High Density Point Exclusion: when checked (enabled), it will exclude data points with a density >3.75
g/cm2 from the analysis. In addition, the note “HD Point Exclusion” will be printed under the scan image of
the Bone Exam Report.

Caution: Norland strongly recommends operating the system with the High Density Point Exclusion
box un-checked (disabled), in order to provide consistent results for trending. The option should only
be turned on for individual scans when needed to remove artifacts from the scan.
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Preferences: Hip Analysis

The following figure shows the default Hip Analysis parameters. The default settings should be effective for
most scanning situations.

—Hip
Femoral Meck Length [cm) 10 & 15

I~ High Density Paint Exclusion
W Alemate Byalue Analysis

[ ‘ward's Region

Figure 3-13: The default Hip Analysis Parameters

Festare Factary Detaults
= Y and

Note: WHAT TO DO: To restore the default Analysis parameters, click

Cloze

. This will restore the defaults for all scan types.

A\ J

Note: WHAT TO DO: To change the default Analysis parameters, access the Scanner Preferences
window from the main Database Navigator window as described next.

If it is not already open, click on Edit > Scanner Preferences > Analysis tab.
Locate the Hip analysis parameters in the window (shown above).

Select and change any of the analysis parameters (see Parameter Descriptions below).

Click‘ seve ‘and| Lo I at the bottom of the window. These settings now become the
default settings until changed again.

PARAMETER DESCRIPTIONS:

» Femoral Neck Length: Femoral Neck Length determines the length of the region of interest along the
femoral neck axis. 1.5-cm is recommended because the longer length ensures better precision. The soft-
ware will automatically default to 1-cm if unable to attain a 1.5-cm region.

» High Density Point Exclusion: when checked (enabled), it will exclude data points with a density >3.75
g/cm2 from the analysis. In addition, the note “HD Point Exclusion” will be printed under the image of the
Bone Exam Report.

Caution: Norland strongly recommends operating the system with the High Density Point Exclusion
box un-checked (disabled), in order to provide consistent results for trending. The option should only
be turned on for individual scans when needed to remove artifacts from the scan.

» Alternate R-Value Analysis: if checked (enabled), the software algorithms will first use standard methods
to analyze hip data. If the computed R-value is determined to be outside of an acceptable range, a second
analysis method will automatically be invoked to analyze the hip scan data.

An R-value is a computed value used during the analysis process to allow the software to estimate the
amount of soft tissue above and below bone. In some individuals with very low density, the routine
algorithms for calculating the “R” value do not allow for the proper processing of hip data.

» Woard’s Region: is the minimum BMD Region automatically defined by the software. It is un-checked (dis-
abled) by default.
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Preferences: Forearm Analysis

The following figure shows the default Forearm Analysis parameters. The default settings should be effective
for most scanning situations.

Forearm

[~ High Density Faint Exclusion

Figure 3-14: The default Forearm Analysis Parameters

Fiestore Factory Defaultz
= y and

Note: WHAT TO DO: To restore the default Analysis parameters, click

52| This will restore the defaults for all scan types.

. J

Note: WHAT TO DO: To change the default Analysis parameters, access the Scanner Preferences
window from the main Database Navigator window as described next.

If it is not already open, click on Edit > Scanner Preferences > Analysis tab.
Locate the Forearm analysis parameters in the window (shown above).

Select and change any of the analysis parameters (see Parameter Descriptions below).

Click‘ seve ‘and| — I at the bottom of the window. These settings now become the
default settings until changed again.

PARAMETER DESCRIPTIONS:
» High Density Point Exclusion: when checked (enabled), it will exclude data points with a density >3.75

g/cm2 from the analysis. In addition, the note “HD Point Exclusion” will be printed under the image of the
Bone Exam Report.

Caution: Norland strongly recommends operating the system with the High Density Point Exclusion
box un-checked (disabled), in order to provide consistent results for trending. The option should only
be turned on for individual scans when needed to remove artifacts from the scan.
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Preferences: Whole Body Analysis

The following figure shows the default Whole Body Analysis parameters. The default settings should be effect-
ive for most scanning situations.

Whole Body

[ High Denzity Paoint Excluzion
[w Soft Tizzue Comection

[w Fatkazz Adiustment

Figure 3-15: The default Whole Body Analysis Parameters

Fiestore Factory Defaults
= L and

Note: WHAT TO DO: To restore the default Analysis parameters, click

Cloze

. This will restore the defaults for all scan types.

A

Note: WHAT TO DO: To change the default Analysis parameters, access the Scanner Preferences
window from the main Database Navigator window as described next.

If it is not already open, click on Edit > Scanner Preferences > Analysis tab.
Locate the Whole Body analysis parameters in the window (shown above).

Select and change any of the analysis parameters (see Parameter Descriptions below).

Click‘ seve ‘and| Llose I at the bottom of the window. These settings now become the
default settings until changed again.

(.

PARAMETER DESCRIPTIONS:

» High Density Point Exclusion: when checked (enabled), it will exclude data points with a density >3.75
g/cm2 from the analysis. In addition, the note “HD Point Exclusion” will be printed under the scan image of
the Bone Exam Report.

TO EXCLUDE HIGH DENSITY OBJECTS FROM THE ANALYSIS: The system software is equipped with a

feature that will exclude high density objects from the analysis. This feature is normally disabled (unchecked).
It can be enabled (checked) for all scans (default setting) by following the steps below.

Determine if the patient has had any dental work, implants, or any sub-dermal high density objects. These
objects may affect the results of the scan.

In the Whole Body area of the Analysis tab, click the check box labeled High Density Point Exclusion (Figure 3-
15). When checked, the Analysis will exclude data points with a density greater than 3.75 g/cm2.

m Caution: Remember to disable High Density Point exclusion at the completion of the scan. ]

» Soft Tissue Correction: For scanners with Soft Tissue Calibration enabled, the Soft Tissue Correction will
be applied to the Fat and Lean mass measurements.

» Fat Mass Adjustment: For scanners with Soft Tissue Calibration enabled, the regional Fat Mass, Total Fat
Mass, Total Fat %, and Soft Tissue Fat % will use the new Fat calculation formula.
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Preferences: Lateral Spine Analysis

The following figure shows the default Lateral Spine Analysis parameters. The default settings should be effect-
ive for most scanning situations.

Lateral Spine

[~ High Denzity Paint Ezclusion

Figure 3-16: The default Lateral Spine Analysis Parameters

Festare Factary Detaults
= Y and

Note: WHAT TO DO: To restore the default Analysis parameters, click

E9® | This will restore the defaults for all scan types.

A\ J

Note: WHAT TO DO: To change the default Analysis parameters, access the Scanner Preferences
window from the main Database Navigator window as described next.

If it is not already open, click on Edit > Scanner Preferences > Analysis tab.
Locate the Lateral Spine analysis parameters in the window (shown above).

Select and change any of the analysis parameters (see Parameter Descriptions below).

Click‘ seve ‘and| Lo I at the bottom of the window. These settings now become the
default settings until changed again.

PARAMETER DESCRIPTIONS:
» High Density Point Exclusion: when checked (enabled), it will exclude data points with a density >3.75

g/cm2 from the analysis. In addition, the note “HD Point Exclusion” will be printed under the scan image of
the Bone Exam Report.

Caution: Norland strongly recommends operating the system with the High Density Point Exclusion
box un-checked (disabled), in order to provide consistent results for trending. The option should only
be turned on for individual scans when needed to remove artifacts from the scan.
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Preferences: Research/Small Subject Analysis

The following figure shows the default Research/Small Subject Analysis parameters. The default settings
should be effective for most scanning situations.

Fesearch/Small Subject
[ High Denzity Point Excluszion
[ Soft Tiszue Comection

[ Regional A4 alue

[w Fatbaszz Adjustment

Figure 3-17: The default Research/Small Subject Analysis Parameters

Fiestore Factory Defaultz
= ’ and

Note: WHAT TO DO: To restore the default Analysis parameters, click

52| This will restore the defaults for all scan types.

. J

Note: WHAT TO DO: To change the default Analysis parameters, access the Scanner Preferences
window from the main Database Navigator window as described next.

If it is not already open, click on Edit > Scanner Preferences > Analysis tab.
Locate the Research/Small Subject analysis parameters in the window (shown above).

Select and change any of the analysis parameters (see Parameter Descriptions below).

Click‘ Save ‘and| Llose ‘at the bottom of the window. These settings now become the
default settings until changed again.

(. /

PARAMETER DESCRIPTIONS:

» High Density Point Exclusion: when checked (enabled), it will exclude data points with a density >3.75
g/cm?2 from the analysis. In addition, the note “HD Point Exclusion” will be printed under the scan image of
the Bone Exam Report.

IF HIGH DENSITY POINT EXCLUSION IS CHANGED FOR A COMPLETED SCAN: The scan will be reana-
lyzed, and the user will be prompted for the reanalysis type.

A Full Analysis will retain all user-placed regions. Any areas Included or Excluded from the scan will be reset to
normal data points.

A Partial Analysis will retain all user-placed regions, as well as retain any Included or Excluded areas.

The Cancel option will revert to the previous setting for the High Density Point Exclusion setting, and the scan
data will not be modified.

Caution: Norland strongly recommends operating the system with the High Density Point Exclusion
box un-checked (disabled), in order to provide consistent results for trending. The option should only
be turned on for individual scans when needed to remove artifacts from the scan.
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» Soft Tissue Correction: For scanners with Soft Tissue Calibration enabled, the Soft Tissue Correction will
be applied to the Fat and Lean mass measurements.

» Regional R-Value: Analyzed scans using individual R-Values for each Region of Interest, instead of a
global R-Value.

Note: The same R-Value setting should be used for all scans of the same study for a patient to pro-
duce consistent results.

» Fat Mass Adjustment: For scanners with Soft Tissue Calibration enabled, all regional Fat Mass values will
use the new Fat calculation formula.

Operator's Guide
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Service Tab Setup

Caution: The Service Setup should not be modified by operators without direct communication from
an authorized Norland Technical Support Representative.

The Site tab is accessed by clicking on Edit > Scanner Preferences. Then click the Service tab.
Here, the operator can view the serial numbers for the Calibration Standard, Scanner and the QC Phantom.

Scanner Preferences X

Site | Scanning | Analysis WlCEl

— Calibration Standard — QC Phantom
ibrati 6734
Calibration Standard 5/M Scanner 5/M 50000 T W
K - Values

K1 Iﬁ.454?_2'|] K3: I-O.'D?_'IS‘}GI BMD I'D.S-‘IJD BMD 5D 0,010
k2 |-0.000090 K |3.01 1980
Fat I-‘Hg.'l Fat SO I'IP_.DDD

K5 |1 630960
Lean IE’DE.-’l Lean 5D 10.000

i

T - Values

LI I-'I-’-l.?BEtD‘IO T3: |1 54351700
— Options
2 IG.S‘}UB‘}O T4 |0.393440 [~ Export Reports To DICOM

[~ Disable Systern calibration Instructions
T5: I?_B.MJDHO 4
v Automatically Adjust Correction Factors

Save Close

Figure 3-18: The Service tab preferences window

» Export Reports To DICOM: when checked (enabled), calibration files can also be exported to a DICOM file
but only if the DICOM interface has been enabled. The default destination is to a PDF file when disabled.

» Disable System calibration Instructions: when checked (enabled), the operator can disable the on-screen
instructions for performing a calibration. This will allow the calibration screen to be displayed much faster.
However, this is not recommended unless the operator is well versed in the calibration technique.

» Automatically Adjust Correction Factors:when checked (enabled), the calibration correction factors will be
automatically adjusted with each daily calibration.

Click to close the window.

NORLANLDO B3D109 Rov-7



Installation and Setup 3-39

Advanced Preferences Command
File Calibration Tools Help

Uszer Preferences

Scanner Preferences

Adwvanced Preferences
/ Users and Groups
The Advanced Preferences selection displays a few different tabbed dialog boxes. The tabs of interest include
the Basic Settings tab, the Reporting tab, the Directories tab, and the Network tab.

System Tab (under the Basic Settings tab)

If the setting Always Display Reference Graphs in Color? is enabled, the reference graphs on all screens
and reports will always be displayed in color. If the setting is disabled and the Image Color is set to Grayscale,
reference graphs will also be displayed in grayscale.

Customer Info Tab (under the Basic Settings tab)

The fields in the Customer Info tab provide the business name and address information that will be printed at
the top of the calibration reports and some patient scan reports.

Click on Edit > Advanced Preferences and click on the Basic Settings tab, then the Customer Info tab to
open the following window:

4/ Advanced Preferences |X|

Reponingl Directoriesl Networkl Study | DICOMl

Systern Customer Info |

Business Marme: IBridgepon Heray Lab

Locality: IElridgepon, CT

Department: IX—ray

Fhone: [203-855-1212 Fax.  [03-555-1414 Hone

Email: IBthrayLah@eanhlink.net

Cancel

e

Address: |555 Main Street

City: IBridgepon State: ICT
Postal Code: |12345 Country: IUSA
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Printing Tab (under the Reporting tab)

The Printing tab allows the user to set the print margins when printing Reports.
Click on Edit > Advanced Preferences and click on the Reporting tab:

Basic Settings ! Directnriesl Networkl Study l DICOM]

Printing

Print Margins (in centimeters)
Left Right Top Bottom
1.5 1.5 [15 15

Owerride template specified margins with these settings T

v Print Table Background Colors
e Done
v Print Siri Graph
Header Configuration
Cancel
Report Template Marme

Date Report Was Printed

Tirne Report Was Printed

Date Report Was Last Modified
Patient 1D

Study Mumber

Page Mumber

4 i S R Y

Enabling the Print Siri Graph option will show the Siri UWE Fat Table on Whole Body reports when Soft Tis-
sue Composition is enabled. When disabled, the graph will not appear on any report layout.

NORLANLDO B3D109 Rov-7



Installation and Setup 3-41

Directories Tab

The Directories tab is where the various paths are set.
Click on Edit > Advanced Preferences and click on the Directories tab to open the following window:

& Advanced Preferences

Basic Settingsl Reporting Networkl Study | DICOM'

Commaon Directory (this is where various configuration files are stored)
IC:\IIIuminatusD}{A\Common Bro

I

E-Mail Directory ithis is the temporarswork directory for E-Mail)
|C:\IIIuminatusD){ﬂ\\IOMail Browse...

Email Demo Path {choose a directory to save ImahalL exe to for demo mode)
JC:lluminatusDxA

E

HTRL Template Directory {imageMaAll headers and footers, etc.)
|C:\IIIuminatusDXA\Common\html

Report Directory ithis is the tempoarary work directary for Reporting) |

- Cancel
IC:\IIIumlnatusDXA\IQRepon

Done

=]
2
3
o

o
2
i
D

Temporary Directory (this is the work directorsd
|C-ulluminatusDxA

E

Auto Prompt Backup Path (example: EX

I Browse...

NOTE: A path MUST be entered in the “E-Mail Directory” box in order for the FolderMail option to work.
Directory Settings for the MAPI Server Type

Follow this procedure to set the proper directory path when using a MAPI server type.
Click on Edit > Advanced Preferences and click on the Directories tab to open the following window:

# pdvanced Preferences

Basic Settingsl Reporting Directories INetworkl Study | DICOMl

Commaon Directary (this is where various configuration files are stored)
|C:\IIIuminatusD}{A\Comm0n Bro

1

E-Mail Directary ithis is the temporary worlk directary for E-Mail)

=}
=
c
§
D

Email Demo Path {choose a directony to save ImghAIL exe to for demo mode)
[C-Miluminatus D

E

HTWML Template Directary {magedAlL headers and footers, ete)
IC:\IIIuminatusDXA\Common\html

Done

Report Directory {this is the terporary work directory for Reporting)

- Cancel
IC:\IIIumlnatusDXA\IQRepon Browse...

i

Click on the Browse button as marked above (to change the E-Mail Directory path).

Click on the series of folders as shown below to get to the 1033 folder. NOTE: you must double click on the
folder icon to select the folder. (Notice the path at the bottom of the window.)
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Select Directory

[Ectocarasn ] gf]  seeet | conce |

[=Cha

[ Frogram Files
= Common Files
[£= System

(= Manpi
#2 1033

£ GG Cache

C'Program Files'Common Files'SystemMapil1033

Once there, click Select. That path now appears in the Directories tab. Click .

Network Tab

The Network tab allows your IT administrator to enter the SMTP Server host name.

Click on Edit > Advanced Preferences and click on the Network tab to open the following window:

M Advanced Preferences @

tudy | DICOM |

Basic Settings] Reportingl Directories
E-Mail |

SMTP Server (enter the hostname of your E-Mail Server here) Server Type |SMTP =
rnail. ouroffice. com . .
| Comprassion (20 Z‘

Done

i

Cancel

NORLANLD
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To set the mail configuration:

# Advanced Preferences

X

Basic Settings] Reponingl Directories  Metwork lStudy ] DICOM]

E-Mail |
SMTP Server (enter the hostname of your E-Mail Server here) Server Type |SMTP =
|mai|.0ur0fﬁce.com SMTP

Compression [pap)|

Done

i

Cancel

Selecting the Server Type “SMTP” (from the drop-down list) will require that the SMTP server (host name of the
server) be entered in the white box labeled SMTP Server as shown above. The setting mail. ouroffice.com was
used in this example.

Selecting the Server Type “MAPI” (from the drop-down list) will use your current e-mail client (i.e. it will invoke
Outlook or Outlook Express). Go to "Directory Settings for the MAPI Server Type" on page 3-41 to set the cor-
rect directory path when using the MAPI server type.
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Users and Groups Command
File | Edit | Calibration Teools Help

User Preferences

Scanner Preferences

Advanced Preferences

/ Users and Groups

The Users and Groups selection displays the User Editor dialog box. It contains two higher level tabs - a Users
tab and a Groups tab.

The Users tab contains the following sub-tabs:

Main Settings - displays the dialog box for changing login name and password, e-mail address, and the width
and height of the Stamp View thumbnail

User’s Groups: - contains the Group List
Additional Settings - has Security Privileges settings

N User, Editor # User Editor &| M User, Editor

Usets ]Gruups] Llsers ]Gruups] Llsers ]Gruups
Al I L ol I L o I L L
MamSemngs I User's Groups } Additioral Settings ] Main Settings  User's Groups ]Addrtiuna\ Settings } Main Settings } User's Groups  Additional Settings ]
Security Privieges

Login Groups for this user Group List [~ Can Yerify Reparts

|nnr|and Users Administrators

Mew Password Administrators = Users

Guests

| Clinicians

Confirm Passwaord )

Full Name

|Narland
Phong Mumber

E-Mail &ddress

|nurland@swwssray.cum

Thurnbnsil YWidth Thumbnail Height
190 45
ey ‘ Exiit ‘ ‘ Bemove | Edit Edit
Close Close Close

Note: WHAT TO DO: Select the tab related to the function you want to perform. Type in the inform-
ation being changed. Click the appropriate button (New, Edit, Cancel, or Remove). Click .

A\

The Groups tab contains the Group List:
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# User Editor,

Users {Grauns |

Group List
Administratars
Users

Guests
Clinicians

Remove

Cloze

(.

%] Note: WHAT TO DO: Select the tab related to the function you want to perform. Type in the inform-

ation being changed. Click the appropriate button (New, Edit, Cancel, or Remove). Click .

Operator's Guide
435D109 Rev. Z
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Calibration Command
To view the Calibration commands, click on Calibration in the Database Navigator window.

File Edit | Calibration | Tools Help
Begin QA
QC Scan...

Results

Quick Descriptions: “Calibration” drop-down list

Begin QA: initiates the QA procedure, which is performed daily. See "Daily Calibration Procedure" on page 4-6
for the complete QA procedures.

QC Scan: prepares the system for a scan of the QC Phantom (independent of the QA procedure).
Results: displays most recent QA results. See "QA Results tab Window Interpretation " on page 4-18.

A Illuminatus DXA 4.4.3

File Edit Calibration Toaols Help
Calibration l GC Scan I 24 Hesulls]

0 ol g . : ~
2o Daily Calibration Procedure 1
Iw Scan QC Fhantom
Scanner S/M: 8113 & daily System Quality Assurance Calibration should always be performed prior to patient scanning to
Spectum ensure quality hone density estimates. If successful calibration has not heen completed within the last 14
Backaround: days, scanting will be disabled.
Peaks
Discriminators 1. Check the Standard and QC Phantom for Damage

Diagnostic Tests Calibration failure may occur if mternal elements i the QA& Calibration Standard become rmsaligned, bent,

) i or cracked. This kind of damage can oceur if the Standard 1z dropped.
Autozet PMT Gain
Reference Gain 1. Check the QA Calibration Standard for bent corners or damaged plastic. No loose parts should be
#-Ray off heard if it is shaken. If the Standard 1z damaged, contact your MNorland Customer Service
Shutter

. representative. See Customer Service Contact Information
Low Attenuation

Medium Attenuation
High Attenuation
Diynamic Filtration

o o
o o o (o o

Calibration Status
[~ Passed
[ Failed

L

Time Remaining -
Current Phase: 00:00:00

Taotal Time: 00:00:00

WIRLANDO

2. Check the QC Phantom for damage (etther the black or the clear phantom)

Start | | Cancel | I | f t |

|Administrator [Report Template: Bone Exam Report - 1 page Scanner Present

Figure 3-19: Preparing for a Daily Calibration by selecting Calibration > Begin QA.
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Tools Command

To view the Tools commands, click on Tools in the Database Navigator window.

File Edit Calibration |Tools | Help

Initialize Scanner

Service Teols 3
File Tools

Calibration Details

Send To: >

Update Report Scan Type Values
DICOM Interface

Mail
Report »

Audio Dictation

Log Files v

Quick Descriptions: “Tools” drop-down list

Initialize Scanner: Select this feature if the message “Scanner Not Present” appears at the bottom of the Data-
base Navigator window and the scanner is powered on. The Scanner will re-initialize.

Service Tools: contains the Find Origin, Table Limits, and Begin Initial Calibration commands. See "Find Ori-
gin" on the next page, "Table Limits" on page 3-49, or "Begin Initial Calibration" on page 3-50 for details.

File Tools: for detailed patient and scan information and system diagnostics files.
Calibration Details: for system diagnostics. Various calibration files can be viewed.

Send To: This (cascading) menu option provides a way for operators to copy a Scan from the Bone Dens-
itometer software to any of the drives (e.g., C:\, floppy, network share), or a folder. From the Stamp View, the
operator should select one or more scans, select Tools > Send To, and select the drive of choice in the sub-
menu.

Update Report Scan Type Values: This command will update the scan types on all previously generated
reports in all databases. The command will disappear from the menu once it has been executed once.

DICOM Interface: This command will launch the DICOM Interface. Refer to Chapter 14, DICOM Interface
for more information. The option will only be available if enabled by an OAC.

Mail: This tool enables the operator to e-mail patient data in a FolderMail file to a colleague. It also displays the
E-mail address book. Refer to "FolderMAIL" on page 12-9 for information.

Report: This selection enables the operator to select a report template, generate a new report, and edit existing
Reports (Complete Report command). Full instructions on how to generate and print a report is included at the
end of each type of scan chapter (for example "Generate and Print a Report" on page 5-24 for AP Spine scans).

Audio Dictation: An Audio Dictation enables a person to record anything, including a report dictation pertaining
to the selected scan that can be written up later. Refer to "Adding Audio to a Patient Record" on page 12-2 for

info.

Log Files: This pull-down provides a secondary menu allowing the administrator to access the following log
files:

» Scanner: errors.log

» Calibration: calib.trc

» Import DB: dbimport.log
» Runtime: client.log
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Find Origin

This setting is accessed by clicking Tools> Service Tools > Find Origin.

File Edit Calibration | Tools | Help

File Tools

Send To:

Mail
Report

Log Files

Service Tools 3 Find Origin

Calibration Details

DICOM Interface

Audio Dictation

Initialize Scanner ‘

Table Limits

Begin Initial Calibration

More Tools...

»

The "Find Origin" command is a diagnostic function that allows operators to redefine system origin location if
the arm was bumped during operation (thus losing a step) or if Technical Support requests this operation during
troubleshooting efforts. It moves the scanner arm to the origin at the left rear corner of the machine. A dialog
box opens warning the user that the table origin will be found and the patient should be kept out of the way. The
operator has the option to continue or cancel the operation.

p
A Caution: Ensure that Scanner Arm path is clear of obstructions before using this feature.

J

A

Note: WHAT TO DO: Click on Tools > Service Tools > Find Origin. The following alert box opens:

Morland Alert
|

Warning! The scanner is aboutto locate the tahle
origin. Flease verify that the patient is clear before
continuing.

Click to continue. The scanner arm will find the origin.

N\

NORLANLD
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Table Limits

This setting is accessed by clicking Tools> Service Tools > Table Limits.

File Edit Calibration | Tools | Help

Initialize Scanner ‘

Service Tools » Find Origin
File Tools Table Limits
tormiEn e Begin Initial Calibration
Send To: 3

More Tools...
DICOM Interface

Mail
Report 3

Audio Dictation

Log Files 3

The "Table Limits" command is a diagnostic function that allows operators to redefine table limits if the arm was
bumped during operation (thus losing a step) or if Technical Support requests operation during troubleshooting
efforts. It moves the scanner arm to the origin position and to the opposite corner to define the scan area. A dia-
log box opens warning the operator that the table dimensions will be found and the patient should be kept out of
the way. The operator has the option to continue or cancel the operation.

p
A Caution: Ensure that Scanner Arm path is clear of obstructions when using this feature.

J

N\

Note: WHAT TO DO: Click on Tools > Service Tools > Find Origin. The following alert box opens:

'Norland Alert

Warning! The scanner is aboutto find the table
dimensions. Flease wverify that the patient is clear
& before continuing.

Cartiriue |

Click to continue. The scanner arm will redefine the table limits.

D10 Fev 2 NORLANLDO



3-50 Installation and Setup

Begin Initial Calibration
This setting is accessed by clicking Tools> Service Tools > Begin Initial Calibration.

File Edit Calibration | Tools | Help

Initialize Scanner ‘

Service Tools » Find Origin
File Tools Table Limits

tormiEn e Begin Initial Calibration

Send To: 3
More Tools...
DICOM Interface
Mail
Report 3
Audio Dictation
Log Files 3

The Begin Initial Calibration command is a tool that allows Technical Support to begin the Initial Calibration pro-
cess for repair purposes. The command should only be used under the direction of Technical Support. The cal-
ibration process will run for a minimum of 6 hours, and once the process is started, it is not possible to scan
patients until it has completed successfully.

N

Note: WHAT TO DO: Click on Tools > Service Tools > Begin Initial Calibration. The following alert
box opens:

@ Warning! This function is used to perform a B-hour initial calibration procedure
Patient scanning will be disablad until the operation completes successtully.
This should only be performed under the recommendation of Norland Technical Support. Do you wish to proceed?

Click to continue. You will be prompted again to confirm. Click e again to con-
tinue.
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Help Command
To view the Help commands, click on Help in the Database Navigator window.
File Edit Calibration Tools @ Help

About

AR Operator's Guide
ELITE Operator's Guide
Morland Support
Swissray Website

Quick Descriptions: “Help” drop-down list
About: displays the llluminatusDXA software version information and the copyright.
XR Operator's Guide: displays the Operator's Guide PDF for XR-Series scanners.
ELITE Operator's Guide: displays the Operator's Guide PDF for ELITE scanners.
Norland Support: opens the Norland Support website http://support.norland.com (if connected to the internet).
Swissray Website: opens the Swissray website http://www.swissray.com (if connected to the internet).

Operator's Guide
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Basic Operation

This chapter begins with an overview of the patient scanning procedure. Guidelines
for obtaining scan precision and accuracy are reviewed next.

System Startup procedures for both the XR-600 and the XR-800 are detailed next.
After startup, detailed instructions for the Daily System Quality Assurance Calibration
Procedures are presented. A discussion of the QA Results follows.

Preparing patient records is the next step in the scanning procedure. How to create a
new patient record and how to update an existing patient’s record are discussed in
detail. From there, you are instructed to go to the pertinent scan-type chapter (AP
Spine, Hip Scan, etc.) to continue the scan.

A discussion of the buttons and fields available in the Patient Demographics window
is given for reference.

Finally, system backup and shutdown procedures are discussed.

This chapter discusses the following.

Patient Scanning Procedure Overview ... ... ... . 4-2
Guidelines for Attaining Precisionand Accuracy ... ................. 4-2
Powering Up the System ... 4-3
Logging into the Norland Software ... ... ... ... ... 4-4
Daily Calibration Procedure . ... ... 4-6
QA Results tab Window Interpretation ... ... ... .. ... 4-18
Preparing Patient Records ... ... ... 4-21
Beginning the Patient Scan .. ... ...l 4-33
System ShUutdOWN . 4-34

CHAPTER 4
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Patient Scanning Procedure Overview

The Norland DXA system quantifies bone mineral in the lumbar spine, hip, lateral spine, forearm, and whole
body for computer and operator-defined regions of interest. The software automatically programs the system for
the correct techniques and parameters based on the selected scan type.

1. The operator selects an existing patient's name from the Database Navigator window or enters a new
patient’s information into the Patient Demographics window.
2. The patient is positioned on the scan table, and a scan type is selected from the software.

3. The operator positions the scanner arm to the patient’s anatomy and defines the scan region. (A scout scan
is used on some scans to assist in defining the scan region.)

4. The actual scan completes without interruption or operator intervention. An audible indicator sounds at the
end of each scan.

5. After the scan has completed, the operator can analyze the scan immediately or save the scan data and ana-
lyze it later.

6. After scan analysis is completed, the results are saved to a default storage location and printed or sent to
DICOM.

Guidelines for Attaining Precision and Accuracy

Patient variability, operator techniques and external radiation may adversely affect the precision and accuracy
of DXA estimations. It is not possible to eliminate all of these factors. However, the operator can reduce their
effects on scans by following these guidelines:

» Perform the Daily Quality Assurance Calibration.
» Screen patients for recent radionuclide uptake procedures (within ten half-lives).

» Make sure that each operator follows the same procedure for patient positioning and analysis. If the patient
has been scanned before, use the same scan parameters as those used for the patient's initial scan. Use the
same scan area size for all scans of the same patient.

Be aware that operating a Norland system near external radiation sources, such as other x-ray gen-
erating devices or devices that involve radionuclides, may affect results.
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Powering Up the System

Norland Bone Densitometers do not require any warm-up period before calibration or patient scanning. Norland
Technical Support recommends that the scanner system be left ON overight and weekends. The scanner sys-
tem should be turned OFF if the system is to be inactive for an extended time (1 week or longer).

Norland STRONGLY recommends that the QA Calibration be performed daily prior to patient scanning as part
of a regular Quality Assurance Program.

The operator should follow these instructions to power up the Norland Bone Densitometer system after it has
been shut down.

IMPORTANT: The scanner MUST be turned on BEFORE entering the IlluminatusDXA software for
proper operation.

| = 0N
0 =0FF

Figure 4-1: Scanner Table Power Switch Location

1. Tumn the scanner ON by depressing the power switch located on the right side of the scanner table base (all
models). | = ON.

2. Turn on the computer and the monitor. The computer will boot into the Windows desktop with the Bone Dens-
itometer Host icon displayed on the desktop.

3. Turnon the printer.
4. Loginto the llluminatusDXA program.
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Logging into the Norland Software

1. Double-click on the “llluminatus DXA” icon on the desktop to start the Norland Bone Densitometer soft-
ware program. The Login window will open, as shown next.

M Lagin

NUORLANLD

Login:lnﬂﬂand vl Password:i Login | Cancel |

Figure 4-2: The Bone Densitometer Login window

2. Typeinthe password and click the button to start the software.

3. If the scanner was previously turned off and back on, you will be prompted to initialize the scanner. Wait
while the Scanner initializes.

Caution: The Scanner Arm will move to its origin position during initialization. STAY CLEAR OF THE
SCANNER ARM.

4. The software will open to the main window - referred to in this manual as the Database Navigator window.
It is shown next for reference.
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Ulyminatus DXA450 o — — _ - — . [E=REER
File Edit Calibration Tools Help
Database: |Cick\Examples -
Patient Visit List
Category: Search:
Quick Search: |Fatient Name =0
Patient ID | Patient Name | Visit Date | ScanType | Anabzed |
Fracture “Spine. fracture -
AP SPINE *Spine.good
Off Center “Spine. off center
Osteoparotic “Spine.osteo
IMPROPER AP “Spine. poor start/end
Sping “5pine. poar. condition
AngldCursors “Spine. scoliogis
Too High “Spine. start too high
Shart “Spine.too shart
DFWE Afhole Body
Gluteus Ahbdominal, Soft Tissue )
k101111 Adams. Helen
Dual Hip Dual. Hip
K11-6654 JOHNSOM, BETTY
K111212 Jones, Mildred
= PatientiD Lastname, Firstname
77 S
Scan Left Hip Tes £
Scan AP Spine e
Scan Left Forearm Yes
Wit 7/19/2000
Visit 742041939 I
Wisit 7/23/1997
Manuall Manwual, Patient
Manual 2 Marual, Palient W
Manusl3 Marial, Patient
MNoSling Mo Rotation, Hip -
I
Delete | << Logout MNew Patient >> Demographics »» Stamp View >>
Administrator | I |Report Template: Bone Exam Report Scanner Present

Figure 4-3: The main Database Navigator window

The Norland software is now ready to:

» perform a System Calibration

» perform a patient scan or

» perform an analysis on an existing scan

To ensure a high level of precision and accuracy, a System Calibration should be performed at the beginning of
the day when patient scans will occur. The daily system calibration procedures are described on the next few
pages.

In the event of a start up problem or other difficulty, please contact your Norland Technical Support
Representative.
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Daily Calibration Procedure

Note: A daily System Quality Assurance Calibration must always be performed prior to patient scan-
ning to ensure quality scan results. If a successful calibration has not been completed within the last
14 days, scanning will be disabled.

1. Check the Standard and QC Phantom for Damage

Calibration failure may occur if internal elements in the QA Calibration Standard become misaligned, bent, or
cracked. This kind of damage can occur if the Standard is dropped.

a. Check the QA Calibration Standard for bent corners or damaged plastic. No loose parts should be heard if it
is shaken. If the Standard is damaged, contact your Norland Technical Support representative. See "Cus-
tomer Service Contact Information” on page 1-3.

Figure 4-4: QA Calibration Standard

b. Check the QC Phantom for damage (either the black or the clear phantom).

Figure 4-5: Black (Body Composition) and Clear (Bone Only) QC Phantoms
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2. Position the Standard and the Phantom on the Scanner

a. Place the QA Calibration Standard on the scanner table and position it so that it is aligned with the cor-
responding marks on the scanner table surface. Point "A" on the calibration standard will face the head (to
the right) of the table on the XR-800, and will face forward (toward the operator) on the XR-600.

XR-800 XR-600
Figure 4-6: Positioning the QA Calibration Standard

b. Place the spine phantom on the table in the marked location.

i. Scanners with Soft Tissue Calibration: Place the black QC Phantom on the scanner table in the marked loc-
ation. The “C” on the box should be orientated to the right side of the table (operator facing the table). Position

the Phantom parallel to the back rest.

ii. Scanners without Soft Tissue Calibration: Place the clear QC Phantom on the scanner table in the marked
location. The “X” at the top of the spine (labeled “C” below, right) should be orientated to the right side of the
table (operator facing the table). Position the Phantom parallel to the back rest.
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3. Calibrate the System Using the QA Calibration Standard

In the Database Navigator window, click Calibration > Begin QA. The Calibration window will open after a
period of time (notice the tab along the top labeled “Calibration”).

o = = e e =
[ s DA LS s i G e S S - — el

File Edit Cabbration Teols Help
| Cobuation | GC S | 04 sl | l
Fow L Daily Calibration Procedure
¥ Sean 0T Phantsn
Seanner S H113 A daily System Qruality Assurance Caltwation should ahways be performed prior to patien scanning to ensare quality bone density estimares.
Spectum Bf snceessfil caBbration has not been completed within the kst 14 days, scansing wil be disabled k
Bachgound
Peaks 1. Check the andQCF for Damage
h
g Calibvation faihure may occ if mbemal clements @ the QA CaSlvation Standard become misaligned. bert, o cracked. This kind of demage
Diagneatic Teaty = o «<an ocour if the Standard is dropped.
an
Autnset PMT Gain = I 1. Check the QA Cabbeation Standard for bent corners or damaged plastic. No koose pans should be beard if & is shaken. If the
Eﬂm:‘e Gan ; ; Standard &5 damaged, contact your Norland Customer Service representative. See Customer Service Contact Information
Iy
Shusier " T
Lo Ameraistion. C T
Mg Atternishion ¥ W
High Aerusion r i
Dynamic Fivation i
Calbrgton S2shis
I Possed
I~ Fasded 4
Time Ressring
Custert Fhase 00.00:00
Totd Tane. 030000
2. Check the QC Phantom for damage (sither the black or the clear phantom)
2. Position the Standard and the Phantom on the Scanner
1. Place the QA Calibeation Standard on the scanner table and position it 5o that it is agned with the corresponding marks on the
—ssemmm tabla e fana =
s | | _cowen | | J | |
Fepent Template: Ten Vear Report Scannes Prevert

Figure 4-7: The Calibration window with “Calibration” tab selected

b. Notice that “Daily” in the Calibration window is selected. Confirm that the “Scan QC Phantom” box is checked.

r —— — q
Duminatus DXA 450 i i e e

File Edit Calibration Tools Help

Calibration | QC Scan | G4 Resuls |

[G‘ Daly ] € Inital | Daii

(IF Scan (AC Phantom )
Scanner 5/M; 8113

A Caution: The Scanner Arm will move during the next step. STAY CLEAR OF THE SCANNER ARM. ]

c. Clickon in the Calibration tab window. A dialog box will open:
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r Mark Calibration Standard =)
Switch on the laser.
Fark points & and B an the Calibration Standard
W FPaint &
m FantE
Frevious Step | |i Cancel |}

d. Press the LASER button on the Scanner Arm Touch Pad to switch ON the laser.

% Caution: Do not stare into the beam. ]

e. Use the arrow buttons to move the scanner arm so that the laser positioning dot is on the “+” on the Calibration
Standard Plexiglas surface (marked “A” in the figure below).

B

MARK <
f. Press - The laser will blink off, then back on. The computer will emit an audible sound, signifying
that the marking of point A is acknowledged.

g. The arm will automatically move to the approximate location of point B.
h. Use the arrow buttons to move the laser positioning dot to the “+” sign (marked "B " above).

. .
i. Press to mark point B.
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4. Calibrate Using the QC Phantoms

i. Once the Calibration Standard has been marked, the following dialog box pops up:
rm Mark QC phantom g‘

Switch o the laser
tark points C and D on the OC phantom

m FaontC

W FPointD

Previous Slepl

ii. Use the arrow buttons to move the scanner arm on the QC Phantom so that the laser positioning dot is
on the X (marked C in the figure below).

iii. Verify that the Phantom is straight by using the arrow buttons to move the laser to the X marked D in the
figure above. Re-position the Phantom if it is not straight.

iv. Move the laser back to the X marked C.

v. Press to mark point C.

vi. The scanner arm will automatically move to the approximate location of point D.

vii. Press to mark point D. The dialog box closes.

viii. As soon as the Phantom is positioned and marked, an Alert dialog box pops up. Wait while the source
ramps up. The dialog box will automatically close when the X-ray source is ready.

i - N

Heray source is not ready. Please wait..

£y

-

ix. Proceed to section "Automatic System Diagnostic Tests " on the facing page.
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5. Automatic System Diagnostic Tests

a. THE CALIBRATION TAB: The Norland software proceeds to turn the laser OFF and position the scanner
arm over the Calibration Standard. A sequence of instrument diagnostic tests will be performed auto-
matically and the results of each test will be displayed in the check mark boxes as they occur. (See the fig-
ure below.)

"I Duminatus DXA 45.0 [

File Edit Calibration Tools Help
Calibration | G Soan | 04 Results |

@ Daily € Iritial
[¥ Sean OC Phantom X-Ray Spectrum
Scanner 5/N: 8113
[ Spectum
Background: 6003
Peaks 2267 2267,1156,1155
Discriminators 1443,240,1469.173

[ Diagnostic Tests | 55000}

o
o

Autoset PMT Gain
Reference Gain
¥Rap off

Shutter

Low Attenuation 45000
Medium Sttenuation
High Attenuation
Dynamic Filration

Calbration Status
I~ Passed
Detail
’V I~ Failed —I*E -

~ Time Femaining

Cunent Phaze: 0:12:40

AR
b e e e e 44

35000}

Cournt Rate

Total Time: 01340

25000

|( - Scanring Calibration Standard - In Progress J

Current Calibration Task 15000)

5000|

Discriminators

Start | Bares) | Do O | e Pzt || < Bammmemies||| <& eamten

| Administrator [ [ |Report Template: Ten Year Fracture Risk Report  [Scanner Present

Figure 4-8: Daily Calibration in progress

b. Notice that the current scanner tasks are displayed in the lower left hand portion of the window. They mark
the phases of the calibration as they occur.

c. The scan of the Calibration Standard proceeds automatically to completion without operator intervention and
the estimated remaining time is updated periodically. Total time is about 25 minutes.

d. THE QC SCAN TAB: After the Calibration Standard data is collected, the software begins doing the QC
Phantom scan. The screen indicates the estimated time remaining.
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Figure 4-9: QC Scans in progress

Basic Operation

e. THE QA RESULTS TAB: The QA Results screen will be displayed at the completion of the QC Scan. The
entire process takes approximately 30 minutes to complete.

Slieie]
ep
o; Prec
Calbaon Standsd /N 5783
K 048329 T 1seas
2 omas 2 osue
K 0msr T3 15w
Ko 300 T o
ks 127 T8 2301
s
QCPhartom S 8517 *
D 0875 SD.0ol  CF 0%o7S .
Fa 420 20 G oww | S
Lo 565 D100 CF 0387 s 3
. . s
8 > 3P b ]
LsSew  Lawieoce v o .
LT T a6t ‘, ' .
Prcidor: 0K
.
\cou -l'.' e 8 &
Fat 112 .y
Lean: 02
we % s % o B wv I
onths
'
N
. L L \
R -
4
we W & & od & wv I T "R Y

Fa | _tem s

ExpottReports| PirtReports | Done | Changecr

[Administrator Report Template: Sconner Present

Figure 4-10: QA Results Screen
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6. Verify the Calibration
BMD: Verify that the PRECISION and ACCURACY fields are labeled OK (see figure below).
FAT (For Soft Tissue Calibration Option Only): Verify that the PRECISION and ACCURACY fields for the Fat

are labeled OK (see figure below). Click on to view the Fat Precision and Fat Accuracy graphs.
LEAN (For Soft Tissue Calibration Option Only): Verify that the PRECISION and ACCURACY fields for the

. . Lean . ..
Lean are labeled OK (see figure below). Click on to view the Lean Precision and Fat Accuracy
graphs.
P2 Hluminatus DXA 465 0 = R
File Edit Calibration Tools Help
0OC Scan QAHesu\tsl
~Calibration Detait
Seanner SN 2113 ( 8mo: precision )
Last (4 Completed: 1041647 513
Last OC Sean: 101647
~ Calbration Standard 5/M 5763
K1 0.46329 T1: 1484043
K2 00035 T2 061442
K3 002573 T 1543345
K4 200268 T4 037549
K 161217 5 22308321 R
®
 BC Phantom 524 8517 *
BMD: 0875 SD: 0.010 CF: 08576 L
Fat 4320 SD: 1200 CF: 09767 ] e @
Lean: 5965 5D: 10.00 CF: 0.9937 8 1 9
* * 3
 GC Fesults o ! * L
2 & 5 b |
LastScan  Last1BGCs OV o & P
BMD: 0875 0878 064 “ 9
: :
A : 0K o oo
couracy: }' g+ B ®
Fat 43173 43425 112 og
Frecision: OK.
Accuracy: OK P
Lean:  B97.61 595.76 0.4z
Precisior: OK.
Aceuracy. OK
UG 15 sEP ocT 15 OV 15 DEC 15 JAN 15 FEB 15 MAR
Months
(BMD Accuracy)
{lglemmemesemoennoemee s e maenne e ee s e s s e s e s se s e se s s s s e e ne s s s as s o e s e asm s s s e e s e s st se s s s s s s e e e s s e e s o= ]
= L\'\'\.\,__//‘I//]/‘/‘\I
e RN,
T . . o ! T . ; ; ; ; T .
AUG sEp ocT 15 oV 15 DEC 15 JAN 15 FEB 15 MAR
WReot | o0 | Rt | Lean | Honths
ExnurlHepoltsl antHepoltsl Done | Change CF | << Patient List | << Demoaraphics | << Stamp View
|Administratar [ [Report Template: Scanner Present

Figure 4-11: QC BMD Results

Operator's Guide
435D109 Rev. Z

NORLANLD,



Basic Operation

7. View and Print Calibration Results Reports

This section assumes that you have performed procedures 1-6 of the Daily System QA Calibration. In this sec-
tion, you will view and print the QC Results Reports. If the QA Results window is not already open, click on Cal-
ibration > Results to open it. The window is copied below for reference.

it
N 8113 BMD: Precision
Last G4 Completed: 10/16417 813

Last@CScan: 1016417
Calbration Standard S/M 5783
K| 046328 T 1284048
K2 0003 T2 B4
K3 002573 T3 1543345
K& 3.00266 T4 0.37543
K5 161217 15 22308321
4
€ Phsntom S/ 8517 ®
BMD: 0875 SD: 0.010 CF: 09376 - *
Fat 4320 SD: 1200 CF 0987 8 o @,
Lean 5966  SD: 1000 CF 0597 8 ’
L) -
. 8 %8
OC Resuls. a ]
i [ - bl |
LetScan  Lasi160Cs OV (I .
BMD: 0.875 ns7e 0E4 - O
Precision: oK ] .
Accuracy: DK L * &
é § » *
Fat 43125 112 °g
oK
cccccc y: 0K
Lea 53576 042
K
Accuacy; OK
AUG 15 SEP 15 ocT 15 NOV 15 DEC 15 JAN 15 FEB 15 MAR
Months.
BMD: Accuracy
]
# LW”VM
4
AUG 15 SEP 15 ocT 15 NOV 15 DEC 15 JAN 15 FEB 15 MAR
A epott | R | e | Wonths

Expurlﬂepullx‘ Pint Reports ‘ Done ‘ Change CF ‘ ‘

‘Administrator

Report Template: Scanner Present

One report is generated if you scanned the clear phantom and three reports are generated if you scanned the
black phantom.

An electronic copy of the report(s) can be created by exporting the report(s). Reports may be exported to either
PDF or DICOM format by clicking the button. The export type is determined by the sett

ing in Scan-
rg)er Preferences. For PDF files, browse to the appropriate directory, type in a file name and click the _
utton.

[ Note: The report is not exported until the QA Results window is exited.

——

The reports may be printed by clicking the button. To view and print individual reports:

1. FOR ABMD REPORT: With the BMD button selected, click the button.

2. Inthe dialog box (below), click to print the QA Results Report for storage in a Calibration Log paper

file. A sample Report is included in this manual for reference, see "Sample Printed QA Results Report” on
page 4-16.
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QA Results Report

Norland at Swissray

W6340 Hackbarth Road ~ Fort Atkinson, WI 53538 USA  (888) 7410413

QC Results
Host: 450 Last QA Completed
Calibration® 450 05/12/15 14:62
Scanner: 2341
Scanner S/N: 5113

K1: 0.46329
K3:-0.02573
K& 161217

Calibration Standard S/N:- 5783

K2: 0.00335
K4: 3.00266

m

Discriminator(FH,FLIH.IL): 1441,239.1466.173

BMD Precision
e LEECE T EEREEE LR e EEREEE R TS EEPER S REEPRERI RS PRISSR R PPRR
' . * 9
. B2, 3 i { $ 58
* *e 82 i ¥ s 8§
S T |
DEC 15 JAN 15 FEB 15 MAR 15 APR 15 MAY 15 JUN 15  JUL
Honths.

Cloze

3. Click to close the dialog box.

4. FOR AFAT REPORT: Clickto display the Fat QC results. Click 94 Repart | o | b |

Click

5. FORAL
Brint

Cloze

EAN REPORT: Click to display the Lean QC results. Click . Click

LCloze

Click

6. Click to close the QA Results tab window and return to the main Database Navigator window.
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Sample Printed QA Results Report

Norland at Swissray

WW6340 Hackbarth Road  Fort Atkinson, W1 53538 USA  (888) 7410413

QC Results
Haost: 4.5.0 Last QA Completed
Calibration: 450 051215 14:52
Scanner: 231
Scanner SN 8113

Calibration Standard S/N: 5783

K1 0.46329 k2 0.00335
k3. -0.02573 K4: 3.00266
KE: 1.81217

Discriminator(FH,FLIH IL): 1441 239 1466173

BMD Precizion

50
[=]
L
]
&*
] L]
L ]
]
o e
&
--E
joR s e

00 S S O S S

DEC 15 JAN 15 FEB 15 MAR 15 APR 15 MNAY 15
Months

BMD Accuracy

DEC 15 JAN 15  FEB 15 MAR 15 APR 15  MAY 1S

Munilhs
Phantom LastQC Last 16 QCs
Ink 8601 Date: 05/1215
BrD: 0.540 BEMD: 0 828 Mean: 0.834
BrD S0: 0.0 BMC: 4998 Cw:0.583
FRECISION: Ok

ACCURACY: OK

NORLANLD,
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When to Repeat the Calibration

Should any part of the calibration process fail, or the precision and accuracy are not OK, make sure the pos-
itioning of the Standard and the Phantom is correct. Then repeat the calibration.

If the diagnostic tests fail a second time, turn OFF the power to the scanner. Tum it back on (leave the com-
puter on). Retry the calibration.

Caution: The Scanner Arm will move when the scanner is turned on. STAY CLEAR OF THE
SCANNER ARM.

If the calibration process fails the third time, contact your Norland Technical Support representative.
See "Calibration" on page 17-6 of the Troubleshooting chapter for other troubleshooting options.

To Stop the Calibration

ciek_st_|

Cancel | | Done ‘
or

CIick|

Click to return to the Database Navigator window.
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QA Results tab Window Interpretation

The most important parts of the QA Results window are the two text lines in the QC Results area labeled “Pre-
cision” and “Accuracy”. You want both lines to read “OK”. They indicate the Precision and Accuracy status of
the system. In the event that the QC results statistics are not OK, other messages will be displayed. These
messages are discussed in "QC Results Statistics Messages" on the facing page.

A typical QA Results window is shown here for reference.

FJ Uluminatus DXA 465 (LSRN
File Edit Calibration Tools Help
0OC Scan QAHesu\tsl

Calibration Details

Scanner S/N; a113 ( BMD: Precision J
Last QA Completed: 1016417 313
Last QC Scar: 10/16/17
Calibration Standard 5/N 5783
K1 046323 T1: 14.84043
Kz 0.00335 T2 0E1442
K3 002573 T3 1543345
K4 3.0026E T4 0.37543
K& 161217 TS 2230831 e
-
.
QC Phantam S/ 8517
BMD: 0.875 5D: 0.010 CF: 03376 © &
Fat 4320 50: 12.00 CF: 03787 ] Y @
Lean 5965 5D: 10.00 CF: 09937 8 1 9
- *
§ - ¢ %%
OC Results o &9
@ [ * i ]
Last Scan Last160Cs  Cv & @ 'y
BMD: 0.875 0878 064 “ o
: 5
Acturacy: DK s, o 8
}. LI .
Fat. 431.72 434.25 112 *g
Precisior: DK
Accuracy DK o -t e oo e e e e e m e e e maaen
Learn:  B97.61 695.76 042
Precisior: DK
Accuracy: 0K
UG 15 sEp 15 ocT 15 NGV 5 DEC 15 JAN 15 FEB 15 WAR
Months
(BMD Accuracy)
Ugfesmmmmesceeecceseseem e e e e e s se s s e cesee s e e s e e e se s se s e ceses s se s es e e se s e s e sesse s e se e soss se sesm e ses ses ses e se sses se s o=
| B /I/‘/\I
* S
e e
I e T T T T T T T T T T T
AlUG 15 SEP 15 ocT 15 NOV 15 DEC 15 JAN 15 FEB 15 WAR
QA Report | Fat | Lean ‘ Months
ExnurlHepolts‘ Print Reports ‘ Done ‘ Change CF ‘
|Administrator Report Template: Scanner Present

Figure 4-12: Sample QA Results tab window

An examination of the window above reveals the information grouped into four areas: Calibration Details, Cal-
ibration Standard, QC Phantom, and QC Results. The right hand side of the window contains two graphs.
These are all discussed next.

CALIBRATION DETAILS AREA: contains the scanner serial number, the date of the last successful
QA Calibration, and the date of the last QC phantom scan.

CALIBRATION STANDARD AREA: contains the serial number of the QA Calibration Standard used at the
facility as well as its K-values and its T-values (when Soft Tissue Calibration is enabled).

QC PHANTOM AREA contains:

NORLANLDO B3D109 Rov-7
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» the serial number of the QC Phantom used at the facility

» the assigned value of BMD, Fat, and Lean values used to plot the Accuracy graph (Fat and Lean only
entered when Soft Tissue Calibration is enabled)

» and the Standard Deviation of each BMD, Fat, and Lean value used to plot the Precision graph.

The assigned values were entered into the system at installation, based on factory characterization of the sys-
tem’s QC Phantom.

QC RESULTS AREA: shows the last Calibration Scan and its resulting BMD and BMC values. If Soft Tissue
Calibration is enabled (an option), the Fat and Lean results are also shown.

Below the last scan date is the numeric result of the last 16 QC’s. There, the mean value and C.V. for the most
recent 16 scans is displayed. If fewer than 16 scans have been performed, all calculated values are used in the
computation.

Next, there are two graphs based on the QC Phantom scans.

UPPER GRAPH: displays the precision of the Norland system. The values from the last 180 days (6 months)
of QC Phantom scans are displayed, showing their scatter about the mean. The two dashed horizontal lines
indicate £2 S.D. about the mean. The points shown between the dotted lines are within £2 standard deviations.
Statistically, 95% of the values obtained will fall in this range. Note that 5% of the points, or 1 out of 20, are stat-
istically expected to lie outside the dashed lines. Points shown outside the dashed lines are those scans that
exceed the £ 2S.D.

LOWER GRAPH: displays the accuracy of the system, based on QC Phantom scans. The mean values of the
last 180 days of calculations (6 months) are plotted against the assigned BMD value (or Fat, or Lean values) of
the QC Phantom. The two dashed horizontal lines indicate deviations of + 1.5% from the BMD assigned value

(or £ 2% from the Fat and Lean values).

QC Results Statistics Messages

The tables that follow describe the possible message readouts for the Precision and Accuracy results. They are
found in the QC Results area of the QA Results tab window (see Sample QA Results tab window ).

The criteria for generating the Precision and Accuracy warning messages are modeled after those of Shewart
(see Table 2 in Orwoll, et. al., J. Bone and Mineral Res. 6:1991, p.196.)

Table 4-8: QA Results tab Precision Messages and Actions

PRECISION MESSAGE OPERATOR
MESSAGE INDICATION ACTION
OK Precision of the system is within specification. No Action Required
OUT OF RANGE Standard deviation estimated from 16 scansis greater thanthe | Repeat QA ("Calibrate the System Using the
expected value. QA Calibration Standard" on page 4-8)
WARNING 1 Asingle value is outside + 3 standard deviations from the mean. | Repeat QA ("Calibrate the System Using the
QA Calibration Standard" on page 4-8)
WARNING 2 Two consecutive values exceed + 2 standard deviations from Repeat QA ("Calibrate the System Using the
the mean. QA Calibration Standard" on page 4-8)
WARNING 3 Four consecutive values of the same sign (either plus or Repeat QA ("Calibrate the System Using the
minus), exceed one standard deviation from the mean. QA Calibration Standard" on page 4-8)

Operator's Guide
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Table 4-9: QA Results tab Accuracy Messages and Actions

ACCURACY MESSAGE OPERATOR
MESSAGE INDICATION ACTION
OK Accuracy of the system is within specification. No Action Required
OUT OF RANGE The Mean BMD, Fat, or Lean computed for the last 16 phantom Repeat QA ("Calibrate the System Using
scans exceeds + 1.5% of the expected value for BMD, or + 2% for Fat | the QA Calibration Standard" on page 4-
or Lean. 8)

TREND WARNING Eight consecutive values fall on the same side of the mean outside + Repeat QA ("Calibrate the System Using
1SD. the QA Calibration Standard" on page 4-
8)

Note: The Daily System Quality Assurance Calibration should be repeated if:
» An OUT OF RANGE message is received.

» AWARNING 1, 2, or 3 message is received.

» ATREND WARNING message is received.

Note: NOTE: Please contact your local Norland Technical Support representative if any of the fol-
lowing occurs:

» OUT OF RANGE messages are generated on repeated calibrations.

» WARNING messages are generated on repeated calibrations.

» ATREND WARNING message is displayed.

» The “QC.FIL DATES ARE OUT OF SEQUENCE” message is displayed.

NORLANLDO B3D109 Rov-7
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Preparing Patient Records

A patient’s database record must be prepared (for both new and existing patients) before a scan can be per-
formed. Continue below to enter a new patient into the database. Proceed to "Locating a Record for an Existing
Patient " on the next page to review and update an existing patient’s record. For systems that have a DICOM
Worklist configured, refer to "Patient Worklist" on page 14-10 for instructions on retrieving patient records from
the DICOM Worklist.

Creating a New Record for a New Patient

This section discusses the procedures to create a record for a new patient. See "Patient Demographics Win-
dow Details" on page 4-25 for a thorough explanation of the buttons and fields in this window.

1. From the Database Navigator window, click the button, or select File > New Patient from the
menu bar. A blank Patient Demographics window will open.

] lluminatus DXA 4.7.2 - O X
File Edit Calibration Tools Help
— Patient Demographics Medical Histery
e ,I Menopause Vear I
First Name | i | Bone History il
Patient D |
Sex " Female ( Male i N/A
Treatment
Ethnicity I VI | ’
Date of Birth I 1/ 171900 'l
Odenos Osteoporosis -
I Medications il I J
City:
ity I Technelogist I j |
State: | zp
Physician I j |
Phone: I
Accession I Referring Physician I j |
MNumber
— Visit Information Comments:
Height: I Weight: I
Billing Information:
Save | LClear Edits | Fracture Risk Questionnaire << Patient List | Scan »» | Starnp Wien = |
Administrator | ‘ |Repor‘t Template: Bone Exam Report |Scanner Present |

Figure 4-13: A blank Demographics window for creating a new patient

2. Enter all of the patient’s information in the Patient Demographics window.

» The <Tab> key moves the cursor down through the fields.
»  The <Shift> <Tab> keys move the cursor up through the fields.

» If necessary, click to delete the typed entries on all fields.
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3. When the new patient information is complete, click m to save. If necessary, refer to Figure 4-15
"Existing Patient Demographics window " on page 4-24 to view a completed sample record.

4. Proceed to"Beginning the Patient Scan" on page 4-33 when the patient record is complete.

Locating a Record for an Existing Patient
This section discusses the steps to locate and update an existing patient’s record.
There are three ways to search for an existing patient’s record in the Database Navigator window.

>

scroll down the Patient Name column
use the Quick Search field to search by Patient Name
C. oruse the Quick Search field to search by Patient ID

w

A: Search in the “Patient Name” Column

1. Be sure that the proper patient Database name appears in the window.
2. Scroll down the Patient Name column to locate the name.

3. Double-click on the name (or click on the name then click ) to open the record.

I3 Dluminatus DXA 45.0 e — — B
. — —
File Edit Calibration Tools Help
Database: [Cich\Examples -l
Patient Visit List
Category: Search
Quick Search: [Patient Name |
Patient ID | Patient Name _# | wist Date Scan Type. Analyzed I
Fracturs “Spine fracture -
AP SPINE S ine. good
0ff Center S pine, of.center
Osteoporotic *S pine. osten
IMFROFER 4P S pine.poor start/end
Spine 5 pine. oot condition
AngldCursors S pine. scaliosis
Too High “Spine.start ton high
Shart *Spine.tao shart
DF w8 “w/hele Bady
Gluteus Abdorinal, Sot Tissue m
K109111 Adams. Helen
DualHip Dudl, Hip
K11-6854 JOHNSON, BETTY
K114212 Janes, Midred
1 PatientD Lastname, Firstname
I 77 R
Sean Left Hip Yes  |E
Scan AP Spins Yes
Scan Left Forsam Yes
wish 7719/2000
Wisit 742041933 I
wisit 712301997
Manuall Manual, Patient
Manual 2 Marusl, Patient m
Manual3 Mhanual, Fatient
NoSling No Ratation. Hip -
[\
i Delete << Logout | New Peient 55 | Demographics 5 | Stamp Yiew 5>
[ [ |Report Template: Bone Exam Report Scanner Present |

Figure 4-14: Sample Patient List in the Database Navigator window

B: “Quick Search” by Last Name

1. Be sure that the proper patient Database name appears in the window.
2. Select “Patient Name” in the Category drop-down list.
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Database [CulluminatsDERA =]
Pafient Visit List
Category: Search:
Quick Search: [Patiert Name =] [m

Patient|D_ Patient NA1#G
B 12345 Smith, Sally E.

Visit Date Scan Type Analyzed

3. Beginto type the patient’s last name in the Search box.

Note: The search is interactive, and will eliminate all names that do not match what you are typing.
For example, type a B, and all patient’s names that begin with a B appear. Typing another letter will
reduce the list further. Delete all the characters to show all the names again.

A\

4. When the patient’s record appears, double-click on it to open the record (or single click the name, then click

)
C: “Quick Search” by Patient ID

1. Be sure that the proper patient Database name appears in the window.
2. Select “Patient ID” in the Category drop-down list.

Database |CllluminatusDEXA =
Patient Visit List
Categony: Search:
Quick Search: [Pstent D =] fi
Patiert ID Patient NP atient Name Wisit Date Scan Type Analyzed
+ 123456789 Black, Sue G
F 124386721 Blue, Gail P,
1234 Crystal
+ 124356745 Green, Sally.J
+ 12345 Smith, Sally E.
+ 124356709 White, Sarah T

3. Beginto type the Patient’s ID in the Search box.

Note: The search is interactive, and will eliminate all patients whose ID do not match what you are typ-
ing. For example, type a 1, and all patient’s I1D’s that begin with a 1 will appear. Typing another char-
acter will reduce the list further. Delete all the characters to show all the names again.

.

4. When the patient’s record appears, double-click on it to open the record (or single click the name, then click

Demographics > )
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Enter Data into the Existing Patient’s Record

Now you are ready to update the patient’s information. If necessary, refer to "Patient Demographics Window
Details" on the facing page for a through explanation of the buttons and fields available in this window.

1. When the Patient Demographics window opens, update the patient’s information as necessary.

» The <Tab> key moves the cursor down through the fields.
»  The <Shift> <Tab> keys move the cursor up through the fields.

» If necessary, click to delete all the entries typed since the record was opened.

[A] luminatus DXA 4.7.2 - ] X
File Edit Calibration Tools Help
— Patient Demographics Medical History
Last Name *ILastname Menopause Year
First Name *IFirstname M IA Bene History il non-traumatic bone fracture
primary osteoporosis
PatientID *|PatientiD
Sex * Female (" Male i N/A
Treatment
Ethnicity ICaucasian vl | ’
Date of Birth I 2/19/1968 'l
Address: 123 Sesame St Osteoporosis Actonel, Fosamax and Vitamin D -
I Medications il I J
City: Anytown
o I i Technologist IWeHs, Mary Jane j
State: [ zIp 99509
Physician IDr‘ Wellness j
Phone: |535-555-1234
Aceession 15765237508 Referring Physicien |Dr. Jones ~]
Number
— Wisit Information Comments:
Height: |56 Weight: |110
Billing Information: | Health Code
Sawve | Clear Edits | Fracture Risk Questionnaire << Patient List | Scan =>> I Stamp View =>
Administrator | | |Report Template: Bone Exam Report |Scanner Present

Figure 4-15: Existing Patient Demographics window

2. When you have finished updating the patient information, DO NOT click right away! Doing so
will overwrite the entire patient data from the previous visits. Click the Save button only if you want to over-

write the patient history. (The current record will be saved after the scan has been completed.)

© s |
Note: Clicking on the scen >> button, instead of the SAVE button, will create a new visit record
for the current date and advance the software into the Scan mode.

3. Proceed to "Beginning the Patient Scan" on page 4-33 when the patient record is complete.

NORLANLD
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Patient Demographics Window Details

Button Functions

S - will save a NEW patient demographic record to the current database. On the other hand, clicking

SAVE will overwrite the data carried in an EXISTING patient’s record from their previous visits.

CPErEA | deletes all the entries typed since the record was opened.

<4 Patient Lizt

- returns you to the main Database Navigator window (will loose all data recently typed).

Scan=>

L

i - click when the patient record is complete and the operator is ready to perform a scan. Clicking
this from the Patient Demographic window will create a new visit record for the current date.

et | click to open the Stamp View window.

Field Entry Details

Last name (*mandatory), First Name (*mandatory) and MI (middle initial, optional)

Patient ID (*mandatory) must be unique to be accepted. For example: SSN or Clinic/Hospital ID. If the ID is
already in use, a message will display indicating that the value is already in use.

Sex: click the appropriate button. Male or female must be chosen in order to automatically display Reference
Charts on the reports.

The Ethnicity field has a drop down list for easy selection. Click the drop-down arrow and select. An eth-
nicity must be entered in order to automatically display Reference Charts on the reports. If the ethnicity is
not listed, click the Notepad button and type one in; however, reference graphs will not be displayed unless a
matching reference data set is loaded. Refer to "How to Customize a “Drop-Down List” Field" on page 4-30.

E thinicity [Caucasian] -

Azian
Black.

hAAEA
v v

A
v

oA
v

Cauc-Hizp
Hizpanic

» The Date of Birth field has the capability to call up a calendar from any year. Simply type in the birth yearin
a 4-digit format (ex: 1956) and click the drop-down arrow. Click the left and right arrows to move to the birth
month. Click on the birth day, and the date will automatically drop into the field (and the calendar closes).
The “Date of Birth” must be entered in order to automatically display Reference Charts on the reports.

Date of Bith | 2419198 ~|
| |

2802 20 Hn 1 2 3
4 5 B 7 8 9 10
11 12 13 14 15 16 17
18 20 N 22 23 024
b 26 0 A8/ 23 1 2
a4 5 B 7 & 8

< Today: 571572015
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Basic Operation

»
»

»

»
»

Address, City, State, Zip and Phone is entered next.

Accession Number: the DICOM accession number may be entered or changed. This field will only be vis-
ible if the DICOM option is enabled.

Height and Weight: enter the patient’s information. Use consistent units of measurement for the height and
weight fields for every visit. Letters can be entered to designate the unit of measure (i.e. cm, ft, in, 527, Ibs,
kg). For example:

Height: |'|55 “Weight: [110

The height and weight values will be recorded for each successive patient visit. Changing these values will
not affect scan results (i.e. scan acquisition or results are not adjusted for height and weight).

Billing Information: enter the patient’s billing information. Make any necessary notes.
Menopause Year: if applicable, enter the year menopause began - in a 4-digit format (ex: 2001).

- Medical Histary

Menopause Year |2EID1|

»

Bone History: There are 2 ways to enter information into the Bone History field.

Bone History non-traumatic baone fracture -

a.

primary osteoporogis

.

Click the Check button ﬂ to open the Bone History Items window (shown next). Then click to select a
bone history entry. Click OK to add it to the patient record.

Select Bone History [tems ——

|5u5pected osteoporosis

|n0n-traumatic bone fracture

|5ec:r;mdar§,r osteoporosis

-
v
v |primar3.f osteoporosis
-
-

Ibone pain

OK Cancel

b. Or, create a new entry by clicking on the Notepad button to open the Bone History Item Manager win-

dow. This allows you to customize the bone history list. See "How to Customize a “Drop-Down List” Field"
on page 4-30 for instructions.
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" B
Bone History Item Manager l_lﬂlg

tanaging Bone History ltems:

[l
Add | Replace Delete Sort | il il

suspected osteoporosis
naon-traumatic bone fracture
primary osteoporosis
secondary osteoporosis
bone pain

oK | Lancel |

A

» Treatment: Click the cursorin the Treatment field and enter any pertinent information.

Treatment Exercize

» The next four fields in the Patient’s Record each contain a drop-down arrow that reveals a fully customized,
operator-created list of names (the Osteoporosis Medications, Technologist,
Physician, and Referring Physician fields). As an example, the Osteoporosis Medications drop-down list

is reproduced here:

DStE.Dp':!rDSiS ¢ | Actonel, Fozamas and Yitamin D ;I

Medications
Actonel
) Fosarmax
Technologist Yikamin [
Physician IDr. Welhess LI |
Referring Physician IDr.JDnes LI |

» Osteoporosis Medications: There are 3 ways to enter information into this field. Click the Check button,
click the drop-down arrow, or click the Notepad button.

(IE i
Osteorersi{” )| o))

a. Click the “check” button _| to ogen the Osteoporosis Medications window (shown next). Click to select
from the previously-created list. Click OK to add selections to the Patient Record.
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4-28 Basic Operation

Select Osteoporosis Medications —

o |A::tonel

v |Fﬂsamax

" |Vitamin D

OK Cancel

b. Or, click the drop-down arrow to select a single medication name from the list.

[ zteoporosis | ot ] Emoore oo ard Wt
Medications ¢ Actonel, Fozamar and Yitamin D ;I

Actanel
Fogzamas
itamin D

c. Or, create a new entry by clicking on the Notepad button to open the Osteoporosis Medications Man-
ager dialog box. This allows you to customize the medications list. See "How to Customize a “Drop-Down
List” Field" on page 4-30 for instructions.

» Technologist: Select a Technologist's name from the drop-down list, or create a new name by clicking the

Notepad button to enter or edit the Technologist information. See "How to Customize a “Drop-Down
List” Field" on page 4-30 for instructions.

Technologist IM..’-‘«. Smith j

» Physician: Select a Physician name from the drop-down list, or create a new name by clicking the Notepad

button to enter or edit the Physician information. See "How to Customize a “Drop-Down List” Field" on
page 4-30 for instructions.

Physician IDr. Zimrmernarn j

» Referring Physician: Select a Referring Physician name from the drop-down list, or create a new name by

clicking the Notepad button to enter or edit the Referring Physician information. See "How to Customize
a “Drop-Down List” Field" on page 4-30 for instructions.

Referring Physician IDr.Jones j

» Comments: Enter any comments here. Be aware that these comments will print out in the Comments area
of the Bone Exam Report.
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Comments: Subject shows bone denisty appropriate for age, gender and ethnic
background with narmal fracture risk. Subject should continue with activity
and diet and conzider re-evaluation in 2 to 5 pears.
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Basic Operation

How to Customize a “Drop-Down List” Field

As previously mentioned, the Osteoporosis Medications, Technologist, Physician, and Referring Physician
fields each contain a drop-down arrow that reveals a fully customized, operator-created list of names. Clicking

on the Notepad button allows the user to customize the list. Full instructions follow.

O ztecporosis |
Medications ¢

= @

Actonel
) Fosamas
Technaologist Yitarmin O
FPhysician IDr. YWielhess

-l @

Refering Phyzician IDr. Jones

To Add a Drop-Down List Entry

1. Click on the Notepad button to open the dialog box.

r
m Osteoporosis Medications Manager

=)

anaging Osteoporosis Medications:

Add | FReplace Delete

Sort | ﬂ ﬂ

Actonel
Fosamex
Vitarnin D

oK |

LCancel |

2. Enterthe information in the first line of the dialog box.

-
m Osteoporosis Medications Manager

| [tz |

Managing O steoporasis Medications:

IEIDniva]

Add | Replace Delete

Sart | il il

Actonel
Fosamax
Yitamin D

-l @
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3. Click| £dd ‘ CIick| QK ‘ (It will now be included in the drop-down list as a selection.)

To Replace (or Edit) a Drop-Down List Entry

This feature is used to replace, edit or fix a spelling error in the drop-down list.

1. Click on the Notepad button to open the dialog box.
2. Click on the entry to be fixed (ex. Fosamax) to copy it to the editor line.

r A
Osteoperosis Medications Manager E‘Eﬂ

I anaging Osteoporasis Medications:

IFosamax (A\endromateﬂ

Add | Replace | Delete | Sort |i|i|

3. Typeinthe correction (or the replacement information) in the box (ex. added drug name).
QK

Replace

4. Click ‘ Click| The correction will now be included in the drop-down list.

To Delete a Drop-Down List Entry

This feature is used to delete an entry from the drop-down list.

1. Click on the Notepad button to open the dialog box.
2. Click onthe entry to be deleted (ex. Vitamin D).

r N
Osteoporosis Medications Manager E@g

M anaging O steoporosis Medications:
[vitamin D

Add | Beplace Delete | Sort | il il

3. Click , and it will disappear from the lower list.

4. Click|___ <"

To Sort the Drop-Down List Alphabetically

This feature makes the entries in the drop-down list appear in alphabetical order.

1. Click on the Notepad button to open the dialog box. Notice the position of Dr. Abram’s name.
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M Referring Physicians Manager

Managing Refering Physicians:

|
Add | Beplace Delete Sort | ﬂ ﬂ

Dir. Jones
Dir. Rickenbacker
Dir. Abrams

2. I(_3Iick . Notice that Dr. Abram’s name was sorted alphabetically and has moved to the top if the
ist.

M Referring Physicians Manager,

i anaging Feferring Physicians:

Add | Beplace Delete

Dr. Abrams
Dr. Jones
Dr. Rickenbacker

3. Click QK to close the box.

To Sort the Drop-Down List Manually

This feature allows the operator to place a favorite entry at the top of the drop-down list (or anywhere else).

1. Click on the Notepad button to open the dialog box.

2. Select the entry to be moved and use the or arrows to move it up or down, respectively.

3. o2 |
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Beginning the Patient Scan
Now that the patient’s record has been prepared, do the following:
Click on g to create a new visit record for the current date. gAs previously mentioned, the Patient
Demographics record will be saved after the scan has been completed.
The Select Scan Type dialog box will open (an AP Spine Scan is used here as an example).

M Select Scan Type [5_<|

t« AP Spine " Left Hip £ Whole Body
" Lateral Spine " Right Farearrn ¢ Research

" Right Hip " Left Forearm = Srall Subject

(0] 4 | Cancel |

Select the type of scan, then click L

At this point, proceed to the relevant chapter listed below for instructions on positioning and marking the patient
and then performing the scan. The following list provides links to those chapters.

» Chapter 5, Scanning AP Spine - "Setting the Scan Parameters" on page 5-8

» Chapter 6, Scanning Hip - "Setting the Scan Parameters" on page 6-8

» Chapter 7, Scanning Forearm - "Setting the Scan Parameters" on page 7-8

» Chapter 8, Scanning Lateral Spine - "Setting the Scan Parameters" on page 8-8

» Chapter 9, Scanning Whole Body - "Setting the Scan Parameters" on page 9-7

» Chapter 10, Research & Small Subject Scan -"Setting the Scan Parameters" on page 10-8

Note: Some of these scanning features are available only as options. Your system might not have
some of these options.
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4-34 Basic Operation

System Shutdown

Note: Norland recommends that the scanner be left on overnight or over the weekend. If the scanner
is to remain idle for a week or more, then the system should be shut off.

The system should be backed up daily, before shutting down. See the backup procedure "Quick Reference
Guide - System Backup for Windows 7" on page 16-4 for instructions.

The following shut down routine will help ensure consistent system operation.

1. From the Database Navigator window, click on File > Exit to exit and close the llluminatus software.
2. Confirm that the software has been closed before performing the next step.

3. Turn the scanner OFF by depressing the power switch located on the right side of the scanner table base (all
models). O = OFF.

|=ON
O =OFF

Figure 4-16: Power Switch location

4. Shut down the computer by clicking the Windows Start button and selecting Shut Down or Turn off the Com-
puter to perform the normal Windows shutdown procedure.

5. Turn off the monitor and the printer.
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CHAPTER S

Scanning AP Spine

The AP Spine Scan procedure estimates bone mineral in the lumbar spine using a pos-
terior-anterior projection. The scan is typically started at the xiphoid process and ends
just below the iliac crests. The scan procedure includes an auto centering routine to
ensure the spine is centered and straight in the scan area. The region of interest is the
L1-L2-L3-L4 segment, which is analyzed for individual and total vertebrae. The ana-
lysis will exclude transverse vertebral process areas from the bone mineral estim-
ations.

Figure 5-1: Patient positioning for the AP Spine Scan

This chapter discusses the following.

Scan SpecifiCations ... ... . L 5-2
Maintaining High Quality AP Spine Scans ... oo, 5-4
General Patient Scanning Cautions ... ... ... 5-5
Quick Reference - AP Spine Scan ... ... . 5-6
Scan Procedures . 5-7
Analyzingthe Scan ...l 5-17
Viewing the Scan Results Tab ... ... . L 5-21
Generate and Print a Report ... ... oo . 5-24
A Sample Bone Exam Report .. ... ... 5-26
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5-2 Scanning AP Spine

Scan Specifications
Detailed specifications for the AP Spine Bone Density scan are in the following tables.

Table 5-1: AP Spine Scan Specifications
Scan Sites Lumbar Spine (L1-L4)

Accuracya Typically within 1.0% of industry standard

In vivo Precisionb | See table below

Scan Times Refer to Technical Reference Section (Performance)

Scan Resolution | Selectable:

1.0mm x 1.0mm

1.5mm x 1.5mm

[Point resolution x line spacing (pixel size)]

Scan Speed Selectable:

High Precision - 65mm/sec.
Standard - 130mm/sec.
High Speed - 260mm/sec.

Table 5-2: AP Spine Scan In vivo Precision

Total L2-L4 C.V. Total L1-L4 C.V.
Measure Scan Mode | Measure Scan Speed | BMD | BMC | AREA| BMD | BMC | AREA
High Speed 260mm/sec 0.84% | 1.32% | 1.39% | 1.05% | 1.28% | 1.64%
*** All specifications are subject to change without notice. ***

8Based on Standard Speed Scans of an anthropomorphic phantom.
bBased upon scans of 14 subjects, 3 scans each using standard procedures, 1.5 X 1.5mm resolution, and 260mm/sec scan speed.
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5-3

Patient Dose

Note: The radiation dose to the patient is dependent on the type of scan procedure and the body thick-
ness of the patient. The table below lists typical entrance skin dosages for the AP Spine Measure
scan based on the listed body thickness.

Table 5-3: AP Spine Scan Skin Entrance Dose

Patient Thickness | High Precision | Standard | High Speed

(cm) (HSV) (HSv) (HSv)
0-3 0.8 0.4 0.2
4-6 1.1 0.6 0.3

7-9 1.6 0.8 0.4
10-12 2.0 1.0 0.5
13-15 3.8 1.9 1.0
16-18 6.5 3.2 1.6
19-21 12.0 6.0 3.0
>21 18.7 9.4 4.7

Operator Dose

meter from the scanner table is less than 1.0 microsieverts per hour.

1 Note: The dose to the operator is negligible. During a scan, the radiation level at a distance of one

Operator's Guide
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54 Scanning AP Spine

Maintaining High Quality AP Spine Scans

Patient positioning, scan and analysis techniques can influence the precision and accuracy of Norland Bone
Density estimations. Facilities can reduce the adverse effects of some of these factors by:

» Performing and monitoring the daily QA procedure to verify that other radiation sources
(x-ray machines, nuclear imagers) are not affecting the performance of the Norland system. The daily QA pro-
cedure verifies proper operation as well.

» Ensuring that all operators position patients and analyze data in the same manner.

» Screening patients for recent radionuclide uptake procedures. Residual emission may be misinterpreted by
the Norland system as x-rays.

» Screening patients for recent ingestion of radiopaque substances. Barium or other dyes used in some x-ray
procedures could result in increased soft tissue x-ray absorption.

» Screening patients for external opaque (metal and plastic) objects. Jewelry, buttons, zippers, rivets,
buckles, pens, keys etc. can affect the results if they are in the scanning region.

» Screening patients for prosthetic devices, implants, surgical staples, or other high density sub-dermal mater-
ials that may affect density estimates.

» Ensuring that scan and analysis parameters remain constant for all scans of the same patient.
» Ensuring the patient does not move during the scan.

Figure 5-2: Example of a Good Quality AP Spine Scan

» The vertebral column is centered and straight. Auto Centering helps to ensure that the vertebral column is
centered and straight in the scan region.

»  Anatomical landmarks such as the ribs off T12 and the top of the iliac crests are visible in the scan image.
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General Patient Scanning Cautions

Caution: Properly Mark the Patient. To ensure scanner arm does not contact the patient, always
verify patient is positioned properly before scanning or moving the scanner arm.

Caution: Do not move the patient while marking the regions to be scanned. Always remain near the
patient, in the event assistance is needed.

Caution: Do not touch the patient and the computer system at the same time as this could increase
leakage currents.

Caution: Do not reach around to the back of the unit while the scanner arm is moving. While guards
are provided, it is wise to avoid any chance of pinching the arm, hand, or fingers between the scanner
arm and the frame, or between the source and the scanner arm.

Caution: Do not allow the patient to bump, push, or lean on the scanner arm. Manually moving the
arm could result in an error message which will require removing the patient from the table and doing
the Find Table Dimensions routine.

Caution: Make certain the patient does not dangle their arm or hand over the riser while the scanner
arm is moving during a scan. The scan will not be usable, as the patient will not be properly positioned,
and the patient may be at risk of pinching their hand or finger between the scanner arm and the riser or
between the x-ray source and the scanner arm.

Caution: Make certain the patient does not stick a finger into the slot in the bottom of the upper arm
cover during a scan; it could be pinched.

Caution: When positioning the patient, ensure they start by sitting near the center of the table and
then swing their legs up. Sitting at either end makes positioning awkward.

Caution: Caution the patient to remain still during the scan to ensure quality results.

Caution: Help the patient up from the scanner after scan data collection; some patients may require a
few minutes to regain equilibrium after lying down for a length of time.

SINESISIESR S SESESS
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Quick Reference - AP Spine Scan

The AP Spine scan takes measurements from L1 through L4.

»

»

»

»
»

Screen patient for contraindications.

In the Database Navigator window, click on the existing patient’s nhame, then click OR click

Mew Patient »»

to start a new record.
Update (or enter) the patient’'s Demographic information.

Click g Click the AP Spine button. Click m. Check the parameters.

Position the patient face up in center of the scanner table. Position the scanner arm over the patient's mid-
section. Use the leg rest block to stretch the spine and relax the curvature.

L% Caution: Caution the patient not to stare into the beam. ]

»
»

»

»

»

»
»

»

»
»

»

»

»

»

»

Click Mark.. in the Parameters tab window.
MARKING THE START POINT: Turn ON the laser. Move the scanner arm until the laser dot is positioned 1-

£ MARK |
cm below the xiphoid process and then press the button on the Scanner Arm Touch Pad.

MARKING THE END POINT: Move the scanner arm so that the laser dot is positioned 2-cm below the iliac

u;m; A
crests and press the button.

Click to begin the Measure Scan. Allow the scan to complete.
If the scan is satisfactory, click .

Select the region type to be analyzed: ol
Click and hold the control points to move the cursors. Position the top line near the top of L2.

Position the bottom line near the bottom of L4.

[ R

Lontinue

Click
Confirm that cursors are set between T12/L1 (if applicable), L1/L2, L2/L3, L3/L4, and L4/L5. Move if neces-
sary.

If you are done scanning, remove the Leg Rest, move the scanner arm and assist the patient up from the
table.

clek_2= |
((j)licl)< to print a Report (or click to end the process and return to the main win-
ow).

Click‘ Eh H Erint |andthen.
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Scan Procedures
Checklist

You are almost ready to begin scanning. Confirm that the following tasks have been completed:
» the system is running (see "Powering Up the System " on page 4-3)

» the System Calibrations are done (see "Daily Calibration Procedure" on page 4-6)

» the Database Navigator window is open (Figure 4-3: on page 4-5)

Preparing the Patient for Scanning

Ensure that the patient has removed all items from their pockets and that clothing is free of metal (i.e. rivets, but-
tons, zippers) or anything else that might be of a high density. It might be necessary to have the patient change
to an examination gown or robe. Shoes should also be removed.

Update (or Create) the Patient’s Record

EXISTING PATIENT: From the Database Navigator window, double-click on the existing patient’s name to
open the patient’s record. Update the patient’s information. (If necessary, refer to "Enter Data into the Existing
Patient’s Record" on page 4-24 for instructions.)

You are now ready to begin the scan process.
Proceed with "Setting the Scan Parameters" on the next page to continue.

NEW PATIENT: From the Database Navigator window, click on to start a new record. Enter all
the patient information. (If necessary, refer to "Preparing Patient Records" on page 4-21 for instructions.)

You are now ready to begin the scan process.
Proceed with "Setting the Scan Parameters" on the next page to continue.
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Setting the Scan Parameters

1. Click " |

2. Click AP Spine in the pop-up window.

# Select Scan Type

AP Spine  Left Hip
© Lateral Spine ¢ Right Forearm

 Right Hip © Left Forearm

QK | Cancel |

 WWhole Body

©* Research

© Bmall Subject

3. Click =

Ok

4. The Parameters tab window opens.

W Iluminatus DXk 4. 2.0

Fie Edt Calbvalion Tooks Help

F'--e-mn-z|

Pabant Dos. Jane

Fatignt Sunirméan

Meght| 61 weighe| 180
Trnchracaan [FAU -

Plyscion [ domes Sty

Scanner

=

AncddoVolloge BVE | 100 Cunendbeil| 13
Estimated Scanning Time Period [M84-55}

So8n Tvpt

[P Sgurm

Womber o Scans: |1 $
=]

Stoait Sean | Measure Scan
{Seeed Grrnfvec) SRR 1 X0
Resohstion (mm) | 15x00 1LEx1LE
lwikhtem)  [fi0 k00
Leesith (1en) (1]

Mt Centering _7lcn
Lk (-t Clews

Puositioning the Patient, AP Spine Scan
& Blake s the patient docs wot b the soanner arma

1. Postion the pateert on the searmer table laymg face up with ther rmght sude to the back rest. Makee sure the patiert 2 centered and Araght on the
tabile. Ensure that the patent's bops, spaes, ad shoulders ae sraght,

2 f‘j}‘. Enure that the [xser 23 tumned OFF, then use the Scanner Arma Touch Pad arroms to maone the scannar ams ta & postion showe the patient's

med-gecton

3. Place the AP Leg Rest block under the patient's legs usng the correct height demension. Place it @ its most upnght pesition g0 that the thagha rest
Grindy apierot the block af & 90% angle. The leg reat block helps to straghten the natural curvature mthe gpme and odi 2 separatmg the vertebrae

F

__H

Confmits

I

e |

Aedniridrabor

Scanner Prenont

Hini:

Figure 5-3: The AP Spine Scan Parameters tab window
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Scanning AP Spine 59

5. The scan parameters are shown in the bottom left hand side of the Parameters tab window, and reproduced
here for reference. Norland recommends that the factory default parameter settings be used for scanning.
The default values are shown below.

Scout Scan |Measure Scan |

Speed (mm/sec) 0.0 130.0
Resolution {(mm) |1.5x0.0 1.5%1.5
Width {cm} 14,10 12,00
Length {cm) 0.0

Auto Centering o]
Mark On-Axis || oFF

» Toreset values to factory defaults, see "Preferences: AP Spine Scan" on page 3-23.

» For a full explanation of the AP Spine Scan parameters (i.e. preferences) see "Preferences: AP Spine Scan"
on page 3-23.

» Ifitis necessary to change the Speed, Resolution, Auto Centering or Mark On-Axis parameters, see
"Changing the Scan Parameters Prior to Scanning" on page 12-64.

6. If youwant the Auto Centering feature to function at its full capabilities, confirm that the Auto Centering is
checked (ON) and that the Mark On-Axis is not checked (OFF).

7. Proceed to "Positioning the Patient" on the next page to continue.
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Positioning the Patient

Refer to the patient positioning photos and instructions in the Norland software (Parameters tab window). The
steps and photos are reprinted in the manual for reference.

# luminatus DXA 4,2.0
Fle Edc Colbration Took Help
Pauenmtes |

Patignt Dos. Jare
Pationt Summany
Rt |68 w10 Positioning the Patient. AP Spine Scan
Tochrca [FAD -
o | PilN Make sure the patient does not bunp the scanner ams.
1. Posion the patieet on the scammer table laymg ace up with their sight side to the back rest. Make sure the patiect o centered and straght on the
Scanner table, Ensure that the patiens's bips, spie, and shoulders e arught,

AncdeVologn V) 100 Cunesitbodl| 13
Estiated Scanning Time Period M55}

e [ ¥
:] j'

Sgirm

2 & Ensure that the Laser » turned OFF, then use the Scanner Arm Touch Pad arrows to move the scannes arm to a postion shove the patent's
med-gection

3. Place the AP Leg Rest block under the patient's legs ussng the correct height denension. Plece it m its sost upright pesition ro that the thaghs sest
Frucdy szt the block st a 90° angle The leg rest bluck helps to sraghten the nabural curvature m the spme md wde = separstmg the vertebrac

| = | ee— i
s Rl | | |
m Caution: Make sure the patient does not bump the scanner arm. J

1. Position the patient on the scanner table laying face up with their right side to the back rest. Make sure the
patient is centered and straight on the table. Ensure that the patient’s hips, spine, and shoulders are straight.

2. A Ensure that the laser is turned OFF, then use the Scanner Arm Touch Pad arrows to move the scan-
ner arm to a position above the patient’s mid-section.
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3. Place the AP Leg Rest block under the patient's legs using the correct height dimension. Place it in its most
upright position so that the thighs rest firmly against the block at a 90° angle. The leg rest block helps to
straighten the natural curvature in the spine and aids in separating the vertebrae.

5. The patient is now ready for scanning.

6. Make the patient as comfortable as possible since movement during the scan will affect the results. The use

of a sheet or light blanket will not interfere with the scan results. The use of a pillow under the head is recom-
mended.
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Marking the Scan Region

1. Click in the Parameters tab window to open the dialog box.

M Mark AP Spine Scan Region

Pogition the patient on the scan table.
Switch on the lazer marker.

W Mark the Xiphaid Point

W Mark the lliac Crests Point [2om below)

Previous Step | [ Cancel |

& Caution: Caution the patient not to stare into the beam. ]

2. Press to turn the laser ON.
3. MARKING THE START POINT: move the scanner arm until the dot is positioned at the xiphoid point and

MARK )
press - (The computer will emit a sound, and the laser will flash.)

| / Saam

= _
Note: Click W] in the dialog box to re-mark the Xiphoid Point. Click at any time

to abort the marking operation.

.

(. J
-

-

~

Caution: Take care not to bump the patient's legs with the scanner arm in the next step. If the scanner
arm movement is interrupted or if the patient moves, the start and end marks may have to be re-iden-
tified.
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4. MARKING THE END POINT: move the scanner arm until the dot is positioned 2-cm below the iliac crests

MARK =}
(see the figure below) and press - (The computer will emit a sound and the laser will flash.)

5. The dialog box will automatically close when the marking tasks are complete.
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Starting the Measure Scan
Caution the patient to remain still.

HALT

o _ . .
Remember, press the HALT button on the Scanner Arm Touch Pad to immediately terminate
the x-ray exposure or stop the scanner arm movement. Refer to "Pressing the Halt Button" on

page 12-37 for instructions on safely resuming the scan.

. Start 5
1. cliok 25 |

2. If the Auto Centering parameter box is checked (ON = enabled), the scanner arm will take a “U” shaped scan
before it does the Measure scan.

Note: If the “U” shaped scan is not successful, the following alert box will be displayed. In this case,
Norland recommends that the scan be terminated and the scan region be re-marked. (Note that mark-
ing too high or too low on the spine caused the Auto Centering to fail.) Proceed to"Auto Centering
Mode" on page 12-66 for further instructions.

Morland Alert

The original mark points are being used because the
2 automatic centering of the spine was not successful.

(. /

3. The Scan tab window displays the image as it develops, shows how many lines will be scanned and gives
an estimate of the total time remaining in the Measure scan.

NORLANLDO B3D109 Rov-7
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4. Monitor the image closely for any indication of patient movement. Cancel the scan immediately if the patient
moves during the scan.

Note: To cancel the scan: Click . Lower the patient’s legs by removing the AP Leg Rest.
Click| Carcel_| Select| Discad_| in the dialog box. Click .

Click 252> | Click ___2=">> ‘SelectAPSgine.

Return to "Marking the Scan Region" on page 5-12 to continue.

.

J

5. When the Measure Scan is complete, the computer will emit a sound. The software will update the Scan tab
window and the Analyze button will become available.

Operator's Guide

4350100 Rev. 2 NORLFANLO
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6. Determine if the quality of the Measure Scan image is satisfactory or unsatisfactory.
7. THE IMAGE IS SATISFACTORY when the image shows L1-L4, is centered and straight, and landmarks
such as the iliac crest appears in the region of interest. Proceed to step 10.

8. THE IMAGE IS UNSATISFACTORY if the iliac crest does not appear in the region of interest. You must
extend the measurement scan to include the necessary landmarks in the region of interest
9. If necessary, proceed to the steps in "Unsatisfactory Measure Scan (AP Spine)" on page 12-65 to re-do the
Measure scan.
10. Remove the leg rest and move the scanner arm out of the way if no further scans are to be performed. Help
the patient up from the scanner table.

Caution: Remember that some patients may require a few minutes to regain equilibrium after lying
down for a length of time.

NORLANLD, 535109 Rev- 7



Scanning AP Spine 5-17

Analyzing the Scan
At this point, the operator can analyze the scan later, or analyze the scan now.

ANALYZE LATER: Click to end the scan process and analyze the scan later. The scan data will
be saved 1o the database for analysis at a later time. The software will go back to the Parameter tab window.

You can do another type of scan, if desired.
OR ANALYZE NOW . ..

1. ek 2|

2. Inthe dialog box that pops up, select the region to be analyzed: =k Mo
[ Note: Only use L2-L4 if L1 does not exist. ]

3. When the Analysis tab window opens, cursors will be displayed in the regions of interest.

Fle Cdt Calbration Tock Heb
Paramatecs | Scan  Anshus

Patinnt Jones. Jos

Ringicas

Fasition the 1o
Positon tha boftom n L

Adrdraler Ssrwes Prewerd i

Note: Explanation: The image of the scanned spine is displayed in the window with a histogram to
the right. The histogram is a line-by-line graphic presentation of the bone mineral content. The “valleys”
of the histogram represent areas of low bone mineral content (BMC); longer lines denote higher BMC.
In a normal spine, the BMC value will be the lowest at the intervertebral gaps, so the cursors should be
positioned on the shortest histogram lines.

43ED109 Rev. 7 NORLFANLO



5-18 Scanning AP Spine

4. Using the click and drag method, position the top cursor at the top of L2.
5. Position the bottom cursor at the bottom of L4.

6. Click.

7. If the spine is so compressed that the software can not automatically find the vertebral gaps, the following
dialog box will be displayed. Click Continue.

' _ : : "
A Unable to find regions automatically. Y'ou must position cursors manually.

8. The Analysis tab window will refresh and add in two more cursor lines for L2-L4 analysis and three more
cursor lines for L1-L4 analysis.

NORLANLD, 535109 Rev- 7
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»

»

10.
»

»

»

11.

If the regions of interest aren’t positioned properly, move the cursors.

If this is the patient’s first AP Spine scan, click on individual control points and drag to move horizontal lines
independently of each other.

If this is a subsequent AP Spine scan, click on any line within a vertebral body (but not on the control point)
and drag to move cursors as a group.

Position cursors at the valleys of the histogram.

If patient has been scanned previously, modify cursors to match the Comparison Image. Right-click on the
image, select Image Analysis > Show Comparison. (See "Comparison Image" on page 12-54).

If patient has scoliosis, it may be necessary to adjust the angles of the cursors to align with vertebral gaps.
See "Angulated Cursors" on page 12-68.

If the patient was previously scanned, the original inter-vertebral spacing will be used for the current scan.

When all the adjusting is finished, the window should look something like the figure below. The Results but-
ton is now available.

43ED109 Rev. 7 NORLFANLO
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Viewing the Scan Results Tab
1. Click . The Scan Results tab window opens.

A (Mumninatus DXA 4.1.0: Jopes, Joe @ 67252006
Fle [de Calbrstion Took Help
e P |

Spre 25JUNZO0E 1555 ScanSpeed 2wy Feschsion 15mm s,
[Regon [ BMD fpfert)[ BWC g [ doen jouf) | Lengh fomi | W
1 10

u 1060
1183

ST OV fos L2L4 BMD: 10 BME: 1.5 Seo Guade lor oen Cve

| TScom | Young el [¥)] Z:5core | AgeMaich(2)] 57
(T3 I TH
as W1 i

053 1073
el 471
(3 1006

[} 1 1768 k] 30
L 1.091 1921 17.61 i
Towl MO Timglewt  TEEIng =F-] 141

Adrdraler 1 Scareer Nok Presert | Hint:

2 ciokl_2= |

»  The image thumbnail, trending or reference population graphs, and a results table are displayed in the Scan
Results tab. (NOTE: image is not for diagnostic purposes.)

» If an exact match of the installed Reference Sets and the ethnic background (entered into the Patient Demo-
graphics window) does not exist, the Scan Results tab window will be displayed without a reference pop-
ulation graph.

» The BMD of the first region of the Detailed Results will be plotted in the reference chart as a dot.

» Detailed Results for each individual vertebrae, L1-L4 or L2-L4, and Total sBMD are displayed in the table at
the bottom of the window.

» Reference graphs for individual vertebral bodies can be displayed by clicking on the ROl in the Results table.
The graph will change according to what is selected. Notice that the name of the selected ROl is displayed
at the top of the Reference graph.
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Scanning AP Spine

& IMuminatus DXA 4.3.0
Fle [dt Calbrstien Took Help
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» Click to generate and print a geggrt using the current default report template. Proceed to Step 5

of "Generate and Print a Report" on page

» orclick Stamp Wiew »»

"Generate and Print a Report" on page 5-24.

. Dermagraphics ==
» orclick to do another scan.

: < Patiert List L
» orclick to end the process and return to the main window.

to generate and print a report using a report template other than the default. Proceed to

NORLANLD
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Definitions of Scan Results

Table 5-4: Definition of Scan Results

T-SCORE The T-score is the number of standard deviations a patient’s BMD value is above or
below a young reference value for individuals of same ethnic background and sex.

% YOUNG The % Young reference value is the ratio of the patient’s bone mass to the young ref-

REFERENCE erence value for individuals of same ethnic background and sex.

Z-SCORE The Z-score is the number of standard deviations that the patient's BMD value is
above or below the reference value for individuals of same age, ethnic background
and sex.

% AGE-MATCHED The % Age-matched value is the ratio of the patient's bone mass to the reference
bone mass value of individuals of the same age, ethnic background and sex.

% ST: SHORT TERM Ratio of change between current scan and most recent previous scan.

CHANGE

% LT: LONG TERM Ratio of change between current scan and patient’s initial scan.

CHANGE

%/YR value Indicates the percent of ST or LT change calculated per year.

Fracture Risk Assessment

The patient's risk of fracture is plotted in the Reference Charts displayed in the Scan Results tab window. Nor-
land incorporates the WHO (World Health Organization) criteria in plotting a patient's fracture risk assessment.
See table below. (Note that this table is re-reprinted here for reference.)

Table 5-5: WHO Ceriteria: Fracture Risk Assessment

Low Risk Represents the range of values determined by WHO to be 'nor-
(Green) mal' (having adequate bone mineral). The BMD T-Score values
in this region are within 1 SD of the young adult reference mean
value. A patient whose value is plotted in this region has no
identifiable risk of fracture.

Medium Risk Represents the range of values determined by WHO to be
(Yellow) 'osteopenic' (having low bone mineral). The BMD T-Score val-
ues in this region range are more than 1 SD below the young
adult mean value but less than 2.5 SD below the mean value. A
patient whose value is plotted in this region may be developing
a tendency to fracture.

High Risk Represents the range of values determined by WHO to be
(Red) 'osteoporotic' (having severely reduced bone mineral). The
BMD T-Score values in this region are more than 2.5 SD below
the young adult mean. A patient whose value is plotted in this
region has a high spontaneous fracture probability.
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5-24 Scanning AP Spine

Generate and Print a Report

Five different types of Reports can be generated for each scan: the Bone Exam Report, the Bone Exam Report
- 1 Page, the Combined Report, the Patient Letter, and the Referral Letter. When saved, these reports become
part of the scan data.

These procedures use the Bone Exam Report - 1 Page for the example.

1. Make sure that the scanned image is being viewed as a thumbnail in the Stamp View or the Filmstrip View.
Click (to highlight) the thumbnail view of the scan.

2. Click Tools > Report > Select Template... or click the M button to open the “Report Con-
figuration” dialog box.

Fir Edi Caleratien (Took | Help

File Tack
Calibration Detaibs
Send To '

g
Report , Gemerate Mew
Audin Dictadion Firush Eaist

Lag Filies '

3. When the Report Configuration dialog box opens, click a Report Template to highlight it (Bone Exam

Report - 1 Page was selected here). See "Sample Scan Reports" on page 2-17 for examples of the report

template selections. Click Dene

Report Configuration

Choose a Default Report Template

Buone Exam Report - 1 pags j Done
Bone Exam Report

Combined Report

Patient Letter

Referral Letter

Ten Year Fracture Risk Report

@ Note: The selected Report Template will remain the default until it is changed. The currently selected
Report Template is always displayed at the bottom of the IlluminatusDXA window.

4. Click Tools > Report > Generate New or click the button.

File Edit Calibration [Tools| Help

Initialize Scanner

Service Tools 3
File Tools

Calibration Details

Send To: >

DICOM Interface

Mail /
Report > enerate New

Audio Dictation Finis|

ting/Make Addendum

View Selected

Log Files »

Scan Quality Issues Editor

Recommendations Editor

Select Template...
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5. The Report is immediately generated and opens up in the window, as shown. At this point, the operator can
type in their comments and recommendations, Lock it, Saveit, Printit, Exportit to a PDF file (ora DICOM

file) and Closeit.

WType: Bone Exam
File

W=

Name: Lasthame, Firstiname A.

Sex: Female
Ethnic:  Caucasian
Age: 34 years

Height: 51"
Weight: 110

AP Spine on: 5/6/2002 1:51:17 PM

L2-14 Norland 4/00
1.411

L2 Norland 4/00 c
1.42,

YowngRef. (%) 811  Date  Valee YoungRef. (%) 775  Date  Valee
T-Score 2128 07/19/00 0.821 T-Scors 151 07/19/00 0.819
AgeMatch (%) 823 07/20/99 0.862 Ag=Match (%) 777 0720099 0.850
Z-Scors -118 0723570894  Z-Scors 2149 07/23/97 0.878

Manal Corsor Placsment
Area  Lensth  Width T- YowmeRef Z-  AseMaich ST Change ST Change LT Change LT Chanse
| Region BMD (gen®) BMC(2) [ 5 . v s P an o P o PR
Tock | zave | Print | Export POF | Export D\COM' Close

6. Click . The “Print” window appears. Select a printer, select which pages to print and choose how

many copies to print.

7. Click to print the Report. The Report is automatically saved and printed.

0o

ciekl 2|

9. You are returned to the Filmstrip view screen. The saved Report can be found under the “Reports” tab. The
Report can be viewed, modified and reprinted at any time. See "The “Reports” Tab" on page 2-14 for more

information.

Operator's Guide
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5-26 Scanning AP Spine
A sample 2-page Bone Exam Report is included here for reference.
5/7/2015 10:05:29 AM Norland at Swissmy Page 1
W6340 Hackbarth Road Fort Atkinson, Wi 53538 USA (888) 741-0413
Name: Lastname, Firsiname Sex: Female Height: 51"
1D: PatientiD Ethnic: Caucasian Weight: 110
DoB: 2191968 Age: 34 years
| I H AP Spine on: 5/6/2002 1:51:17 PM
@ L2-L4 Norland 4/00 c
1
Young Ref. (%) 81.1 Date Value
T-Score -L28 0719700 0.821
. Age Match (%) 813 O7/20/99 0,862
Z-Score =119 07/23/97 0.894
Bone image not for diagnosis.
Manual Cursor Placement
” Arca Length  Width T-  YoungRel. Z- Age Maitch ST Change ST Change LT Change LT Change
Region BMD(gfon?) BMC (g) (cm?) {cm) (cm)  Scorc (%) Score (%) (%) (%alyr) (%) (%fyr)
L2-14 08942 39.17 43.80 9.75 12.0 -1.28 I =119 R®23 89 4.9 0.0 0.0
L2 08503 11.86 1394 330 12.0 -1.51 77.5 =1.49 frir i 4 39 2.2 =3.1 =117
L3 0.9006 1322 14.68 i3 120 -1.25 808 -1.21 81.3 10.4 58 2.1 0.4
L4 0.9284 14.09 1517 3135 12.0 -0.91 B3R {180 873 12.0 6.7 9 0.2
:;;:rl} 962 Imglem* 42150mg 4380 9.75 12.0 -1.28 811 =119 2.2 B9 4.9 3.7 1.3
STD CVs for L2-L4 BMD: 1.0 BMC: 1.5 See Guide for other CVs,
1.5mm X 1.5 mm, 130 mm/s, 12.00 cm, Rev. 3.9.4/2.1.0 Calib. 05/06/02 S/N 3840
Comments:
User-entered comments when the report was generated.
Figure 5-4: Page 1 of the Bone Exam Report
NORLANLD 1555100 Rov. 2
®
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6712015 10:05:29 AM

Norland at Swissray

W6340 Hackbarth Road Fort Atkinson, WI 53538 USA (888) 741-0413

Page 2

L2 Norland 4/00
1.42

115
-1.51
77.7
=149

Young Rel (%)
T-Score
Age Maieh (%)
£-Score

Total sBMD Norland 4/00
1520,

1320

Young Ref. (%)

1.1
-1.28
822
-1

T-Score
Age Match (%)
Z-Score

Date
07/19/00 0.819
07/20/99 0850
07/23/97 0878

Value

C

Date Value
O7/19/00 883 8
0720099 928.0

0723797 NiA

L3
1.45,

125
1.05
0.85

Young Rell (%) 808
T-Score
Age Match (%5) 81.3
Z-Score

60

AGE
Date Value
G719/00 0816
07/20099 0 883
07/23/97 0,882

-1.25 T-Score

-1.21 Z-Score

1.401

1.201

1.001
o

0.801
5 0.601

Age Match (%)

Name Lastname, Firstname 1] PaticntlD
Ethnic Caucasian
Address DOB 21191968
Telephone Age 34 vears
History non-traumatic bone fracture and primary ostcoporosis Meno Year
Treatment Sex Female
Medications  Actonel, Fosamax and Vitamin D Height 3
Commenis Weight 1
Scan Information
Scan Type: AP Spine Resolution: 15215
Analysis Date: 52172005 5:22:02 AM Speed: 130 mm/s
Calibration Date: 0506102 Width: 120
Technologist: Host/Scanner: 394210
Physician: Analysis/Revision: 394
Detailed Results
c Norland 4100  C | L4  Morand4mo

20 40

Young Rel (%) 858

-0.91
7.3
BRI

& 8

AGE

Date
O7/19/00 0,829
0720099 D834
07/23/97 01L.920

Value

NORLANLG

Figure 5-5: Page 2 of the Bone Exam Report
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CHAPTERG

Scanning Hip

The Hip Scan procedure estimates bone mineral in the Femoral Neck, Greater
Trochanter, and Ward's Triangle regions of the left or right hip. Estimates for Total Hip
and sBMD Hip are also available.

The process begins with a Scout scan of the hip area. The scan should start above
the neck of the femur and extend far enough down the femur so that the femoral neck
is in the analysis area. The operator identifies the center of the femoral neck on the
scout scan image, then the Measure scan is taken.

Figure 6-1: Patient Positioning for the Hip Scan

This chapter discusses the following.

Scan Specifications .. ... .. L 6-2
Maintaining High Quality Hip Scans ... ... ... 6-4
General Patient Scanning Cautions ... ... ... 6-5
Quick Reference -Hip Scan ... ... L 6-6
Scan Procedures . 6-7
Analyzingthe Scan ... .. 6-23
Viewing the ScanResults Tab ... ... . L 6-26
Generate and Print @ Report ... .. . 6-29
A Sample Bone Exam Report ... ... L 6-31

Operator's Guide
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Scanning Hip

Scan Specifications

Detailed specifications for the Hip scan are in the following tables.

Table 6-1: Detailed Hip Scan Specifications

Scan Sites

Femoral neck, Greater Trochanter, Ward's Triangle, Total Hip

Accuracya

Typically within 1.0% of industry standard

In vivo Precisionb

See table below

Scan Time Refer to Technical Reference Section
Scout Scan 1.0mm x 4.0mm: Point resolution x line spacing (pixel size)
Resolution
Measure Scan 1.0mm x 1.0mm: Point resolution x line spacing (pixel size)
Resolution
Scan Speed Selectable:
High Precision - 45mm/sec
Standard - 90mm/sec
Table 6-2: Hip Scan In vivo Precision
Femoral Neck C.V. | Greater Trochanter C.V. | Total
gueasure s?:naenagl;:;eed BMD | BMC | AREA | BMD | BMC | AREA | BMD
Standard Speed | 90mm/sec 1.5% | 1.6% | 1.0% | 1.1% 2.0% 1.4% | 0.7%
*** All specifications are subject to change without notice. ***

aBased on Standard Speed scans of an anthropomorphic phantom.
bBased on scans of 14 subjects, 3 scans each, using standard procedure, scout and measure scan speed of 180mm/sec, scout scan resolution
of 1mm x4mm, and measure scan resolution of Tmm x 1mm.

NORLANLD

Operator's Guide
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Scanning Hip 6-3

Patient Dose

Note: The radiation dose to the patient is dependent on the type of scan procedure and the body thick-
ness of the patient. The table below lists typical entrance skin dosages for the Hip Scout scan and
Measure scan based on the listed body thickness.

Table 6-3: Scout Scan Skin Entrance Dose

Patient('(l:'rr;]i)ckness Entrance Dose (uSv)

0-7 0.1

8-10 0.2

11-13 0.2

14-16 0.3

17-19 0.5
20-22 0.9
23-25 1.7

>25 2.6

Table 6-4: Measure Scan Skin Entrance Dose

Patient(l’rr:‘i)ckness High Precision (uSv) | Standard (uSv)

0-7 1.7 0.9

8-10 2.4 1.2

11-13 3.6 1.8

14-16 4.4 2.2

17-19 8.4 4.2
20-22 14.2 7.1
23-25 26.4 13.2

>25 411 20.6

Operator Dose

Note: The dose to the operator is negligible. During a scan, the radiation level at a distance of one
meter from the scanner table is less than 1.0 microsieverts per hour.

D10 Fev 2 NORLANLDO
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Scanning Hip

Maintaining High Quality Hip Scans

Patient positioning, scan and analysis techniques can influence the precision and accuracy of Norland Bone
Density estimations. Facilities can reduce the adverse effects of some of these factors by:

»

»

»

»

»

»

»
»
»

Performing and monitoring the daily QA procedure to verify that other radiation sources (x-ray machines, nuc-
learimagers) are not affecting the performance of the Norland system. The daily QA procedure verifies
proper operation as well.

Ensuring that all operators position patients and analyze data in the same manner.

Screening patients for recent radionuclide uptake procedures. Residual emission may be misinterpreted by
the Norland system as x-rays.

Screening patients for recent ingestion of radiopaque substances. Barium or other dyes used in some x-ray
procedures could result in increased soft tissue x-ray absorption.

Screening patients for external opaque (metal and plastic) objects. Jewelry, buttons, zippers, rivets,
buckles, pens, keys etc. can affect the results if they are in the scanning region.

Screening patients for prosthetic devices, implants, buttock augmentation, surgical staples, or other high
density sub-dermal materials that may affect density estimates.

Ensuring that scan and analysis parameters remain constant for all scans of the same patient.
Always allowing the Hip Measure Scan to complete without interaction.
Ensuring the patient does not move during the scan.

»

»

»
»

Figure 6-2: Example of a Good Quality Hip Scan

The femoral neck cursor should be a 1.5-cm horizontal slice of femoral neck, centered on axis, and should
not include any other anatomy.

The scan includes the entire Greater Trochanter, shows the Lesser Trochanter and some of the femoral
shaft.

The Lesser Trochanter is minimized in the region of interest, indicating proper rotation.
The Femoral shaft is straight, indicating proper abduction.

NORLANLD, 535109 Rev- 7



Scanning Hip 6-5

General Patient Scanning Cautions

Caution: Properly Mark the Patient. To ensure scanner arm does not contact the patient, always
verify patient is positioned properly before scanning or moving the scanner arm.

Caution: Do not move the patient while marking the regions to be scanned. Always remain near the
patient, in the event assistance is needed.

Caution: Do not touch the patient and the computer system at the same time as this could increase
leakage currents.

Caution: Do not reach around to the back of the unit while the scanner arm is moving. While guards
are provided, it is wise to avoid any chance of pinching the arm, hand, or fingers between the scanner
arm and the frame, or between the source and the scanner arm.

Caution: Do not allow the patient to bump, push, or lean on the scanner arm. Manually moving the
arm could result in an error message which will require removing the patient from the table and doing
the Find Table Dimensions routine.

Caution: Make certain the patient does not dangle their arm or hand over the riser while the scanner
arm is moving during a scan. The scan will not be usable, as the patient will not be properly positioned,
and the patient may be at risk of pinching their hand or finger between the scanner arm and the riser or
between the x-ray source and the scanner arm.

Caution: Make certain the patient does not stick a finger into the slot in the bottom of the upper arm
cover during a scan; it could be pinched.

Caution: When positioning the patient, ensure they start by sitting near the center of the table and
then swing their legs up. Sitting at either end makes positioning awkward.

Caution: Caution the patient to remain still during the scan to ensure quality results.

Caution: Help the patient up from the scanner after scan data collection; some patients may require a
few minutes to regain equilibrium after lying down for a length of time.

SINESISIESR S SESESS
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Quick Reference - Hip Scan

The Hip scan process consists of a brief Scout scan over the femoral neck area, a Measure scan, calculation of
numeric results, and the saving and printing of data.

» Screen patient for contraindications.

» Inthe Database Navigator window, click on the existing patient’s name, then click OR click

Mew Patient »»

to start a new record.
» Update (or enter) the patient’'s Demographic information.

» Click £ Click the Right Hip or Left Hip button. Click QK . Check the parameters.

» Position the patient face up in the center of the scanner table. Place the Hip Sling with straps under the
patient's legs as close to the pelvic area as possible. Place the Leg Separator Block between the patient’s
heels.

» Position and pull up on the Velcro strap (to remove any slack) on the leg that will not be scanned. Repeat the
process on the leg that will be scanned.

m Note: Scan the non-dominant side (except in the case of a previous fracture or prosthetic device). ]

» Onthe leg that will not be scanned, gently pull the Velcro strap to the next reference number to rotate the hip.
Repeat the process on the leg that will be scanned.

@ Caution: Caution the patient not to stare into the beam. ]

» Click in the Parameters tab window.

» MARKING THE CENTER OF THE FEMORAL NECK: Position the scanner arm over the patient's mid-
section. Turn ON the laser and position the laser dot at the approximate center of the femoral neck. Press

the button on the Scanner Arm Touch Pad.
» Click to begin the Scout Scan.

i Note: The Scout Scan may be terminated when the entire femoral neck is visible. A minimum of 10 ]

scout scan lines must be completed.

» When the Scout scan is finished, click on the target and drag it to the center of the femoral neck.

. &l 5
» Click on . Allow the Measure scan to complete.

» If the scan is satisfactory, click .

» If no further scans are to be performed, remove the Hip Sling and assist the patient up from table.

» Click on the target, drag it to the center of the femoral neck, click .
s click_"* | cickl_5= ] ikt print a Report.

- [
» C|ICk‘ ik ‘ = andthenl__="" |
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Scan Procedures
Checklist

You are almost ready to begin scanning. Confirm that the following tasks have been completed:
» the system is running (see "Powering Up the System " on page 4-3)

» the System Calibrations are done (see "Daily Calibration Procedure" on page 4-6)

» the Database Navigator window is open (Figure 4-3: on page 4-5)

Preparing the Patient for Scanning

Ensure that the patient has removed all items from their pockets and that clothing is free of metal (i.e. rivets, but-
tons, zippers) or anything else that might be of a high density. It might be necessary to have the patient change
to an examination gown or robe. Shoes should also be removed.

Update (or Create) the Patient’s Record

EXISTING PATIENT: From the Database Navigator window, double-click on the existing patient’s name to
open the patient’s record. Update the patient’s information. (If necessary, refer to "Enter Data into the Existing
Patient’s Record" on page 4-24 for instructions.)

You are now ready to begin the scan process.
Proceed with "Setting the Scan Parameters" on page 5-8 to continue.

NEW PATIENT: From the Database Navigator window, click on to start a new record. Enter all
the patient information. (If necessary, refer to "Preparing Patient Records" on page 4-21 for instructions.)

You are now ready to begin the scan process.
Proceed with "Setting the Scan Parameters" on page 5-8 to continue.
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6-8 Scanning Hip

Setting the Scan Parameters

The photos used in these procedures are for a left hip scan. However these instructions are easily applied to a
right hip scan by adopting a mirror image of the patient positioning photos.

1. Click 4|5 >

2. Click Left Hip (or Right Hip) in the pop-up window.

# Select Scan Type

AP Spine @ Left Hip © Whole Body
¢ Lateral Spine " Right Forearm ¢ Research

" Right Hip © Left Forearmn ¢ Small Subject

[0]%9 | Cancel |

3. Click__ 2"

4. The Parameters tab window opens.

& Illuminatus DXA 4.2.0

Fle Edt Colbratin Tock Hep
Paameters

Patfient: Smth, Jane

Patient Summary s s 2
e ST Positioning the Patient, Hip Scan
et T When the scanning takes place, the patient wll be laying in supme position with femurs rotated using the Morland Hip Slng
For routine Bone Density studies, avoid scanming areas of previous surgical procedure or mmplants.
Phyocian [Dr. Jay hd MOTE: Scan the non-dominant side (except in the case of a previous fracture or prosthetic device). The left hip will be
scanned in this example.
Scanner A
Anode Vltage [KVE| 100 Cunert md} | 1.3 Make sure the patient does not bumnp the scanner ann.

Estimated Scanning Time Period [MM:SS] | 00:00 Positien the patient on the scanner table Iping face up, with their night side to the back rest. Make sure the patient is centered and straight on the
table.

Scan Type

Humbes of Scans: E1 < Mok
T |

o~

Ensure that the laser is tuned OFF, then use the Scanner Arm Touch Pad arrows to move the scanner arm to a position above the patient's
mud-section

A DO NOT pesitien the scanner arm directly over the patient’s face.
Place the Hip Skng between the patient's legs and position as shown.
e

w

Scout Scan  Measure Scan |
Speed (mm/sec) 1800 0.0
mmm(mml 1.0x 4.0 10x1.0
_Wlllﬁl(cm) 12,00 9.00
flengtls (om)._ [12.00 .00
.
O e |
‘Aderinistr stor Scarner Present Hind:

Figure 6-3: The Hip Scan Parameters tab window

5. The scan parameters are shown in the bottom left hand side of the Parameters tab window, and reproduced
here for reference. Norland recommends that the factory default parameter settings be used for scanning.
The default values are shown below.
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Scanning Hip 6-9

Scout Scan |Measure Scan
Speed {mm/sec) |180.0 a0.0
Resolution {(mm) |1.0x 4.0 1.0x1.0
width {(cm) 12.00 9,00
Length {cm) 12 9

» Toreset values to factory defaults, see "Preferences: Hip Scan" on page 3-24.

» For a full explanation of the Hip Scan parameters (i.e. preferences) see "Preferences: Hip Scan" on page 3-
24,

» If itis necessary to change the Speed or Width parameters, see "Changing the Scan Parameters Prior to
Scanning" on page 12-70.

6. Change the number of multiple scans of the same subject only when scanning phantoms.
7. Proceed to "Positioning the Patient" on the next page to continue.
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6-10 Scanning Hip

Positioning the Patient

When the scanning takes place, the patient will be lying in supine position with femurs rotated using the Nor-
land Hip Sling.

For routine Bone Density studies, avoid scanning areas of previous surgical procedures or implants.

Note: Scan the non-dominant side (except in the case of a previous fracture or prosthetic device). The
left hip will be scanned in this example.

Refer to the patient positioning photos and instructions in the Norland software (in the Parameters tab window).
The steps and photos are reprinted in the manual for reference.

& lluminatus DXA 4.2,0

Fie Edt Colbration Tock Hep
Paeameters |

Fafient: Smih, lane
Patient Summary

frei el Positioning the Patient, Hip Scan
Techwicam 3] When the scanning takes place, the patient wall be laying in supine position with femurs rotated using the Morland Hip Skng,
For routine Bone Density studies, avoid scanming areas of previous surgical procedure or mmplants.
Fycianc (D1 Jay hd MOTE: Scan the non-dominant side (except in the case of a previous fracture or prosthetic device). The left hip will be
scanned in this example.
Scanner A
AnodeVekage (KVE| 100 Cument (ma}| 1.3 Make sure the patient does not bunp the scaumer ann.
Estimsted Scannig Time Period M-S} | 00.00 I, Position the patient on the scanner table Iping Face up, with their sight side to the back rest. Make sure the patient is centered and swrzight on the
table.
Scan Type
[ Mok
T |
2. Ensure that the laser is turned OFF, then use the Scanner Arm Touch Pad arrows to move the scanner anm to a position abave the patient's
aud-section

A DO NOT position the scanner arm directly over the patient’s face.
Place the Hip Skng between the patient's legs and position as shown.

w

SCOUL SCan  Measure Scan i

Speed (mm/sec) (1800 0.0

Resolution (mm) 1.0 x 4.0 10x1.0

‘Width (em) 12,00 9.00

et em) 1200 (500

4. Center the base of the sling and position the straps under the patient's legs. Gently sbide the Hip Sbng toward the pelvic area The patient may aid
i ok o colbing i i o s s ol s e . s i i wind st
S < 3 .

£ odd | Fstssonn || o | |
derinistr stor Scarner Pressnt Hand:
m Caution: Make sure the patient does not bump the scanner arm. ]

1. Position the patient on the scanner table laying face up with their right side to the back rest. Make sure the
patient is centered and straight on the table. Ensure that the patient’s hips, spine, and shoulders are straight.
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Scanning Hip 6-11

2. A Ensure that the laser is turned OFF, then use the Scanner Arm Touch Pad arrows to move the scan-
ner arm to a position above the patient’s mid-section.

m Caution: DO NOT position the scanner arm directly over the patient’s face. ]

3. Place the Hip Sling between the patient’s legs and position as shown.

o —
_andl

-

-\l‘r. i

Note: If the patient's legs are too large to fit in the hip sling, it may be omitted. Continue to "The patient
is now ready for scanning." on page 6-15.
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6-12 Scanning Hip

Note: To maintain consistent patient positioning, the hip sling should be used on all patients whenever
:( ! \ possible.

4. Centerthe base of the sling and position the straps under the patient’s legs. Gently slide the Hip Sling toward
the pelvic area. The patient may aid the operator by pulling the Hip Sling as close as possible to the pelvic
area without causing undue discomfort.

Note: For the next step, instruct the patient to relax their legs. It is important that the rotation of the leg
is a direct result of using the hip sling and not due to the patient rotating the leg in an effort to help the
operator.

6. Position the leg that will not be scanned in the fixture (patient’s right leg in this photo). Put the leg strap in the
slot, then pull up on it to remove any slack. Hold the strap taut but do not rotate the leg.
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7. Locate the Velcro on the top of the fixture. Fold the strap down to secure it to the Velcro.

[
e\

8. Position the other leg in the fixture and pull up on the leg strap to remove any slack. Hold the strap taut but do
not rotate the leg. Then secure the strap to the Velcro on top of the fixture.

b

9. Notice that each Velcro strap is marked in increments consisting of letters and numbers (A 1-7, B 1-7, etc.).
On the leg that will not be scanned (right leg, in this example), note the letter-number combination on the
edge of the strap that is closest to the reference line on the fixture (B 4 in this example).
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6-14 Scanning Hip

RefLinel

-

10. Grasp the top of the Hip Sling with one hand and pull the strap gently with the other hand. While pulling gently
on the strap, the patient's leg should begin to rotate almost immediately. If it does not, start over.

When done properly, the strap will be free of slack. The patient must not “help” rotate the femur. If they do,

improper and inconsistent positioning may result.
Lift and pull the strap to rotate the leg a total of seven (7) marked increments on the strap (if initially at B-1,

pull to C-1). Secure the strap to the Velcro pad on top of the fixture.

11.

12.

[
L

T

\ s 2

13. Repeat the process on the other leg. Remember, if the patient's leg does not begin to rotate almost imme-
diately, start over.

Operator's Guide

NHR LﬂNa 435D109 Rev. Z



Scanning Hip 6-15

14. Position the patient’s hands at their sides or over the chest to ensure that they will not be in the scan field.

15. The patient is now ready for scanning.

16. Make the patient as comfortable as possible since movement during the scan will affect the results. The use

of a sheet or light blanket will not interfere with the scan results. The use of a pillow under the head is recom-
mended.
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Scanning Hip
Marking the Scan Region

1. Click in the Parameters window to open the dialog box.
# Mark Hip Scan Region

3

Pozition the patient on the scan table.
Switch on the lazer marker.

W Mark Center of Fernaral Meck

2. Locate the approximate center of the femoral neck on the patient.

3. Forassistance in locating the femoral neck, refer to Figure 6-4: below and Table 6-5: "Three methods to loc-
ate the center of the Femoral Neck" on the facing page.

are shown below. Each scan region is centered around the recommended MARK point. The asterisk %
neck.

in the figure corresponds to the location of the recommended Mark point at the center of the femoral

~

Note: FOR CLARIFICATION: The typical default settings of the left and right hip Scout Scan regions

{ Marking -, - Marking \
RIGHT HIP " LEFT HIP
i

!
|

- Scans.

|
Y - AR s 2]
nl

"
i
T E)
' H
L - 0
r b
H e
"

: /
Figure 6-4: Approximate Center of the Femoral Neck
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Scanning Hip
Table 6-5: Three methods to locate the center of the Femoral Neck
Pelvis tip Locate the tip of the pelvis (anterior superior) and the pubic ; Tip of
and pubic symphysis. Place the laser positioning dot perpendicular to el
symphysis the midpoint of this line and about 4" (10cm) out from the line.
T MARK
Publc puint
Symphysis
Greater Locate the Greater Trochanter and position the laser pos- MARK
Trochanter itioning dot on a point several centimeters above the i
trochanter, and several centimeters from the centerline of the P
femur (anterior superior). 3
i & FEMUT
" Centerline
Pubic symphysis | Imagine a transverse line across the pubic symphysis. Ima- MARK
gine another line down the center of the femur. Place the laser point
positioning dot 1cm above the intersection of these two lines.
+1 cm
Ty
Pubic %, Femur
Symphisis | { [Centerline
& Caution: Caution the patient not to stare into the beam. ]

4. Press to turn the laser ON.
5. MARKING THE FEMORAL NECK: Place the laser positioning dot on the center of the femoral neck and
¥ MARK |
press . (The computer will emit a sound, and the laser will flash.).

6. The dialog box will automatically close.
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6-18 Scanning Hip

Starting the Scout Scan

Once the center of the femoral neck has been marked, the Start Scan button in the Parameters tab window will
become available to the operator. Caution the patient to remain still.

Remember, press the HALT button on the Scanner Arm Touch Pad to immediately terminate
the x-ray exposure or stop the scanner arm movement. Refer to "Pressing the Halt Button" on

page 12-37 for instructions on safely resuming the scan.

. Start 5
1. ik 315 |

2. The Scan tab window displays the image as it develops, shows how many lines will be scanned and gives
an estimate of the total time remaining in the Scout scan.

A Mluminatus DEXA 1.0.9.14 E]E]

File Edit Calibration Tools Help

Parameters  Scan I

Patient: Doe. Jane L.
Left Hip
Segment:  ScoutScan
Angle(deg. )
Width (cm.]: 12.00

Length [cm): [12.00 Stop
Estension [t of ines): |1 E
206
018

Time Remaining
Total [MM:S5);
Current Segment (MM:55):

Progress
Scan 1 of1

Segment 1 of 1
Scanning Line 11 of 30

manager Inbox: O Scanner Present Hint:

3. Monitor the image closely for any indication of patient movement. Cancel the scan immediately if the patient
moves during the scan.
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Scanning Hip

=]
. Note:TocanceIthescan:CIick‘ Stop ‘Click| Fance |

Select in the dialog box. Click .

Click =M™ | Click ___>=">* | Select Left Hip or Right Hip.
Return to "Marking the Scan Region" on page 6-16 to continue.

.

4. When the Scout Scan is complete, the computer will emit a sound. The software will update the Scan tab
window and the Measure Scan button will become available.

A Mluminatus DEXA 1.0.9.14 @@E

File Edit Calibration Tools Help

Parameters  Scan I

Patient: Doe. Jane L.

Left Hip

Segment:  Scan Complete

Angleldeq.}

‘width (cm.) 12.00 Rescan
Length [em]: 12.0

Estension [t of ines): |1 E Estend

Time Remaining

Total [MM:S5); 1:49
Current Segment (MM:55): ool
Progress

Scan 1 of1

Segment 1 of 1
Scanning Line 30 of 30
Position the cursar at the
center of the femoral neck

| MeasweScan|  Cancel | |

manager Inbox: O Scanner Present Hint:

5. Determine whether the quality of the Scout Scan image is satisfactory or unsatisfactory.

6. THE SCOUT SCAN IMAGE IS SATISFACTORY when the scanned area includes the entire Femoral
Neck, the entire Greater Trochanter, part of the femoral shaft and the ilium. Proceed to step 8.

7. THE SCOUT SCAN IMAGE IS UNSATISFACTORY when the region of interest does not fit inside the
cursor box. Proceed to the steps in "Unsatisfactory Scout Scan (Hip)" on page 12-71 for instructions.
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6-20 Scanning Hip

8. To set the initial position of the region of interest (ROI), imagine a line across the femoral neck, as shown
below, and locate the center.

9. Click on the target in the Scan window, drag it to the middle of the femoral neck, and release the mouse but-
ton to deposit the cursor.
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Scanning Hip 6-21

Starting the Measure Scan

Remember, press the HALT button on the Scanner Arm Touch Pad to immediately terminate
the x-ray exposure or stop the scanner arm movement. Refer to "Pressing the Halt Button" on

page 12-37 for instructions on safely resuming the scan.

2. The Scan tab window displays the image as it develops, shows how many lines will be scanned and gives

an estimate of the total time remaining in the Measure scan.

& Illuminatus DXA 4.0.0.20
File Edit Calibration Tools Help

Parameters  Scan

Patient: Smith, Sally E
Left Hip

Segment:  Measure Scan

Angle(deg.):

“Wwidth [cm.]: | 9.00
Length [em]: | 9.00 Stop

Estension [# of lines) 1 pis g

Time Remaining

Total [kk:55] 1:22
Curent Segment [MM:55): 122
Progress

Scan 1 of1

Segment1 of 1
Scanning Line 19 of 90

Bone image not for di

Inbox: O Scanner Present

¥

Administrator

Note: Always allow the Measure Scan to complete without interruption. This will ensure that the
region of interest is the same from scan to scan and will ensure the best precision.

3. Monitor the image closely for any indication of patient movement. Cancel the scan immediately if the patient
moves during the scan.

Operator's Guide NURLHND@
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6-22 Scanning Hip

Note: To cancel the scan: Click . Click .
Select in the dialog box. Click .
Click . Click g Select Left Hip or Right Hip.

Return to "Marking the Scan Region" on page 6-16 to continue.

. J

4. When the Measure Scan is complete, the computer will emit a sound. The software will update the Scan tab
window and the Analyze button will become available.

W Ininatus DEXA 1.0.9.14
Fle Edt Calbrabon Tock Hep
Paraiees  Sean

Patiant: Dos. Jane L

Laft Hip

Segeerd  Sean Coeplein

Angieideg |

Wih[cn | |50 3 |

Léngth [on} 50

Exteraion [ of inezt |1 s Esterd |

Total MM:55) [
Camerd Segrmerd MM 551 o

Frogess

k= 1oit

Se nt 1ot
Scaneing Ling 40 6190

dnshon | Derm Coreel |

marager Ibox:D  Sconner Prasont i

5. If nofurther scans are to be performed, remove the Hip Sling from the patient and help the patient up from the
scanner table. Make sure the scanner arm will not impede the patient's ability to sit up.

Caution: Remember that some patients may require a few minutes to regain equilibrium after lying
down for a length of time.
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Analyzing the Scan
At this point, the operator can analyze the scan later, or analyze the scan now.
ANALYZE LATER: Click to end the scan process and analyze the scan later. The scan data will

be saved 1o the database for analysis at a later time. The software will go back to the Parameter tab window.
You can do another type of scan, if desired.

OR ANALYZE NOW . ..

1. k2=

2. When the Analysis tab window opens, a target cursor will be placed in the region of interest.

M iumminatus DXA 4,1.0: Smith, Jane 123 456 7890 61292005

Fle [dt Calbestion Took Help
et | S Rass |

Patinat Smify. Line

Riagicas

Click and hold on the coniral poinss 1o meve.
Position e cursar althe
cantar of e Famaral Neck

Argle; 0.0 degrues

Adrdraler 1 Seorwer Bk Preiost | Hint:

3. Using the click and drag method, position the target cursor on the mid-point of the femoral neck and release
the mouse button to deposit it.
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6-24 Scanning Hip

4. Click . If the automatic computer analysis is successful, the software will construct a cursor box
and the Results button will become available.

M iumminatus DXA 4,1.0: Smith, Jane 123 456 7890 61292005
Fle Cdt Celbrsten Took Heb
darussit | 5o Aesus |

Pationt Sodh. Jane
Ringicas

Regaon Lengthimun) | width{en)
Fem hech. 150 .

fddFogon | DeieBegon| Dotk

Inchudn/Exclude

frekain | Erekee

Argle; 230 degroes

Adrdraler 1 Seorwer Bk Preiost | Hint:

Note: Norland strongly recommends using the computer-generated analysis unless the regions of
interest are blatantly incorrect.

5. If the patient has a prior scan, use the Show Comparison feature to aid in positioning the cursors in a con-
sistent fashion.Right-click on the image, select Image Analysis > Show Comparison. (See "Comparison
Image" on page 12-54).

6. If the software cannot automatically find the regions, the following dialog box will be displayed. Click
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! . . . "
A Unable to find regions autamatically. Yiou must pasition cursors manually.

7.

»

»

»

»

The region of interest cursors become available for adjustments.

Click and hold on control points to set the regions of interest.

Click and drag from anywhere within the cursor box to drag the cursor group to the new position. Center the
axis line through the femoral neck.

The side cursors should be adjusted to include all of the neck. The neck cursor box should include only the
neck. It should not include any other bone. Reposition the side cursors by using the pointer to click on a con-
trol point. Drag the cursor to its new location.

The neck cursor box should enclose the narrowest part of the neck. To adjust the length of the femoral neck
cursor box, use the pointer to click on one of the control points of the box that are on the centerline axis. Drag
it along the centerline to adjust the length. Ideal length is 1.5-cm (or longest length possible).

Align the centerline by clicking on the centerline control point and angulate to attain a horizontal slice of
femoral neck.

Note: If it is not possible to attain either a 1.5cm or 1.0cm femoral neck length without including the
pelvis, adjust the cursors to a maximum femoral neck length.
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Viewing the Scan Results Tab
. Click . The Scan Results tab window opens.

55555 -1234: BI6/2004

o 5
ACE

funa 07450 07450
T sBMD 1007 Wiinglcnd  NEETIng  NOME e w4 om2 M -— e

BMCg)| Acsa )| Langthicn]] Wisth [on]| T-Scoe] YourgRel )] ZScon| AgeMatchit)] ST Change(3]] ST Cunge
(1) 150 T o 0% Tz s L Sy S

T3 ¥ = —
10060 160 ook B0 0% w0 - - e e

Carcel sow |

marager rbox: B Scanner Mok Present | Hind:

Note: Review in baseline mode is strongly recommended to determine if “Alternate R- Value Analysis”
is necessary. Refer to the Alternate R-Value Analysis on page 12-81 of the Additional Techniques sec-
tion for detailed instructions.

»

»

»

»

»

ciek 2|

The image thumbnail, trending or reference population graphs, and a results table are displayed in the Scan
Results tab. (NOTE: image is not for diagnostic purposes.)

If an exact match of the installed Reference Sets and the ethnic background (entered into the Patient Demo-
graphics window) does not exist, the Scan Results tab window will be displayed without a reference pop-
ulation graph.

The BMD for the femoral neck will be plotted in the reference chart as a dot and the results will be displayed
below the graph.

The BMD, BMC, Area, Length, Width, T-Score, Young Ref %, Z-Score, and Age Match % for each region of
interest are displayed.

If the patient has been scanned before, % Short Term and % Long Term will be displayed.
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@ \lurminatus DXA 4.3.0
Fle [de Calbrston Took Help
Pasnstecs | Sean | Anauis Soan Racbs |

Fambeck  Merdod 4000

LefHp 24JUM 2009 113 Scan Speed 180mmiy Aescltion: 1.0mm 4 1 Omm ST0 OV o Mipck BMD; 1. 28N 1.7 Soe Guide for other Cvs,  Cument Imager Lin Bane
Pegon | BB fglcat) [ BME [g) Asea foof) [ Length teed [ Wik [l [ T-Scove [ Young el ()] 2:Score | Age Maich (%) ST Change [ ST Change ke LT Change ()| LT Change i) |
FemMack e Elie. ) aEn 150 208 ™2 118 -,y - — -
Tioch 05565 5457 a8 an m? Bk a4 - o
Wards Arna oS ame 1000 110 w2 S5 AX ur oo s o —
Tokal sHMID 51 Bengfent XA Oy e 168 e 1 L2 L p— @ CAem. Ay
Pt c¢ Patiet Lt | < Dmncgrnpitics | << Stmnp Viemw |

Pepcet Termploke: Bone Exom Repert Scareer Presonk

» Click to generate and print a reBort using the current default report template. Proceed to Step 5
of "Generate and Print a Report" on page 5-24.

» orclick L="™¥*"”” |10 generate and print a report using a report template other than the default. Proceed to
"Generate and Print a Report" on page 5-24.

. u] hics 55
» orclick to do another scan.

. <4 Patient List . .
» orclick to end the process and return to the main window.
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Definitions of Scan Results

Table 6-6: Definition of Scan Results

T-SCORE The T-score is the number of standard deviations a patient’'s BMD value is above or
below a young reference value for individuals of same ethnic background and sex.

% YOUNG The % Young reference value is the ratio of the patient’s bone mass to the young ref-

REFERENCE erence value for individuals of same ethnic background and sex.

Z-SCORE The Z-score is the number of standard deviations that the patient's BMD value is

above or below the reference value for individuals of same age, ethnic background
and sex.

% AGE-MATCHED

The % Age-matched value is the ratio of the patient's bone mass to the reference
bone mass value of individuals of the same age, ethnic background and sex.

% ST: SHORT TERM
CHANGE

Ratio of change between current scan and most recent previous scan.

% LT: LONG TERM
CHANGE

Ratio of change between current scan and patient’s initial scan.

%/YR value

Indicates the percent of ST or LT change calculated per year.

Fracture Risk Assessment

The patient's risk of fracture is plotted in the Reference Charts displayed in the Scan Results tab window. Nor-
land incorporates the WHO (World Health Organization) criteria in plotting a patient's fracture risk assessment.
See table below. (Note that this table is re-reprinted here for reference.)

Table 6-7: WHO Ceriteria: Fracture Risk Assessment

Low Risk
(Green)

Represents the range of values determined by WHO to be 'nor-
mal' (having adequate bone mineral). The BMD T-Score values
in this region are within 1 SD of the young adult reference mean
value. A patient whose value is plotted in this region has no
identifiable risk of fracture.

(Yellow)

Medium Risk

Represents the range of values determined by WHO to be
'osteopenic’ (having low bone mineral). The BMD T-Score val-
ues in this region range are more than 1 SD below the young
adult mean value but less than 2.5 SD below the mean value. A
patient whose value is plotted in this region may be developing
a tendency to fracture.

High Risk
(Red)

Represents the range of values determined by WHO to be
'osteoporotic' (having severely reduced bone mineral). The
BMD T-Score values in this region are more than 2.5 SD below
the young adult mean. A patient whose value is plotted in this
region has a high spontaneous fracture probability.
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Generate and Print a Report

Six different types of Reports can be generated for each scan: the Bone Exam Report, the Bone Exam Report -
1 Page, the Combined Report, the Patient Letter, the Referral Letter, and the Ten Year Fracture Risk Report.
When saved, these reports become part of the scan data.

These procedures use the Bone Exam Report - 1 Page for the example.

1. Make sure that the scanned image is being viewed as a thumbnail in the Stamp View or the Filmstrip View.
Click (to highlight) the thumbnail view of the scan.

2. Click Tools > Report > Select Template... or click the M button to open the “Report Con-
figuration” dialog box.
File Edi  Calibration [E]Hﬂp e

Calibration Detaibs
Send To '

3. When the Report Configuration dialog box opens, click a Report Template to highlight it (Bone Exam

Report - 1 Page was selected here). See "Sample Scan Reports" on page 2-17 for examples of the report

template selections. Click Dene

Report Configuration

Choose a Default Report Template

Buone Exam Report - 1 pags j Done

Bone Exam Report

Combined Report

Patient Letter

Referral Letter

Ten Year Fracture Risk Report

Note: The selected Report Template will remain the default until it is changed. The currently selected
Report Template is always displayed at the bottom of the IlluminatusDXA window.

4. Click Tools > Report > Generate New or click the button.

File Edit Calibration [Tools| Help

Initialize Scanner

Service Tools 3
File Tools

Calibration Details

Send To: >

DICOM Interface

Mail

Report
Audio Dictation

View Selected

Log Files »

Scan Quality Issues Editor

Recommendations Editor

Select Template...
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6-30 Scanning Hip

5. The Report is immediately generated and opens up in the window, as shown. At this point, the operator can
type in their comments and recommendations, Lock it, Saveit, Printit, Exportit to a PDF file (ora DICOM
file) and Closeit.

M Report Type: Bane Exam Report - 62812006 - Creating Mew

Mame: Smith, Jane £ Caucarian
A Leit g Mot (=19
Age: 68 yoart Wt 1568
S Femae

Lkt Hip ere RAZ006

Fem Heck Horisnd 400
1,215,

1]

o g
& psrs]
2 &0 &0 a0
Ak

Youmg Kt (3] 995
T-Scom Bt
Ag Mt (%) 175
LSeem 1%

Ban image mon for dingronis

Bagon  BMD(ghmf BMCL Amafos)  Lenghiom)  Wilthios) T-fosms  TouwngRef(%)  ZSeor A Much(¥) 5T Chasge() 5T Changs (%) LTChsa() LT Chings (%)
] L3 0ie 3 13 v vy vaven

nnnnn oun 4w i (£ .
Toeek 0897 1148 1315 0w 1105 234 [ET Sl e s e

Wishdna 0753 0756 1000 Lm L0 076 BB 18 1342

Totd MD 11 Timgher® Tiimg 58 14 1igs e o5 e wwess - e

ST O fiw Mk BMD 12 BME 1.7 Sowe G fn ot O
10 rrem 1 rem, 455 e, 500 e Fiew, 2500200 ok, DE5006 5.0 248

Lommunts

wee || msave ' o memenpor | Bmemocow | —

6. Click . The “Print” window appears. Select a printer, select which pages to print and choose how
many copies to print.

7. Click to print the Report. The Report is automatically saved and printed.
okt ]

9. You are returned to the Filmstrip view screen. The saved Report can be found under the “Reports” tab. The
Report can be viewed, modified and reprinted at any time. See "The “Reports” Tab" on page 2-14 for more
information.

o
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A Sample Bone Exam Report

A sample 2-page Bone Exam Report is included here for reference.

5/7/2015 10:05:49 AM Norland at Swissray Page 1
W6340 Hackbarth Road Fort Atkinson, WI 53538 USA (888) 741-0413
Name: Lastname, Firstname Sex: Female Height: 51"
1D: PatientlD Ethnic:  Caucasian Weight: 110
DOB: 2/19/1968 Age: 34 years
L H Left Hip on: 5162002 1:56:29 PM
Fem Neck Norland 4/00 C
Young Ref. (%) 71.7 Date Value
T-Score -2.39 07/19/00 0.726
Age Maich (%) 76.1 07/20/9%9 0.755
Z-Score -1.90 07/23/97 0.769
Bone image not for diagnosis.
L Arca Length Width T- Young Ref. Z- Age Match ST Change ST Change LT Change LT Change
Reg BMD (glem®) BMC .
Fglon (gem?) (& {em?) (cm) (em)  Score (%) Score o) (%) (%alyr) (%) (%alvr)
Fem Neck 7078 3458 4. 886 1.50 -2.39 7.7 =190 76.1 =24 -1.4 -19 -7
Troch 06256 7.299 11.67 =148 79.5 =104 347 2.4 1.3 13.5 28
Total B33 Omglem?® 26844mg 3222 =100 871 -0.91 BR.2 1.9 1.1 =37 -1.3
SBMD 33 0mglem?® 2 £ 22 | 5 + : 3. 3
STD CVs for Neck BMD: 1.2 BMC: 1.7 See Guide for other CVs.
1.0mm X 1.0 mm, 180 mm/s, 9.00 cm, Rev. 3.9.4/2.1.0 Calib. 05/06/02 S/N 3840
Comments:
User-entered comments when the report was generated.

Figure 6-5: Page 1 of the Bone Exam Report

Operator's Guide
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5/7/2015 10:05:49 AM Norland at Swissray

W6340 Hackbarth Road Fort Atkinson, W1 53538 USA (

Page 2

888) 741-0413

Name Lastname, Firstname (] Patient1D
Ethnic Caucasian

Address DoB 2/19/1968

Telephone Age 34 years

History non-traumatic bone fracture and primary osteoporosis Meno Year

Treatment Sex Female

Medications  Actoncl, Fosamax and Vitamin D Height U

Comments Weight 110

Scan Information

Scan Type: Left Hip Resolution: 1.0x1.0

Analysis Date: 5/21/2005 5:21:51 AM Speed: 180 mmfs

Calibration Date: 05/06/02 Width: 90

Technologist: Host/Seanner: 3941210

Physician: Analysis/Revision: 384

Detailed Results

Total sEMD NHANES 1l c
1202

1002
802
602

Noriand 4/00

Troch
0.993,

0.793]
(=]
(=]
0.593
z g

0'393.
20 40 60

45 65 85

AGE | AGE
Young Rel. (%) 79.5 Date Value Young Refl” (%) 87.1 Date Value
T-Score =148 0719700 0.611 T-Score -L00 071900 $17.4
Age Match (%) 84.7 07/20/99 (0.640 Age Match (%) 88.2 07/20/99 8654
Z-Score -1.04 07/23/97 0.551 Z-Score -0.491 07/23/197 N/A

NORLANGDG

Figure 6-6: Page 2 of the Bone Exam Report
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Scanning Forearm

Note: The Forearm Scanning feature is available as an option with the Bone
Densitometer. Be aware that your system might not have this option.

———

The Forearm Scan procedure estimates bone
mineral in the distal and/or proximal regions of
either the left or right forearm.

The Forearm scan process begins with a quick
Scout scan over the distal forearm. The DXA
software creates and displays an image of the
scanned anatomy. The operator identifies the
ulnar end plate and the intersection of the ulna
and radius on the Scout scan image.

A Measure scan, consisting of scanning ten
lines of the distal forearm, ten lines of the prox-
imal forearm, and one distal soft tissue scan line
is taken. The analysis can either be performed
with the standard scan-then-analyze sequence
of operations, or the scan data may be saved
and analyzed later. Results are saved and prin-
ted to complete the study.

The patient will be sitting in a chair (without
wheels or armrests) in front of the scanner with
the forearm resting on the table. Long sleeves
should be rolled up above the elbow. Any brace- Figure 7-1: Patient positioning
lets, rings, or watches should be removed. for the Forearm Scan

This chapter discusses the following.

CHAPTER 7

Scan Specifications ... ... .. oL 7-2
Maintaining High Quality Forearm Scans ... . .. ... 7-4
General Patient Scanning Cautions ... . .. ... 7-5
Quick Reference - Forearm Scan ... ... ... 7-6
Scan Procedures . 7-7
Analyzingthe Scan ... .. 7-21
Viewing the ScanResults Tab ... ... .. L 7-22
Generate and Print @ Report ... .. . 7-25
A Sample Bone Exam Report . ... ... L 7-27
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Scanning Forearm

Scan Specifications
Detailed specifications for the Forearm Bone Density scan are in the following tables.

Table 7-1: Forearm Scan Specifications

Scan Sites Distal and/or Proximal radius and ulna and
Proximal radius
Accuracya Typically within 1.0% of industry standard

In vivo Precisionb

See table below

Scout Scan Resolution

1.0mm x 1.0mm:;
Point resolution x line spacing (pixel size)

Scout Scan Speed 45mm/sec
Measure Scan 1.0mm x 1.0mm:
Resolution Point resolution x line spacing (pixel size)

Measure Scan Speed

High Precision: 2.0mm/sec
Standard: 8.0mm/sec
High Speed: 20.0mm/sec

Table 7-2: Forearm Scan In vivo Precision

Distal Radius & Ulna

Proximal Radius & Ulna

Proximal Radius

Cc.v. C.v. Cc.v.

Measure

Scan Mode BMD | BMC | AREA | BMD | BMC | AREA | BMD | BMC | AREA

High Precision | 0.7% [0.9% |0.8% |[0.5% |0.6% |0.6% |0.5% |0.7% | 0.6%

Standard 0.8% |14% |1.0% [0.8% |0.7% [0.6% |[0.9% |0.8% |0.7%

High Speed 09% |1.3% | 1.4% [0.7% |0.7% [0.8% |[0.9% |0.9% | 0.8%

*** All specifications are subject to change without notice. ***
8Based on Standard Speed Scans of an anthropomorphic phantom.
bBased upon 120 scans of 30 subjects and 75 phantom scans using standard procedures.

Operator's Guide
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Scanning Forearm 7-3

Patient Dose

Note: The radiation dose to the patient is dependent on the type of scan procedure and the body thick-
ness of the patient. The table below lists typical entrance skin dosages for the Forearm scan based on
the listed body thickness.

Table 7-3: Scout Scan Skin Entrance

Operator Dose

Dose
Patient Thickness | Entrance Dose
(cm) (HSv)
0-3 1.7
4-6 2.4
7-9 3.6
10-12 4.4

Table 7-4: Measure Scan Skin Entrance Dose (uSv)

Patient Thickness | High Precision | Standard | High Speed
(cm) (HSV) (HSv) (HSV)

0-3 38.5 9.6 3.9

4-6 55.0 13.8 5.5

7-9 80.5 20.1 8.1

10-12 100.0 25.0 10.0

A

Note: The dose to the operator is negligible. During a scan, the radiation level at a distance of one
meter from the scanner table is less than 1.0 microsieverts per hour.

Operator's Guide
435D109 Rev. Z
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Scanning Forearm

Maintaining High Quality Forearm Scans

Patient positioning, scan and analysis techniques can influence the precision and accuracy of Bone Density
estimations. Facilities can reduce the adverse effects of some of these factors by:

»

»
»

»

»

»
»

»
»
»
»
»
»

Performing and monitoring the daily QA procedure to verify that other radiation sources (x-ray machines, nuc-
lear imagers) are not affecting the performance of the Norland system. The daily QA procedure verifies
proper operation as well.

Ensuring that all operators position patients and analyze data in the same manner.

Screening patients for recent radionuclide uptake procedures. Residual emission may be misinterpreted by
Norland Bone Densitometers as x-rays.

Screening patients for recent ingestion of radiopaque substances. Barium or other dyes used in some x-ray
procedures could result in increased soft tissue x-ray absorption.

Screening patients for prosthetic devices, implants, surgical staples, or other high density sub-dermal mater-
ials that may affect density estimates.

Ensuring that scan and analysis parameters remain constant for all scans of the same patient.
Repeat any Measurement in which the patient moves.

Figure 7-2: Example of a Good Quality Forearm Scan

The arm is centered and straight in the image.

The ulna end plate is visible, yet few lines of data appear before the end plate.
The path of the distal Soft Tissue line does not include any bone.

Both ulna and radius appear in the image and are not cut off.

There is no visible sign of movement.

The ROI’'s seem credible in that the distal is in an area of minimum BMD and proximal at the 1/3 (i.e. cortical)
site.

NORLANLD, 535109 Rev- 7
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General Patient Scanning Cautions

Caution: Properly Mark the Patient. To ensure scanner arm does not contact the patient, always
verify patient is positioned properly before scanning or moving the scanner arm.

Caution: Do not move the patient while marking the regions to be scanned. Always remain near the
patient, in the event assistance is needed.

Caution: Do not touch the patient and the computer system at the same time as this could increase
leakage currents.

Caution: Do not reach around to the back of the unit while the scanner arm is moving. While guards
are provided, it is wise to avoid any chance of pinching the arm, hand, or fingers between the scanner
arm and the frame, or between the source and the scanner arm.

Caution: Do not allow the patient to bump, push, or lean on the scanner arm. Manually moving the
arm could result in an error message which will require removing the patient from the table and doing
the Find Table Dimensions routine.

Caution: Make certain the patient does not dangle their arm or hand over the riser while the scanner
arm is moving during a scan. The scan will not be usable, as the patient will not be properly positioned,
and the patient may be at risk of pinching their hand or finger between the scanner arm and the riser or
between the x-ray source and the scanner arm.

Caution: Make certain the patient does not stick a finger into the slot in the bottom of the upper arm
cover during a scan; it could be pinched.

Caution: When positioning the patient, ensure they start by sitting near the center of the table and
then swing their legs up. Sitting at either end makes positioning awkward.

Caution: Caution the patient to remain still during the scan to ensure quality results.

Caution: Help the patient up from the scanner after scan data collection; some patients may require a
few minutes to regain equilibrium after lying down for a length of time.

SINESISIESR S SESESS
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Quick Reference - Forearm Scan
The Forearm scan takes measurements from the distal and/or proximal radius and ulna or the proximal radius.

»

»

»

»

»

Screen patient for contraindications.

In the Database Navigator window, click on the existing patient’s nhame, then click OR click

Mew Patient »»

to start a new record.
Update (or enter) the patient’'s Demographic information.

Click g Click the Left Forearm or Right Forearm button. Click m Check the para-

meters.

Place the Forearm Fixture on the front edge of the table, centered left-to-right. Pull the wrist strap through the
hole to form a loop. Hang the remaining 3 straps over the front edge of the table.

@ Note: Scan the non-dominant side (except in the case of a previous fracture or prosthetic device). ]

»

»

With the patient seated in a standard chair (without wheels or armrests), position the forearm on the fixture,
aligning the head of the ulna with the reference mark on the fixture and secure with straps.

Position the Forearm Fixture so that the angle formed between the forearm and the upper arm is 90°.

take care not to bump the patient.

% Caution: Caution the patient not to stare into the beam. Scanner arm will be moved in the next step; }

»
»

»

»

»
»

»

»

»

Click in the Parameters tab window.

MARKING THE START POINT: Turn ON the laser. Move the scanner arm until the laser dot is positioned

approximately Tmm off the edge of the patient’s wrist - immediately adjacent to the ulnar head center, and

then press the button on the Scanner Arm Touch Pad.

MARKING THE END POINT: Move the scanner arm so that the laser dot is positioned even with the end of

the elbow and press the button.
Click to begin the Scout Scan.

Click after the area of minimum BMD is displayed on the image (typically 30 to 45 scan lines).
Reposition cursors, if necessary. Position the horizontal cursor at a point distal to the ulnar end plate. Next,

. . . . . . . . Continue 5
position the vertical cursor at the midpoint of the intersection of the ulna and radius and click Sriinbe 2=,

If the scan is satisfactory, click .
Click [ ==dls ] Click‘ e ‘ Click| I |to print a Report (orclickto end the

process and return to the main window).

Click‘ S H Erint |andthen.
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Scan Procedures
Checklist

You are almost ready to begin scanning. Confirm that the following tasks have been completed:
» the system is running (see "Powering Up the System " on page 4-3)

» the System Calibrations are done (see "Daily Calibration Procedure" on page 4-6)

» the Database Navigator window is open (Figure 4-3: on page 4-5)

Preparing the Patient for Scanning

Ensure that the patient has removed all items from their pockets and that clothing is free of metal (i.e. rivets, but-
tons, zippers) or anything else that might be of a high density. It might be necessary to have the patient change
to an examination gown or robe. Shoes should also be removed.

Update (or Create) the Patient’s Record

EXISTING PATIENT: From the Database Navigator window, double-click on the existing patient’s name to
open the patient’s record. Update the patient’s information. (If necessary, refer to "Enter Data into the Existing
Patient’s Record" on page 4-24 for instructions.)

You are now ready to begin the scan process.
Proceed with "Setting the Scan Parameters" on page 5-8 to continue.

NEW PATIENT: From the Database Navigator window, click on to start a new record. Enter all
the patient information. (If necessary, refer to "Preparing Patient Records" on page 4-21 for instructions.)

You are now ready to begin the scan process.
Proceed with "Setting the Scan Parameters" on page 5-8 to continue.
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Setting the Scan Parameters

Note, the illustrations used in these instructions are for a Left Forearm procedure. However, these instructions
are easily applied to a right forearm scan by adopting a mirror image of the patient positing shown.

1. Click 4|5 >

2. Click Left Forearm in the pop-up window.

M Select Scan Type

AP Spine  Left Hip  Wyhaole Body
© Lateral Spine ¢ Right Forearm ¢ Research

 Right Hip & |eft Forearm  Small Subject

3. Click_2* |
4. The Parameters tab window opens.

73 Muminatus

File Edmt Calibration  Tools  Help
Pargmetrss |
Pahent: Jone:. Mided
Patiant Summary
Headn Weshi %5 Positioning the Patient, Forearm Scan
The & for pasitioning and scansing the forearm are for the left forearm . These instructions can be applied 1o the right forearm by reversing
Technckgit: [ =l <
the physical references.
Py pohwon”Dr. 2 NOTE: Secan the non-dominant side (sxcept in the case of a previous fracture of prosthetic device]. s
1. Place the Foreasm Positicemng Fixture on the font edge of the table, centered left-to-right. Lecate the Hand Rest Block and the Elbow Pad.
Scanner Position a chair {without wheels or armeests) 3s close a5 possible 1o the from of the scanner
AnodeVokege FVL| 100 Cumentindl| 13
Estimatedt Scarvsy To Procd MMLSS) | D000
Scan Type
NubeolScane |1 [T Mah. |
[Len Feamarm -l
2 Have the patient sit straight in the chair with both feet flat on the floce and their forearm resting on the table. Long slesves should be rolled
up sbove the elbow. Any braceless or waiches should have been removed
3 & Ensure that laser is uned OFF and move the scanner arm away from the patient
4. Pullthe wrist strap (second serap from the right when scanning the keft forearm) through the hele in the back of the fonwre. forming a brge
foup. Let the remaing tiree straps hang dovn over the freut of the tray.
loce o o [SDILEGE  Hithive £oaa |
[Spmond trentnecd S L)
| Resolution (mm) | L0% L0 Lox 10
S ) s 00 e
oS (cm) o Lo B L
Messiere Regions. | oth
Dietnus Cancel
[ Bdmiristrator [ {Report Template: Bone Exam Report - 1 page Scanmer Present

Figure 7-3: The Forearm Scan Parameters tab window
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5. The scan parameters are shown in the bottom left hand side of the Parameters tab window, and reproduced
here for reference. Norland recommends that the factory default parameter settings be used for scanning.
The default values are shown below.

Scout Scan  |Measure Scan
Speed (mm,/sec) |45.0 20.0
Resolution fmm} [1.0x1.0 1.0x1.0
Width (cm) 5.00 5.00
Length {cm) p to Proximal 1.0
Measure Regions Both

» Toreset values to factory defaults, see "Preferences: Forearm Scan" on page 3-25.
» For a full explanation of the Forearm Scan parameters (i.e. preferences) see "Preferences: Forearm Scan"

on page 3-25.

» Ifitis necessary to change the Scan Speed parameter, see "Changing the Scan Parameters Prior to Scan-
ning" on page 12-75.

6. Proceed to "Positioning the Patient" on the next page to continue.

Operator's Guide
435D109 Rev. Z
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Positioning the Patient

The instructions for positioning and scanning the forearm are for the left forearm. These instructions can be
applied to the right forearm by reversing the physical references.

@ Note: Scan the non-dominant side (except in the case of a previous fracture or prosthetic device). ]

Refer to the patient positioning photos and instructions in the Norland software (Parameters tab window). The
steps and photos are reprinted in the manual for reference.

1. Place the Forearm Positioning Fixture on the front edge of the table, centered left-to-right. Locate the Hand
Rest Block and the Elbow Pad. Position a chair (without wheels or armrests) as close as possible to the
front of the scanner.

2. Have the patient sit straight in the chair with both feet flat on the floor and their forearm resting on the table.
Long sleeves should be rolled up above the elbow. Any bracelets or watches should have been removed.

3. A Ensure that the laser is turned OFF and move the scanner arm away from the patient.

4. Pull the wrist strap (second strap from the right when scanning the left forearm) through the hole in the back
of the fixture, forming a large loop. Let the remaining three straps hang down over the front of the tray.

5. Place the patient’s left arm on the surface of the fixture and slide the hand through the large loop formed by
the wrist strap. (Support the other arm on a pillow in the patient’s lap for comfort.) Align the head of the ulna
with the reference mark on the back edge of the fixture. The head of the ulha is the lump which protrudes

NORLANLDO B3D109 Rov-7



Scanning Forearm 7-11

from the top of the wrist. This protrusion is typically obvious, however, it may be necessary to palpate some
patients to locate the head of the ulna.

< Location of Ulna

6. Position the Hand Rest under the patient’s palm and against the back of the fixture. The patient’s fingers
should be aligned along the outer front edged of the pad and the thumb must remain flat against the fixture
base, when the patient is relaxed. If part of the thumb is still in the air, slide the hand rest forward until the
length of the thumb is laying on the tray.

T ATA s~

7. First fasten the hand strap diagonally over the thumb and fingers and attach to the fixture back rest. Next,
tighten and fasten the wrist strap to the fixture back rest.

Top View

D10 Fev 2 NORLANLDO
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8. Position the elbow pad under the patient’s elbow, so that the short side of the pad is along the tray backrest
and the elbow is in the middle of the pad.

Back View

Note: If the distance between the ulna head and the back of the fixture exceeds 1-cm, reposition the
hand rest and re-fasten the wrist strap.

10. The angle formed between the forearm and the upper arm should be 90°. Slide the fixture along the edge of
the table to change the angle, if necessary.

NORLANLDO B3D109 Rov-7
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11. When finished, the patient should be positioned with shoulders straight, feet flat on the floor and the elbow at
a 90° angle.

12. The patient is now ready for scanning.

D10 Fev 2 NORLANLDO
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Marking the Scan Region

1. A Ensure that the laser is turned OFF, then use the Scanner Arm Touch Pad arrows to move the
scanner arm over the patient’s forearm.

2. Click in the Parameters tab window to open the dialog box.

M Mark Forearm Scan Region E| M Mark Forearm Scan Region E|
Pozition the patient on the scan table. Poazition the patient on the scan table.
Switch on the laser marker. Switch oh the lazer marker,
W Mark Point 1 mm adjacent to center of Ulnar Head. W Mark Paoint T mm adjacent to center of Ulnar Head.

m  Mark Point next to the end of Elbow

i+ ilse Previous Arm Length ©_Mark Mew Arm Length

/
[

Click this button when Click this button for a repeat
scanning a patient with scan, but need to mark a new
a prior forearm scan arm length (ex. growing child)

Figure 7-4: Forearm Marking window for First Time (left) or Repeat (right) Forearm Scans

& Caution: Caution the patient not to stare into the beam. ]

3. Press to turn the laser ON.
4. MARKING THE START POINT: move the scanner arm until the laser positioning dot is approximately Tmm
¥ MARK |
adjacent to the center of the Ulnar Head and press . (The computer will emit a sound and the

laser will flash.)
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Top View

Mark the Start Point

~
1

Detail

abort the marking operation.

(.

Note: Click M in the dialog box to re-mark the Start Point. Click at any time to

5. MARKING THE END POINT: move the laser positioning dot even with the end of the elbow and press the

'-;RK_ D
button.

Mark the End Point

6. The computer will emit a sound and the laser will flash.

7. The dialog box will automatically close when the marking tasks are complete.

Operator's Guide
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7-16 Scanning Forearm

Starting the Scout Scan

Once the scan region has been marked, the Start Scan button in the Parameters tab window will become avail-
able to the operator. Caution the patient to remain still.

Remember, press the HALT button on the Scanner Arm Touch Pad to immediately terminate
the x-ray exposure or stop the scanner arm movement. Refer to "Pressing the Halt Button" on

page 12-37 for instructions on safely resuming the scan.

The Scan tab window opens and the Bone Densitometer will begin to scan.

3. The software will begin to generate the scan image based on the detector output as the scan data is being
collected. An estimate of the Total Time Remaining will also be displayed.

N —

& Iluminatus DXA 4.0.0.23
File Edit Calibration Tools Help

Parameters  Scan

Patignt: Smith, Sally E
LFAmH
Segment:  Scout Scan

Angle(dea.):
Width [cm.]. | 8.00
Length [cm): [4.90 Stop

Estension [t of fines): |1 £

Time Rermaining
Total [MM:S5); 444
Current Segment MM:S5): (]

Progress
Scan1of1

Segment1 of 1
Scanning Line 30 of 49

Administr ator Inbox: O Scanner Present Hint:

4. Monitor the image closely for any indication of patient movement. Cancel the scan immediately if the patient
moves during the scan.
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Note: To cancel the scan: CIick‘ Stop ‘ CIick| Fance |
Select in the dialog box. Click .

Click =M™ | Click ___>=">* ‘ Select Left Forearm or Right Forearm.
Return to "Marking the Scan Region" on page 7-14 to continue.

. J

5. Click onthe button after the area of minimum BMD is displayed on the image (typically 30 to 45
scan lines). Subsequent scans of the same patient require only 5 scan lines past the ulnar end plate be com-

pleted before scan termination.

6. When the Scout scan has completed (or been terminated), the Scan window will update, and the computer
will emit a sound to indicate that the Scout scan is complete. The Measure Scan button will become avail-
able.

# Nluminatus DXk 4,0.0.23
Fle Ede Calbesbion Took el
Paanastees |36
Patiark Smth, 58k £
LF AmmH
Segrent Sean Comgletn
Angleldeg |
Widh[ea] B0

Langth [ea} 4.9
Esteraion [of Inest |1 e Eaterd |

s
Segrmend MM 551 ilig

Sean ol
Sagment1 o1
Scanning Lina 19 of 43

Admristrater b0 Scannes Prassk Mint:

7. Verify that the image contains the ulna, the ulna end plate, and the radius.
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7-18 Scanning Forearm

Remember, press the HALT button on the Scanner Arm Touch Pad to immediately terminate
the x-ray exposure or stop the scanner arm movement. Refer to "Pressing the Halt Button" on

page 12-37 for instructions on safely resuming the scan.

2. The Scan tab window will be updated to show cursor placement.

# Nluminatus DXk 4,0.0.23
Fle Edt Calbrstion Took Help
Paramastees  Scan

Patiant Smth. Salv £
LF AmH
Segerd
Angleideq |
Widh[en] (B0

Length [ca} [4.90

Esteraion (i of lres}

s
e

refinemant of harzontad ine.

Continus Soan) Carcel

Admristrater b0 Scannes Prassk Mint:

Norland strongly recommends using the computer-generated cursor placement unless they are
blatantly incorrect.

3. Reposition cursors, if necessary:

» by clicking on the control point for the horizontal cursor and dragging to a point distal to the ulnar end plate.
» next, click on the vertical cursor and drag it to the midpoint of the intersection of the ulna and radius.

Note: Positioning the vertical cursor also initiates the automated ulnar end plate location search. If the
horizontal cursor is moved after the vertical cursor, the automated search is defeated and the pre-
cision may be affected.
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Figure 7-5: Proper Cursor Placement

. . S . Continue 5 . .
4. Caution the patient to remain still and click M to continue the Measure Scan for both the distal and
proximal forearm. The scan areas consist of:

» 10lines (10mm) of the distal ulna and radius.
» 1 axial line between the radius and the ulna (soft tissue).
» 10 lines (10mm) of the proximal ulna and radius.

Figure 7-6: Scanning of the Distal (left), Axial Line (center), and Proximal (right) regions

4. Monitor the image closely for any indication of patient movement. Cancel the scan immediately if the patient
moves during the scan.

=]
. Note:TocanceIthescan:CIick‘ Stop ‘Click| Fance |

‘ Select in the dialog box. Click . ‘

Operator's Guide
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7-20 Scanning Forearm

Click . Click g Select Left Forearm or Right Forearm. ‘

L Return to "Marking the Scan Region" on page 7-14 to continue. J

5. When the Measure Scan is complete, the computer will emit a sound. The software will update the Scan tab
window and the Analyze button will become available.

# Nluminatus DXk 4,0.0.23
Fle Ede Calbesbion Took el
Paramstees | 3can

Patiant Smith. S8y £
LF A H
Segert. Szan Completn
Angiedde |
Weth fem ] [BED

Length o} 4.9

Esdenaion (8 of lnest |1

Sean 1 ol
Segmemt 3ol 3
Scanning Lina 10 610

Anshze | Dona Cancel

Admristrater b0 Scannes Prassk Mint:

6. Determine if the quality of the Measure Scan image is satisfactory or unsatisfactory.
7. IF THE IMAGE QUALITY IS SATISFACTORY, proceed to Step 9.

8. IF THE IMAGE QUALITY IS NOT SATISFACTORY, click and remark the scan region (see
"Marking the Scan Region" on page 7-14).
9. If nofurther scans are to be performed, release the patient from the forearm fixture.
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Analyzing the Scan

At this point, the operator can analyze the scan later, or analyze the scan now.

ANALYZE LATER: Click to end the scan process and analyze the scan later. The scan data will
be saved 1o the database for analysis at a later time. The software will go back to the Parameter tab window.
You can do another type of scan, if desired.

OR ANALYZE NOW . ..

1. Click . When the Analysis tab window opens, lines will be displayed in the regions of interest.

# Numinatus DXk 4,0.0.23 EB
Fle Edt Calbrsbon Took Help

Puanstect | Sean  Anas

Pationt Sodh Salv L

Riagicas

Progress

Click aad hold 0n the cantol poins 16 mawe

Chiek an region 1 salect

Admistrater b0 Scannes Prassk Mint:

2. Atthis point, the operator can use the Include/Exclude feature on page 12-45 to include or exclude areas of
interest.
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7-22 Scanning Forearm

Viewing the Scan Results Tab
1. cioc =]

& IMuminatus DXA 4.0.0.23

Fle e Calbrstion Tock Heb
Pamsters | Sean | Ansiz Sean sy |

CT 2004 1835 Scan Spoed Bee's Redchéor: Tres s T

z e Lorigh e | ia e | 1-Score | Voumg et 51| 2 Szome [ ige Meh 1] ST Crange 55T Change el | LY Change 51 LT Change P
= k. 3 nre mn an ms /3 103 23 00—
Pros sl Usd 250 26 un W 00 %3 Wik 5000 we -
Fow B 0o 130 1505 o e or s Lra b ) £ 59 e

Egmnistrater Trbow0  Scarner Present iz

2. Click to save the Scan Results.

» The image, trending or reference population graphs, and results are displayed in the Scan Results tab.
(NOTE: image is not for diagnostic purposes.)

» If an exact match of the installed Reference Sets and the ethnic background (entered into the Patient Demo-
graphics window) does not exist, the Scan Results tab window will be displayed without a reference pop-
ulation graph.

» The BMD of the first region of the Detailed Results will be plotted in the reference chart as a dot.

» Detailed Results for the Distal Radius and Ulna, Proximal Radius and Ulna, Proximal Radius, and any other
operator-defined regions are displayed in the table at the bottom of the window.

» Reference graphs for individual regions can be displayed by clicking on the ROI in the Results table. The
graph will change according to what is selected. Notice that the name of the selected ROl is displayed at the
top of the Reference graph.

» If the patient has been scanned before, % Short Term & % Long Term will also be displayed next to the T-
Score and Z-Score information.
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& Nluminatus DXA 4.3.0
File Edit Calibration Tools Help

Parameters | Scan | Analysis Soan Fesuts |

Dist. R+Ll Morlznc 798 [

g 0.292| Mecium Risk
&

0.257]

ik for diagrosis
1319 Scan Speed: 20mmds Resolution 1.0mm« 1.0mm  5TD CV for Prosimal Riadius BMD: 0.9 Ses Guide for other C¥s.  Current Image: Lin Bone
| BMD (a/cn?) | BMC ()| Area (o) | Length (om) [ Width (om) [ T-Score | Youna Fief. (%) | ZScore [ AgeMatch ()| ST Change (%) 5T Change (/v | LT Change ()| LT Change (/) |

LFAmH 25JUN 2003

Fiegion
Dist. R+l 03063 1178 3831 1.00 gO0 082 @0 0% 855 = m— e e
Prox. Ri+l) 0EsE8 1629 2460 1.00 800 265 78 288 753 = e e
Prox R 0.6%65 08410 1.207 1.00 g0 203 821 215 gz e e

“Hepon << Patint it | ¢< Demograptics | < Stamp view |

service Repart Template: Bone Exam Report Scanner Prasent

» Click to generate and print a report using the current default report template. Proceed to Step 5
of "Generate and Print a Report" on page 7-25.

» orclick 2™ " _|to generate and print a report using a report template other than the default. Proceed to
"Generate and Print a Report" on page 7-25.

. i} hics »»
» orclick to do another scan.

. << Patient List . .
» orclick to end the process and return to the main window.

Operator's Guide NHRLHND@)
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Scanning Forearm

Definitions of Scan Results

Table 7-5: Definition of Scan Results

T-SCORE The T-score is the number of standard deviations a patient’'s BMD value is above or
below a young reference value for individuals of same ethnic background and sex.

% YOUNG The % Young reference value is the ratio of the patient’s bone mass to the young ref-

REFERENCE erence value for individuals of same ethnic background and sex.

Z-SCORE The Z-score is the number of standard deviations that the patient's BMD value is

above or below the reference value for individuals of same age, ethnic background
and sex.

% AGE-MATCHED

The % Age-matched value is the ratio of the patient's bone mass to the reference
bone mass value of individuals of the same age, ethnic background and sex.

% ST: SHORT TERM
CHANGE

Ratio of change between current scan and most recent previous scan.

% LT: LONG TERM
CHANGE

Ratio of change between current scan and patient’s initial scan.

%/YR value

Indicates the percent of ST or LT change calculated per year.

Fracture Risk Assessment

The patient's risk of fracture is plotted in the Reference Charts displayed in the Scan Results tab window. Nor-
land incorporates the WHO (World Health Organization) criteria in plotting a patient's fracture risk assessment.
See table below. (Note that this table is re-reprinted here for reference.)

Table 7-6: WHO Ceriteria: Fracture Risk Assessment

Low Risk
(Green)

Represents the range of values determined by WHO to be 'nor-
mal' (having adequate bone mineral). The BMD T-Score values
in this region are within 1 SD of the young adult reference mean
value. A patient whose value is plotted in this region has no
identifiable risk of fracture.

(Yellow)

Medium Risk

Represents the range of values determined by WHO to be
'osteopenic’ (having low bone mineral). The BMD T-Score val-
ues in this region range are more than 1 SD below the young
adult mean value but less than 2.5 SD below the mean value. A
patient whose value is plotted in this region may be developing
a tendency to fracture.

High Risk
(Red)

Represents the range of values determined by WHO to be
'osteoporotic' (having severely reduced bone mineral). The
BMD T-Score values in this region are more than 2.5 SD below
the young adult mean. A patient whose value is plotted in this
region has a high spontaneous fracture probability.

NORLANLD

Operator's Guide
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Scanning Forearm 7-25

Generate and Print a Report

Five different types of Reports can be generated for each scan: the Bone Exam Report, the Bone Exam Report
- 1 Page, the Combined Report, the Patient Letter, and the Referral Letter. When saved, these reports become
part of the scan data.

These procedures use the Bone Exam Report - 1 Page for the example.

1. Make sure that the scanned image is being viewed as a thumbnail in the Stamp View or the Filmstrip View.
Click (to highlight) the thumbnail view of the scan.

2. Click Tools > Report > Select Template... or click the M button to open the “Report Con-
figuration” dialog box.
File Edi  Calibration [E]Hﬂp e

Calibration Detaibs

Send To ’

3. When the Report Configuration dialog box opens, click a Report Template to highlight it (Bone Exam

Report - 1 Page was selected here). See "Sample Scan Reports" on page 2-17 for examples of the report

template selections. Click Dene

Report Configuration

Choose a Default Report Template

Buone Exam Report - 1 pags j Done

Bone Exam Report

Combined Report

Patient Letter

Referral Letter

Ten Year Fracture Risk Report

Note: The selected Report Template will remain the default until it is changed. The currently selected
Report Template is always displayed at the bottom of the IlluminatusDXA window.

4. Click Tools > Report > Generate New or click the button.

File Edit Calibration [Tools| Help

Initialize Scanner

Service Tools 3
File Tools

Calibration Details

Send To: >

DICOM Interface

Mail

Report
Audio Dictation

View Selected

Log Files »

Scan Quality Issues Editor

Recommendations Editor

Select Template...
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Scanning Forearm

5. The Report is immediately generated and opens up in the window, as shown. At this point, the operator can
type in their comments and recommendations, Lock it, Saveit, Printit, Exportit to a PDF file (ora DICOM
file) and Closeit.

# Report Type: Bone Exam Repart - 10/24/2004 - Editing Faisting

B irmage ot o disgroria

Digt Rl Morland 798 ©
.87,

0.3%7]
S 02|
0167)

0 s, T0 W
A

Yormg Bl (3 1021
TiSeur (1]
Age Maaeh (2 1018
L X o

Mame S, SapE Frs Caucatian
RFTT Heht i
e 28 yearr s 1
Female
e — Ll Foseawn on 10/28/2004

Prow. Ralj Noriand 795
1023,

0823}
o 082
3 ta)
Lles)

E .
AL

Young Ruf (5] 1000

TSeom ol
Age Masrh (35 #93
TS e

Bagun  EMDigem®) BMCP Amifem)  Lenphicm) Wilthicm) Tl YougBaf (9 T ApMuchi®)  STChsge (30 ST Chisge () LT Chisge(3) LT Chisgu (i)
Dit Boll 03843 [T [1T] 121 an 16 L N
P el 0862 FE TR il 1010 o I e B
P B oBess [E RT3 0z zs (35 LS eesss s sssss sees

S0 CV o Frouimal Flags BUD: 019 See Guade lor ohes O
1.0 men i 1.0 o 8 s, 80,00 om. lew. 400/237 Calb, 10724104
Comments:

Subjeccs acan locks normal. Continue taking calcium and exercising. Repeat scan within 5 years.

[Coo] sve | em | Eporree | eponceon

P

6. Click . The “Print” window appears. Select a printer, select which pages to print and choose how

many copies to print.

7. Click to print the Report. The Report is automatically saved and printed.

ciekl 2|

o

9. You are returned to the Filmstrip view screen. The saved Report can be found under the “Reports” tab. The
Report can be viewed, modified and reprinted at any time. See "The “Reports” Tab" on page 2-14 for more

information.
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Operator's Guide
435D109 Rev. Z



Scanning Forearm 7-27

A Sample Bone Exam Report

A sample 2-page Bone Exam Report is included here for reference.

5/29/2015 10:37:03 )
AM Norland at Swissray Page 1

W6340 Hackbarth Road Fort Atkinson, WI 53538 USA (888) 741-0413

Name: Lastname, Firsiname A. Sex: Female Height: 51"
1D: PatientiD Ethnic:  Caucasian Weight: 110
DOB: 2118/1968 Age: 34 years

| Left Forearm on: 5/672002 1:45:50 PM

2

Dist. R+«U Norland 798 c
0.487

H
f==

0.367
Q 0287
0.167|

AGE

Young Ref (%) 71.8

T-Score -1.87
. "‘ ’ ¥ l - Age Maich (%) 71.6
Z-Score -1.89

Bone image not for diagnosis.

R BMD BMC Arca Length Width T-  Young Ref. Z-  Age Match ST Change ST Change LT Change LT Change
RHv (glem?) (g) {em?) {em) {em)  Scorc (%) Score (%) (%s) (%alyr) (%) (%alyr)
I;'S:J 0.2561 1012 3.952 1.00 800 -1.87 1.8 -1.89 71.6 FhaEE FhEEw FhaEE FEded
Prox. % 5 whane hae seeke wahan
R+U 0.3993 1.095 2.743 100 500 -6.09 46.7 =620 46.2

Prox. R 0.4124  0.6230  1.510 1.00 800 -3R3 48.6 -5.89 484 whese Led il Aal s senes

STD GV for Proximal Radius BMD: 0.9 See Guide for other CVs.
1.0 mm X 1.0 mm, 20 mm/s, 8.00 cm, Rev. 3.9.4/2.1.0 Calib. 05/06/02 S/N 3840
Comments:

User-entered comments when the report was generated.

NORLANLG.

Figure 7-7: Page 1 of the Bone Exam Report
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5/29/2015 10:37:03
AM Norland at Swissray Page 2
W6340 Hackbarth Road Fort Atkinson, WI 53538 USA (888) 741-0413
Name Lasiname, Firstname A. (] Patient1D
Ethnic Caucasian
3 Ses 5 3 TA 95
Address 123 Sesame St Anytown CA 99999 DOB 211911968
Telephone  535-335-1234 Age 34 years
History non-traumatic bone fracture and primary osteoporosis Meno Year
Treatment Sex Female
Medications  Actoncl, Fosamax and Vitamin D Height U
Comments Weight 110
Scan Information
Scan Type: Left Forearm Resolution: 1.0x1.0
Analysis Date: 5/21/2005 5:22:13 AM Speed: 20 mm/ls
Calibration Date: 05/06/02 Width: 8.0
Technologist: Wells, Mary Jane Host/Scanner: 3941210
Physician: Dr. Wellness Analysis/Revision: 384
Detailed Results
Prox. R+U Norland 798 c Prox. R Norland 798

= 0.623]
Young Rel. (%) 46.7 Young Rel” (%) 48.6
T-Score -6.09 T-Score -5.83
Age Match (%) 46.2 Age Match (%) 4%.4
Z-Score -6.20 Z-Score -5.89

Figure 7-8: Page 2 of the Bone Exam Report

NORLANLD
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Scanning Lateral Spine

Note: The Lateral Spine Scanning feature is available as an option with the
Norland Bone Densitometer. Be aware that your system might not have this
option.

The Lateral Spine Scan procedure estimates bone mineral in the lumbar spine using a
lateral projection. The region of interest is the L2, L3 and L4 vertebral bodies. The ana-
lysis software excludes the posterior elements from the calculations.

The process begins with a Scout scan over the lumbar spine area. The Scout scan
should start 2-cm above the lowest point of the rib cage and extend to 2-cm below the
iliac crests along a center line that is approximately 10-cm anterior to the patient’s
back. The operator visually confirms the computer defined measurement regions of
interest are correct, then the Measure scan is taken.

Figure 8-1: Patient positioning for the Lateral Spine Scan

This chapter discusses the following.

CHAPTER 8

Scan SpecifiCations .. ... ... L 8-2
Maintaining High Quality Lateral SpineScans ..................................... 84
General Patient Scanning Cautions ... .. ... ... 8-5
Quick Reference Guide - Lateral SpineScan ... 8-6
Scan Procedures .. 8-7
Analyzing the Scan ... 8-21
Viewing the ScanResults Tab ... ... . .. 8-24
Generate and Print a Report ... ... oo . 8-26
A Sample Bone Exam Report . ... . 8-28
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Scanning Lateral Spine

Scan Specifications

Table 8-1: Detailed Lateral Spine Scan Specifications

Scan Site

Lumbar Spine (L2-L3, L3, L3-L4) - Lateral View

Accuracya

Typically within 1.0% of industry standard

In vivo Precisionb

See table below

Scout Scan Resolution

1.5mm x 3.0mm: Point resolution x line spacing (pixel size)

Scout Scan Speed

130mm/sec

Measure Scan Resolution

1.0mm x 1.0mm: Point resolution x line spacing (pixel size)

Table 8-2: Lateral Spine Scan In vivo Precision

Two Vertebra C.V. | Single Vertebra C.V.

Measure Scan Mode | Measure Scan Speed | BMD | BMC | AREA | BMD | BMC | AREA
High Precision 15mm/sec 24% | 3.7% | 2.2% |2.7% | 4.5% | 3.6%
Standard 30mm/sec 3.7% | 6.1% | 3.3% |4.5% | 6.7% | 3.3%

*** All specifications are subject to change without notice.

*k%k

8Based on Standard Speed scans of an anthropomorphic phantom.

bBased upon 42 scans of 7 subjects (single vertebra) and 33 scans of 3 subjects (two vertebra) using standard procedures.

NORLANLD

Operator's Guide
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Scanning Lateral Spine 8-3

Patient Dose

Note: The radiation dose to the patient is dependent on the type of scan procedure and the body thick-
ness of the patient.

Table 8-3: Scout Scan Skin Entrance Dose

Patient Thickness (cm) | Entrance Dose (uSv)
0-3 0.2
4-6 0.3
79 0.4
10-12 0.5
13-15 1.0
16-18 1.7
19-21 3.2
>21 4.9

Table 8-4: Measure Scan Skin Entrance Dose (uSv)

Patient Thickness (cm) | High Precision (uSv) | Standard (uSv) | High Speed (pSv)

0-7 5.1 2.6 1.3

8-10 7.3 3.7 1.8

11-13 10.7 5.4 2.7

14-16 13.3 6.7 3.3

17-19 25.3 12.7 6.3

20-22 42.7 21.3 10.7

23-25 79.3 39.7 19.8

>25 123.3 61.7 30.8

Operator Dose

Note: The dose to the operator is negligible. During a scan, the radiation level at a distance of one
meter from the scanner table is less than 1.0 microsieverts per hour.

Operator's Guide NURLHND@;
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84 Scanning Lateral Spine

Maintaining High Quality Lateral Spine Scans

Patient positioning, scan and analysis techniques can influence the precision and accuracy of Bone Density
estimations. Facilities can reduce the adverse effects of some of these factors by:

» Performing and monitoring the daily QA procedure to verify that other radiation sources (x-ray machines, nuc-
lear imagers) are not affecting the performance of the Norland system. The daily QA procedure verifies
proper operation as well.

» Ensuring that all operators position patients and analyze data in the same manner.

» Screening patients for recent radionuclide uptake procedures. Residual emission may be misinterpreted by
Norland Bone Densitometers as x-rays.

» Screening patients for recent ingestion of radiopaque substances. Barium or other dyes used in some x-ray
procedures could result in increased soft tissue x-ray absorption.

» Screening patients for prosthetic devices, implants, surgical staples, or other high density sub-dermal mater-
ials that may affect density estimates.

» Ensuring that scan and analysis parameters remain constant for all scans of the same patient.

Figure 8-2: Example of a Good Quality Lateral Spine Scan

Note that:

» the spine is straight.
»” the vertebrae are encompassed by the cursors and positioned properly.
» theribs are not obscuring L2 and/or the crest is not obscuring L4.

NORLANLD, 535109 Rev- 7
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General Patient Scanning Cautions

Caution: Properly Mark the Patient. To ensure scanner arm does not contact the patient, always
verify patient is positioned properly before scanning or moving the scanner arm.

Caution: Do not move the patient while marking the regions to be scanned. Always remain near the
patient, in the event assistance is needed.

Caution: Do not touch the patient and the computer system at the same time as this could increase
leakage currents.

Caution: Do not reach around to the back of the unit while the scanner arm is moving. While guards
are provided, it is wise to avoid any chance of pinching the arm, hand, or fingers between the scanner
arm and the frame, or between the source and the scanner arm.

Caution: Do not allow the patient to bump, push, or lean on the scanner arm. Manually moving the
arm could result in an error message which will require removing the patient from the table and doing
the Find Table Dimensions routine.

Caution: Make certain the patient does not dangle their arm or hand over the riser while the scanner
arm is moving during a scan. The scan will not be usable, as the patient will not be properly positioned,
and the patient may be at risk of pinching their hand or finger between the scanner arm and the riser or
between the x-ray source and the scanner arm.

Caution: Make certain the patient does not stick a finger into the slot in the bottom of the upper arm
cover during a scan; it could be pinched.

Caution: When positioning the patient, ensure they start by sitting near the center of the table and
then swing their legs up. Sitting at either end makes positioning awkward.

Caution: Caution the patient to remain still during the scan to ensure quality results.

Caution: Help the patient up from the scanner after scan data collection; some patients may require a
few minutes to regain equilibrium after lying down for a length of time.

SINESISIESR S SESESS

D10 Fev 2 NORLANLDO



8-6

Scanning Lateral Spine

Quick Reference Guide - Lateral Spine Scan

The Lateral Spine scan procedure consists of a brief Scout Scan over the lumbar area, a Measure Scan, cal-
culation of numeric results, and the saving and printing of the data.

»

»

»

»
»

»

Screen patient for contraindications.

In the Database Navigator window, click on the existing patient’s name, then click OR click

Mew Patient »»

to start a new record.

Update (or enter) the patient’s Demographic information.

Cick | Click the Lateral Spine button. Click L2 | Check the parameters.

Place the Leg Rest, Back Rest, and the Rib Cage Support blocks in position on the scanner table.

Position the patient on their left side, with back against the Back Rest block. Position the Leg Rest block so
that the patient’s legs form a 135° angle. Support the ribs with the Rib Cage Support block and place the
Head Roll under the patient’s head. Place the Limb blocks between the arms and legs. Position the scanner
arm over the patient's midsection.

Caution: Caution the patient not to stare into the beam. ]

»
»

»

»

»
»

»
»

»
»

»

»

Click in the Parameters tab window.

MARKING THE START POINT: Turn ON the laser. Position the laser dot 2-cm above the lowest point of

the rib cage and 7-cm to 10-cm anterior (forward) of the patient’s back, then press the button on the
Scanner Arm Touch Pad.

MARKING THE END POINT: Position the laser dot 2-cm below the iliac crest and press the but-

fon.
MARKING THE BASELINE POINT: Position the laser dot over the abdominal region, 5-cm anterior to the

spine and press the button.
Click to begin the Scout Scan.

When the Scout Scan is finished, use the cursors to encompass L3 (single vertebra), L2-L3, or L3-L4 (mul-
tiple vertebrae). Position the center line to touch the anterior edge of vertebra(e).

Click . Allow the measure scan to complete. If the scan is satisfactory, click datl |

If you are done scanning, assist the patient up from the table.
Select the region to be analyzed in the “Regions” window. Click U .
Place the upper left control point inside the vertebral notch, above and to the left of the top vertebra. Place

the bottom left control point inside notch, below and to the left of the bottom vertebra. Click .

Click| Resshs ]Click| gave ‘Click| Report ‘toprintaRepon(orcIicktoendthe

process and return to the main window).

Click‘ Eh H Erint |andthen.
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Scanning Lateral Spine 8-7

Scan Procedures
Checklist

You are almost ready to begin scanning. Confirm that the following tasks have been completed:
» the system is running (see "Powering Up the System " on page 4-3)

» the System Calibrations are done (see "Daily Calibration Procedure" on page 4-6)

» the Database Navigator window is open (Figure 4-3: on page 4-5)

Preparing the Patient for Scanning

Ensure that the patient has removed all items from their pockets and that clothing is free of metal (i.e. rivets, but-
tons, zippers) or anything else that might be of a high density. It might be necessary to have the patient change
to an examination gown or robe. Shoes should also be removed.

Update (or Create) the Patient’s Record

EXISTING PATIENT: From the Database Navigator window, double-click on the existing patient’s name to
open the patient’s record. Update the patient’s information. (If necessary, refer to "Enter Data into the Existing
Patient’s Record" on page 4-24 for instructions.)

You are now ready to begin the scan process.
Proceed with "Setting the Scan Parameters" on page 5-8 to continue.

NEW PATIENT: From the Database Navigator window, click on to start a new record. Enter all
the patient information. (If necessary, refer to "Preparing Patient Records" on page 4-21 for instructions.)

You are now ready to begin the scan process.
Proceed with "Setting the Scan Parameters" on page 5-8 to continue.
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8-8 Scanning Lateral Spine

Setting the Scan Parameters

1. Click " |

2. Click Lateral Spine in the pop-up window.

M Select Scan Type

= AP Spine = Left Hip = Whaole Body
@ Lateral Spine ¢ Right Forearm ¢ Research

" Right Hip  Left Forearm  Small Subject

oK I Cancel

3. Click 2

4. The Parameters tab window opens.

i [Nleminatus DXA 4.2.0

Flo Edt Calbestion Took Help

Pusametess |
Patigrit Smih, Jane
Patient Summary Paositioning the Patient, Lateral Spine Scan e
Heght | & Weght| 123 When the scaraing takes place, the patient will be layng on hisher left side, with thewr back firmly agasmst the Back Rest Block
e The Lateral Spme scan requires the use of several positicreng 2ids: the (AP Spime) Leg Rest block the Back Rest block the Fib Cage Support block, 2
Lateral Lemb Suppest Blocks, and a Head Roll Have these postioning aids readdy avadable before postioning the patient for the Lateral Spine scan
e =
o ==
Scanner '&'&':fz T
X L)
AncdaVokags JEVE| 100 Cument sl | 13 [ Sesk 4 £
o
Estivated Scarring T Peicd MMS5] | 0000 T Seannor Table
(Top View)
Scon Type Besmner b
MHumber of Scana: 1 H Mark P
T — I Use the Scanser Arm Touch Pad to move the scasmer am to the foot of the seanner (F it 12 not already there)
2 Place the Back Rest block apgroamately = the center of the table and aganst the back of the scannes
3 Place the Leg Rest block to the left of the Back Rest block and against the back of the scanner.
4. Place the Rib Cage Suppost block sdjacent to the Back Rest block, ag shown
‘- —
% Have the pateent ke on histher left side, therr back frmily agamst the Back Rest block  Place the Head Roll under the patient's neck
Sl
|Speed (mm/see) 1300 o b
| Resolution (mm) [15x30 1010 ¥,
| 00
0.0
6 Check to see that the nibs are supported by the Rib Cage Support block, but not elevated
T 1lte the (AP Seire) Teo Reet hlnck tn dras the koees forward to form a 1392 anols hetwern the e and the thioch The ke shodd remainin
Delalts Carcel
ity shoe ‘Scannes Presert. Hint:

Figure 8-3: The Lateral Spine Scan Parameters tab window

5. The scan parameters are shown in the bottom left hand side of the Parameters tab window, and reproduced
here for reference. Norland recommends that the factory default parameter settings be used for scanning.
The default values are shown below.

NORLANLDO B3D109 Rov-7



Scanning Lateral Spine

Scout Scan |Measure Scan

Speed (mm/sec) |130.0 30.0
Resolution {mm} |[1.5x 3.0 1.0x1.0
Width {cm) 14.75 10.00
Length {cm) n.o n.o

Measure on AXis oM

» Toreset values to factory defaults, see "Preferences: Lateral Spine Scan" on page 3-27.
» For a full explanation of the Lateral Spine Scan parameters (i.e. preferences) see "Preferences: Lateral Spine

Scan" on page 3-27.

» If it is necessary to change the Speed or Measure on Axis parameters, see "Changing the Scan Parameters

Prior to Scanning" on page 12-78.

6. Proceed to "Positioning the Patient " on the next page to continue.

Operator's Guide
435D109 Rev. Z
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8-10 Scanning Lateral Spine

Positioning the Patient

Refer to the patient positioning photos and instructions in the Norland software (Parameters tab window). The
steps and photos are reprinted in the manual for reference.

i [Nleminatus DXA 4.2.0

Fo Edt Colbeotin Tock Help
Passmetess |

Patigrit Smih, Jane

Patient Summary Paositioning the Patient, Lateral Spine Scan e
Hesght [~] Weght | 123 When the scaraing takes place, the patient will be layng on hisher left side, with thewr back firmly agasmst the Back Rest Block
e The Lateral Spme scan requires the uge of several positicreng 2ds: the (AP Spime) Leg Rest block the Back Rest block the Fib Cage Support block, 2
L Lateral Lemb Suppest Blocks, and a Head Roll Have these postioning aids readdly avadable before posmioning the patient for the Lateral Spine scan
Pysiciors [Di Jay =
Bact Ren ok
s s EELTIEE
Scanner e cme
AfrodeVkags BVE| 100 Cumentfmik| 13 |, Seek ] oy
o
Estimated Seareing Time Pesicd MW.SS] | 00.00 R Scannor Table
(Top View)
Scon Type Besmner b
MHumber of Scana: 1 H Mark i
e —— Use the Scanmer Arm Touch Pad to move the scasmer amm to the oot of the scanner (it 12 not already there)

Place the Back Rest block apgeosamately = the center of the table and aganst the back of the scannes
Place the Leg Rest block to the left of the Back Rest block and aganst the back of the scanner
Place the Rib Cage Suppost block sdjacent to the Back Rest block, ag shown

Have the patsent ke on histher lof side, their back frmly agamst the Back Rest block  Place the Head Roll under the patient's neck

P

Scout Scan | Measure Scan

Speed frmsec) 1300 10

| Resobution gmm) 1530 10318
T 10.00
|Length (om} |00 o0

Steasure on Anis |[£]on

o

Check to see that the ibs are supperted by the Rib Cage Support block, but not elevated
11em the (4P Srine) oo Rest hlnck tr draw the loees foeward to Farm a 1342 anole hetwern the s and the thioh The bine thosdd remainin %

_ Deluts | eiion | caed | J | |

Adminestrator ‘Scannes Present Hintz

o

When the scanning takes place, the patient will be laying on his/her left side, with their back firmly against the
Back Rest block.

The Lateral Spine scan requires the use of several positioning aids: the (AP Spine) Leg Rest block, the Back
Rest block, the Rib Cage Support block, 2 Lateral Limb Support blocks, and a Head Roll. Have these pos-
itioning aids readily available before positioning the patient for the Lateral Spine scan.

ERBSI Blﬂ

Rib
Cage
Block
Scanner Table
(Top View)

Scanner Arm

1. Use the Scanner Arm Touch Pad to move the scanner arm to the foot of the scanner (if it is not already
there).

2. Place the Back Rest block approximately in the center of the table and against the back of the scanner.
Place the Leg Rest block to the left of the Back Rest block and against the back of the scanner.
4. Place the Rib Cage Support block adjacent to the Back Rest block, as shown.

w
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Scanning Lateral Spine 8-11

5. Have the patient lie on his/her left side, their back firmly against the Back Rest block. Place the Head Roll
under the patient’s neck.

6. Check to see that the ribs are supported by the Rib Cage Support block, but not elevated.

7. Use the (AP Spine) Leg Rest block to draw the knees forward to form a 135° angle between the spine and
the thigh. The hips should remain in a vertical line.

1
[ Lateral Limb Support Blocks . 4

m Note: Make sure that the patient does not sag or droop forward. ]

8. Place a Lateral Limb Support block on top of the left leg, just below the knee. Rest the other leg on top of the
Limb Support block.

D10 Fev 2 NORLANLDO



8-12 Scanning Lateral Spine

9. Place the other Lateral Limb Support block on top of the left arm, just below the wrist. Rest the other arm on
top of the Limb Support block. Position the shoulders in a vertical plane with arms at 90°.

10. The patient is now ready for scanning.

11. Make the patient as comfortable as possible since movement during the scan will affect the results. The use

of a sheet or light blanket will not interfere with scan results. Use of a pillow or the Head Roll under the head
is recommended.

NHR LHND® Operator's Guide

435D109 Rev. Z



Scanning Lateral Spine 8-13

Marking the Scan Region

1. Click in the Parameters tab window to open the dialog box.

# Mark Lateral Spine Scan Region ['5_(|

Position the patient on the scan table.
Switch on the laser marker.

W Mark the Start Point
W Mark the End Point

W Mark the Soft Tissue Paint [in abdomen adjacent
to sping]

/% Caution: Caution the patient not to stare into the beam. ]

2. Draw animaginary line parallel to the scanner back rest and 10-12-cm in front of the edge of the Back Rest
block.

3. Ensure that the laser is OFF, then use the Scanner Arm Touch Pad arrows to move the scanner arm over the
patient’s midsection along this imaginary axis.

Scanner Back Rest

End Point
Baseline

Start Point

Figure 8-4: Typical Lateral Spine Scout Scan region

Note: Explanation: The typical Lateral Spine Scout scan region is from mid-L1 to the iliac crest,
extending approximately 7-cm posterior to the anterior edge of the vertebral bodies and 7-cm into the
abdomen (shown above).

Note that all of L2-L4 is included in the scan when the:

» scan start point is 15-cm above the iliac crest (S)
» and the scan end point is 2-cm below the iliac crest (E).

The soft tissue Baseline point (B) is marked anterior to the spine, not over bone.

A /

/% Caution: Caution the patient not to stare into the beam.

D10 Fev 2 NORLANLDO



8-14 Scanning Lateral Spine

4. Press to turn the laser ON.

5. MARKING THE START POINT (S): move the scanner arm until the dot is approximately 2-cm above the

MARK |

lowest point of the rib cage and press . (The computer will emit a sound, and the laser will flash.)

© ' [ col ]
Note: Click W] in the dialog box to re-mark the Start Point. Click at any time to

abort the marking operation.

6. MARKING THE END POINT (E): move the scanner arm until the dot is about 2-cm below the iliac crest and
- -
press . (The computer will emit a sound and the laser will flash.)

7. MARKING THE BASELINE POINT (B):move the scanner arm until the dot is at a point in the abdominal

MARK |

region, about 5-cm anterior (forward) from the spine and press

NORLANLDO B3D109 Rov-7



Scanning Lateral Spine 8-15

8. The computer will emit a sound and the laser will flash.
9. The dialog box will automatically close when the marking tasks are complete.

D10 Fev 2 NORLANLG



8-16 Scanning Lateral Spine

Starting the Scout Scan

Once the center of the femoral neck has been marked, the Start Scan button in the Parameters tab window will
become available to the operator. Caution the patient to remain still.

Remember, press the HALT button on the Scanner Arm Touch Pad to immediately terminate
the x-ray exposure or stop the scanner arm movement. Refer to "Pressing the Halt Button" on

page 12-37 for instructions on safely resuming the scan.

. Start 5
1. ik 315 |

2. The Scan tab window displays the image as it develops, shows how many lines will be scanned and gives
an estimate of the total time remaining in the Scout scan.

A liuminatus XA 4.0.0.32

Searnes Prasack

3. Monitor the image closely for any indication of patient movement. Cancel the scan immediately if the patient
moves during the scan.

NORLANLD, 535109 Rev- 7



Scanning Lateral Spine 8-17

Note:TocanceIthescan:CIick‘ Stop ‘Click| Fance |

Select in the dialog box. Click .

Click =M™ | Click ST ‘ Select Lateral Spine.
Return to "Marking the Scan Region" on page 8-13 to continue.

. J

4. When the Scout Scan is complete, the computer will emit a sound. The software will update the Scan tab
window and the Measure Scan button will become available.

A2 Aluminatus D24 4,0.0.22

Fle Cde Calbrstion Tock Heb

Parmters | S

‘ntiank Snith, Saky £
Lat Sping

Segrwerd  Sean Compleln

Aegeideg | O i

Width[en} 1825 Fmscan

Lergh (e} 1250

b 0 Scarnes Present iz

5. Determine if the quality of the Scout Scan image is satisfactory or unsatisfactory.

6. WHEN THE SCOUT SCAN IMAGE IS SATISFACTORY, the image of the lumbar segment in the scan is
straight. Since the factory setting for the Measurement on Axis is set to ON by default (enabled), the lumbar
segment image must be straight so that the Measure Scan can be properly defined. Proceed to step 8.

7. WHEN THE SCOUT SCAN IMAGE IS NOT SATISFACTORY, the lumbar segment is not straight. Refer
to the information in "Unsatisfactory Scout Scan (Lateral Spine)" on page 12-79 for further instructions.

8. Click and drag to move the top and bottom of the cursor box to define the area to be measured. There are
three distinct areas for measurement in a lateral spine scan: L2-L3, L3, or L3-L4. The table below describes
where to place the cursor box for each of these three areas.

43ED109 Rev. 7 NORLFANLO



8-18 Scanning Lateral Spine

L3 Position the cursor to include the bottom third of L2 and the top surface of L4.
Position the center line of the cursor box to just touch the anterior edge of L3.
L2-L3 Position the cursor box to include portions of the adjoining vertebra above and
or below the two vertebrae being measured. Position the center line of the cursor
L3-L4 box to just touch the anterior edge of the vertebrae.
4 lluminatus XA 4,0.0,22 ~EX]

Fle Cde Calbrstion Tock Heb

Meanes Geon|  Corecel
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Scanning Lateral Spine 8-19

Starting the Measure Scan

Remember, press the HALT button on the Scanner Arm Touch Pad to immediately terminate
the x-ray exposure or stop the scanner arm movement. Refer to "Pressing the Halt Button" on

page 12-37 for instructions on safely resuming the scan.

2. The Scan tab window displays the image as it develops, shows how many lines will be scanned and gives
an estimate of the total time remaining in the Measure scan.

producticn Searnds Fresant itz

e | areieos 16 e

Note: Always allow the Measure Scan to complete without interruption. This will ensure that the
region of interest is the same from scan to scan and will ensure the best precision.

3. Monitor the image closely for any indication of patient movement. Cancel the scan immediately if the patient
moves during the scan.

Note:TocanceIthescan:Click‘ Stop ‘Click| Cencel |

‘ Select in the dialog box. Click . ‘

43ED109 Rev. 7 NORLFANLO



8-20 Scanning Lateral Spine

Click . Click g Select Lateral Spine. ‘

L Return to "Marking the Scan Region" on page 8-13 to continue. J

4. When the Measure Scan is complete, the computer will emit a sound. The software will update the Scan tab
window and the Analyze button will become available.

# luminatus DXA 4,0.0.22

sbrstion Took Hep

Ansyre Done Carcel

producticn Inbanc: 0 Searner Presak itz

L‘.{__j. L§ LE P __
5. Determine if the quality of the Measure Scan image is satisfactory or unsatisfactory.
6. IF THE IMAGE QUALITY IS SATISFACTORY, proceed to Step 8.

7. IF THE IMAGE QUALITY IS NOT SATISFACTORY, do one of the following:

» Enter the appropriate number of scan lines in “Extension (# of lines)” and click toinclude the

entire region of interest.

» OR click and remark the scan region (see "Marking the Scan Region" on page 8-13).

8. Remove the Patient Positioning Aids and help the patient up from the scanner table if no further scans are to
be performed. Make sure the scanner arm will not impede the patient's ability to sit up.

Caution: Remember that some patients may require a few minutes to regain equilibrium after lying
down for a length of time.

NORLANLD, 535109 Rev- 7



Scanning Lateral Spine 8-21

Analyzing the Scan
At this point, the operator can analyze the scan later, or analyze the scan now.
ANALYZE LATER: Click to end the scan process and analyze the scan later. The scan data will

be saved 1o the database for analysis at a later time. The software will go back to the Parameter tab window.
You can do another type of scan, if desired.

OR ANALYZE NOW . ..

1. ek 2|

im0 4. S

Progress

b0 Scannes Prassk Mint:

2. Inthe dialog box that pops up, select the region to be analyzed - L3, L2-L3, or L3-L4 - and click OK

(L2-L3 was used in this example.)
3. When the Analysis tab window opens, cursors will be displayed in the regions of interest.

43ED109 Rev. 7 NORLFANLO



8-22 Scanning Lateral Spine

4. Click and drag to position the upper left control point inside the vertebral notch to a point just above and
behind the upper vertebra to be analyzed.

5. Position the lower left control point inside the vertebral notch, below and behind the lower vertebra to be ana-
lyzed. The figure below shows the proper cursor positioning for L2-L3.

A llaminadus DXA 4.0.0.22
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Scanning Lateral Spine 8-23

6. Click .The Results button will become available.

7. The system software will automatically proceed to find the intervertebral spaces and construct a cursor box
that will contain each vertebra being analyzed with a minimum of soft tissue.

M |lamdnatus DXA 4.0.0, 22

fesuity

Note: Norland strongly recommends using the computer-generated analysis unless the regions of
interest are blatantly incorrect.

8. Adjust the cursors, if needed.

9. If the patient has a prior Lateral Spine scan, use the Show Comparison feature to aid in positioning the curs-
ors in a consistent fashion (see "Comparison Image" on page 12-54).
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8-24 Scanning Lateral Spine

Viewing the Scan Results Tab
1. Click . In this example, a prior Lateral Spine scan existed to plot a Trending Graph.

2. Click

3. Numeric data is displayed at the bottom of the window for each of the individual vertebrae and the L2-L3 pair
of vertebrae. If the patient has been scanned before, the values for % Short Term and % Long Term will also
be displayed. Their definitions are given in the following table.

% SHORT TERM CHANGE | Ratio of change between current scan and most recent previous scan.

% LONG TERM CHANGE | Ratio of change between current scan and patient’s initial scan.

%/YR value Indicates the percent of change calculated per year

NORLANLD, 535109 Rev- 7
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¥ Iluminatus DXA 4.3.0

No Trandng D ats Avalabis

Regat. o Potient Linl | << Demogephics | < Stamp View

Fapcet Template: Bone Lo Raport Scarnes Prasack

» Click to generate and print a report using the current default report template. Proceed to Step 5
of "Generate and Print a Report" on the next page.

» orclick L>"™*"* |to generate and print a report using a report template other than the default. Proceed to

"Generate and Print a Report" on the next page.

. Dermagraphics ==
» orclick to do another scan.

: < Patiert List L
» orclick to end the process and return to the main window.
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8-26 Scanning Lateral Spine

Generate and Print a Report

Five different types of Reports can be generated for each scan: the Bone Exam Report, the Bone Exam Report
- 1 Page, the Combined Report, the Patient Letter, and the Referral Letter. When saved, these reports become
part of the scan data.

These procedures use the Bone Exam Report - 1 Page for the example.

1. Make sure that the scanned image is being viewed as a thumbnail in the Stamp View or the Filmstrip View.
Click (to highlight) the thumbnail view of the scan.

2. Click Tools > Report > Select Template... or click the M button to open the “Report Con-
figuration” dialog box.

Fir Edi Caleratien (Took | Help

File Tack
Calibration Detaibs
Send To '

g
Report , Gemerate Mew
Audin Dictadion Firush Eaist

Lag Filies '

3. When the Report Configuration dialog box opens, click a Report Template to highlight it (Bone Exam

Report - 1 Page was selected here). See "Sample Scan Reports" on page 2-17 for examples of the report

template selections. Click Dene

Report Configuration

Choose a Default Report Template

Buone Exam Report - 1 pags j Done
Bone Exam Report

Combined Report

Patient Letter

Referral Letter

Ten Year Fracture Risk Report

@ Note: The selected Report Template will remain the default until it is changed. The currently selected
Report Template is always displayed at the bottom of the IlluminatusDXA window.

4. Click Tools > Report > Generate New or click the button.

File Edit Calibration [Tools| Help

Initialize Scanner

Service Tools 3
File Tools

Calibration Details

Send To: >

DICOM Interface

Mail /
Report > enerate New

Audio Dictation Finis|

ting/Make Addendum

View Selected

Log Files »

Scan Quality Issues Editor

Recommendations Editor

Select Template...
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5. The Report is immediately generated and opens up in the window, as shown. At this point, the operator can
type in their comments and recommendations, Lock it, Saveit, Printit, Exportit to a PDF file (ora DICOM

file) and Closeit.

# Report Type: Bone Exam Repart - 10/24/2004 - Creating New

S, Sy E
15
ez
Frmain

PE3}

b Couaan
Mt "W

a
3

Ben imigs w01 for dingroris

Laperal Spine on TV /2004

(=] LT v 1o
L 1006 1081 1043
12.13 1007 062 Ly

Fagen EMDigem?) BMCID Amalon)  Lengthiomd) Widthiond TSoom  ToogRf (%) I-5om
3 4

Q0731 Colls 1031704

Nertebea BMD: 27 Soe Gude lor other CVe
30 ey, 10000 e, Rews. 4

[T ] emt | eponrer | epomoeou

oo

6. Click . The “Print” window appears. Select a printer, select which pages to print and choose how

many copies to print.

7. Click to print the Report. The Report is automatically saved and printed.

ciekl 2|

o

9. You are returned to the Filmstrip view screen. The saved Report can be found under the “Reports” tab. The
Report can be viewed, modified and reprinted at any time. See "The “Reports” Tab" on page 2-14 for more

information.

Operator's Guide
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A Sample Bone Exam Report

A sample 2-page Bone Exam Report is included here for reference.

5/29/2015 2:17:08 PM

Norland at Swissray Page 1

W6340 Hackbarth Road Fort Atkinson, WI 63538 USA (888) 741-0413

Name: Lateral, Scan Sex:

Male Height: &7
1D: Laterali Ethnic: Caucasian Weight: 176
DoB: 11/211850 Age: 53 years

Lateral Spine on; 10/13/2004 4:20:49 PM

Bone image not for diagnosis.

Region BMD BMC Area Length Width T-  Young Ref.  Z-  Age Match ST Change ST Change LT Change LT Change
g (gfem?) {g) (cm?®) {cm) {cm) Score (%) Score (%) (%) (Falvr) (%) (%alvr)
L2 08053 1226 15.23 wrenn hene COCTU R T e hene T e
L3 07372 1018 1381 renen hene LT T e hane e e

L2-L3 0.7729 2244 29.04 senen s wruny e whene T senne renne

STD CV for Vertebra BMD: 2.7 See Guide for other CVs.
1.0mm X 1.0 mm, 30 mm/g, 10.00 cm, Rev. 4.0.0/2.3.1 Calib. 10/13/04 S/N 8167

Comments:

NORLAND
Figure 8-5: Page 1 of the Bone Exam Report

NHR LHNJ Operator's Guide
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Scanning Lateral Spine 8-29

5/29/2015 2:17:08 PM

Norland at Swissray Page 2

W6340 Hackbarth Road Fort Atkinson, WI 53538 USA (888) 741-0413

Name Lateral, Scan 2] Laterall
Address 123 Oak Street Anytown W1 55555 %;" ILI“;';“:;";:_
Telephone  222-555-4568 Age 53 years
History Meno Year

Treatment Sex Male
Medications Height 67
Comments Weight 176

Scan Information

Scan Type: Lateral Spine Resolution: 1.0x 1.0

Analysis Date: 4142005 5:22:37 AM Speed: 30 mmis

Calibration Date: 10113704 Width: 100

Technologist: T™MD Host/Scanner: 4.0.062.3.1

Physician: Analysis/Revision: 400
Detailed Results

NORLANG.

Figure 8-6: Page 2 of the Bone Exam Report

Operator's Guide
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CHAPTER9

Scanning Whole Body

Note: The Whole Body Scanning feature is available as an option with the
Bone Densitometer. Be aware that your system might not have this option.

The Whole Body scan option quantifies bone mineral for a subject’s entire body. The
analysis will present the Bone Mineral Content (BMC) in grams, Bone Mineral Density
(BMD) in g/lcm2, and AREA in cm?2, for the total body as well as the head, trunk, abdo-
men, arms, legs, and operator-defined regions of interest.

The Whole Body scan requires the operator to mark the start and baseline points. Intel-
ligent scanning (i.e. scanning body edge to body edge) is used to minimize scan time
and to ensure the scan automatically stops after scanning the patient’s feet.

Figure 9-1: Patient Positioning for the Whole Body Scan

This chapter discusses the following.

Scan Specifications ... ... .. oL 9-2
Maintaining High Quality Whole Body Scans ... ... ... ... .. iiiiiiiii .. 9-3
General Patient Scanning Cautions ... ... 94
Quick Reference - Whole Body Scan ... ... ... 9-5
Scan Procedures . 9-6
Analyzingthe Scan ...l 9-15
Viewing the ScanResults Tab ... ... .. L 9-18
Generate and Print @ Report ... .. . 9-20
A Sample Bone Exam Report . ... ... L 9-22
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9-2 Scanning Whole Body

Scan Specifications
Detailed specifications for the Whole Body scan are in the following tables.

Table 9-1: Whole Body Scan Specifications

Scan Site Entire Body

Accuracya Typically within 2.0% of industry standard

In vivo Precisionb | See Table 9-2 below

Table 9-2: Whole Body Scan In vivo Precision - Scanners with Dynamic Filtration

Resolution,
Scan Speed Head | Trunk | Abdomen | Arms | Legs | Total
6.5x 13.0mm | BMCC.V. [1.5% |1.2% |2.3% 1.8% | 1.1% | 0.67%
260mm/sec
BMDC.V. |1.6% [21% |2.3% 1.6% | 1.3% | 0.78%
AREAC.V. [1.2% | 1.4% | 2% 1.6% | 1.0% | 0.66%
*** All specifications are subject to change without notice. ***

Patient Dose

Note: The radiation dose to the patient is dependent on the resolution, filtration, the scan speed used,
and the system configuration. Dose values listed below are for any patient thickness.

Table 9-3: Whole Body Scan Skin Entrance Dose
Resolution | Scan Speed | Patient Dose (uSv)

6.5x 13.0mm | 260mm/sec 0.2
130mm/sec | 0.4
4.5x9.0mm | 260mm/sec | 0.3
130mm/sec | 0.5
2.8x7.8mm | 200mm/sec | 0.5
100mm/sec | 0.9

Operator Dose

Note: The dose to the operator is negligible. During a scan, the radiation level at a distance of one
meter from the scanner table is less than 1.0 microsieverts per hour.

8Based on Standard Speed Scans of an anthropomorphic phantom.
bBased upon 14 subjects, 3 scans each, using standard procedures.
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Maintaining High Quality Whole Body Scans

Patient positioning, scan and analysis techniques can influence the precision and accuracy of Bone Density
estimations. Facilities can reduce the adverse effects of some of these factors by:

»

»
»

»

»

»
»
»
»
»

Performing and monitoring the daily QA procedure to verify that other radiation sources (X-ray machines, nuc-
learimagers) are not affecting the performance of the Norland system. The daily QA procedure verifies
proper operation as well.

Ensuring that all operators position patients and analyze data in the same manner.

Screening patients for recent radionuclide uptake procedures. Residual emission may be misinterpreted by
Norland Bone Densitometers as x-rays.

Screening patients for recent ingestion of radiopaque substances. Barium or other dyes used in some x-ray
procedures could result in increased soft tissue x-ray absorption.

Screening patients for prosthetic devices, implants, surgical staples, or other high density sub-dermal mater-
ials that may affect density estimates.

Ensuring that scan and analysis parameters remain constant for all scans of the same patient.
Ensuring all jewelry, eye glasses, belts, and other high density objects are removed from the patient.
Ensuring all body parts are within the scan area.

Advise the patient to breath normally and do not move during the scan.

Consistent Whole Body cursor placement is critical for producing consistent analysis results.

Figure 9-2: Example of a Good Quality Whole Body Scan (Bone, Composite, % Lean, and % Fat images)
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94 Scanning Whole Body

General Patient Scanning Cautions

Caution: Properly Mark the Patient. To ensure scanner arm does not contact the patient, always
verify patient is positioned properly before scanning or moving the scanner arm.

Caution: Do not move the patient while marking the regions to be scanned. Always remain near the
patient, in the event assistance is needed.

Caution: Do not touch the patient and the computer system at the same time as this could increase
leakage currents.

Caution: Do not reach around to the back of the unit while the scanner arm is moving. While guards
are provided, it is wise to avoid any chance of pinching the arm, hand, or fingers between the scanner
arm and the frame, or between the source and the scanner arm.

Caution: Do not allow the patient to bump, push, or lean on the scanner arm. Manually moving the
arm could result in an error message which will require removing the patient from the table and doing
the Find Table Dimensions routine.

Caution: Make certain the patient does not dangle their arm or hand over the riser while the scanner
arm is moving during a scan. The scan will not be usable, as the patient will not be properly positioned,
and the patient may be at risk of pinching their hand or finger between the scanner arm and the riser or
between the x-ray source and the scanner arm.

Caution: Make certain the patient does not stick a finger into the slot in the bottom of the upper arm
cover during a scan; it could be pinched.

Caution: When positioning the patient, ensure they start by sitting near the center of the table and
then swing their legs up. Sitting at either end makes positioning awkward.

Caution: Caution the patient to remain still during the scan to ensure quality results.

Caution: Help the patient up from the scanner after scan data collection; some patients may require a
few minutes to regain equilibrium after lying down for a length of time.

SINESISIESR S SESESS
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Quick Reference - Whole Body Scan

The Whole Body scan procedures take measurements from the entire body and present BMC, BMD and Area
for the total body as well as the head, trunk, abdomen, arms, and legs.

» Screen patient for contraindications.

» Inthe Database Navigator window, click on the existing patient’s name, then click OR click

Mew Patient »»

to start a new record.
» Update (or enter) the patient’'s Demographic information.

» Click 5| Click the Whole Body button. Click L2 | Check the parameters.

» Have the patient lie on the table, face up with the head oriented to the right side of the table, (operator facing
the table).

L% Caution: Caution the patient not to stare into the beam. ]

» Click in the Parameters tab window.

» MARKING THE START POINT: Turn ON the laser. Position the laser dot 1-cm above the top of the center

".-m\nx D |
of the patient’s head, and press the button on the Scanner Arm Touch Pad.
» MARKING THE END POINT: Move the scanner arm over the patients abdomen. Turn ON the laser. Pos-
ition the laser dot at a point on the abdomen adjacent to the spine and midway between the lowest rib and the

F I;Anx_-x
iliac crest. Mark in an area of maximum soft tissue and no bone. Press the - button.

» Click to begin the Measure Scan.
» If the scan is satisfactory, click .

» If you are done scanning, assist the patient up from the table.

» Position the top edge of the chest cursor to just under the chin. Position the upper control points above the
junctions of the humerus and scapula. Position the bottom control points between the arms and torso to
include the rib cage.

» Position the pelvic cursor to encompass the pelvis, yet containing a minimum of midriff, leg, and femoral
neck tissue. Place the upper control points between the arms and torso.

» Position the leg cursors so that both legs are encompassed, and the centerline separates the legs.

" . Conti

» Once the cursors are positioned, click .

» Cliok_=2_]

» Click to print a Report (or click to end the process and return to the main win-

dow).

]
» Cllck‘ i ‘ = andthenl__="" |
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9-6 Scanning Whole Body

Scan Procedures
Checklist

You are almost ready to begin scanning. Confirm that the following tasks have been completed:
» the system is running (see "Powering Up the System " on page 4-3)

» the System Calibrations are done (see "Daily Calibration Procedure" on page 4-6)

» the Database Navigator window is open (Figure 4-3: on page 4-5)

Preparing the Patient for Scanning

Ensure that the patient has removed all items from their pockets and that clothing is free of metal (i.e. rivets, but-
tons, zippers) or anything else that might be of a high density. It might be necessary to have the patient change
to an examination gown or robe. Shoes should also be removed.

1 Caution: Do not scan patients that may be pregnant or have had a recent radionuclide uptake pro-
cedure.

Update (or Create) the Patient’s Record

EXISTING PATIENT: From the Database Navigator window, double-click on the existing patient’s name to
open the patient’s record. Update the patient’s information. (If necessary, refer to "Enter Data into the Existing
Patient’s Record" on page 4-24 for instructions.)

You are now ready to begin the scan process.
Proceed with "Setting the Scan Parameters" on page 5-8 to continue.

NEW PATIENT: From the Database Navigator window, click on to start a new record. Enter all
the patient information. (If necessary, refer to "Preparing Patient Records" on page 4-21 for instructions.)

You are now ready to begin the scan process.
Proceed with "Setting the Scan Parameters" on page 5-8 to continue.
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Setting the Scan Parameters

1. Click " |

2. Click Whole Body in the pop-up window.

Pl seiec scon e

AP Spine " Left Hip & Whole Body

¢ Lateral Spine ¢ Right Forearm  Research

° Right Hip " Left Forearm  Small Subject

OK | Cancel |

Click &

4. The Parameters tab window opens.

w

Padant Summarny
a5 Wk Patient Positioning, Whole Body Scan
Ty — Positioning the patient for 2 Whole Body scan is quite simple. There are no special positioesng aids required, however, care must be taken to ensare
Technclogat ey x that positioning can be easly repeated for subsequent seans
Lt d 1. Using the Scanner Arm Touch Pad, position the scamer arm at the foot of the table
e 2. Have the patient bie on the table, face up with the head oriested to the right side of the table {operater facing the rakle).
inar
AnodeVokege FVL| 100 Cusentimdl| 13
Estenaled Scannng Tre Prcd MM 53] | DIEOD
Sean Type
MWurberolSens |1 [ Mah. |
[prrn =
3 Center the patient on the table
| %
Scout Scan | Measure Scan 4 -
Speed, Resalution | 6.5% 10082600 4. Place the arms at the sides of the patient and the feet 1gether
Imw(ulll | oo
Datnin | Cancel |
cdmivéstratcs [ Mepon Template: Done Exam Report - 1 pege  |Scanmer Present

Figure 9-3: The Whole Body Scan Parameters tab window

5. The scan parameters are shown in the bottom left hand side of the Parameters tab window, and reproduced
here for reference. Norland recommends that the factory default parameter settings be used for scanning.
The default values are shown below.
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Scanning Whole Body

Measure Scan |
Speed/Resolution | 6.5% 13.0 @ 260 |

G 0 @ 2ol
6.5% 13.0 @ 130
Length (cm) 4,5% 9,0 @ 260
4.5% 5.0 @ 130
28X 7.8 @200
2.3X 7.8 @ 100

» Toreset values to factory defaults, see "Preferences: Whole Body Scan" on page 3-26.

» For a full explanation of the Whole Body Scan parameters (i.e. preferences) see "Preferences: Whole Body

Scan" on page 3-26.

» Ifitis necessary to change the Speed/Resolution parameter, see "Changing the Scan Parameters Prior to

Scanning" on page 12-77.

6. Proceed to "Positioning the Patient" on the facing page to continue.

NORLANLD
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Scanning Whole Body 99

Positioning the Patient

Positioning the patient for a Whole Body scan is quite simple. There are no special positioning aids required,
however, care must taken to ensure that positioning can be easily repeated for subsequent scans.

Refer to the patient positioning photos and instructions in the Norland software (Parameters tab window). The
steps and photos are reprinted in the manual for reference.
1. Using the Scanner Arm Touch Pad, position the scanner arm at the foot of the table.

2. Have the patient lie on the table, face up with the head oriented to the right side of the table, (operator facing
the table).

3. Center the patient on the table.

4. Place the arms at the sides of the patient and the feet together.

D10 Fev 2 NORLANLG



9-10 Scanning Whole Body

5. Use velcro straps, tape, or a sheet to secure the hands and feet so that patient movement is kept to a min-
imum.

@ Caution: Caution the patient not to stare into the beam. ]

6. Turn ON the laser by pressing

7. Move the scanner arm around the penmeter of the table, using the laser positioning dot to make sure that the
patient is within the scan window.

Laser Positioning Dot

8. The patient is now ready for scanning.

9. Make the patient as comfortable as possible since movement during the scan will affect the results. The use
of a sheet or light blanket will not interfere with scan results. Do not use a pillow under the patient’s head.
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Marking the Scan Region

1. Click in the Parameters tab window to open the dialog box.

| F7] Mark Whole Body Scan Region

Pozition the patient on the scan table.
Switch on the laser marker.

m Mark Point 1cm above top of Head

W Mark the Soft Tigsue Point (in abdomen adjacent
to spine)

Frevious Step

2. A Ensure that the laseris OFF, move the scanner arm above the patient’s head.

L% Caution: Caution the patient not to stare into the beam. ]

Press to turn the laser ON.
4. MARKING THE START POINT: move the scanner arm until the laser positioning dot is approximately 1-cm

MARK 2|

w

above the top of the center of the patient’s head and press . (The computer will emit a sound,

and the laser will tum OFF.)

Laser Positioning Dot
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9-12 Scanning Whole Body

-
Note: Click W] in the dialog box to re-mark the start point. Click at any time to

abort the marking operation.

5. MARKING THE END POINT: move the scanner arm over the patient’s abdomen.

6. Press to turn the laser ON.
7. Position the scanner arm so that the laser positioning dot is at a point on the abdomen adjacent to the spine
and midway between the lowest rib and the iliac crest (see figure below). This is the area of maximum soft

o
tissue thickness. Press the button.

8. The computer will emit a sound, and the laser will shut OFF.
9. The dialog box will automatically close when the marking tasks are complete.

NORLANLDO B3D109 Rov-7
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Starting the Measure Scan
Caution the patient to remain still.

Remember, press the HALT button on the Scanner Arm Touch Pad to immediately terminate
the x-ray exposure or stop the scanner arm movement. Refer to "Pressing the Halt Button" on
page 12-37 for instructions on safely resuming the scan.

. Start 5
1. cliok[ 2250 |

2. The Scan tab window displays the image as it develops, shows how many lines will be scanned and gives

an estimate of the total time remaining in the Measure scan.

73 Muminatus DA 454 =
ton  Tools

Fahent Body. Wk
DF Body
Segmert  Measure Scan

Fanginfton |

Administrator

3. Monitor the image closely for any indication of patient movement. Cancel the scan immediately if the patient
moves during the scan.

Note: To cancel the scan: Click .

clickL_E%® | geject| Lieer |inthedialogbox.CIick.

Click [25™2%M > | Click ___2=">> ‘SelectWhoIeBodx.

Return to "Marking the Scan Region" on page 9-11 to continue.
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4. When the Measure Scan is complete, the computer will emit a sound. The software will update the Scan tab
window and the Analyze button will become available.

73 Muminatus DA 454 =
 Filg - Edit Tools  Hel

Fahent Body. Wk
DF Body
Segmert  Scan Completn

farginiieg |

Withjem B4

| | Lengthierd 7554

Tokal k (I
Cusrest Segment (MM 551 (E]

Frogoss

exhibited, proceed to Step 8.

7. IF THE IMAGE QUALITY IS UNSATISFACTORY, do one of the following:

» Enter the appropriate number of scan lines in “Extension (# of lines)” and click toinclude the

entire region of interest.

Determine if the quality of the Measure Scan image is satisfactory or unsatisfactory.
IF THE IMAGE QUALITY IS SATISFACTORY, and no evidence of patient movement during the scan is

» OR click and remark the scan region (see "Marking the Scan Region" on page 9-11).

arm will not impede the patient's ability to sit up.

If no further scans are to be performed, help the patient up from the scanner table. Make sure the scanner

down for a length of time.

A

Caution: Remember that some patients may require a few minutes to regain equilibrium after lying

NORLANLD,
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Analyzing the Scan

At this point, the operator can analyze the scan later, or analyze the scan now.

ANALYZE LATER: Click to end the scan process and analyze the scan later. The scan data will
be saved 1o the database for analysis at a later time. The software will go back to the Parameter tab window.

You can do another type of scan, if desired.
OR ANALYZE NOW . ..

1. k2=

2. When the Analysis tab window opens, cursors will be displayed in the regions of interest: the chest, pelvic

area, and each leg.

E llluminatusDXA 4.7.3: Whole Body scan : 3/21/1997
File Edit Calibration Teols Help
Analysis I

Patient: [Whale Body scan

Regions

Region |Length (cm) |width (cm) |~
=

Total pa— a—

Head
Chest
Midriff

User Defined Region

[4Sides / Corner Control <] Continue
Tt

Include/Exclude

Progress

Click and hold on the control points to move.

Click on regien to select.

Current Image: Sqrt Composite

F Cancel

Administrator 1 Report Template: Bady Composition Report Large  |Scanner Not Present

cursor positioning. See "Comparison Image" on page 12-54.

(.

Note: If this scan is not the initial scan, use the Show Comparison function to aid in matching the

3. Click and drag to position the chest cursor around the chest. Position the upper cursor points above the junc-

tions of the left and right humerus and scapula, at the bottom of the chin. Position the bottom cursor points
between the arms and torso, with the bottom edge barely enclosing the rib cage.

Operator's Guide
435D109 Rev. Z
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9-16 Scanning Whole Body

4. Position the pelvic cursor next. Move the upper control points to just above the iliac crests, between the arm
and torso. Position the bottom left pelvic cursor so that the left cursor edge passes through the femoral neck
and is close to the pelvis, and the bottom edge of the pelvic cursor is just below the pubic symphysis. Pos-
ition the bottom right cursor similarly on the opposite side. Make sure the trapezoid is set to enclose the pel-
vis.

5. If positioned correctly, the pelvic cursor will completely surround the pelvis and contain a minimum of midriff,
leg, and femoral neck tissue.

L 2

6. Position the lower left leg and right leg cursors so that the legs are fully enclosed in the regions. The bottom
edge should be below the toes. Position the center cursor so that it separates the left and right leg.

Note: Consistent Whole Body cursor placement is critical for producing consistent analysis results. ]

The regions of interest are defined graphically in Figure 9-4.
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Figure 9-4: Regions of Interest, Whole Body Scan

7. Click . The Results button will become available.

9-17

E llluminatusDXA 4.7.3: Whole Body scan : 3/21/1997
File Edit Calibration Teols Help
Ana\ys\sl

Patient: [Whale Body scan

Regions

Region |Length (cm) |width (cm) |~

Total pranes xerr

Head =~ w=e== s=sse
Chest

Midiff e "

User Defined Region

[4'Sides / Corner Control ~|  Continue
RegionName |

|
Include/Exclude

Progress

Click and hold on the control points to move.

Click on regien to select,

Current Image: Sqrt Composite

Cancel

Report Template: Body Composition Report Large  Scanner Not Present

| Administrator 1

Operator's Guide
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9-18 Scanning Whole Body

Viewing the Scan Results Tab
1. Click . The Scan Results tab window opens.
2

View the image to ensure that cursors are positioned correctly and analysis results are satisfactory.

3. The scanimage, trending graphs, results for Total Body will be displayed in the Results tab. The Total BMD
(in g/cm2) and the Total BMC (in grams) will be displayed below the trending graph.

The BMD, BMC, and AREA (in cm2) for Total and each region of interest analyzed will also be displayed.

If Soft Tissue Composition is enabled, the Whole Body regions Total Fat %, Siri UWE Fat %, Brozek
UWE Fat %, Soft Tissue Fat %, and % TBMC/FFM will also be displayed for the Total region. Lean Mass
and Fat Mass will be displayed for all regions of interest. (Be aware your system may not have the Soft Tis-
sue Composition option.)

File Edit Calibration Tools Help
Scan Results I

Mo Reference Data Available

Mo Trending Data &vailable

Bor is
DF Body  1TJUN 2015 11:37 Scan Speed: 260mm/s Resolution: 9.0mm x 4.5mm  STD CV: Total BMC=0.9, Lean=0.93, Fat=1.4; See Guide for other C¥s.  Cunent Image: Sait Composite

Fiegion [ %[ BMD (g/cr?) | BMC(a) | Area (om?) | Length (om) | Width fom) [ Lean Mass (g) | FatMass ()| T-Score | YounaFief ()] Z-5core | Age Match %] | ST Change (%) ST Changs (4] | LT Changs ()| LTCF «
Total Fat % B2 e e
Sl IWE Fal % % 2 T

Brozek UWE Fatz 166

Soft Tissue Fat % 16.7

% TBMC/FFM 32

< T b

Cancel Save

| Administrator Report Template: Bone Exam Report - 1 page Scanner Present

6. Click to save the Scan Results.

» Click to generate and print a regon using the current default report template. Proceed to Step 5
of "Generate and Print a Report" on page 9-20.

I H

» orclick to generate and print a report using a report template other than the default. Proceed to
"Generate and Print a Report" on page 9-20.

NORLANLD, 535109 Rev- 7



Scanning Whole Body 9-19

. 8] hics >
» orclick to do another scan.
. <4 Patient Lizt . .
» orclick to end the process and return to the main window.
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Generate and Print a Report

Seven different types of Reports can be generated for each scan: the Body Composition Report, the Body Com-
position Report - 1 Page, the Bone Exam Report, the Bone Exam Report - 1 Page, the Combined Report, the
Patient Letter, and the Referral Letter. When saved, these reports become part of the scan data.

These procedures use the Bone Exam Report - 1 Page for the example.

1. Make sure that the scanned image is being viewed as a thumbnail in the Stamp View or the Filmstrip View.
Click (to highlight) the thumbnail view of the scan.

2. Click Tools > Report > Select Template... or click the M button to open the “Report Con-
figuration” dialog box.

Fir Edi Caleratien (Took | Help

File Tack
Calibration Detaibs
Send To '

g
Report , Gemerate Mew
Audin Dictadion Firush Eaist

Lag Filies '

3. When the Report Configuration dialog box opens, click a Report Template to highlight it (Bone Exam

Report - 1 Page was selected here). See "Sample Scan Reports" on page 2-17 for examples of the report

template selections. Click Dene

Report Configuration

Choose a Default Report Template

Buone Exam Report - 1 pags j Done
Bone Exam Report

Combined Report

Patient Letter

Referral Letter

Ten Year Fracture Risk Report

@ Note: The selected Report Template will remain the default until it is changed. The currently selected
Report Template is always displayed at the bottom of the IlluminatusDXA window.

4. Click Tools > Report > Generate New or click the button.

File Edit Calibration [Tools| Help

Initialize Scanner

Service Tools 3
File Tools

Calibration Details

Send To: >

DICOM Interface

Mail /
Report > enerate New

Audio Dictation Finis|

ting/Make Addendum

View Selected

Log Files »

Scan Quality Issues Editor

Recommendations Editor

Select Template...
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5. The Report is immediately generated and opens up in the window, as shown. At this point, the operator can
type in their comments and recommendations, Lock it, Saveit, Printit, Exportit to a PDF file (ora DICOM
file) and Closeit.

.| Report Type: Bone Exam Report - 1 page - 6/1/2015 - Creating New

File

Name: Whole Body, Example Sex: Male Height: &7
1D: M3 Ethnic: Caucasian Weight: 170
poB: SZRMETE Age: 33 years

H Whole Body on: 5/11/2012 3:02:00 PM

Total

Region kT
Total Fat 242 I
0.95) -
1618 20 2224 26 28 30 32 34 Siri UWE Fat 193
AGE
Brozek UWE Fat 193
Date  Yahe Soft TissueFat 252
11/12/10 1.013
04/17/09 1.033 TBEMCFFM 5.1
10V11/04 0.999
090795 0.963
Bons image not for diagnosis.
1 1 o _-- Fat S Asrs T i LT .
Region DMD BMC Aea Leasth Width Llea (i T- o Yows  Zo o F g ST Chanss oo LT Chanse

@) @ () (m) (em) M@ C2F Seors Ref(%) Seers OO oy (Bhiye) povs (Biye)

-

Save | Print | EgpnrtPDFl ExpurtDICOMl Close |

6. Click . The “Print” window appears. Select a printer, select which pages to print and choose how
many copies to print.

7. Click to print the Report. The Report is automatically saved and printed.
cliek 2]

You are returned to the Filmstrip view screen. The saved Report can be found under the “Reports” tab. The

Report can be viewed, modified and reprinted at any time. See "The “Reports” Tab" on page 2-14 for more
information.

© x©
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A sample 2-page Bone Exam Report is included here for reference.
:’;‘"”15 12:41:08 Norland at Swissray Page 1
W6340 Hackbarth Road Fort Atkinson, WI 53538 USA (888) 741-0413
Name: ‘Whole Body, Example Sex: Male Height: &7
1D: 313 Ethnic: Caucasian Weight: 170
DoB: /2911978 Age: 33 years
H Whole Body on: 51112012 3:02:00 PM
Total
1.05
10— b8
10 .
2 059 ' Region %
D .97 Total Fat 242
0.95t )
161820222426 28 30 32 34 Siri UWE Fat 19.5
AGE
Brozek UWE Fat  19.3
Date;  Yales Soft Tissue Fat 252
1712710 1013 )
(41709 1.033 TBMC/FFM 31
11104 0,999
D9/07/95 0,963
Bone image not for di
Regi BMD BMC  Area  Length Width Lean  Fat Mass  T- Young Z- \.{afch ST Change ST Change (‘hLT LT Change
SO gemd) (@) (em®  (em) (em)}  Mass(g) (g} Score  Ref (%) Score ‘:G: (%) (%iyr) 3 [;,:fc (%alye)
Total 1036 3049 2943 S6RE0 19126 #%*ss  wsssd skkes Sess 23 1:5 7.5 035
STD CV: Total BMC=0.9, Lean=0.93, Fai=1.4; See Guide for other CVs.
6.5 mm X 13.0 mm, 260 mm/s, 66.95 cm, Rev. 4.4.0/2.3.1 Calib. 05/11/12 SIN 8500
Comments:
Sin UWE Fat Table
18
@
o [20-39] i
< [40-59 ._
G108 — _
0 5 10 15 20 25 30 35 40 45
Siri UWE Fat %

Figure 9-5: Page 1 of the Bone Exam Report
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5/20/2015 12:41:08

Norland at Swissray

Page 2

11/12/10 2972
O/ 17705 30010
1071104 2941
09/07/95 2791

112710 26,14
0417009 25 53
L1104 1951
GH0T95 18.30

11/12/10 5,051
O4/17/09 5,128
o4 5267
(RHO7/95 5,348

PM
W6340 Hackbarth Road Fort Atkinson, Wi 53538 USA (888) 741-0413
Name Whele Body, Example ] 33
dress Ethnic Caucasian
M DoB 9/20/1978
Telephone Age 33 years
History Meno Year
Treatment Sex Male
Medications Height 67
Comments Weight 170
Scan Information
Scan Type: Whole Body Resolution: 130265
Analysis Date: 411372012 5:17:59 PM Speed: 260 mm/s
Calibration Date: sz Width: &7.0
Technologist: P.F. Brown, RT Host/Scanner: 4400231
Physician: Dr. J. Hibbert, MD Analysis/Revision: 440
—Detailed Resulls
R BMD BMC Ara Length Width  Lean ,j‘“ T-  Youg M"*‘I"‘h ChST ST Change “]'“T LT Change
g {glem?®) (g} {em®) {em) fem)  Mass (g) ‘;:s Score  Ref (%) Scorc [?}h'; E;::;c {%alyr) ' :;:’gc {%alyT)
Head 1.893 4839 25356 2774 1420 ey LR 1] aEEEE aEEEw aEEw LT (LT ThEE
Chest 09724 6327 6506 14767  S64R  *eeer  swees wsesk ssess wraan CEEEE L rEhEE
Midriff 1273 4464 3507 3259 1507 *eer  weaws  sesen  assee PrPT PPOT P seene
Pelvis 1,255 3397 2707 BI20 3049 *Kess wwese ssess sssss ssses senes FTYT
|i.-cl'l 1073 S§7.7 5199 10591 IRE seREE weeks seees seess seann ahREn FhaEE T
cg
Right
1064 5247 4932 10297 FERG  HEEEE KRR kEEEs AEsEs wses ELETTY LT LR
Leg
Left 3 e . srenn
s 1.6752 2545 3770 3847 1424 *evEn itk o A ol o b b ot
Right 0.6216 211.6 340.5 3224 1305 woehan okt ke e Ehonay
Arm
Total Total
R e g ERA 5.44
. o 2 .‘.’c =
= 24 1 ts' T
225 O 524 .
< 20s R
o sy B T i
185 #c4 dh A
; 2 e
1618202224 2626 3032 34 161820222426 283032 34 16182022242628303234
AGE AGE AGE
Daie Value Date Value Daie Value

NORLANG

Figure 9-6: Page 2 of the Bone Exam Report
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Research & Small Subject Scan

Note: The Research Scan and Small Subject Scan features are available as
options with the Bone Densitometer. Be aware that your system might not
have either of these options.

The Research Scan software quantifies bone mineral in any user-defined region of a
patient or subject anywhere within the scanner’s active scanning area. The subject of
a Research scan could be human, animal, or an inanimate object. The Research Scan
is typically used for animal scans, anything from excised bones to whole body large
rats to implants.

Figure 10-1: An example Research Scan image of the top view of a vertebra

This chapter discusses the following.

CHAPTER 10

Introduction .. 10-2
Scan SpecifiCations ... .. .. . 10-2
Maintaining High Quality Research Scans ... .. .............................. 104
General Patient Scanning Cautions ... ... 10-5
Quick Reference Guide - Research/Small Subject ... ... ...................... 10-6
Scan Procedures . 10-7
Analyzingthe Scan ... .. 10-16
Viewing the Scan Results Tab ... ... L 10-18
Generate and Print a Report ... ... 10-20
A Sample Bone Exam Report-1Page ... ... ... ... 10-22
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Introduction

The Research scan consists of a Measure scan over an area defined by the operator. An optional Scout scan is
available to assist the operator in defining the scan region. Analysis is performed on the scan data using oper-
ator-defined regions of interest and numeric results are calculated and displayed.

The operator has the capability of adjusting the start and end points of the Scout and Measure scans. Other
adjustable parameters are the scan speed, scan resolution, and scan width.

Scan Specifications

Detailed specifications for the Research and Small Subject scans are in the following tables.

Table 10-1: Research/Small Subject Scan Specifications

Scan Site Any operator-defined region within the
scanner Active Scanning Window
Scan Speed 1.0mm/sec to 260mm/sec
Scan Width 2 x selected pixel size up to maximum scan width
Scan Length 2 x selected pixel size up to maximum scan length

Spatial Resolution | See table below

Table 10-2: Research/Small Subject Scan
Spatial Resolution

Point Resolution x
Line Spacing

Scout Scan 1.0x1.0mm | 1.5x 1.5mm
1.0x2.0mm | 3.0x 3.0mm
1.0x 3.0mm | 6.0x 6.0mm

Measure Scan | 0.5x 0.5mm | 3.0 x 3.0mm
1.0x 1.0mm | 6.0 x 6.0mm
1.5x 1.5mm

Table 10-3: Bone Threshold Values
Bone Threshold is 0.125 g/cm2 for Research Scan

Bone Threshold is 0.04 g/cm2 for Small Subject Scan

Note: All specifications are subject to change without notice. ]
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Patient Dose

Note: The radiation dose to the subject is dependent on the resolution, filtration, and the scan speed
used. Dose values listed below are based on the default scan parameters.

Table 10-4: Scout Scan Skin Entrance Dose (uSv)
(60mm/sec at 3.0mm x 3.0mm resolution)

Subject Thickness (cm) Entrance Dose (uSv)

0-3 0.4
4-6 0.6
7-9 0.9

10-12 1.2

13-15 2.2

16-18 3.7

19-21 6.9
>21 11.0

Table 10-5: Measure Scan Skin Entrance Dose (uSv)
(60mm/sec at 1.0mm x 1.0mm resolution)

Subject Thickness (cm) Entrance Dose (uSv)

0-3 1.3
4-6 1.8
7-9 2.7

10-12 3.3

13-15 6.3

16-18 11.0

19-21 20.0
>21 31.0

Operator Dose

Note: The dose to the operator is negligible. During a scan, the radiation level at a distance of one
meter from the scanner table is less than 1.0 microsieverts per hour.
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104 Research & Small Subject Scan

Maintaining High Quality Research Scans

Variations in subject and positioning, scan and analysis techniques can influence the precision and accuracy of
Bone Density estimations. Facilities can reduce the adverse effects of some of these factors by:

»  Performing and monitoring the daily QA procedure to verify that other radiation sources (x-ray machines, nuc-
learimagers) are not affecting the performance of the Norland system. The daily QA procedure verifies
proper operation as well.

» Ensuring that all operators position patients/subjects and analyze data in the same manner.

» Screening patients/subjects for recent radionuclide uptake procedures. Residual emission may be mis-
interpreted by Norland Bone Densitometers as x-rays.

» Screening patients/subjects for recent ingestion of radiopaque substances. Barium or other dyes used in
some x-ray procedures could result in increased soft tissue x-ray absorption.

» Screening patients/subjects for prosthetic devices, implants, surgical staples, or other high density sub-
dermal materials that may affect bone density estimates.

» Ensuring that patients/subjects contain no metal objects or other high density objects that might affect bone
density estimations.

» Ensuring that scan and analysis parameters remain constant for all scans of the same patient or subject.
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General Patient Scanning Cautions

Caution: Properly Mark the Patient. To ensure scanner arm does not contact the patient, always
verify patient is positioned properly before scanning or moving the scanner arm.

Caution: Do not move the patient while marking the regions to be scanned. Always remain near the
patient, in the event assistance is needed.

Caution: Do not touch the patient and the computer system at the same time as this could increase
leakage currents.

Caution: Do not reach around to the back of the unit while the scanner arm is moving. While guards
are provided, it is wise to avoid any chance of pinching the arm, hand, or fingers between the scanner
arm and the frame, or between the source and the scanner arm.

Caution: Do not allow the patient to bump, push, or lean on the scanner arm. Manually moving the
arm could result in an error message which will require removing the patient from the table and doing
the Find Table Dimensions routine.

Caution: Make certain the patient does not dangle their arm or hand over the riser while the scanner
arm is moving during a scan. The scan will not be usable, as the patient will not be properly positioned,
and the patient may be at risk of pinching their hand or finger between the scanner arm and the riser or
between the x-ray source and the scanner arm.

Caution: Make certain the patient does not stick a finger into the slot in the bottom of the upper arm
cover during a scan; it could be pinched.

Caution: When positioning the patient, ensure they start by sitting near the center of the table and
then swing their legs up. Sitting at either end makes positioning awkward.

Caution: Caution the patient to remain still during the scan to ensure quality results.

Caution: Help the patient up from the scanner after scan data collection; some patients may require a
few minutes to regain equilibrium after lying down for a length of time.

SINESISIESR S SESESS
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Research & Small Subject Scan

Quick Reference Guide - Research/Small Subject

The Research Scan feature quantifies bone mineral in any specially-defined region of a patient or subject any-
where within the scanner’s active scanning area.

»

»

»

»
»

Screen patient for contraindications.

In the Database Navigator window, click on the existing patient’s name, then click OR click

Mew Patient »»

to start a new record.
Update (or enter) the patient’s Demographic information.

Click ___**">>__| Click the Research or Small Subject button. Click L_2* | Check the parameters.

Position the patient/subject on the table.

L% Caution: Caution the patient not to stare into the beam. ]

»
»

»
»

»
»

»

»
»

»

»

»

»

Click Mark... in the Parameters tab window.

MARKING THE START POINT: Turn ON the laser. Position the laser dot at the start point and then press

MAR;.'X
the button on the Scanner Arm Touch Pad.

MAR;.'X
MARKING THE END POINT: Position the laser dot at the end point and press the button.
MARKING THE BASELINE POINT: Position the scanner arm so that the laser positioning dot is over a
point (within the start and end points) of maximum soft tissue (no bone). For objects which contain no soft tis-

m\nx- .->1
sue, take a baseline point in table adjacent to object. Press the - button.

Start Scan

Click to perform the Scout Scan.
Use the click and drag method to move the cursor box to define the area to be measured.

Click on and define the regions of interest.

If the scan is satisfactory, click .

Define the regions of interest with the Special Regions option.

click == |
(Cj)licl)< to print a Report (or click to end the process and return to the main win-
ow).

Click‘ Save H Erint |andthen.
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Scan Procedures
Checklist

You are almost ready to begin scanning. Confirm that the following tasks have been completed:
» the system is running (see "Powering Up the System " on page 4-3)

» the System Calibrations are done (see "Daily Calibration Procedure" on page 4-6)

» the Database Navigator window is open (Figure 4-3: on page 4-5)

Preparing the Patient for Scanning

When performing a Research scan on a human patient, confirm that the patient has been prepared for scanning.
Ensure that the patient has removed all items from pockets and that clothing is free of metal (i.e. rivets, but-
tons, zippers) or anything else that might be of a high density. It might be necessary to have the patient change
to an examination gown or robe. Shoes should also be removed.

Patients/subjects should be checked for any metal or high-density objects in the region of interest (ROI) that
would affect bone density estimations.

Update (or Create) the Patient’s Record

EXISTING PATIENT: From the Database Navigator window, double-click on the existing patient’s name to
open the patient’s record. Update the patient’s information. (If necessary, refer to "Enter Data into the Existing
Patient’s Record" on page 4-24 for instructions.)

You are now ready to begin the scan process.
Proceed with "Setting the Scan Parameters" on page 5-8 to continue.

NEW PATIENT: From the Database Navigator window, click on to start a new record. Enter all
the patient information. (If necessary, refer to "Preparing Patient Records" on page 4-21 for instructions.)

You are now ready to begin the scan process.
Proceed with "Setting the Scan Parameters" on page 5-8 to continue.
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Research & Small Subject Scan

Setting the Scan Parameters

[lluminatus software in Norland equipment can be fitted with Research and Small Subject Software that allows
the operator to scan an operator selected region for bone, lean or fat tissue. Research and Small Subject Soft-
ware differ from each other in bone edge detection software. Research Scan Software utilizes the same bone
edge detection software as other software in DXA and is recommended for animals over two kilograms or
human subjects over two years of age. Small Subject Software utilizes a fixed bone edge detection system that
will trigger at a much lower level and is recommended for children under two years of age and for animals
between two-hundred grams and two kilograms in weight. In most cases using Research and Small Subject
Software in these settings will effectively locate bone containing points and allow effective assessment of

bone, lean and fat tissue.

1. Click 4|5 >

2. Click Research or Small Subject in the pop-up window.

M Select Scan Type E| M Select Scan Type
= AP Spine " Left Hip T Whole Body AP Spine O Left Hip " Whole Body
" Lateral Spine ¢ Right Forearm & Research " Lateral Spine ¢ Right Forearm " Research

" Right Hip " Left Forearm " Small Subject " Right Hip © Left Farearm @« Small Subject
oK Cancel oK Cancel
or
. 8134
3. Click =

4. The Parameters tab window opens.

fde fdn Cabbration Took Help
Binsmens |
Potiont Rewmch. Groge
Patient Summiiy = S il
Heiht ke g the ject, Research and Small Subject Scans
Toul | Positioning is important in serial studies for consistent ceiensation of the scan area  Therefore, replicate the imimial subject posticning on all
“ subsequent scams of the same subject.
Py | -
bz = NOTE: To produce the highest accuracy, the entire intended RessarchiSmall Subject scan area must lie within the
= scanner's active scan area.
Seannar
ArcdeNohags BVE | 100 Cument lh} | 13 N .
SN LV R = 1. Position the patient ce subject as desiced
SoonTopn 2. Make bving subjects as comfortable as possible since movement during the scan will affect resuhs
T
Wenbes of Scane |1 2 Mok 3 The Research and Small Subject scan types &ffer from each other only intheir bone edge detection sysems
[T ) )
oo 4. The Rescarch scan type uses the same bone edge detection system a3 the other scan types (cxcept Small Subject) and is
recommended for animals over 2Ky and buman subsects over two years of age
5 The Seal Subject sean ype ties  fixed bone edge detection system that biggers at @ much liwer beved thin the other sean types
and is recommended for children under two years ef age and for amimals between 200pm and kg i weight
6 Tnmost cases, nsing these fwo scan Types a5 described sbove will effectively locane bone containing poines and allow effective
assessment of boae, lean and fat
‘Sout scan [ ieasure scan
Speed (mm/sec) [ 20.0 w0
Resolition (mm) 50x 10 0% 30
Width (cm) 0.8 .90
Lengthfom) 60 [
Force On ks | Elon
Hax Degrees | 15
ScwstScen “lon
[ r— oy
Ontousts Corcel |
| Adrministaston Report Ternplate: Gone Exaen Report « 1 page Scannes Prevert.

Figure 10-2: The Research Scan Parameters tab window
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Research & Small Subject Scan 109

5. The scan parameters are shown in the bottom left hand side of the Parameters tab window, and reproduced
here for reference. Norland recommends that the factory default parameter settings be used for scanning.
The default values are shown below.

Scout Scan |Measure Scan
Speed (mm,/sec) |60.0 A0.0
Resolution {mm) |3.0x 3.0 1.0x1.0
width {cm) 13.80 10,00
Length {cm) 0.0 0.0
Force On-Axis i
Max Degrees 15
Scout Scan 2
Scan Type Name Research

» Toreset values to factory defaults, see "Preferences: Research/Small Subject Scan" on page 3-28.

» For a full explanation of the Research and Small Subject Scan parameters (i.e. preferences) see "Prefer-
ences: Research/Small Subject Scan" on page 3-28.

» Ifitis necessary to change any of the parameters, see "Changing the Scan Parameters Prior to Scanning
on page 12-80.

6. Proceed to "Positioning the Patient/Subject " on the next page to continue.
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Positioning the Patient/Subject

Positioning is important in serial studies for consistent orientation of the scan area. Therefore, replicate the ini-
tial positioning on all subsequent scans of the same subject.

Note: To produce the highest accuracy, the entire intended Research/Small Subject scan area must
lie within the scanner’s active scan area.

Refer to the patient positioning photos and instructions in the Norland software (Parameters tab window). The
steps and photos are reprinted in the manual for reference.

Fde Edt Cabbration Teols Help
Panammeiras |
Pasiant Frmmch, Ginogn

Faiand Summan/ ® " P
Height Weidht Positioning the t'Subject, and Small Scans

Technogit [ =] irioning is important in serial studies for consistent orientation of the scan area.  Therefore, replicate the indial subject positioning on 3l
subsequent scans of the same subject.

NOTE: To produce the highest accuracy, the antire intended Ressarch/Small Subject scan area must lis within the

scanner’s active scan area.
Seannar

ArcdeNolage FVE| 10 Cusenlimhl| 13

g Scarring The PeicdMMSSE . (G500 1 Position the patient or subject as desired

Soan Type I Make bving subjects as as possihle since during the sean will affect resuhs
Murbes of Scorne. |1 . Mt | 3 The Retearch and Small Subject ecan types &ffer from each other only in their boe adge detection evetems
[Fpenaren =

4 The Research scan type wses the same bone edge detection svitem as the other scan types (except Small Subject) and 1
recommended for animals over 2kg and buman subjects over vwe years of age

S, The Seall Subject scan type uses a fixed bone edge detection system that riggers at a much krwer level than the other scan types
and is recommended for children under two years of age and for animals berveen 200gm and kg & weight

6 Inmos cases, uting these two scan types a5 described sbove will effectively locate bone containing points and allow effective
assessment of bone, bean and fat

Speed (mm/sec) (300 6.0

[Resohution (mm) | 20%310  30x 30

Width (om) B 990

Length fom} o0 00

| Force On-Ads | [Elon

HaxDegrees | 15

rr———

Sy Nawin

Orenay | | cwen | | | |

[ dministiater FRepent Template: Bone Exaen Report - 1 page Scannes Present

1. Position the patient or subject as desired.
2. Make living subjects as comfortable as possible since movement during the scan will affect the results.
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Marking the Scan Region

1. Click in the Parameters tab window to open the dialog box.

Mark Research/Small Subject Scan Region e e

Puazition the patient on the scan table.
Switch on the lazer marker.

W Maik the Start Paint

W Mark the End Poaint

W Mark the Baseline Paoint

2. Press to turn the laser ON.

¥ MARK |
3. MARKING THE START POINT: Move the scanner arm to the start point and press - (The com-
puter will emit a sound, and the Taser will flash.)

; MARK )|
4. MARKING THE END POINT: Move the scanner arm to the end point. Press the- button. (The
computer will emit a sound, and the laser will flash.)

5. MARKING THE BASELINE POINT: Position the scanner arm so that the laser positioning dot is over a
point (within the start and end points) of maximum soft tissue (no bone). For objects which contain no soft tis-

MARK |
sue, take a baseline point in the table adjacent to object. Press the - button. (The computer will
emit a sound, and the laser will flash.)

» If the Scout scan was enabled, these points are the start and end points of the Scout scan.

» If the Scout scan was disabled, these are the start and end points of the Measure scan.

» The Measure scan may be defined by the operator at the Scan tab window upon completion of the Scout
scan.

6. The dialog box will automatically close when the marking tasks are complete.
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Starting the Scout Scan

If applicable, caution the patient to remain still.

Remember, press the HALT button on the Scanner Arm Touch Pad to immediately terminate
the x-ray exposure or stop the scanner arm movement. Refer to "Pressing the Halt Button" on

page 12-37 for instructions on safely resuming the scan.

. Start 5
1. cliok[ 2250 |

2. The Scan tab window displays the image as it develops, shows how many lines will be scanned and gives

an estimate of the total time remaining in the Scout scan.

Widhfem] 1080
Lenghfem] |£10 S10p

Extrrscn (8 o inest |13

Administrator Fepunt Ternplate: Patient Letter Fuannes Prevent

3. Monitor the image closely for any indication of patient movement. Cancel the scan immediately if the patient
moves during the scan.

Note: To cancel the scan: Click . Click .
Select in the dialog box. Click .
Click . Click g Select Research or Small Subject.

Return to "Marking the Scan Region" on the previous page to continue.
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10-13

4. When the Scout Scan is complete, the computer will emit a sound. The software will update the Scan tab
window and the Measure Scan button will become available.

o
oreed
Argieidegt OnAws
Widhfem] | 360
Lenghfem] |£10

Scan Compiete

Extrrscn (8 o inest |13

[T

Repont Template: Patient Letter

Sannes Frevert

5. Using the click and drag method, move the cursor box to define the area to be measured.

6. If the Scout Scan image is satisfactory, proceed to "Starting the Measure Scan" on the next page to con-
tinue with the Measure Scan.

Operator's Guide
435D109 Rev. Z

NORLFANLO



10-14 Research & Small Subject Scan

Starting the Measure Scan

Remember, press the HALT button on the Scanner Arm Touch Pad to immediately terminate
the x-ray exposure or stop the scanner arm movement. Refer to "Pressing the Halt Button" on
page 12-37 for instructions on safely resuming the scan.

2. The Scan tab window displays the image as it develops, shows how many lines will be scanned and gives

an estimate of the total time remaining in the Measure scan.

Widhfem] |30
| | Lenghiem (820 S8

Extrrscn (8 o inest |13

Administraten

Flepurt Ternplate: Fatient Lester Scanne Prevert

3. Monitor the image closely for any indication of patient movement. Cancel the scan immediately if the patient
moves during the scan.

Note: To cancel the scan: Click . Click .
Select in the dialog box. Click .
Click . Click g Select Research or Small Subject.

Return to "Marking the Scan Region" on page 10-11 to continue.

(.

J

4. When the Measure Scan is complete, the computer will emit a sound. The software will update the Scan tab
window and the Analyze button will become available.

N”R LHND® Operator's Guide
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10-15

Costerd Segpment MM 55

Frogress

Anskzn Done

Carerd

5. Determine if the quality of the Measure Scan image is satisfactory or unsatisfactory.
6. IF THE IMAGE QUALITY IS SATISFACTORY, and no evidence of patient movement during the scan is
exhibited, proceed to Step 8.
7. IF THE IMAGE QUALITY IS NOT SATISFACTORY: do ONE of the following:
» Enter the appropriate number of scan lines in “Extension (# of lines)” and click to
include the entire region of interest.
» OR click and remark the scan region (go to "Marking the Scan Region" on page 10-11).
8.

If no further scans are to be performed, help the patient up from the scanner table (if applicable). Make sure
the scanner arm will not impede the patient's ability to sit up.

Caution: Remember that some patients may require a few minutes to regain equilibrium after lying
down for a length of time.

Operator's Guide
435D109 Rev. Z
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10-16 Research & Small Subject Scan

Analyzing the Scan

At this point, the operator can analyze the scan later, or analyze the scan now.

ANALYZE LATER: Click to end the scan process and analyze the scan later. The scan data will
be saved 1o the database for analysis at a later time. The software will go back to the Parameter tab window.
You can do another type of scan, if desired.

OR ANALYZE NOW . ..

1. ek 2|

m Mimanatus (36 4510

Porarmsten: | Scan  Anabmis

| Fanant Fessach Groge

| Regions

l Ui Dsfinad Fagion

4 Sricdas ! Comwm Coraad -
Fzgion Nemwa |

= |

£ R |
IrvdudeEnckade

[rachacds | [T T

Frogiess
Chck and Bald on the conol poinis o move

Click. o resgian o select

Current Imaga: Lin Hong

Adminstreion Feport Template: Pebent Letier Foanner Present

2. When the Analysis tab window opens, you will need to create and position Special Region Cursors to
identify the regions of interest (see Special Region Cursors on page 12-45 for full instructions).

» Research/Small Subject scans can analyze up to 7 regions of interest per study.
» Name the regions in a consistent manner with the protocol.
» A Research scan of a vertebral body is used in this example.

3. Inthe User Defined Region drop-down list, select the desired region shape.

4. Typein a Region Name (Transverse was used here). Click .

NORLANLD, 535109 Rev- 7
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— UserDefined Region

Cantinue |

Fegion MName ITranaverse

Add Region | Delete Flegiu:unl Details... |

5. Continue to add regions in accordance to the protocol. Different protocols have different specifications.

— Regions
Region | Length (cm) |\'Ir|dth (cm) |
Body 3.60 5,10
Transverse e R

6. If the patient/subject has a prior scan, use the Show Comparison feature to aid in positioning the cursors in
the same place as the subject’s initial scan (refer to "Comparison Image" on page 12-54).
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Viewing the Scan Results Tab

1. Once all the regions are properly defined, click . The Scan Results tab window opens.

J7§ lluminatus DXA 4.5.0 =R

File Edit Calibration Tools Help

Parameters | Sean | Anaysis  Sean Resuls |

Mo Reference Data Available

Mo Trending Data Available

Research 21 MaY 2015 1256 Scan Speed: 60mm/s Resolution: 1.0mm < 1.0mm  See Operator's Guide for information on Cv's. Cument Image: Lin Bone

Regon | %[ BMD (a/cm?) | BMC (o) | Area (onf) | Length (om) | width (em] | Lean Mass (@) | Fat Mass (g) | TScore | YoungRef. (%) Z-Score |_Age Match (%) ST Change ()| ST Change (%) | LT Change (%)| LT Change (¢
Body 0.3891 4,608 1248 360 510 E8.26 1437 SIS I e e
Transverse 0.5370 4.782 8.905 E7.37 1418 SRS B e S
‘ T »
Cancel Save | ‘ |
Administrator Report Template: Patient Letter Scanner Present

2. View the image (which is not for diagnostic purposes) to ensure that cursors are positioned correctly and ana-
lysis results are satisfactory.

3. Click to save the Scan Results.

»  The image will display with trending graphs to the right of the image.

» The BMD (in g/cm2), BMC (in grams), and AREA (in cm2) for each region of interest will be displayed below
the graphs. The length and width of each ROI will also be displayed.

» Soft Tissue values will be presented if Soft Tissue Composition option is enabled.

Vi\ Note: The Show Baseline mode is recommended for viewing bone and non-bone pixels. ]
L ]
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Hluminatus D!
File Edit Calibration Tools Help

Falameters} Scan 1 Analysis  ean Results ]

No Reference Data Available

Mo Trending Data Available

Bone imag o
Research 21 MaY 2015 1256 Scan Speed: G0mm/s Resolution: 1.0mm = 1.0mm  See Operator's Guide for information on Cv's. Cument Image: Lin Bone

10-19

| 3 BMD (grere) | BMC [g)|_Avea [et) | Length fcm] | widh [em) | Lean Mass (g) |_Fat Mass (g) [ T-Score | ‘Young Ret. (%] Z-Score | Age Match (%1] ST Change (%)] ST Change (%/w) [ LT Change (%]] LT Change [

m

Region
Body 036 4606 1248 360 510 EB.26 1437 MRS e b
Transwerse 0.5370 4782 8905 B7.37 4.8 i e b

»

Fiaport

Scanner Present

Administrator Report Template: Patient Letter

«¢ Patient List | << Demographics | << Stamp View

» Click to generate and print a report using the current default report template. Proceed to Step 5

of "Generate and Print a Report" on the next page.

. St Wi
» orclick """

"Generate and Print a Report" on the next page.

. i} hics »»
» orclick to do another scan.

. << Patient List . .
» orclick to end the process and return to the main window.

Operator's Guide
435D109 Rev. Z

to generate and print a report using a report template other than the default. Proceed to
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Generate and Print a Report

Five different types of Reports can be generated for each scan: the Bone Exam Report, the Bone Exam Report
- 1 Page, the Combined Report, the Patient Letter, and the Referral Letter. When saved, these reports become
part of the scan data.

These procedures use the Bone Exam Report - 1 Page for the example.

1. Make sure that the scanned image is being viewed as a thumbnail in the Stamp View or the Filmstrip View.
Click (to highlight) the thumbnail view of the scan.

2. Click Tools > Report > Select Template... or click the M button to open the “Report Con-
figuration” dialog box.

Fir Edi Caleratien (Took | Help

File Tack
Calibration Detaibs
Send To '

g
Report , Gemerate Mew
Audin Dictadion Firush Eaist

Lag Filies '

3. When the Report Configuration dialog box opens, click a Report Template to highlight it (Bone Exam

Report - 1 Page was selected here). See "Sample Scan Reports" on page 2-17 for examples of the report

template selections. Click Dene

Report Configuration

Choose a Default Report Template

Buone Exam Report - 1 pags j Done
Bone Exam Report

Combined Report

Patient Letter

Referral Letter

Ten Year Fracture Risk Report

@ Note: The selected Report Template will remain the default until it is changed. The currently selected
Report Template is always displayed at the bottom of the IlluminatusDXA window.

4. Click Tools > Report > Generate New or click the button.

File Edit Calibration [Tools| Help

Initialize Scanner

Service Tools 3
File Tools

Calibration Details

Send To: >

DICOM Interface

Mail /
Report > enerate New

Audio Dictation Finis|

ting/Make Addendum

View Selected

Log Files »

Scan Quality Issues Editor

Recommendations Editor

Select Template...
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5. The Report is immediately generated and opens up in the window, as shown. At this point, the operator can
type in their comments and recommendations, Lock it, Saveit, Printit, Exportit to a PDF file (ora DICOM
file) and Closeit.

(=]

File

Name: Research, George Sex: N/A Height:
in: V003 Ethnic: Weight.
DOB: 1/1/1900 Age:

[ . H Research on: 5/21/2015 12:55:01 PM

Tock | zave | Print |EgpnrtPDF| ExpnrlD\COMl Close

6. Click . The “Print” window appears. Select a printer, select which pages to print and choose how
many copies to print.

7. Click to print the Report. The Report is automatically saved and printed.
okt ]

9. You are returned to the Filmstrip view screen. The saved Report can be found under the “Reports” tab. The
Report can be viewed, modified and reprinted at any time. See "The “Reports” Tab" on page 2-14 for more
information.

0o
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Research & Small Subject Scan

A Sample Bone Exam Report - 1 Page

5/21/2015 1:00:59 PM Norland at Swissray Page 1

W6340 Hackbarth Road Fort Atkinson, WI 53538 USA (888) 741-0413

Name: Research, George Sex: MIA Height:
ID: V003 Ethnic: Weight:
DOB: 11111900 Age:

Research on: 5/21/2015 12:56:01 PM

Bone image not for diagnosis

Manual Cursor Placement

. . . Age ST LT
. BMD BMC  Area  Length  Width Lean Fat T- Young Z- . ST Change LT Change
Region {g/lem?) (g} {em?®) {em}) (em)  Mass (g) Mass(g) Score Ref (%) Score N:a‘yl:h (‘l[l;\:,c {Yaiyr) Cl:::}gc (%alvr)
Body 0.3691 4.606 1248 360 510 G826 1437 *s%es  sksas seess wsssk sesek ekeks sessk ekdes
‘T'”‘ns‘.c'sc ”53?“ 4?“2 “l}”j {‘? 3‘? 141.8 EEEEN ahEEE EHEEE EER R LR LS EREEE LR L BEEEE
See Operator's Guide for information on CVs,
1.0 mm X 1.0 mm, 60 mm/s, 9.60 cm, Rev. 4.5.0/2.3.1 Calib. 0512115 S/N 8113
Figure 10-3: A sample Bone Exam Report - 1 Page for a Research Scan
NORLANLD 1555100 Rov. 2
®
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Soft Tissue Composition

Note: The Soft Tissue Composition feature and Body Composition Reports
are available as an option with the Bone Densitometer. Be aware that your
system might not have either of these options.

The Norland Soft Tissue Composition option estimates the lean and fat composition
of the soft tissue in the Whole Body, and operator-defined regions of interest on
Research and Small Subject scans. It works in conjunction with the Whole Body,
Research, and Small Subject scans to provide lean and fat soft tissue mass values in
addition to the bone density values.

No additional dose is required to obtain these soft tissue composition values.

This chapter discusses the following.

Introduction .. 11-2
Tissue Composition Standards ... ... 11-2
Scan Specifications ... 11-3
Whole Body Scans .. ... .. 114
Body Fat Charts -Whole Body Scan ... .. 115
Research & Small Subject Scans ... .. . ... ... 11-6
Generate and Print a Report ... .. ..o . 11-7
A Sample Bone Exam Report .. ... . 11-9
A Sample Body Composition Report ... ... ... 11-11

CHAPTER 11

D10 Fev 2 NORLANLDO



11-2 Soft Tissue Composition

Introduction

When Soft Tissue Composition is resident on the system, soft tissue values are automatically presented for
the computer-generated and operator-defined regions of interest on Whole Body scans and for operator-defined
regions of interest on Research and Small Subject scans. Refer to the appropriate chapters in this manual for
more details on Whole Body and Research and Small Subject scans.

DXA provides independent values of bone mineral content (BMC) and bone mineral density (BMD) and non-
bone lean mass (LEAN), as well as fat mass (FAT) from which the true bone mass fraction is calculated for
Whole Body scans. (This value must be manually calculated for Research and Small Subject scans.) Siri and
Brozek equations for underwater weighing equivalent values are reported in addition to the BMD, BMC, LEAN
MASS and FAT MASS values for Whole Body scans.

Using DXA technology to determine fat content is a much quicker and simpler process than underwater weigh-
ing (UWW), which is often said to be the “gold standard”. Underwater weighing requires that subjects be able
and willing to be completely submerged in water while exhaling rather forcibly. This method is ill suited for sub-
jects who are sick, infirm, unconscious, or afraid of water.

Another advantage of DXA over UWW is its insensitivity to body gas. The effect of gases contained in the body
must be compensated for when using underwater weighing, while the x-ray beam used in DXA is unaffected by
such gases.

Tissue Composition Standards

The soft tissue assessment is based on the following industry standards:

» The standard for bone is hydroxyapatite, a substance equal to the mineral component in bone. It is available
in purified form as calcium phosphate tribasic, type IV, from the Sigma Chemical Company of St. Louis, Mis-
souri, USA.

» The standard for fat is stearic acid, a fatty acid which closely approximates the triglyceride esters which
make up mammalian fat in molecular composition and in photon attenuation properties.

» The standard for lean soft tissue is 0.6% sodium chloride in water. This saline solution closely approximates
the photon attenuation properties of the various lean soft tissues, such as muscle, blood and skin.

NORLANLDO B3D109 Rov-7
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11-3

Scan Specifications
Detailed specifications for Soft Tissue Composition are in the following tables.

Table 11-1: Research/Small Subject Scan Specifications

Scan Site Whole Body: System-defined and operator-defined regions of interest
Research and Small Subject: Operator-defined regions of interest
Accuracya Typically within 2.0%

In vivo Precisionb

See table below

Table 11-2: Soft Tissue Composition Scan In vivo Precision

Total Body C.V. | Head C.V. | Trunk C.V. | Abdomen C.V. | Arms C.V. | Legs C.V.
Soft Tissue Mass | 0.1% 1.4% 0.81% 2.3% 1.8% 0.57%
Lean Body Mass | 0.93% 1.4% 1.6% 2.6% 2.3% 1.5%
Fat Mass 1.4% 1.9% 1.9% 3.7% 4.8% 2.1%
Percent Fat 1.4% 0.91% 1.7% 2.2% 3.5% 2%
*** All specifications are subject to change without notice. ***

aStandard for calibration: BONE - hydroxyapatite; FAT - stearic acid; LEAN- 0.6% NaClin H,0.
bBased upon 3 scans each of 14 subjects Whole Body procedures outlined in the Whole Body chapter, using 6.5 X 13mm resolution and 260m-

m/sec scan speed.

Operator's Guide
435D109 Rev. Z
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11-4 Soft Tissue Composition

Whole Body Scans

Soft Tissue Composition - Whole Body Scans

All Soft Tissue values are derived from data acquired during the scan. Soft Tissue values are automatically cal-
culated for all regions of interest when the operator:

1. completes a Whole Body scan
2. performs the routine Analysis (see "Analyzing the Scan" on page 9-15).

When performing serial soft tissue characterizations of the same patient/subject, it is important to position all
cursors the same as in the initial (baseline) scan. Use "Comparison Image" on page 12-54 to aid in positioning
cursors for serial patients.

Results - Whole Body Scan

Table 11-3: Measured Values

BMC (g) Bone Mineral Content in grams
Lean Mass (g) Lean Tissue in grams

Fat Mass (g) Fat Tissue in grams

Area (cm2) Area in squared centimeters

Table 11-4: Calculated Values

Total Fat % Total Fat Mass/(BMC + LEAN + FAT)

SIRI UWE Fat % [(4.95/Dt) - 4.142] * 100 (Dt = Total Density)
BROZEK UWE Fat % [(4.57/Dt) - 4.142] * 100 (Dt = Total Density)
Soft Tissue Fat % Fat Mass/(Lean + Fat)

%TBMC/FFM (Total Total BMC/(Total BMC + Total Lean Mass)

Bone Mineral Content
/Fat Free Mass)

» Total Lean Mass (g), Total Fat Mass (g), Total Fat %, Siri and Brozek Underwater Weighing Equivalents
(UWE), Soft Tissue Fat % and the % TBMC/FFM values are displayed below the image on page 1 of the
Bone Exam Report.

» Lean and Fat Mass values for head, arms, legs, chest, midriff, pelvis, legs, arms, and total body will also be
displayed.

» SIRI AND BROZEK underwater weighing equivalents are presented for comparisons to DXA % Fat as
underwater weighing may be considered the gold standard in fat content determinations.

» TBMC/FFM is the ratio of Total Bone Mineral Content (bone) to Fat Free Mass (lean tissue).

NORLANLDO B3D109 Rov-7
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Body Fat Charts - Whole Body Scan

A Body Fat Chart is displayed on the bottom of page 1 of the Whole Body Bone Exam Report that shows the
classification of the patient according to the patient's Siri UWE fat percentage. The chart displayed in the report
is based on the patient's age and sex and is derived from the charts shown below:

Male 7-18:

Underfat Healthy Owverfat Obese

0% 10% 2
Male 18-79:

0% 10% 20% 30% 40%
Female 7-18:
Underfat Healthy Overfat Obese

0% 10% 20% 30%
Female 18-79:
Overfat Obese

0% 10% 20% T 40%

D10 Fev 2 NORLANLG



11-6 Soft Tissue Composition

Charts supplied courtesy of Tanita Ltd, data from:
Body Fat Ranges for Standard Children

» Body Fat Reference Curves for children Targeted at BMJ (British Medical Journal) Draft 1-AMP 19 June (by
Dr Andrew)

» Gallagher D et al. Am J Clin Nutr 2000,72:694-701. "Healthy percentage body fat ranges: an approach for
developing guidelines based on body mass index."

Body Fat Ranges for Standard Adults

» Based on NIH/WHO BMI Guidelines
» As reported by Gallagher, et al, at NY Obesity Research Center

Research & Small Subject Scans

Soft Tissue Composition - Research & Small Subject Scans

All Soft Tissue values are derived from data acquired during the scan. Soft Tissue values will be calculated for
operator-defined regions of interest (see "Special Region Cursors " on page 12-38).

After completing the scan, perform the routine analysis (see "Analyzing the Scan" on page 10-16).

Add and position Special Regions for desired soft tissue calculations. The operator can place up to seven (7)
Special Regions on Research or Small Subject scans.

When performing serial soft tissue characterizations of the same subject, it is important to position all cursors
the same as in the initial (baseline) scan. Use Comparison Image to aid in positioning cursors for serial subjects
(see "Comparison Image" on page 12-54).

Results - Research & Small Subject Scans

Lean Mass (g) and Fat Mass (g) values for any operator-defined regions will be displayed in the Bone Exam
Report.

NORLANLDO B3D109 Rov-7
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Generate and Print a Report

Seven different types of Reports can be generated for each scan: the Body Composition Report - 1 Page, the
Body Composition Report, the Bone Exam Report, the Bone Exam Report - 1 Page, the Combined Report, the
Patient Letter, and the Referral Letter. When saved, these reports become part of the scan data.

These procedures use the Bone Exam Report - 1 Page for the example.

1. Make sure that the scanned image is being viewed as a thumbnail in the Stamp View or the Filmstrip View.
Click (to highlight) the thumbnail view of the scan.

2. Click Tools > Report > Select Template... or click the M button to open the “Report Con-
figuration” dialog box.
File Edi  Calibration [E]Hﬂp e

Calibration Detaibs

Send To ’

3. When the Report Configuration dialog box opens, click a Report Template to highlight it (Bone Exam

Report - 1 Page was selected here). See "Sample Scan Reports" on page 2-17 for examples of the report

template selections. Click Dene

Report Configuration

Choose a Default Report Template

Buone Exam Report - 1 pags j Done

Bone Exam Report

Combined Report

Patient Letter

Referral Letter

Ten Year Fracture Risk Report

Note: The selected Report Template will remain the default until it is changed. The currently selected
Report Template is always displayed at the bottom of the IlluminatusDXA window.

4. Click Tools > Report > Generate New or click the button.

File Edit Calibration [Tools| Help

Initialize Scanner

Service Tools 3
File Tools

Calibration Details

Send To: >

DICOM Interface

Mail

Report
Audio Dictation

View Selected

Log Files »

Scan Quality Issues Editor

Recommendations Editor

Select Template...
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5. The Report is immediately generated and opens up in the window, as shown. At this point, the operator can

type in their comments and recommendations, Lock it, Saveit, Printit, Exportit to a PDF file (ora DICOM
file) and Closeit.

M Report Type: Bane [xam Report - 1/8/2012 - Creating Hew

M Wi, By Exarrple Fllwic. Conearion
» Whie Body Height

Agr. 8 yrany Wil

[ (™

W Bty o ATOE10 §5440 AM

Region %
Teotad Fat n
SmUWEFu 24
Drossk UWEFat 34
Bolt Tasae Fal 28
TEMCFFM 4

Fagicn BWDighw®t BME(D) Amafcm Langhiom) Wilthicm) LewsMua(c FatMani) To-Zom ToorgBaf (99 Tcom AgeMaich (%) 5T Chisge (%) T Changs D) LT Changs (%9 LT Chusgs {%8r1)

Tulad b my mn N Tz eeews weses - seers seees wvers  wvess rare
Basd 1512 amR 17 2969 1996 wesss assss  wasas T - N—
Chat (1) R 3R Ve S vavee weees

ST for Tokal BAMD: 18 See Gude for over C43.
6.5 0 01,0 e, 260 e, 4.3 o, B 4.3 002 .9 Calb 047910 S 1)

Siri LIWE Fat Tabla

(G ] s | me | Egoirer | . e |

o0

Click . The “Print” window appears. Select a printer, select which pages to print and choose how
many copies to print.

Click to print the Report. The Report is automatically saved and printed.
clek 2= ]

You are returned to the Filmstrip view screen. The saved Report can be found under the “Reports” tab. The

Report can be viewed, modified and reprinted at any time. See "The “Reports” Tab" on page 2-14 for more
information.
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A Sample Bone Exam Report

A sample 2-page Bone Exam Report for a Soft Tissue Composition Whole Body Scan:

5/20/2015 12:41:06

W6340 Hackbarth Road Fort Atkinson, WI 53538 USA (888) 741-0413

PM Norland at Swissray Page 1

Name: ‘Whole Body, Example Sex: Male Height: &7
1D: 313 Ethnic: Caucasian Weight: 170
DoB: /2911978 Age: 33 years
H Whole Body on 5111/2012 3.02:00 PM
Total
1.05
1.03
1.01 Region %
S 0.99 ¢
D .97 Total Fat 242
0.95} »
16 18 20 2224 26 28 30 32 34 Siri UWE Fat 19.5
AGE
Brozek UWE Fat  19.3
Date;  Yales Soft Tissue Fat 252
11712710 1.013
04/17/09 1.033 TBMC/FFM sl
11104 0,999
D9/07/95 0,963
Bone image not for di
i Age LT
Region BMD BMC  Area  Length Width Lean  Fat Mass  T- Young Z- Match ST Change ST Change Chiangs LT Change
(glem®)  {g)  (em®) {cm) (em)  Mass (g) (&) Score  Refl (%) Score %) (%) {Halvr) Py (olyr)
Total 1036 3049 2943 S6RE0 19126 #%*ss  wsssd skkes Sess 23 1:5 7.5 0.3
STD CV: Total BMC=0.9, Lean=0.93, Fat=1.4; See Guide for other CVs.
6.5 mm X 13.0 mm, 260 mm/s, 66.95 cm, Rev. 4.4.0/2.3.1 Calib. 0511712 SIN 8500
Comments:

Siri UWE Fat Table
18
@
o [7030]
< 4059
10374 I : _
0 5 10 15 20 25 30 35 40 45

Siri UWE Fat %

NORLANDG

Figure 11-1: Page 1 of the Bone Exam Report

Operator's Guide
435D109 Rev. Z
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Soft Tissue Composition

5/2002015 12:41:06
M Norland at Swissray Page 2
W6340 Hackbarth Road Fort Atkinson, Wi 53538 USA (888) 741-0413
Name Whele Body, Example ] 33
dress Ethnic Caucasian
M DoB 9/20/1978
Telephone Age 33 years
History Meno Year
Treatment Sex Male
Medications Height 67
Comments Weight 170
Scan Information
Scan Type: Whole Body Resolution: 130265
Analysis Date: 411372012 5:17:59 PM Speed: 260 mm/s
Calibration Date: sz Width: &7.0
Technologist: P.F. Brown, RT Host/Scanner: 4400231
Physician: Dr. J. Hibbert, MD Analysis/Revision: 440
—Detailed Resulls
Rogion  BMD  BMC Ara  Lengh  Width  Lean ,j::s T-  Youg M";‘I‘:h Chi:gc ST Change F;:Ec LT Change
s " a; . 0
{glem?®) (g} {em?) {cm) {em)  Mass (g) @® Score  Ref (%) Score pod ) {%alyr) (%) {%alyT)
Head 1.893 4839 25356 2774 1420 ey LR 1] aEEEE aEEEw aEEw LT (LT ThEE
Chest 09724 6327 6506 14767  S64R  *eeer  swees wsesk ssess wraan CEEEE L rEhEE
Midriff 1273 4464 3507 3259 1507 *eer  weaws  sesen  assee PrPT PPOT P seene
Pelvis 1.25%5 3397 270.7 £120 3049 *EREE wREEE BEeEs Reses sannn LT . *hhnE
|i.-cl'l 1073 S§7.7 5199 10591 IRE seREE weeks seees seess seann ahREn FhaEE T
cg
Right 5 2 g ()  EEREE EREEE EREEE sEEEE exas ) e rraE
Leis 1064 5247 4932 10297 2589
Left 06752 2545 3770 1847 1424 4ees seses ssess ssses TTIL] TII] T P
Arm
Right ool 2116 340.5 3224 1105 sesss  ssess sssss  sesss sases sekks seaes
Arm
Total
3064'—'—"'—:-‘ e O By
: R 245
T 225
L 4
- 205
18.5)
1618202224 2626 3032 34 161820222426 283032 34 16182022242628303234
AGE AGE AGE
Daie Value Date Value Daie Value
11/12/10 2972 1112710 26,14 1112410 5,051
04017709 3001 0417009 25 53 4/17/09 5,128
/104 2941 1114 19.51 104 5267
09/07/95 2791 GH0T95 18.30 (RHO7/95 5,348

Figure 11-2: Page 2 of the Bone Exam Report

NORLANLD,
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A Sample Body Composition Report

A sample Body Composition Report for a Soft Tissue Composition Whole Body Scan with prior trending:

100672014 9:38:35 AM

Page 1

Name: Patient. Example Sex: Male Height: 57
I il3 Eihnic: Caucazian Weizht: 170
DOE: 9/39/1978 Age: 33 years Technologist: P F. Brown, BT
Scan Date; 571172012 3:02:00 PM Physician: Dr. ] Hibbert
Total Fat % 242 Total BMD (z/cm®) 1.032
SnUWEFat% 196 Totzl BMC (g) 3038
Brozek UWE Fat % 19.3 Totzl Area (cm”) 2943
Soft Tissue Fat % 232 Total Lean (z) 56832
TBMCTFFM % 51 Total Fat () 19155
BMD {giem®) BMC{g) Area(cm®) LeanMass(g) FatMass(g)|
Teml 1032 3038 043 56852 19130
Head 1854 4883 2633 3020 1404
(Chest 09619 6232 1o 146635 5681
Mlidrife 127 4482 33513 3250 1507
Pelviz 1143 3525 2837 8532 3216
Lefi Lag 1068 3480 5130 10373 2351
Fizht Leg 1070 5118 4378 10041 2334
Lefi Arm 04751 1343 3767 3857 1422
Right Arm 04111 149 3353 3007 1017
Totsl Toisl
M ] B3 T T 1
184 —~—~—u}—= e
g E|al— - | o Eo TN B
= 149 : — woons . |
E 1 i 1 | : \
w120 1 o @ 185 H 1
2 25 30 35 20 ) S gl e
AGE AGE
Dae  Vame Dae  Value
111210 203 111210 2614
= 5 . 0417100 198 041709 25353
Bone-Tissue Composite a
1071104 13.9 101104 12.51
090785 116 090785 1830

Siri UYYE Fat Table

Age

Siri LWVE Fat %

STD CV: Total BMC=0.9. Lean=0.93_Far=1.4: See Guide for other CVs. Images not for dingnosiz
6.5 mm X 13.0 mm. 260 mm's. 6693 em. Rev. 44.002.3.1 Calib. 0511712, SN 8500

NORLAND

Figure 11-3: Page 1 of the Body Composition Report

Operator's Guide
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Soft Tissue Composition

10/6/2014 9:38:35 AM Page 2
'
Name Panent. Example Sex: Mlale Height: 57
ID: 313 Ethnie: Caucaszian Weight: 170
DOB: 0/29/1978 Age: 35 years Technologizst: P F. Brown. BT
Scan Date: 571172012 3:02:00 PM Phyzician:  Dr. J. Hibbert
| I H | I H
Current Scan: Bazeline Scan: Current Scan: Bazeline Scan:
Fat %
Toisl Toigd
M2AI—— Wy Dae Value wHE T Dae Value
§ : : F : 11712/10 19777 el . H I 111210 35873
= dspia———————— - = e 5 i
= 1 g | 01708 19031 Z 5128 : ; T 041709 33517
% B lonned 125 SR S 101104 52900
e | T 1 S 0795 M 25 i 35 705
e 09/07/95 11068 i 090795 45399
ST Chanze (%%} 5T Chanee (o7} LT Chanee (%5} LT Chanee {3&h)
Total BMD (zfom”) 1.032 1e 13 ik | 04
Total BMC (g) 303 1z 15 B9 03
Total Lean (g} 56852 18 12 158 Lo
Total Fat (g) 10139 -32 22 625 37
STD CV: Total BMC=0.9. Lean=0.93_Far=1.4: See Guide for other CVs. Images not for dingnosiz
6.5 mm X 13.0 mom, 260 mm's, §6.95 cm Rev. 4400231 Calib. 05711712, S/ 8300 Ngﬁlﬁm

Figure 11-4: Page 2 of the Body Composition Report
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Additional Technigues

The Norland Bone Densitometer software has been designed to offer the operator

automatic analysis routines. This chapter provides information on creating user-
defined regions of interest (special region cursors), tools for enhancing image display,
N and other utilities for performing non-routine operations.
It also goes into great details about many of the special features of the software,
F including the Audio feature, FolderMail, Database management and Reference Set
management.
This chapter discusses the following.
m Adding Audiotoa Patient Record ... ... ... 12-2
Using the Voice Note Option ... ... . 12-3
I I I Using the Audio Dictation Option ... ... ... ... ... 12-5
IMageM AL 12-8
FolderMAIL .. 129
Database Management ... .. 12-14
P Working with Reference Sets ... 12-26
Pressing the Halt Button . ... . L 12-37
Special Region CUrsors ... ... 12-38
Include/EXClUde . . ... L 12-45
Usingthe Ruler Tool ... ... 12-52
Companison IMage ... 12-54
Image Compositionand ImageMode ... ... ... 12-56
Image Display - Zoom, Pan, Brightness, and Contrast ....._.................. 12-59
I Analyzing Saved Scan Data ... ... . 12-60
ReanalyzingScan Data .. ... .. 12-62
Changing Height or Weight onthe Report ... ... ... ... . ... ............ 12-63
AP Spine TeChniqQUes . . ... .. 12-64
Hip TechniqQues . ... ... 12-70
Forearm Scanning Techniques ... 12-75
Whole Body Scanning Techniques .. ... ... . 12-77
Lateral Spine Scanning Techniques ... .. ... 12-78
Research and Small Subject Techniques ... ... ... . .. 12-80
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12-2 Additional Techniques

Adding Audio to a Patient Record

The DXA software provides a means for adding the spoken word to a patient record. Audio can be added to a
patient record in two ways:

AVoice Note is spoken information that is usually specific to the scan. Once recorded, the voice note icon ﬂ
is attached to the thumbnail view of the scan (as seen in the figure on the left).

An Audio Dictation is spoken information that is usually associated with the visit. The dictation is stored in a
separate Audio Dictations tab (as seen in the figure to the right).

- | 7 lluminatus DXA 4.5.0:

File Edit Calibration Tools Hel,

[]e] Elf
Audio Dictations |

Scans | Reports

Figure 12-1: Voice Note (left) and Audio Dictation (right) icons

IMPORTANT: These procedures assume that the microphone has been installed and the software has been
properly set up during installation. The Microphone “Select” check box must be checked for successful record-
ing (see "Installing the Microphone" on page 3-6).
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Using the Voice Note Option

As previously mentioned, a Voice Note is spoken information that is usually specific to the scan.

How to Record a VVoice Note

1. Have the microphone nearby, and your thoughts together before starting this procedure.
2. Click to highlight the scan that you want to add a Voice Note to.

[ s 6 45

File Edit Calibration Tools Help

Scans | Reports |

File Edit Calibration Tools Help
Scans | Rgpmsl

Note: RECORDING BEGINS IMMEDIATELY in the next step. ]

4. Click on Add Voice Note to begin the recording. The Audio Player window pops up and starts recording.
B

Recording Annotation Audi |

5. Click to stop recording.

6. The Audio Player window automatically closes and a Speaker icon ﬂ appears in the corner of the image
where the Voice Note is attached.

D10 Fev 2 NORLANLG
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Fig Hluminatus DXA 4.5.0

File Edit Calibration Tools Help

Scans | Reports |

How to Play a Voice Note
Locate the image where the Voice Note is attached and click on the Speaker icon to play the audio clip.

Fig Hluminatus DXA 4.5.0

File Edit Calibration Tools Help
Scans | Reports |

How to Delete a Voice Note
1. Click to highlight the image where the Voice Note is attached.
2. Right click to open the menu and select Remove Voice Note.

File Edit Calibration Tools Help
Scans | Reports |

Sound Note Removed

[The sound note has been removed

NORLANLD, B3D109 Rov-7
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Using the Audio Dictation Option

As previously mentioned, an Audio Dictation is spoken information that is usually associated with the visit. The
Audio Dictation option enables a person to record anything, including a report dictation pertaining to the selec-
ted scan that can be written up later. This Audio file can be sent to a consultant along with the entire patient visit
data via FolderMAIL (see "FolderMAIL" on page 12-9). However, Norland software is necessary for viewing,
and listening.

Overview of the Audio Dictation Buttons
The following image describes the Audio Player dialog box buttons:

LAudiu Player
([

LPIﬁr;g-;: io...

Play Pause Stop Forward Reverse Record Done (saves & closes Audio Player)

When an Audio Dictation file is saved (by clicking the button), it is appears as a blue “microphone”
icon in the Audio Dictations tab.

I3 muminatus DXA 4.5.0: La

File Edit Calibration T

s:3ns| Reports| Audio Dictations

Audio Dictation

How to Record an Audio Dictation
1. Have the visit open in the Stamp View or the Filmstrip View of the software (i.e. click on the Patient Name,
Visit Date, Scan type, and then click Stamp View).

2. Have the microphone in place and your thoughts together regarding the information to record. It is advisable
to first describe which scan image this Audio Dictation is associated with.

[ Note: RECORDING BEGINS IMMEDIATELY in the next step. ]

3. Select Tools > Audio Dictation.
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12-6 Additional Techniques

Calbration Details
Send Tes

Updste Report Scan Type Values
DICOM Interdace

Mail

Reporl

Audin Dictation

Log Files

4. The Audio Player dialog box pops up, and voice recording begins IMMEDIATELY.

éudmplayer
e ] I | | Done

Recording Audio... |

. L . > . . ]
5. Click Stop - tostop. Click Play -—_Itolisten. Click Record to record.

6. Click when finished recording. The audio dialog box closes and the recording is saved.
7. Notice the addition of a new tab labeled Audio Dictations. Click the tab to see this view.
[ nluminatus DXA 4

File
Scansl Reports| Audic Dictations

Audio Dictation

How to Play Back (or Add to) a Recording

; -.u-.
1. Double-click on the “Audio” icon ‘&‘ found in the Audio Dictations tab. The recording will begin playing
immediately.

Scans | Reports Ao Dickaions |

W
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||
2. Click Stop - to stop. Click Play ﬂ to listen to the recording. Click Record ﬂ to add to the record-
ing.

3. Click to close the Audio Player dialog box.

How to Delete an Audio Dictation
This operation will permanently delete the audio dictation.

1. Select the Audio Dictation tab.
2. Click to select the blue “Audio” icon (the background should tumn red).

File Edit Calibration Tools Help

Scans| Reports  Audio Dictations |

3. Right click the mouse over the recording to open the menu. Select Delete Object(s).

(I8 omrovs 6 5

File Edit Calibration Tools Help

Scansl Reports  Audio Dictations |

Delete Object(s)
Properties...
4. Click to confirm deletion.

@ Areyou sure wau wish to delete the selected waice file(s)?

D10 Fev 2 NORLANLG
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ImageMAIL

The ImageMAIL feature is currently disabled in the llluminatusDXA software. It is recommended to use the
report Export PDF feature to create attachments to be emailed.

How to Export a Report to PDF

1. From the Database Navigator window, select the Patient Name or Patient ID containing the scan(s) to
report. Select the Visit Date containing the scan(s).

. Stamp Yiew > .
Click to open the scan images.

3. The style of report that will be used to create the PDF is shown at the bottom of the screen next to Report
Template. To change to a different report style, select Tools > Rei ort > Select Template or click the
Done

Select Template

N

button, select a new report style, and click

Select one or two scans (depending on your report type), and click .

Complete any optional fields in the report preview window.

. Export PDF
|

Browse to the appropriate directory, type in a file name, and click Save.
8. Close the reporting window when finished.

AN o

N o
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FolderMAIL

FolderMail provides a way for the operator to e-mail all the related data from a patient’s single visit to a col-
league at a remote location for evaluation. The colleague, who must also have the Norland Bone Densitometer
windows software, can then work with the data in the same llluminatus DXA environment. They can analyze
the data with all the functionality of the Norland System.

A typical file name for a FolderMAIL attachment is FolderMAIL_05-28_2004-xxxx-xxxX.igf. The recipient
can then save the file to disk and rename it with a meaningful, unique name.

The FolderMAIL file includes all the DXA scans selected for that visit date, the patient demographic data, any
reports, and any audio dictations associated with that visit.

Requirements

» To use the FolderMAIL feature, you must have a network connection for the llluminatusDXA computer avail-
able.

»” You must have an SMTP or MAPI mail server available with permissions to send messages.

» On the receiving computer, you will need a network connection, and an accessible email address to receive
the FolderMAIL files.

»  Toimport the FolderMAIL files, you will need the llluminatusD XA software installed and a valid license key
to operate the software. Workstation licenses are available from Norland.

How to Send FolderMAIL

1. From the Database Navigator window, select the Visit Date of the scan image(s) to be e-mailed.

Patient Visit List
Category: Search:
Quick Search: [Patient Name =
Patient ID | Patient Name | Visit Date Scan Type Znalyzed
Fracture “Spine. fracture ~
4P SPINE “Spine.gaod
Off Center “Spine.off.center
Osteoporotic “5pine. osten
IMPROPER 4P “Spine. paor start/end
Spine “Spine. poor condiion
AngldCursors “Spine.scaliosis
Too High “Spine.stait too high
Shart “Spine.too shert
DF WE “whole Body
Gluteus Abdominal, Soft Tissue |
k101111 Adams, Helen
Dud Hip Dual, Hip
k116654 JOHNSON, BETTY
k111212 Jones, Midred
= PatienlD Lastname. Firstname
S 7
Scan Left Hip Yes  |E
Scan AP Spine Yes
Scan Lelt Foreaim Yes
Visit 7/19/2000
Visi /2011993
Visit 742311397
Marual Manual, Patient
Marual 2 Manual, Pafient M
Marusld Manual, Patient
MaSiing o Ratation, Hip -

2. Click to open the scan images. Select Tools > Mail.
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Fle Edit Cabbration [Taoh |

Scans | Reports |

Irnsghee Scanner

| Service Touk *
File Toals
Calbratsan Deteits
Send Tox 3
Update Report Scan Type Values

DICOM Imesface

Maid

Report v
Audic Dictation

Log e

3. Click on the persons name in the Address book (who is to receive the FolderMAIL) and click the

button. See "How to Add Names to the Address Book" on page 12-12 for reference, if neces-
sary. If FolderMail is not active, refer to Troubleshooting "FolderMAIL" on page 17-9.

Mailbox
EHail |
E-Mail Addressbook
Add Remove
Personal |

Email address for one time FolderMAIL recipient

@ imageMAIL| B FolderMAIL|

4. Fillin the email Subject and body text to be included in the email message.

Mailbox
Eail |
Cancel E-Mail Type your message below
Then press the E-Mail button again
i to send
Subject

|D24& Seans for Patient KBR549

Dr. Pau,
patient on 6 May 2002.
Biest regards,

Dr. J. Allertan
Fegional Hospitsl

Please see the attached DiXk study for Patient BERS43. |t includes the AP Spine, Left Hip, and Right Forearm scans performed for this

[ imagenall| @ FolderMAIL|

5. Click again to send the file.

NORLANLD,
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FolderMail Sent

| The FolderMail has been sent to your outgoing emall server for deliveny.

6. The dialog box closes, and the file is sent.
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How to Add Names to the Address Book
This procedure explains how to populate the ImageMAIL/FolderMAIL Address Book.

1. From a Stamp (or Filmstrip) View window, click on Tools > Mail. The Mailbox window opens.

2. Click the m button. Type the recipients e-mail address in the box. Press the Enter key when done.

EMat
E-Mail Addresshook

Erirs How -l Adkdot Foe Flecassng Anciient
[Press ENTER when dore]
Rl hemseds Bt b althaysinms. s

B imagemaiL B Fomemal

3. Type in the name to display for this e-ma

EMat
E-Mail Addresshook

e o e o this b ks o St
[Prazt ERTER when dore]
[0 B Homdds. Hntra Haslth Sysbemd

il recipient. Press the Enter key when done.

B imagemaiL B Fomemal

EMal
E-Mail Addrossbook
had Ramova.

Dr B Hownrds. Moto Hanlth Syatims
1. A Poul Memarial Hospitsl b K
Dr. T. Williams. Regionsl Health bl hewmards Smetioheslthsystern. ong|

4. Notice than the recipients name now appears in the address book.

Ernal anbbess s o vt FenMAL recgamd

B imagemaiL B FomemaL

(Note: name must be highlighted.)

1 Tip: Click on the Address book name and hover (the pointer) over it to reveal their e-mail address.
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How to Import FolderMAIL to a Database

1. Open your mail program, and the e-mail containing the FolderMAIL attachment (the attachment has a .iqf

extension).

2. Save the attachment to a folder on your computer. You can rename the file to something meaningful, such as
the patient chart number or patient name. Be sure to retain the .iqf extension. Make a note of the folder and

the attachment file names.

3. From the Database Navigator window, select the Database name where you want to place the imported

patient FolderMAIL file.

Database: |CilluminatusDx4

Chllluminatus D
ChllluminatusDxa\Patients A-F
ChllluminatusD=ahPatients G-hd
ChllluminatusD=AsPatients N-5
ChllluminatusD=AFatients T-2

&

4. Click File > Import FolderMail... to open the following dialog box. Browse to the location of your saved
FolderMAIL file. Select the filename to import (AM-23300.igf used in the example below) and click

o |

,
I Open [
Lok in: | TuminatusDXA j - B ek B
Name = Date modified Type -

|| Patients G-M
1| Patients N-S
1| Patients T-Z
1 SampleDBs

5/22/201511:36 AM  File folder
5/22/201511:36 AM  File folder
5/22/201511:36 AM  File folder
1/29/20159:38 AM  Filefolder
5/28/201410:33 AM  File folder
1. widata 5/21/20151:00 PM File folder H

|| serverconf

| ] Am-23300.iqf 5/22/201511:26 AM _IQF File

<] i I v
File name |AM-23300 OK I
Fies of type: [ FolderMAIL Archive | Cancel

5. The folder and all its contents will quickly be imported. The following dialog box will momentarily flash on the

screen to confirm that the action is taking place.

V4500

Importing FolderMAIL: C:\lluminatusDXAWAM-23300.iqf: Processing Object 5...

[

6. Notice the patient’s file is now listed in the Database selected in step 1, along with any scans in that folder.

Scan

Scan
Scan

Patient Visit List
Category: Search:
Quick Search: [Fatient Name =l
| Patient ID [ Patient Name_ # [ isit Date [ ScanTwype [ Anayeed |
= PatientD Lasthame, Firsthame A,

e ez
Left Hip Tes
AP Spine Yes
Left Farearm Yes

Operator's Guide
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Database Management

The File > Database command provides access to all the database functions, including Add to List and
Remove from List of an Active Database, as well as Create, Import, and Export.

Edit Calibration Tools Help

Mew Patient |

Database 4 Active Database 4 Add To List

Tfrmmen T Create Remaove From List
Import...

Import FolderMail... Expieie

Logout

Exit

These database commands and procedures are discussed at length in this section.

Creatinga Database Folder ... . 12-15
Active Database > Remove From List ... ... 12-16
Active Database > Add to List .. ... 12-17
Importing @ Database . . .. ... 12-18
Exporting a Database .. il 12-20
Deleting Patient Files and Scan Files ... . 12-22
Deleting a Patient File ...l 12-22
Deleting a Patient Visit . ... 12-23
Deleting a Scan Image ... ... 12-24
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Creating a Database Folder

This command will create a new Database folder (a listing) that will appear in the Database Navigator drop-
down list. You must enter a uniqgue name. Once created, it becomes available in the Database Navigator win-
dow.

1. Click File > Database > Create.

Edit Calibration Tools Help

Mew Patient

Database » Active Database »

Reference Sets Create

Import...
Import FolderMail... Export...
Logout
Exit

2. Typeinaname forthe new database folder ("New Study Database’ was used in this example).
Create Patient Database u

Databaze:

INew Study Databaze

|& el
LA

L«

iy | »

.. BDETemp
. Cache

.. Comman ok |

LCancel

. conf
L db
.. Dicom -

3. Click . The following window pops up confirming the New Study Database listing was suc-
cessfully created.

Database Creation Successful u

Successfully created new database:
C\lluminatusDXA\New Study Database\dbhigdb.wymd

4. Click . The pop-up closes, and the Database Navigator window immediately updates to include
the newly created Database name.

Database: IC:‘-,IIIuminatusDXA‘s,New Study Database j

5. From here, you can begin to enter a new patient’s information, or Import existing data.
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Active Database > Remove From List

This command will remove the selected database from the database list in the Database Navigator window.
The database will, however, remain on the hard drive.

1. Click File > Database > Active Database > Remove From List.
Edit Calibration Tools Help

Mew Patient

Database 4 Active Database 4 Add To List

Tfrmmen T Create Remaove From List
Import...

Import FolderMail... Expieie

Logout

Exit

2. Click the drop-down arrow to view all the Databases in the list, and select the Database folder to be
removed.

m Select Database To Remaove From List u
g— — W

C:AllluminatusDissPatients &-F
C:MlluminatusDi=asPatients G-
CoMlluminatusDissPatients M-5
C:SllluminatusDi=a5\Patients T-2

CiilurninatuzDedsNew Databaze
3. click 2~
4. When the following dialog box pops up, click fes ‘or| o
m Are you sure? - WAl .. e u
@ Areyou sure you wish to remaowe this database from the list™

ChllluminatusDxaiNew Database

NORLANLDO B3D109 Rov-7
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Active Database > Add to List

This command adds an existing database name to the drop-down list in the Database Navigator window (see
figure below). Upon completion, it becomes the active database in the Database Navigator window. The data-
base of interest must have been created using the Norland Windows-based software.

Database: |CilluminatusDx4 -

Chllluminatus DA

ChllluminatusDxa\Patients A-F
ChllluminatusD=ahPatients G-hd
ChllluminatusD=AsPatients N-5
ChllluminatusD=AFatients T-2

The “Add to List” command is used when the Database of interest was previously removed from the drop-down
list (but not deleted from the hard drive) and the operator wants to restore it.

1. Click File > Database > Active Database > Add to List.
Edit Calibration Tools Help

Mew Patient

Database » Active Database 3 Add To List

Reference Seis Create Remove From List
Import...

Import FolderMail... Fra

Logout

Exit

2. Inthe Open Patient Database window, scroll down to locate the folder name of the Database being added
to the list.

3. Double-click on the folder to select it and write it to the path above the white box in the window.

m Open Patient Database (eS|

Database:

C:MllurninatusDi<ahPatients A-F

& =0 =l
G |
. lurninatus DA,

I} Patients A-F

LCancel

[oeed |
oK |

4. Click . Notice that the Database becomes active in the Database Navigator window.
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Importing a Database

This command imports Patient Files from a Norland DOS system or scans imported from Illuminatus, and adds
them to the currently selected Database.

1. Make sure you have created and highlighted a database folder with a unique name, as shown below. Here,

New Study Databaseis used in the example.

| Database: IC:‘-,IIIuminatusDXA\New Study Database

B

2. Click File > Database > Import.

Edit Calibration Tools Help

Mew Patient
Database » Active Database 3
Reference Sets Create
Import...
Import FolderMail... ey
Legout
Exit

3. Browse to (or type) the location of the files (to be imported) into the box labeled “Database”. In this example,
the path “F:\Exported Scans” is used. All the files in that location are now listed in the window.

-

Import From Database o D ) |
-—
Database: =l Browse... |
Patient Name Patient |0 Wisit Date(s]
dy A 0/11/200
Abdominal, Soft Tissue Gluteus 24472002 Research
Body, whole wib-1 B/1/2015 OF Body
Dual, Hip Dual Hip 2/4/2008 Left Hip, Right Hip
Lasthame, Firstname 4. PatientlD 742341997, 742041999, 7419/2000, 576/ L F A H, Left Hip, Spine
Lateral, Scan Laterall 1041372004 Lat Spine
No Rotation, Hip NoSling 11/10/2014 Left Hip
Research, George W-003 542142015 Research
Spine, Hip, Forearm One Visit E/28/2004 R F &m H, Right Hip, Spine
‘Whole Body scan DF B/21/1997 OF Body
Whole, Body Trending2 84172004, 5/1/2006, 7/3/2008 OF Body
Irnpart Al | Impart | Cloze |
L

4. Toimport all patients listed, click . To import only selected patients, highlight the patient(s) you

want to import and click . Additional patients may be selected and imported until all required
patients have been imported.

5. When the import is complete, a success message will be temporarily displayed.

Operator's Guide
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Success

pata Imported Successfully

6. When complete, click .

7. The imported patient scans now appear in the Database selected in step 1.

Dalabase: |CylminansCraew Study Database

Patient Visit List

Category. Search.
Quick Search: [Faien Nane |

Patiect Hawen + | Vi Dt [ Seanfym | Ansosd
Abdoeanel 5ol Tasue

Body. Whale

Dusl o

¢ Loget Mo Paeet 35

‘Report Temgplate: Bone Exam Report - 1page Scanmer Not Present

Operator's Guide
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Exporting a Database

This command exports an entire database, selected patient files inside a database, a single patient file, or the
scans from a single patient visit. You can export to a previously created folder on the hard drive or any access-
ible drive letter and path.

1. Inthe Database Navigator window, select the record(s) to be exported (it must be highlighted). A minimum of
one record must be selected to open the Export tool.

» Single click on the Patient name to export the entire patient record.

» Single click on the individual Visit Date of interest under the patient’'s name.

» Hold the <Shift> key and click the consecutive names of the patients you want to export.

» Hold the <Ctrl> key and click only the patient names you want to export in the database.

2. If necessary, create a destination folder on the destination drive. The folder “F:\Exported Scans” is used in
the example below.

3. Click File > Database > Export.

Edit Calibration Tools Help

MNew Patient

Database » Active Database »

Reference Sets Create

Import...
Import FolderMail... Export...

Logout

Exit

4. Click and browse to the desired drive and folder.

Exporting to DOS Database x|

Path to DOS Database:

F:A\E=ported Scans
I- f: j
CFN
I} Exported Scans

Cancel |
oK |

5. When the destination location is selected, click .
6. To export only the selected patient%s% orvisit(s), click &l To export all of the patients and visits
Export All

from the current database, click .
7. When the export is complete, a success message will be temporarily displayed.
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Success

Data Exported Successfully

8. Thefiles that were successfully exported now appear in the Export to Database window, along with the visit
dates selected (multiple names appear, if more that one name was selected).

rm Export To Database - E@g

Database: =l Browse...

Fatient Mame Scan Type
DF Body
Abdominal, Soft Tizsue Gluteus 24472008 Research
Body, 'whole wh-1 6172015 CF Body
Dual. Hip Diual Hip 24472008 Left Hip. Right Hip
Lastname, Firstname &, Patientl D FA23N997, 742041999, 71942000, 546, LF Am H, Left Hip, Spine
Lateral, Scan Laterall 1041342004 Lat Spine
Mo Rotation, Hip MoSling 114002014 Left Hip
Research, George W-003 2125 Rezearch
Spine, Hip, Forearm One Wisit B/28/2004 R F & H, Right Hip, Spine
‘Whole Body scan DF B/21/1997 DF Body
Whole, Body Trending2 8/1/2004, 51/2008, 7/3/2008 DF Body
Export &l Export Lloze

9. Click to return to the Database Navigator window.

Note: For subsequent export procedures, you can click the drop down arrow in step 4 and select an
existing folder instead of clicking Browse to export to the same location.
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Deleting Patient Files and Scan Files

When duplicate scans or unsatisfactory scans exist, trending analysis is hampered. Patients, Visits, or indi-
vidual Scans can be deleted. There is NO undo for the Delete function.

Deleting a Patient File

Caution: Deleting a patient record will delete all the associated scan data files that go with that
patient. Deletions cannot be undone.

1. Select the patient from the Patient Visit List to be deleted. Only one patient can be deleted at a time.

Dalabase: |CylminansCraew Study Database =

Patient Visit List

Calegory. Search;
I Quick Search: [Feer Nane |

Fatawrd 1) Patinrt N it Dt Sean Typm Furhyomd

+ Ghreus Abdominal. Solt Tisue
# wbl Body. ‘Whale
s —
= Vs 2044 2000

Sean Right Hig Yes
Scan Left g s
Sean Right Hyp s
Sean Leit Hip s

Deie 44 Logmt Hew

[Admiristrator | Report Template: Bone Exam Report - 1 page Scanner Not Present

2. Click the button at the bottom of the window.

3. A confirmation dialog box will be displayed.

m Confirm Deletion u

“r'ou are about to delete the patient:

@ 'Dual, Hip'
and all associated wisit records and their scan(s).

Are you sure you wish to continue?

Cancel |

4. Click on oK to delete the entire patient record (remember, there is NO undo).

5. The selected patient file will be deleted from the database.
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Deleting a Patient Visit

Caution: Deleting a visit from a patient record will delete all the associated scan data files that go with
that visit. Deletions cannot be undone.

1. Click onthe patient’s visit scan date (in the Database Navigator window) that is to be deleted.

Dalabase: |CylminansCraew Study Database =

Patient Visit List

Calegory. Search;
I Quick Search: [Feer Nane |

Delele 6 Lot Hew

[Admiristrator | Report Template: Bone Exam Report - 1 page Scanner Not Present

2. Click the button at the bottom of the window.

3. A confirmation message will be displayed.

m Confirm Deletion u

v'ou are about to delete the entire visit record for patient:
@ 'Body. Whole'
created 6/1/2015.

Are wou sure you wish to continue?

LCancel |

4. Click on oK to delete the visit record (remember, there is NO undo).

5. The selected patient visit will be deleted from the database.
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Deleting a Scan Image

m Caution: Deleting a scan from a patient visit cannot be undone. ]

1. From the Database Navigator window, select the visit or scan record of the scan image to be deleted (i.e.
select the Patient Name, Visit Date, and Scan Type).

Dalabase: |CylminansCraew Study Database =
Patient Visit List
Category. Search,
Quick Search: Fme%« |
Fatirt ) Ptinrt Naen | Vi Dste | GeanTypm | Anshosd
+ Ghees Abdoinl Soh Tizzue
® wbl Body. Whale
+  Patertll Laatname, Fritname A
= DVt Sk, Hip. Forsart
- Wit G2 2004

Sean Righe Hi ‘fes
Sean AP S o
I | ) A

0 Lot How

[ cdmiristratcs | Mepor Temgplste: Done Exam Report - 1psge  |Scanmer Mot Present

2. Clickon to open the Scans tab window.

3. Highlight the scan (or scans) to be deleted. (Hold the <Ctrl> key to select more than one scan.)
4. Right click to reveal a menu. Select Delete Scan(s).

Remove Voice Note

Delete Scan(s) [}

Properties...

5. A confirmation message will be displayed.
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I s 1

@ Areyaou sure you wish to delete the selected scan(s)?
Tez
6. Clickon fes to delete the scan(s) (remember, there is NO undo).

7. The selected scan will be deleted from the database.

Operator's Guide
435D109 Rev. Z

NORLANLG



12-26 Additional Techniques

Working with Reference Sets

The “Reference Sets” are accessed by clicking File > Reference Sets. These Reference Sets are installed on
the hard drive during installation. The Reference Set command provides some tools for maintaining and cre-
ating Reference Sets on the system.

Note: Printed Norland supplied “Reference Set Data Sheets” are located in Chapter 19, Reference
Data Sets. Chapter 19 also describes the source of the data and explains the information gathering cri-
teria.

The Reference Sets window (shown below) displays a list of currently available Reference Data sets.

i iefereme Sets [ e

Enabled | Title | Scan Type | Region | Data Type | Gender | Race -
— Create

Yes Morland 392 [2.2] Hip Fem Meck BHD Caucasian

Yes Morland 392 [2.2] Hip Fem Meck BHD Caucasian
Caucasian Get

Yes Morland 392 [2.2] Hip Troch BHD

Yes Morland 392 [2.2] Hip Troch BrD Caucasian L

ez Marland 392 [2.2) Hip “wards Tri BMD Caucasian = Close

es Morland 798 Farearm Distal BMD Caucasian

es Morland 798 Farearm Prowimal BMD Caucasian

Yes Morland 798 Farearm pradius BrD Caucasian

es Morland 798 Farearm H Distal BMD Caucasian

Yes Morland 798 Farearm H Prowimal BD Caucasian

Yes Morland 798 Farearm H p radius BrD Caucasian

Yes MHAMES 11l Hip Hip TsBMD sBMD Caucasian

Yes Morland 4/00 AP Spine wert L1 BrD Caucasian

Yes Morland 4/00 AP Spine wert L2 BrD Caucasian

‘ez Marland 4400 AP Spine wert L3 BMD Caucasian

Yes Morland 4/00 AP Spine wert L4 BrD Caucasian

Yes Morland 4/00 AP Spine wert L1-4 BrD Caucasian

Yes Morland 4400 AP Spine werk L2-4 BMD Caucasian
Yes Morland 4/00 AP Spine APL14sBMD  <BMD
ez Marland 4400 AP Spine APL24sBMD sBMD
Yes Morland 4/00 AP Spine L1 BrD
Yes Morland 4/00 AP Spine L1-L4 BrD
Yes Morland 4400 Hip Fern Meck BMD
Yes Morland 4/00 Hip “Waards Tri BrD
‘ez Marland 4400 Hip Trach BMD
Yes Morland 4/00 AP Spine wert L1 BrD
Yes Morland 4/00 AP Spine wert L2 BrD
Yes Morland 4400 AP Spine werk L3 BMD
Yes Morland 4/00 AP Spine wert L4 BrD
e Marland 4400 AP Spine wert L1-4 BMD
Yes Morland 4/00 AP Spine wert L2-4 BrD
Yes Morland 4/00 AP Spine APL14sBMD  sBMD
Yes Morland 4400 AP Spine APL24:BMD sBMD
‘ez Morland 4,00 AP Spine L1 BMD

Caucasian
Caucasian
Caucasian
Caucasian
Caucasian
Caucasian
Caucasian
Cauc-Hisp
Cauc-Hisp
Cauc-Hisp
Cauc-Hisp
Cauc-Hisp
Cauc-Hisp
Cauc-Hisp
Cauc-Hisp
Cauc-Hisp

Ba Tt B B B W W e i B B B e o e B B e e e B B B B e e e e B B B -l - |

Figure 12-2: The Reference Sets Data Table

To Create a Reference Set . il 12-27
To Geta Reference Set ... 12-29
ToEdita Reference Set ... . 12-31
ToDelete a Reference Set .. ... 12-32
To Send a Reference Set . .. 12-33
To Print a Reference St ... 12-34
Reference Set Selection .. ... . 12-35
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To Create a Reference Set

Reference sets can be created for local populations. The Create Reference Set feature allows the operator to
input reference data from a printed copy or from a statistical analysis of a local population.

The operator is able to select the scan type and the region for which the reference set is being created. For each
scan type, the region pull-down menu has an option labeled “Other”. When this option is selected, the “User
Defined” edit field determines the region name.

Note that the operator is allowed to create reference sets for multiple user defined regions for a given scan type.
Also, for the same scan type and region name, multiple reference sets can be created with different titles. In the
case of the Small Subject scan type, you will note that when you click on Small Subject, the “Small Subject”

checkbox in the Research group box is checked as active.

This section explains how to create a Reference Set.

1. Click on File > Reference Sets to open the Reference Set window.

2. Clickon ﬂl to open the Create Reference Set dialog box.

Create Reference Set = I jm] ll
[~ Scan Type
i ,ﬁPSp\na " Hp " Forearm " Lateral Spine  Whale Bady i Research i Small Subject
AP Spine Hip Forearm Lateral Spine ‘whole Body Research
ju || [Fembeck <] || [Prosimal Radis ] || [L2 | [T =l [T Small Subject
User User User User User Lzer
Defined I ;I Defined I ;I Defined I ;I Defined I ;I Defined j' Drefined I 19
~ Reference Data
T & BMD  C BMC ¢ IBMC/FFM  ( STFet%  © sBMD
itle: I
Age Value 25.D. =
Ethnigity ICaucasian vI 1
“foung Reference I
i Female  Male M/ R
Display By * Yalue  I-Scoe Rk Bany Covel |:|
¥ Enabled |~ Pediatric: Refersnce Set
[~ Paost 22 Hip i
a »
Save | LCancel

3. Click ona Scan Type radio button according to the type of Reference Set being created (“Whole Body’ is
used in this example).

4. Click the drop-down arrow to select and define a scan region (Total used here). The box labeled User
Defined would be a special region designed by the operator.

—Whale Body ——
ITntaI LI
LI
Defied | 7
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5. Continue to enter data for each of the fields and make appropriate selections in the Reference Data area of
the window. Select Pediatric Reference Set only if the set is being created for patients younger than twenty
years old. The Title entered in the box will appear at the top of the Reference Graph. A sample Reference Set

is reproduced below for reference.

7] Creste Reference Set - |d ll
[ Scan Tppe

" AP Spine i Hip " Foreaim " Lateral Spine (* ‘whole Body " Research " Small Subject
AP Spine Hip Forearm Lateral Spine ‘whole Body Research

Jut )| | [Fembesk ] || [Prosimal Radiis ] | | [L2 ||| Total | I71 Small Subject

u u u U u U
Defined | =1 | | vefied | 1| | pefirest | <1 | | Defined | =1 | | nefined | k2| Defined | E

~ Reference Data
& BMD ¢ BMC ¢ IBMC/FFM  © STFat% sBMD

Tile Dudey
Age Value [25.. [-
Ethricity  |Caucasian vI 20 e S
Young Reference  |.979 50 919 2
@ Female ¢ Male 7 N -
Display By @ Yalue ¢ I-Score Risk Bands Levels j+
[l
¥ Enabled [~ Pediatric Reference Set
[~ Post 22 Hip i
o™ b

6. Click and then to enter the newly created Reference Set into the database.
7. Click to close the Reference Sets window.
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To Get a Reference Set

The Get feature allows the user to load Reference Sets from an existing Reference Set file to the current Refer-
ence Set file.

1. Click on File > Reference Sets to open the Reference Sets window.

Enabled | Title | Scan Type | Region | Data Type | Gender | Race

Yes Morland 392 [2.2] Hip Fem Meck BHD Caucasian
Yes Marland 392 [2.2] Hip Fern Meck BMD Caucasian
Yes Morland 392 [2.2] Hip Troch BrD Caucasian
Yes Morland 392 [2.2] Hip Troch BHD Caucasian
Yes Morland 392 [2.2] Hip Wards Tri BrD Caucasian
es Morland 798 Farearm Distal BMD Caucasian
Yes Morland 798 Farearm Proimal BHD Caucasian
Yes Morland 798 Farearm p radius BrD Caucasian
es Morland 798 Forearm H Distal BMD Caucasian
es Morland 798 Forearm H Prowimal BMD Caucasian
Yes Morland 798 Farearm H p radius BrD Caucasian
ez NHAMES 1 Hip Hip TsBMD sBMD Caucasian
Yes Morland 4/00 AP Spine wert L1 BrD Caucasian
Yes Morland 4/00 AP Spine wert L2 BHD Caucasian
Yes Morland 4/00 AP Spine wert L3 BHD Caucasian
Yes Morland 4/00 AP Spine wert L4 BrD Caucasian
ez Marland 4/00 AP Spine wert L1-4 BMD Caucasian
Yes Morland 4/00 AP Spine wert L2-4 BrD Caucasian
Yes Morland 4/00 AP Spine APL14sBMD  <BMD Caucasian
Yes Morland 4/00 AP Spine APL24sBMD  sBMD Caucasian
Yes Morland 4/00 AP Spine L1 BrD Caucasian
ez Marland 4400 AP Spine L1-L4 BMD Caucasian
Yes Morland 4/00 Hip Fem Meck BrD Caucasian
Yes Morland 4/00 Hip “Waards Tri BrD Caucasian
Yes Morland 4/00 Hip Troch BrD Caucasian
Yes Morland 4/00 AP Spine wert L1 BrD Cauc-Hisp
ez Marland 4400 AP Spine wert L2 BMD Cauc-Hisp
Yes Morland 4/00 AP Spine wert L3 BrD Cauc-Hisp
Yes Morland 4/00 AP Spine wert L4 BrD Cauc-Hisp
Yes Morland 4/00 AP Spine wert L1-4 BHD Cauc-Hisp
Yes Morland 4/00 AP Spine wert L2-4 BrD Cauc-Hisp
ez Marland 4400 AP Spine APL14sBMD sBMD Cauc-Hisp
Yes Morland 4/00 AP Spine APL24sBMD  sBMD Cauc-Hisp
‘ez Morland 4,00 AP Spine L1 BMD Cauc-Hisp

T e B B B W B e e B B B e e e B B e e e B B e W e e e B B Bl i |

2. Clickon 3 to open the file selection window.
m Get Reference Set : : &J

Reference Set Source:

Browsee

LCancel
Ok

3. Specify the file that the Reference Sets are to be gotten from by typing in the full path of the file or by select-
ing the file using the browser.

4. Click to open the file and list its contents.
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(R e

Enabled I Title | Scan Type | Region | Data Type | Gender I Race

Yes Morland 738 Farearm H Distal BMD ] Caucasian
Yes Morland 738 Forearm H Praimal EMD M Caucasian
Yesx Marland 738 Forearm H pradius BMD & Caucasian

x|
s |

LCancel

5. There are four choices for selecting References:

a. toselect all of the References in the set, click &l , or

b. toselect anindividual Reference, highlight it and click m or
c. toselect multiple References, press the <Ctrl> key to highlight the desired References and click

Lo

d. toselect a group of References, click on the first desired Reference, press <Shift> and click on the last

to highlight the group and click .

6. These options will merge the new Reference Sets with the existing ones.

7. Click to finish.
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To Edit a Reference Set

The Edit feature allows installed Reference Sets to be edited. In addition, Reference Sets can be enabled and
disabled through the Edit window.

1. Click on File > Reference Sets to open the Reference Sets window.
2. Highlight the Reference Set to be edited, then right click on it.

3. Click Edit....

Enabled I Title

I Scan Type | Region
Egton

I Data Type | Gender I Race

Yesx Maorland 392 [2.2]
Yes Morland 392 [2.2]
Yesx Marland 392 [2.2]
Yesx Marland 392 [2.2]
Yesx Marland 392 [2.2]
es Morland 738
es Marland 798
es Morland 738
‘Yes Morland 738

‘es

‘Yes Morland 4/00
es Marland 4/00
Yes Morland 4400
eg Morland 4/00
‘Yes Morland 4/00
es Marland 4/00
Yes Morland 4400
eg Morland 4/00
‘Yes Morland 4/00
es Marland 4/00
Yes Morland 4400
es Morland 4400
es Morland 4/00
es Marland 4/00
es Morland 4400
‘Yes Morland 4/00
e Morland 4/00
Yes Marland 4700

Hip Fem Neck

Hip Fem Meck

Hip Trach

Hip Trach

Hip Wards Tri

Forearm Distal

Farearm Proimal

Forearm pradius

Forearm H Distal
Froximal

Forearm H
= 1

p1adius

Hip TsBMD
vert L1
vert L2
wert L3
B vert L4
AP Spine wert L1-4
AP Spine wert L2-4
AP Sping APL14sBMD
AP Sping APL24sBMD
AP Spine L1
AP Spine L1-L4
Hip Fem Neck
Hip Wards Tri
Hip Troch
AP Spine wert L1
AP Spine wert L2
AP Spine wert L3
AP Spine werk L4
AP Spine wert L1-4
AP Spine wert L2-4
AP Spine APL14sBMD
AP Spine APL24sBMD
AP Spine L1

BMD
EMD
BMD
EMD
BMD
BMD
BMD
BMD
BMD
BMD

sBMD
BMD
BMD
BMD
BMD
EMD
BMD
sBMD
sBMD
EMD
BMD
EMD
BMD
EMD
BMD
EMD
BMD
BMD
BMD
BMD
sBMD
sBMD
BMD

R R R T R e R e e T Bl B e R B B B B R B | R R B B B R B R B |

Caucasian
Caucasian
Caucasian
Caucasian
Caucasian
Caucasian
Caucasian
Caucasian
Caucasian
Caucasian
Ca i

Caucasian
Caucasian
Caucasian
Caucasian
Caucasian
Caucasian
Caucasian
Caucasian
Caucasian
Caucasian
Caucasian
Caucasian
Caucasian
Caucasian
Cauc-Hisp
CaucHisp
CaucHizsp
Cauc-Hisp
Cauc-Hisp
CaucHisp
CaucHisp
Cauc-Hisp
Cauc-Hisp

m

4. When the Edit window opens, make the necessary edits. Notice that the Reference Set can also be Enabled
or Disabled here by clicking the Enabled check box. Clicking this check box will enable the Reference Set to
be used in a graph or to calculate T-Scores/Z-Scores.

[ Edit Reference Set _IDiI
[ Scan Type
" AP Spine " Hip " LateralSpine ¢ ‘whole Body " Reseach " Small Subject
[~ AP Spine Hip Farearm Lateral Spine ‘Whale Body Research
Lt =1 | [ [FemMeck =] | | [FrosimalRadius ~] | | [L2 =1 | [ro | 7 Small Subject
User User User User User User
Defined | = || pefined | =] | | Defined | =1 | | Defined | =1 | | Defined - Defired | E
i~ Reference Data
@ BMD " BMC ¢ TBMC/FFM ¢ STFatz sBMD
Title INorIamd 798
Age Value 25.D. =
Ethnicity IEaucas\an - 0.848100 0199440 [
Yourg Reference  [0.848100 50 0.857500 0.149440
L 0.536900 0.149440

& Female  Male & N/A
Display By * Yale ¢ I-Score
¥ Enabled

[~ Post22Hip

I~ Pediatric Reference Set

Medium Risk

™

Risk Bands Levels
0.773380

0.773280
0.661300
0.661200

LCancel

Save |
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5. When done editing, click .
6. Click to close the Edit window.

7. gonfirm téﬂat the change was made to the edited Reference Set. Click to close the Reference
ets window.

To Delete a Reference Set

The Delete feature allows installed Reference Sets to be deleted from the system. The deletion cannot be

undone.

1. Click on File > Reference Sets to open the Reference Sets window.
2. Locate and click to highlight the Reference Set(s) to be deleted.

» To select an individual Reference Set, click on it.

» To select multiple References, press the <Ctrl> key and click on the desired References.
» To select a group of References, click on the first desired Reference, press <Shift> and click on the last

to highlight the group.

3. Right click on the highlighted record(s) to open the “Edit/Delete/Send” pop-up.
4. Click on Delete (remember, this cannot be undone). The Reference will be deleted from the list.

Ve
es
ez
es
es
Ve
es
‘fes

5. Click to close the Reference Sets window.

Enabled I Title

| Scan Type | Region

Morland 392 [2.2]
Morland 392 [2.2]
Marland 392 [2.2)
Morland 392 [2.2]
Morland 392 [2.2]
Maorland 738
Morland 798
Morland 798
Morland

Morland

Marland
MHAMES 1l
Morland 4/00
Morland 4,400
Morland 4400
Maorland 4/00
Morland 4/00
Morland 4400
Morland 4400
Morland 4,400
Morland 4/00
Morland 4,400
Morland 4400
Morland 4,400
Morland 4/00
Maorland 4/00
Morland 4400
Morland 4/00
Morland 4/00
Morland 4,400
Morland 4/00
Morland 4,400
Morland 4400
Morland 4,/00

Hip

Hip

Hip

Hip

Hip
Farearm
Farearm
Farearm
Faorearm H

AP Spine
AP Spine
AP Spine
AP Spine
AP Spine
AP Spine
AP Spine
Hip

Hip

Hip

AP Spine
AP Spine
AP Spine
AP Spine
AP Spine
AP Spine
AP Spine
AP Spine
AP Spine

Fem Meck
Femn Meck
Troch
Trach
Wwards Tri
Distal
Prowimal

p radius

Hip TsBMD
wert L1

wvert L2

wert L3

wert L4

wvert L1-4
wvert L2-4
APL14sBMD
APL24sBMD
L1

L1-L4

Fern MNeck
Wwards Tri
Trach

wert L1

wvert L2

wert L3

wert L4

wvert L1-4
wert L2-4
APL14sBMD
APL24sBMD
L1

BMD
BMD
BMD
BMD
BMD
BMD
BMD
BMD

F

]
E
]
F
F
F
E
F
F
F
F
E
F
F
F
F
F
F
F
F
F
F
F
F
F
F
F
F
F
F
F
F
F

| Data Type | Gender I Race I -

Caucasian
Caucasian
Caucasian
Caucasian
Caucasian
Caucasian
Caucasian
Caucasian

Caucasian
Caucasian
Caucasian
Caucasian
Caucasian
Caucasian
Caucasian
Caucasian
Caucasian
Caucasian
Caucasian
Caucasian
Caucasian
Caucasian
Cauc-Hisp
Cauc-Hisp
Cauc-Hisp
Cauc-Hisp
Cauc-Hisp
Cauc-Hisp
Cauc-Hisp
Cauc-Hisp
Cauc-Hisp

Create |

Get
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To Send a Reference Set

The Sendfeature allows a user to export a Reference Set from the current Reference Set file to a user defined
Reference Set file which may be shared with other users. The Send function does not remove the Reference
Set from the current Reference Set file.

1. Click on File > Reference Sets to open the Reference Sets window.

2. Locate and click to highlight the Reference Set(s) to be sent.

» Toselect anindividual Reference Set, click on it.
» To select multiple References, press the <Ctrl> key and click on the desired References.
» To select a group of References, click on the first desired Reference, press <Shift> and click on the last
to highlight the group.
3. Right click on the highlighted record(s) to open the “Edit/Delete/Send” pop-up.
4. Click on Send.

Enabled I Title | Scan Type | Region | Data Type | Gender I Race I -
Yes Morland 392 [2.2] Hip Fem Meck BHD F Caucasian
Yes Marland 392 [2.2] Hip Fern Meck BMD Caucasian
Yes Morland 392 [2.2] Hip Troch BrD Caucasian
Yes Morland 392 [2.2] Hip Troch BHD Caucasian
Morland 392 [2.2] Hip Wards Tri BrD Caucasian
Morland 798 Farearm Distal BMD Caucasian
Morland 798 Farearm BHD Caucasian
Morland 798 Farearm BMD i
Forearm H Di

Morland 798 p radiug
MHAMES 11l Hip TsBMD
Morland 4/00 wert L1
Morland 4400 wvert L2
Morland 4,400 seap wert L3
Morland 4/00 AP Spine wert L4 Caucasian
Marland 4/00 AP Spine wert L1-4 Caucasian

]

F

M

F

F

F

F

F

F

F

F

F Caucasian
F
F
F
F

Morland 4/00 AP Spine wert L2-4 F Caucasian

F
F
F
F
F
F
F
F
F
F
F
F
F
F
F
F

Caucasian
Caucasian

Morland 4/00 AP Spine APL14sBMD Caucasian
Caucasian
Caucasian
Caucasian
Caucasian
Caucasian
Caucasian
Cauc-Hisp
Cauc-Hisp
Cauc-Hisp
Cauc-Hisp
Cauc-Hisp
Cauc-Hisp
Cauc-Hisp
Cauc-Hisp
Cauc-Hisp

Morland 4/00 AP Spine APL24sBMD
Morland 4/00 AP Spine L1

Marland 4400 AP Spine L1-L4
Morland 4/00 Hip Fem Meck
Morland 4/00 Hip “Waards Tri
Morland 4/00 Hip Troch
Morland 4/00 AP Spine wert L1
Marland 4400 AP Spine wert L2
Morland 4/00 AP Spine wert L3
Morland 4/00 AP Spine wert L4
Morland 4/00 AP Spine wert L1-4
Morland 4/00 AP Spine wert L2-4
Marland 4400 AP Spine APL14sBMD
Morland 4/00 AP Spine APL24sBMD
Morland 4,00 AP Spine L1

5. Specify the file the Reference Sets are to be sent to by typing in the full path of the file or by selecting the file
using the browser.

6. Click to send the Reference Set(s).
7. Click to finish.
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To Print a Reference Set

1. A Reference Set can be printed by selecting Tools > File Tools.
2. Click onthe Normals tab.

I Norland File Viewer ==
Patients ] Scans ] Regions ] System ] Gc ] Diagnostics |
Normals File Name: |C:!IIIuminatusDXMnorland\normal =
Reference Data Reference Sets
- Title: | Scan Type | Fegion | Data Type | Sex | Race -
3 Morland 392 (2.2] Hip Fem Meck BMD F Caucasian B
Mext R 92 —
st Morland 332[22] Hip FemMeck  BMD M Causasian =
Prev Rec 8 Morland 392 (2.2] Hip Troch EMD F Caucasian
Morland 332 [2.2] Hip Trach BMD b Caucasian
Enabled? ¥
rene = Merlard 332(22] Hip WardsTi BMD F Coucssian
Scan Type No. 255 Marland 7928 Forearm Distal BD F Caucasian f
i Morland 733 Forearm Frazimal BMD F Caucazian
Scan T Hi
i Lt i Morland 798 Farearm pradius BMD F Caucasian
Region Type Mo, |4 Morland 798 ForearmH  Distal EMD F  Caucasian
. Morland 738 ForearmH  Proximal BrD F Caucasian
R Fem Neck
ik il Morland 798 ForearmH  pradius BMD F Caucasian
Title Morland 392 (2.2) NHAMES Il Hip Hip TsBMD  sBMD F Caucasian
" Morland 4/00 AP Spine  wert L1 BMD F Caucasian
o Laucasan Morland 4/00 AP Spine  wertL2 BMD F Caucasian
Sex F Marland 400 AP Spine  wertL3 BMD F Caucasian
BMD Morland 4/00 AP Spine  wertL4 BMD F Caucasian
Morland 4/00 AP Spine  wertL1-4 BEMD F Caucasian
By T-Score? Mo Morland 4400 AP Spine  wertL2-4 EMD F  Caucasian
" Morland 4/00 AP Spine  APL14sBMD  sBMD F Caucasian
Post 2.2 Hip? il -
ils : Moland 400 AFSpne  APL24BMD sBMD  F  Caucasian
al™ E Nerland 4400 AP Sriee 11 RkD F laurasian %
b

3. To print one Reference Set, click on the Reference Set of interest to select it and then click on the “Print

Selected’ button.

& & princal |

Print 5 elected |

ata Tupe | Sex | Race |

w0 F Caucasian
w0 b Caucaszian =
W[ F Caucazian
W0 k Caucasian

4. To print all the Sets, click on the “Print All’ button.
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Reference Set Selection

After a scan has been performed and analyzed, the reference sets corresponding to the patient's demographic
data are loaded automatically. However, if matching reference sets could not be found, the user is prompted to
select which reference sets are used.

A single matching Reference Set could not be found for region L2 - L4, Select a
Reference 5et from the Reference Set List.

The user may then select any of the available reference sets available for the scan type by clicking on it and

C ok I . | Cancel . .
then clicking = Click if no reference sets are desired.
m Reference Sets E X |
Enabled | Title | Scan Type | Region | Data Type | Gender | Race |
Yes Morland 4/00 AP Spine wert L2-4 BHD F Caucasian
Yes Morland 4/00 AP Spine wert L2-4 BHD F Cauc-Hisp
Yes Morland 4/00 AP Spine wert L2-4 BHD F Black,
Yes Morland 4/00 AP Spine wert L2-4 BrD F Agian
ez Marland 4400 AP Spine wert L2-4 BMD F Hispanic

LCancel

oK
[ ored |

The reference sets selected are used for all subsequent viewings of the scan and the reports generated for the
scan. To change the reference sets being used for the scan, right click on the image while in the Scan Results
tab window. Select Change Ref Sets from the Graphs menu.
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File Edit Calibration

Scans |

Tools

Help

Scan Assuls |

Medium Risk

L2-L4 Norland 4/00

Graphs
Color

Baseline

Image Analysis

Image Composition

Image Mode

@ | Reference
Trending
Ref/Trending
Change Ref Set

Spine  28JUN 2004 8:34 Scan Speed: 130mmds  Resolution: 1.5mm x 1.5mm

STD CWs for L2-L4 BMD: 1.0 BMC: 1.5 See Guide for other Cv's.  Cument Image: Lin Bone

Stamp View

Report

56.75
17.78
20.90
L4 1.016 18.07
Total sBMD 1146mg/cn E1070mg

Length (em) [ width (em) [ T-Seore | “Young Ref, (%) | ZScore | Age Match (%) [ ST Change (%) | ST Change (/v [ LT Change (%] LT €

11.4
375
4.05
360
11.4

120
120
120
120
120

0.23 966
0.20 7.0
0.02 936
0.39 939
0.23 966

012
016

0.04
-0.26
012

a8.2 e =
a7 s s
100.6 * *
95.8
98.2

<

Select Template |

i

<< Patient List <« Demographics

| Administrator

| |Report Template: Bone Exam Report - 1 page

Scanner Not Present
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Pressing the Halt Button

HALT

o _ . .
Press the HALT button on the Scanner Arm Touch Pad to immediately terminate the x-ray exposure and
stop the scanner arm movement.

After the HALT button has been pressed, you must turn the scanner power switch OFF and back ON again to
resume scanning.

Caution: When the scanner power switch is turned back on, the scanner arm will return to its origin
position. ENSURE THAT THE PATIENT IS NOT IN THE SCANNER ARM PATH!

From the Tools menu, select Initialize Scanner to reinitialize the scanner.
The following warning will appear:

Nerland Alert
l

Warning! The scanner is aboutto locate the table
atigin. Please verify thatthe patientis clear befare
& cantinuing.

Click to continue. The scanner arm will find the origin.

Leave the computer power switch ON to retain the current study.
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Special Region Cursors

Special Region Analysis software estimates bone mineral in operator-defined regions of the DXA scan.

Norland software automatically includes defined special regions when it calculates and presents numeric res-
ults, and it saves the cursor placement and size information with the analysis.

Subsequent scans should incorporate the Show Comparison feature to aid in replication of any special region
cursors.

Number of Special Regions Permitted

The maximum number of special regions permitted depends on the scan type. The table below lists the max-
imum number of Special Regions permitted for each Norland scan option.

Table 12-1: Number of Special Regions

Scan Type Maximum # of Special Regions
AP Spine 2
Left/Right Hip 2
Whole Bodya 2
Left/Right Forearma 2
Lateral Spine @ 2
Researcha 7
Small Subjecta 7

aThis scan type is not available on allmodels.
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Add a Special Region

The Special Region analysis process begins with placement of the first cursor box to circumscribe the area of
interest. Refer to Table 12-1 on page 12-38 for the number of special regions allowed per scan type. Be sure to
name the regions in a consistent manner with your study protocols.

1. Open the scan of interest in the Analysis tab.

ity

| faminstrator Fepart Templates Patient Letter Scanner Present t

2. Inthe User Defined Region area of the window, click the drop-down arrow and select a cursor type ("8 Sides”
is selected here).

Uzer Defined Region

[eoie |

Fegion MName ‘Tranaverse

Add Region | | Detab. |
4 Sides / Cursor is the original on-axis rectangular area defined with side placement. It is commonly
Side Control used for regular on-axis areas or areas that need dimensions to be displayed or printed.
4 Sides / Cursor is a quadrilateral area defined with corner placement, resulting in angular special
Corner Control region Cursors.
8 Sides / Cursor is an eight-sided area also defined with corner placement. It can be used to cir-
Corner Control cumscribe more complex regions.

3. Typeinaname to identify the special region to be added (“Transverse’ is used in this example).

4. Click the button. Notice the addition of an 8-sided Region of interest (ROI) cursor box - with a
cursor in each corner of the box.

43ED109 Rev. 7 NORLFANLO
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5. Adjust the ROI in accordance with your study protocol. Different protocols have different specifications.

6. Inthe Regions area of the Analysis tab window, the name of the special region appears under the heading of
Region (“Transverse” and “Body” used in the example below). The dimensions of a 4-Sides / Side Control
box are listed under Length and Width. Corner Control boxes and 8-Sided boxes will not list Length and

Width values.

Fegions

Region |Length (cm) |1.I'-l"|dth (cm) |
Body 3.60 5,10
Transverse ——— E——

7. The Length and Width values will update as control points are adjusted.

8. The cursor can be modified as any other cursor. Click on any point inside the cursor and drag to a new loc-
ation. Click on any control point to reshape cursor.

9. To add additional regions, return to step 2 above.

10. When all regions have been placed, click (at the bottom of the window).

11. The special regions will be saved with the scan data file. Future scans should use the same dimensions for
effective trending comparisons.
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Modify an Existing Special Region

12-41

1. Inthe Scan Results window, right-click to open the menu shown below.

File Edm Calbraten Tool  Help

Scans

Graphs
Colent

Baseline

Image Anahysis

Irnage Mode

Pesearch 21 MAY 2015 1256 Scen Speed Bmm's Pesclution: 1.0mm x 1,.0mm

Ho Astersnen Daln Svakshin

No Tiending D ats Avalable

Eralysis Options.
Moy Reguen.
Feanalyse..

Fules Tocl.

——————————]

Soe Dperator's Guide for infomation on O, Cunent knage: Lin Bone

Regon | %] BMD [glenfy| BMC(gl| dvesfent}] Lengthicmi] Wi jcmi|
| By 030 AEE 1248 FED 510
Transvaize 050 47 B9

Lesn s 5] Tot oz g1
X ar
B B e e

stamp Yew

Admiristrates 1 Report Template: Bone Exam Report - 1 page

Scanmer Present

2. Select Image Analysis > Modify Region.

3. Click on the border of the region needing to be modified to enable it.

Fiagion Mame
fckd Rogon | Dekens Foaggors|

inchide/Exciude

Frogmss
Click andl hold on the contiol ponts 1o mave.

=

Cunent image: Lin Bono

Adrraiitates 1
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5. Continue positioning the remaining sides or corners of the cursor box until you are satisfied with the cursor
box size and placement for the modified region.

6. To modify another region, click on the border of the next region to enable it, and modify the region as needed.

7. Click when finished. Click .
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Delete a Special Region

1. Inthe Scan Results window, right-click to open the menu shown below.
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2. Select Image Analysis > Modify Region.
3. Click on the border of the region to be deleted.
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Rename a Special Region

1. Inthe Scan Results window, right-click to open the menu shown below.
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2. Select Image Analysis > Modify Region.
3. Inthelist of regions, highlight the region to be renamed.

Fegions

Region | Length (cm) ||.||ﬁdth {cm) |
Body 3.60 5.10
Transverse | = Eaan

. Ciok| 2= |

Region Detai X
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Length [rm) 3E0 ‘width [2m) 510
Top Bottom
Left ®: 25 Y40 Leit = 25 ¥ 78
Right *: 75 Y40 Right *: 75 75
LCloze |

5. Inthe Region Details window, type a new name for the Region in the Region Name box.

6. Click Bename Click Llose l The new region name will appear in the Regions table.
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Include/Exclude

Although not recommended, it may be necessary to remove artifacts from a scan region (such as hip pros-
thetics, pins, or staples). Doing so will negate the automatic analysis provided by the Norland software.

Note: The DXA software provides both an /nclude and an Exclude function to be used for editing scan
results. If it is necessary to use the functions to add or remove artifacts or islands of tissue from a
scan region, subsequent scans of the same patient must have the identical Include or Exclude oper-
ation performed in order to obtain meaningful serial analyses.

Include

The Include function allows the operator to include odd-shaped islands of the scan, which did not contribute to
BMD results as bone information or were separated from the primary investigation site. It may also be used to
recover data points previously excluded (see the "Exclude" on page 12-49 section). Scan data is not changed,
but the tabulated result values may be affected by this operation.

1. Inthe Scan Results tab of the Filmstrip view, right-click to open the menu shown below. Confirm that
Baseline is checked.

Note: All non-bone tissue in the Included area will be displayed in the baseline color or shade. (Not
related to density spectrum.)
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2. Right click again to open the menu and select Image > Modify Region.
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Graphs
Color 3
v Baseline

Image Analysis

Reanalvze...

Ruler Toal. .

Baone image not for diagnos Shows Comparison...

3. Click the button.

A Hlminatus DXA 4,000, 20: Do, Jaoe L. 555 G55 1034 BIG004

Fle Ede Calbration Todls Help
Brsytis | Sean Resulls

Patignt Doe.Jane |

Eingpans
Hegion Lengthimm) | Width{mm} | =
e el
L3 330 12.00

L+ .85 12.00

1214 15 12,00

Usserr Db Biegeon
4531/ Comer Contrel =
Reginn Mami |

Add Region Detade

InchudeExclude

Inchat Evchuba Desezannd
Frogress
Chick and hald on the confrol pomls $o mov

Click on region to select

ez | Cancel | | |

Aubmivisls slor 1 Iribax; O Scarwre Not Present | Hiel:

4. Position the pointer on the edge of the include box (left-hand picture) and drag it to the general area to be
included. Use the click and drag method to position the cursors around the artifact to be included (middle pic-
ture).
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L L

L~

5. When the include box is in position, CLICK ON Eont'nue . The included area is added back into the image
(right-hand picture).

6. Repeat steps 3, 4 and 5 to define additional regions to be included.

7. Toinclude an irregularly-shaped artifact, make the size of the include box small. Drag it so it covers a part of

the artifact, then click on Continue. Repeat with another small box. Continue this incremental including pro-
cess until the entire artifact is included.

8. Click the button at the bottom of the window.
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9. Data within the included region is added to the results calculations. Norland software stores the INCLUDE

region information with the scan analysis. Click .
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10. The scanis saved and the Filmstrip view appears, showing the newly included region in the thumbnail to the

left.
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Exclude

The Exclude function allows an operator to delete tissue from a scan region. The excluded area is subtracted
from the resulting calculations.

Scan data is not changed, but tabulated result values are affected by this operation. The excluded region can be
brought back by re-analyzing the scan.

Note: If an external object such as buttons or zippers are included in the scan region, it is better to re-
scan the patient after removing the object. Using the Exclude function deletes underlying or superior
tissue values in the excluded region from the calculations.

1. Inthe Scan Results tab of the Filmstrip view, right-click to open the menu shown below. Confirm that
Baseline is checked.

Note: All non-bone tissue in the scan image will be displayed in the baseline color or shade. (Not
related to density spectrum.)
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2. Right click again to open the menu and select Image Analysis > Modify Region.

Color

Baseline

Image Analysis

Analysis Options...
Madify Region...
Reanalyze... I"\’

Image Composition v

Image Mode 3

Ruler Tool...

Show Comparison...

3. Click the button.

D10 Fev 2 NORLANLDO



12-50 Additional Techniques
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4. Position the pointer on the edge of the exclude box (left-hand picture) and drag it to the general area to be
excluded. Click and drag to position the cursors around the artifact to be excluded (middle picture).

—
E kB
A | A |

5. xVhtan the ex)clude box is in position, click . The excluded area is removed from the image (right-
and picture).

6. Repeat steps 3, 4 and 5 to define additional regions to be excluded.

7. Toexclude an irregularly-shaped artifact, make the size of the exclude box small. Drag it so it covers a part
of the artifact, then click on Continue. Repeat with another small box. Continue this incremental excluding
process until the entire artifact is eliminated.

8. Click the button at the bottom of the window.

R |
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s | _cues |

Admintrator

Report Template: Bone Exam Report - 1 page

Seanner Not Present

9. Data within the excluded region is removed from the results calculations. The DXA software stores the

excluded region information with the scan analysis. Click .
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Using the Ruler Tool

A Ruler Toolis included in the software for displaying linear measurements of anatomical features.
1.

In the Scan Results window, right-click to open the menu shown below. Select Image Analysis > Ruler
Tool.
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2. The Ruler Tool will display on the scan, with cursors at each end
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3. Click and drag one end of the ruler to the place being measured.

4. Click and drag the other end of the ruler to the final position and release. The measured length will be dis-
played in millimeters in the window.
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5. Click . The measurement will not be a permanent part of the image.
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Comparison Image

To ensure that the region of interest is comparable to previous scans performed on the patient, cursor place-
ment can be modified using the Comparison Image function. This is very important for accurate trending res-

ults.
1. From the Scan Results window, right click over the scan image to open the menu. Select Image Analysis >
Show Comparison.
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2. Theimage of the patient's first scan of the same type is recalled and presented to the right of the current
scan using the same color scale as the existing image. The example below shows an AP Spine Com-

parison.
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3. Cursors can be positioned to match the comparison image.
4. 1t will be necessary to rescan if the current scan doesn’t match the patient’s initial scan.

5. Once positioned, click to display the scan results, or right-click and deselect Image Analysis >
Show Comparison to hide the comparison image and remain in Analysis mode.
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Image Composition and Image Mode

The Image Composition and Image Mode features allow customization of the scan image by selecting an
alternate density spectrum distribution algorithm. Quantitative results and scan data remain unchanged, but the
image displayed and the printed report can be enhanced in several ways.
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To change the Image Composition, right click on the image while in the Scan Results window to open the
menu. Select the composition type desired from the Image Composition menu.

The following Image Composition types are available:

» Bone - Default setting for all scan types (except Whole Body) that provides an image of the bone value of
each point.

» Soft Tissue - provides an image scaled in terms of the non-bone tissue value of each point.

» Composite - Default setting for Whole Body scans that provides a low energy attenuation image similar in
appearance to an x-ray film image.

» Fat % - Provides an image showing regional fat distribution such as pockets of fatty tissue based on a scale
of 0-90%, with bone points shown as such.

» Lean % - Provides an image showing regional lean tissue distribution based on a scale of 0-90%, with bone
points shown as such.

» Fat - Provides an image scaled in terms of the fat value of each point, with the fat at bone points based on
the amount of fat found at the last soft tissue/bone borderline location.

» Lean - Provides an image scaled in terms of the lean tissue value of each point, with the lean tissue at bone
points based on the amount of lean tissue found at the last soft tissue/bone borderline location.
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To change the Image Mode, right click on the image while in the Scan Results tab window to open the menu.
Select the image type desired from the Image Mode item.

The following Image Mode types are available:

» Lin - Denotes a linear distribution of data points from minimum to maximum when presenting a scan image.
Lin is the default scaling mode when entering analysis and is the most commonly used mode.

Log - Denotes a logarithmic scaling of data points. Log accommodates a wide distribution of dynamic ranges
of values.

Sin2 - Denotes a Sin2 density scaling. This mode permits the viewer to focus in on specific regions of
change such as bone edges.

» Sqrt - Denotes a square root scaling of the data points and is similar to Log.

>

v

>

v

The system retains the current Image Mode and Image Composition settings while scans created during the
same visit are being viewed. The Image Mode and Image Composition are reset to their default values when
the Filmstrip View is exited.

Reports with modified images must be printed before exiting Filmstrip View. Images in saved reports are set to
the default setting when the Filmstrip View is exited.

The images in saved reports may be viewed using different Image Modes and Image Compositions. To view a
saved report at a later date with a different Image Mode/Image Composition:

1. Select ascanin Stamp View and click to view the scan in the Scan Results tab window.
2. Select the Image Mode and Image Composition from the popup menu.

3. Click the Reports tab and select the report that is to be viewed.
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Click Tools > Report > View Selected to regenerate the report with the selected image mode.

File Edit Calibration |Tools| Help

Initialize Scanner
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Calibration Details
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Select Template...

See "Scan Reports" on page 2-12 for more details on viewing reports.
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Image Display - Zoom, Pan, Brightness, and Contrast

Zoom and Pan

In the analysis screen, the scan image may be zoomed in and out for easier placement of analysis cursors on
the scan image.

In the upper left corner of the scan image panel, use the & and & buttons to zoom in and out of the image.
When the @ panning button is selected, clicking and dragging the scan image will pan the image round the view
window. Deselect the panning button to select and adjust the analysis cursors.

A mouse with a scroll wheel may also be used to zoom in and out of the scan image.

Brightness and Contrast

In the analysis screen, the brightness and contrast of the scan image may be adjusted in order to identify scan
landmarks for easier placement of analysis cursors.

In the upper left corner of the scan image panel, slide the Brightness (B) control to adjust the image brightness,
and slide the Contrast (C) control to adjust the image contrast.
When proceeding to the Results screen, the Brightness and Contrast adjustments will remain in effect. To read-

just the image display, return to the Modify Regions screen and move the Brightness and Contrast controls to
the desired location. The Brightness and Contrast will also be reset to default settings each time a scan is

opened for viewing or for analysis.
The Brightness and Contrast controls will not affect the results of the scan.
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Analyzing Saved Scan Data

The Norland software allows an operator to perform a scan on a patient, save the data, and then analyze the
saved scan data later. These procedures explain how to analyze the saved data. The same procedure applies
to all of the types of scans.

1. Locate the patient’s name (or ID) in the Database Navigator window containing the scan that you want to
analyze.

2. Forunanalyzed scans, the word “No” appears in the column labeled Analyzed. If the word “Yes” is shown, it
indicates that the scan has already been analyzed. If this is the case, you must follow the steps labeled
"Reanalyzing Scan Data" on page 12-62 instead.

F i3 lluminatus DXA 4.5.0

File Edit Calibration Tools Help

Database: IC:\\IIummatusDXA\New Stucly Database j
Patiant Visit List
Category: Search:
Quick Search: [Patient Name B

Patient ID | Patient Name  » Wisit Date Scan Type Analyzed
Gluteus Abdominal, Soft Tissue
PatientiD Lastname, Firstname &,
O isit Spirne, Hip, Foreamm
= Unal Spine, Unanalyzed

= Visit 6/2/2015

Delete: << Logout MNews Patient 3> Demographics »> Stamp Yiew >

| Administratar | | Report Template: Bone Exam Report - 1 page Scanner Present

. Sk Wiew >
Click on

4. Double click on the stamp view of the scan you want to analyze. The following message will be displayed.

Click to proceed.

w

Warning: Un-Analyzed

@ The scan you are opening is un-analyzed, doyou wish to analyze it now?

Yes
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»
»
»
»
»
»

The analysis may be performed the same as if the scan had just been acquired. Proceed to the sections lis-

ted below to continue the analysis, based on your scan type:

AP Spine scan - see "Analyzing the Scan" on page 5-17

Hip scan - see "Analyzing the Scan" on page 6-23

Forearm scan - see "Analyzing the Scan" on page 7-21

Lateral Spine scan - see "Analyzing the Scan" on page 8-21

Whole Body scan - see "Analyzing the Scan" on page 9-15

Research and Small Subject - see "Analyzing the Scan" on page 10-16

Operator's Guide
435D109 Rev. Z

NORLANLD,



12-62 Additional Techniques

Reanalyzing Scan Data

Norland software allows an operator to reanalyze a scan using the Reanalyze command. This command starts
the Analysis process over from the beginning, retaining any operator-defined special regions.

» The Reanalyze command may also be used to recover all regions which may have been excluded with the
Include/Exclude function.

The Reanalyze command is also used to reanalyze old scans with a new version of the Norland software.

Renalyze cannot be used to change the measurement scan region of the patient after the scan data is col-
lected.

» Scout Scan studies can not be processed by Reanalyze.

»
»

Note: If a series of scans are to be Reanalyzed, it is important to reanalyze the patient's initial scan
first. This will establish new baseline areas and values to which subsequent scans may be compared.

1. From the Scan Results window, right click over the scan image to open the menu. Select Image Analysis >
Reanalyze. ..
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2. The analysis may be performed the same as if the scan had just been acquired. Proceed to the sections lis-
ted below to continue the analysis, based on your scan type:

» AP Spine scan - see "Analyzing the Scan" on page 5-17

» Hip scan - see "Analyzing the Scan" on page 6-23

» Forearm scan - see "Analyzing the Scan" on page 7-21

» Lateral Spine scan - see "Analyzing the Scan" on page 8-21

» Whole Body scan - see "Analyzing the Scan" on page 9-15

» Research and Small Subject - see "Analyzing the Scan" on page 10-16
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Changing Height or Weight on the Report

The height and weight on the printed report is saved from the patient's demographic information at the time of
the scan. These values do not affect the scan results but can be updated if they were entered incorrectly fora

Scan.

1. Select a scan on the Stamp View or Filmstrip view.
2. Right-click on the selected scan and select Properties.

(T tuminatus D 45

File Edit Calibration Tools Help

Scans | Reports |

Add Voice Note
Remove Voice Note
Delete Scan(s)

Properties...

3. Update the Height and/or Weight values in the lower left corner.
4. Click Done when complete.
5. Generate a report and verify the values have been updated.
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AP Spine Techniques

Changing the Scan Parameters Prior to Scanning

1. Ifitis necessary to change the Speed or Resolution, click on their values and select another value from the
drop-down list (see figure below).

2. Click the appropriate check box for Auto Centering or Mark On-Axis if you must change them.

Scout Scan |Measure Scan |

Speed (mm/sec) 50.0 130.0
Resolution {fmm) |[1.5x0.0 1.5x1.5
Width {cm) 14.10 12.00
Length {cm) 0.0

Auto Centering QM
Mark On-Axis | oFF

Table 12-2: AP Spine Scan Settings
Setting Available Settings

Speed (mm/sec) | 65, 130%, 260
Resolution (mm) | 1.0x1.0, 1.5x1.5*

Auto Centering | On*, Off
Mark On-Axis On, Off*

* Default settings

Note: If scan parameter changes are made prior to scanning, they will only apply to the current scan
being acquired. To save the changes as defaults for all scans, or to revert to the default values:

Click the ﬂl button at the bottom of the Parameters window.

(¢ Restore ™ Save

OK Cancel

Select Saveto store these settings as the new default values, or

Select Restoreto revert to the previously saved default values.

Click to continue with the scan process.
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Unsatisfactory Measure Scan (AP Spine)

12-65

If the L1 vertebra or the iliac crests do not appear in the region of interest, there are 3 choices:

1. You may extend the scan by entering a value for the number of lines (1 line = 1.5mm, default 15 lines).

Ensure the arm will not hit the patient with the extended scan length, then click .

Exterzion [# of lines): 15 = Extend

2. OR:you can click and hold on the control points to extend the top of the scan area to include L1. Then click

Rescan . .
on to rescan the newly defined scan region.

Fahient o, Unanshoed
Spine
Segmert  Scan Complets
fanglelceg |
widhlemy 1200 _ Pean |
Length femy 120

Evtormin (8 otinent (15 |7 Ernnd
Tima Remaining
Total M 55} i

Cusresd Segment (MM 55] o

Frogoss

Analyze Dione Cancel

Report Template: Bone Exam Report - 1 page Scanner Fresent

Administrator

3. OR:if there is not enough room to include L1 when extending the box, click to remark the

patient. In the Cancel Scan dialog box (shown below), select Discard and click

M s I ===

{* Re-Scan {~ Discard

oK Cancel

Operator's Guide
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Auto Centering Mode

HOW IT WORKS: The Auto Centering option automatically centers the spine in the image. When Auto Cen-
tering is checked (enabled) [default], a ‘U’ shaped scan is performed prior to the Measure scan (see figure). The
start and end points marked by the operator will be on the path of the U.

_ /‘j—\[—(_\

il AN
%Mark Point

End Mark Point

»
I

—
Figure 12-3: Auto-Centering U-Scan

Note: The “Force mark points on-axis” option should be disabled (not checked) to fully take advantage
of the Auto Centering mode.

If the start and end points are found to be off center, they are recalculated and implemented for the Measure
scan. No operator intervention is required and there is no need to physically reposition the patient.

ted next, and discussed.

{ Note: WHAT TO DO: There are four possible warning dialog boxes that may pop up. They are reprin- l
| 1. Click on Continue to acknowledge any of the warnings. |

L 2. Click on Stop to reposition and remark the patient.

» If automatic centering was not successful, the original start and end points would be used for the Measure
scan and the following warning message will display:

“The original mark points are being used because the automatic centering of the spine was not suc-
cessful.”

In this case, Norland recommends that the scan be terminated and the scan region re-marked. Take care to
mark 1-cm below the xiphoid and 2-cm below the iliac crests. Note that marking too high or too low caused the
Auto Centering to fail.

» If metal was detected on the U shaped scan, the following warning message will display.
“The original mark points are being used because metal was detected.”

» If auto centering determined that the start and end points would require shifting by 5-cm or more, the fol-
lowing warning will display.

“The original mark points are being used because the scan was moved 5-cm or more.”

» If auto centering determined that the scan would exceed the scanner arm travel limits, the following warning
will display.

“The scan extends off the table. Either remark the scan location or adjust the scan parameters.”
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Force Mark Points On-Axis

When this option is checked (enabled), it forces the densitometer to transverse the scan region inthe X & Y
axes only. When not checked (disabled) [default], it will allow scanning on a diagonal which will automatically
straighten the spine in the scan image, despite patient orientation. (It will not straighten scoliotic spines.)

m Note: To achieve the highest quality Spine scans, this feature should be DISABLED. ]

Figure 12-4 illustrates an example of a scan with the Force Mark Points On-Axis checked. Figure 12-5 is the
same patient without repositioning and Force Mark Points On-Axis not checked.

Figure 12-4: Force mark points on-axis checked (enabled)

Figure 12-5: Force mark points on-axis not checked (disabled)
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Angulated Cursors
The Angulated Cursors feature is used during Analysis for a patient who has scoliosis. This feature allows the
operator to adjust the angles of the cursors to align with the vertebral gaps.
1. During the Analysis phase of the AP Spine Scan, right click over the scanned image to open the menu.
Select Image Analysis > Analysis Options.

Sean Rosuls |

Analysis Options...
Medily Region...

Rescalyze..

Ruler Tool.

L20L4 BMD. 10BME 15 Srn Guade fon otter (Ve Cosveed bevage: Lin Borm
[ WeargRed (%[ 2corm | gn Mateh (1] ST Charge (2] ST Churgn i) [ L1 Chargm ] =
BE 205 02 — — -—

24z 2
2:m Eha 1593 EHE
247 g 211 5a
208 =1 an ns - - — -
24 B3 20 5 "

Samp Yew Begort Feiect Tempiane

Report Template: Bane Exam Repart - 1 page Scanner Not Present

2. Click on Angulatedin the Scanner Preferences window to select it. Click .

Analyzis |

AF Spine

Analysis Mode " Standard o

[~ High Density Paint E xclusion

3. The control points on the cursors will now be at the ends instead of the centers. Click and drag the endpoints
to align with vertebral gaps of angulated spines.
4. The figure below shows an example of the cursor placement on a scoliotic spine.
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f\mﬂhmmm;.win" oo < J2A155:
Il File  Edm  Calibestion Tosls  Help
s |

Patignt: "Spine scobosis

Fagions

Rryina Length {em) | Width {em) | -
g pmees o weees

include/Evciude

ekl Exchaln Giecad |

Fragress
Click and hald en the contral points ta move.

Chek.

Adrmiritrator Report Template: Bane Exam Repart - 1 page Scanner Not Present

5. Continue with the AP Spine Analysis. See "Viewing the Scan Results Tab" on page 5-21.

6. Regions of interest (L1, L2, L3, L4, L2-L4, L1-L4) will be compared to reference populations which did not
include studies with scoliotic spines.
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Hip Techniques

Changing the Scan Parameters Prior to Scanning
The Hip Scan Speed and Width can be changed from the Parameters tab window.

To change the Measure Scan Speed parameter, click on the value in the Measure Scan column and select
another value from the drop-down list (see figure below).

To change the Scout Scan Width, click on the value in the Scout Scan column and select another value from
the drop-down list. Note that the Measure Scan width will also change.

Scout Scan |Measure Scan |
Speed {(mm,/sec) |130.0 Q0.0
Resolution {mm) |1.0:x 4.0 1.0x% 1.0
width {cm) 12.00 9.00
Length {cm) i 9

Table 12-3: Hip Scan Settings
Setting Available Settings

Speed (mm/sec) | 45, 90*

Width (cm) *Scout 12cm/ Measure 9 cm
Scout 16 cm / Measure 12 cm

* Default settings

Note: If scan parameter changes are made prior to scanning, they will only apply to the current scan
being acquired. To save the changes as defaults for all scans, or to revert to the default values:

Click the ﬂl button at the bottom of the Parameters window.

(¢ Restore ™ Save

OK Cancel

Select Saveto store these settings as the new default values, or

Select Restoreto revert to the previously saved default values.

Click to continue with the scan process.
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Unsatisfactory Scout Scan (Hip)

If the Hip Scout Scan image is considered unsatisfactory, there are 3 options.

Option 1: Extend the Scout Scan

If the entire region of interest (ROI) is not included in the cursor box, the scout scan can be extended to include
the ROI.

1.

Enter a value for the number of lines (1 line =4 mm, default 15 lines) in the “Extension (# of lines)”.

Extension [ of lnes); |15 = Extend

w

5.

Caution the patient to lie still and click

The Extendfeature may be repeated until the scan Iength has reached its limit of 255 lines.

To set the initial position of the region of interest (ROI), click and drag the target cursor to the middle of the
femoral neck.

Proceed with "Starting the Measure Scan" on page 6-21.

Option 2: Reposition the Scout Box and Rescan

Use the Rescan feature to re-define the region of interest (without re-marking the patient) and run a new Scout
Scan.

1.

2.
3.

4.

Click and drag the target cursor to the middle of the femoral neck. If the femoral neck is not visible, you may
reposition the scout box at any location closer to the neck region.

Caution the patient to lie still. Click on

The scanner will perform a new Scout scan in the newly defined region of interest.
Proceed with "Starting the Measure Scan" on page 6-21.

Option 3: Cancel the Scout Scan and Remark

Cancel the scan and restart the procedure if the hip is too wide to fix in the cursor box. In this case, you must
increase the Scan Width parameter to include the entire Trochanter and Ischium.

From the Scan tab window, click on

1.
2. Atthe Cancel Scan window, select Discard and cl|ck OK.
3. TIO rf%tﬁrt the scan process, click L= , then click g Select Left Hip or Right Hip and
clic
4. Inthe Parameters tab window, click on the 12 in the Width box (of the Scout Scan column). Select 16 to
increase the width of the Scout Scan. This will resize the ROI.
Scouk Scan |Measure Scan |
Speed {(mm/sec) |[180.0 a0.0
Resolution {mm) (1.0 x4.0 1.0x1.0
Width {cm) 12.0 E 9,00
Length {cm) 9
16.0

5. Proceed to "Marking the Scan Region" on page 6-16 to continue.
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Alternate R-Value Analysis

m Note: Norland strongly recommends viewing hip scan in the baseline mode. ]

Baseline displays non-bone data points in the image in the baseline color or shade. If the image appears to have
missing areas of bone then the “Alternate R-Value” option should be disabled and the scan reanalyzed.
Changing the Alternate R-Value option can make a large difference in the T-Score and Z-score.

View in the Baseline Mode

1. Right click on the scan image in the Filmstrip view to access the image menu.

LeliHg 178 2003 1847 ScanSpeed Shomds Fessibon 1 0mme) Do ST0 DV lor Nesck BMD- 1.2 BMC 1.7 Son Gude lor oher DV

[Fogen | #MDigics]|  &WC ()| Auma o) Loragth con] | Wickh cas] | T-5omm | Yeurg Red [
Fem Neck 07639 147 197 150 186 78 4

Trogh 052 P 28 ANERE: mi -
ToBMD  MASmgicd  ZNmg 78 am mp a1 w3

sapyew | wor | ﬁem'emmJ nEme.:lJ <« Damograghics

Admiristrator 1 Report Template: Bane Exam Repart - 1 page Scanner Not Present

2. Click on Baseline. The image will display all the non bone data points.

Image with Baseline enabled Image with Baseline disabled
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Reanalyze with Alternate R Value

1. Right click on the scan image in the filmstrip view. Click Image Analysis > Analysis Options.

. ey Fegen-

a0E

FReanshze

LefiHig 17 WAY 2003 1647 Scan Soond S i e i ot . Cuord sages L Borm
W ] e | dvea Fuder Tool Bttsech (] 57 Cranga il 51 AT Crangaie [ U1
Fom bk [E] 307 G CTEE—— e e
Troch sz 450 5 7EA L -
Tl MO MSmge  XTiTeg AW Fre Wi o 73 e
et Fomcatn. Batmnilin | o= peeegraptcs

Repe Templste: Bane Exan Repon - 1 page Seanes Bt Present

2. Uncheck the box for Alternate R-Value Analysis. Click on .

Hip
Femaral Meck Length (cm) 10 18

I~ High Denszity Paint Exclusion

I~ ward's Region

3. When the Analysis tab window opens, place the target cursor in the middle of the femoral neck.
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| Pavens o Atune e

| Ragions

inchede/Exchude

Peme—— 1 Fepent Template Sone Exan Repert - § page Seannes Kot Presert

Additional Techniques

4. Click . If the automatic computer analysis is successful, the software will construct a cursor box
and the Results button will become available.

Calibestien Tech Help
Hewds
| Pavens o Atune e

| Ragions

Regen Length (cm] | Width (cm)
Femthedk 1% "
sy e e

5. cio_Fete |

6. The proper anaI%

save the Scan Results.

NORLANLD,

. _— . Save
sis will include all areas of bone and have proper cursor placement. Click to
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Forearm Scanning Techniques

Changing the Scan Parameters Prior to Scanning
1. Ifitis necessary to change the Scan Speed or Measure Regions, click on the value in the Measure column
and select another value from the drop-down list.

2. Ifitis necessary to change the scan Width, type a new value in the Scout column. The Measure Width will
be identical.

Scout Scan | Measure Scan
Speed (mm,/sec) |45.0 20.0
Resolution {(mm) [1.0x1.0 1.0x1.0
Width {cm) 8,00 £.00
Length {cm) p to Proximal 1.0
Measure Regions Both

Table 12-4: Forearm Scan Settings
Setting Available Settings

Measure Speed (mm/sec) | 2, 8, 20*
Width (cm) 8*, User-Defined

Measure Regions Distal, Proximal, Both*

* Default settings

Note: If scan parameter changes are made prior to scanning, they will only apply to the current scan
being acquired. To save the changes as defaults for all scans, or to revert to the default values:

Click the ﬂl button at the bottom of the Parameters window.

(+ Restore i Save

OK Cancel

Select Saveto store these settings as the new default values, or

Select Restoreto revert to the previously saved default values.

Click to continue with the scan process.
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Conversion of Comac Forearm Scans

In previous versions of Norland software, forearm analysis could be done using two different modes: Comac
and Hydroxyapatite. Comac analysis has been discontinued; however, Comac-analyzed forearm scans may
be converted to Hydroxyapatite analysis.

To Convert a Scan:

1. Locate the patient's name in the Database Navigator and select the visit which contains the Comac-ana-
lyzed scans.

. Stamp Wiew »>
lck L=emen |

Double click on the Comac-analyzed scan to display the scan.
4. A message box will appear stating Comac analysis is no longer supported.

w N

Warning

Comac analysis of Forearm Scans is no longer supported. Do wou wish to reanalyze the

_L scan using Hydroxyapatite analysis?

& [x]

1. Click to reanalyze the scan using Hydroxyapatite.
2. Afterthe scanis reanalyzed, click to view the scan results.

3. Click to save the Hydroxyapatite analysis.
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Whole Body Scanning Techniques

Changing the Scan Parameters Prior to Scanning
If it is necessary to change the Scan Speed/Resolution, click on its value and select another value from the

drop-down list (see figure below).

Measure Scan |

Speed/Resolution |6.5% 13.0 @ 260 |

0 O @ 2ol
8.5% 13.0 @ 130
Length (cm) 4,5% 9,0 & 260
4,5% 9.0 @ 130
28X 7.8 @ 200
23X 7.8 @ 100

Table 12-5: Whole Body Scan Settings

Setting

Available Settings

Speed/Resolution

*6.5mm x 13.0 mm @ 260 mm/s
6.5mmx 13.0mm @ 130 mm/s

4.5mmx 9.0 mm @ 260 mm/s
4.5mmx 9.0mm @ 130 mm/s
2.8mmx 7.8 mm @ 200 mm/s
2.8mmx 7.8 mm @ 100 mm/s

* Default setting

(¢ Restore ™ Save

oK Cancel

Note: If scan parameter changes are made prior to scanning, they will only apply to the current scan
being acquired. To save the changes as defaults for all scans, or to revert to the default values:

Click the ﬂl button at the bottom of the Parameters window.

Select Saveto store these settings as the new default values, or

Select Restoreto revert to the previously saved default values.

Click to continue with the scan process.
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Lateral Spine Scanning Techniques

Changing the Scan Parameters Prior to Scanning

1. Ifitis necessary to change the Measure Scan Speed, click on its value and select another value from the
drop-down list (see figure below).

2. Click the check box for Measure Scan On-Axis if you must change it.

Scout Scan |Measure Scan |

Speed {(mmysec) |[130.0 30.0
Resolution {(mm) [1.5x 3.0 1.0x1.0
Width {cm) 14,25 10,00
Length {cm) 0.0 0.0

Measure on Axis it}

Table 12-6: Lateral Spine Scan Settings

Setting Available Settings
Measure Speed (mm/sec) | 15, 30%, 60
Width (cm) Scout: 14.25%, User-Defined

Measure: 10.0*, User-Defined

Measure on Axis On*, Off

* Default settings

Note: If scan parameter changes are made prior to scanning, they will only apply to the current scan
being acquired. To save the changes as defaults for all scans, or to revert to the default values:

Click the ﬂl button at the bottom of the Parameters window.

(+ Restore i Save

OK Cancel

Select Saveto store these settings as the new default values, or

Select Restoreto revert to the previously saved default values.

Click to continue with the scan process.
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Unsatisfactory Scout Scan (Lateral Spine)

UNSATISFACTORY: If the lumbar segment is not straight, the Scout image quality is unsatisfactory. You
must discard the scan, re-mark the Scan Region and re-start the Scout Scan process. Before beginning the
Scout scan, you must first disable the Measurement on Axis feature (set to OFF).

1. From the Scan tab window, click on .

2. Atthe Cancel Scan window, select Discard and click OK.

3. Torestart the scan process, click , then click g Select Lateral Spine and click OK.

4. Inthe Parameters tab window, uncheck the box for Measure on Axis to tumn the setting OFF. This will allow
the Measure Scan to be scanned on an angle.

Scout Scan |Measure Scan |

Speed {(mm/sec) |[130.0 30.0
Resolution {(mm) [1.5x 3.0 1.0x1.0
Width {cm) 14.25 10.00
Length {cm) 0.0 0.0

Measure on AXis o]

5. Proceed to "Marking the Scan Region" on page 8-13.
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Research and Small Subject Techniques

Changing the Scan Parameters Prior to Scanning

If it is necessary to change any of the parameters, click on their values and select another value from the drop-

down list (see figure below). Adjust the parameters as required for your study protocol.

Scout Scan |Measure Scan |

Speed {(mm/sec) |[60.0

Resolution {mm) |3.0x 3.0
Width (cm) 13.80
Length {cm} n.o

Force On-Axis

Max Degrees
Scout Scan oM

Scan Type Name

£0.0
1.0% 1.0
10,00
0.0

(] am
15

Research

(+ Restore

Note: If scan parameter changes are made prior to scanning, they will only apply to the current scan
being acquired. To save the changes as defaults for all scans, or to revert to the default values:

Click the ﬂl button at the bottom of the Parameters window.

i Save

Cancel

Select Saveto store these settings as the new default values, or

Select Restoreto revert to the previously saved default values.

Click to continue with the scan process.
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CHAPTER 13

Ten Year Fracture Risk

Note: The Ten Year Fracture Risk feature is available as an option with the
Bone Densitometer. Be aware that your system might not have this option.

A Ten Year Fracture Risk assessment may be provided for patients by entering demo-
graphics information, performing a hip scan, and creating a Ten Year Fracture Risk
report.

The Ten Year Fracture Risk feature is intended to aid the clinician by allowing an eval-
uation that incorporates a review of risk factors into the T-score based interpretation.
It is based on the Frax® paper charts which were developed by the World Health
Organization (WHO) to evaluate fracture risk of patients. The charts were developed
by WHO by studying population-based cohorts in Europe, North America, Asia, and
Australia.

Two sets of charts were developed by WHO for use by clinicians, a set based on
Bone Mineral Density (BMD), and a set based on Body Mass Index (BMI). Since bet-
ter characterization of the Ten Year Fracture Risk is provided by the BMD charts, this
data is used to calculate the Ten Year Fracture Risk by the Illuminatus DXA software.
The data sets based on the BMD use a fixed value for BMI of 24. Note that for
patients that have a much lower BMI (less than 20), the actual Ten Year Fracture Risk
may be greater than calculated.

The Ten Year Fracture Risk feature provides a Ten Year Hip Fracture Risk and a Ten
Year Major Osteoporotic Fracture Risk. The hip fracture risk is provided to aid the clini-
cian in assessing how to best proceed with interpreting a T-score based treatment
strategy. In general, when interpreting data from a US population a Ten Year Hip Frac-
ture Risk of greater than 3% justifies raising the aggressiveness of the T-score based
treatment strategy. As guidelines have not yet been developed for interpretation of
Ten Year Major Osteoporotic Fracture Risk, that information is provided for inform-
ative purposes only.

The Ten-Year Fracture Risk feature is specifically designed for assessment of sub-
jects that are at least 50 years old. When subjects with an age below 50 are pro-
cessed, the Ten-Year Fracture Risk Program will process the risk analysis based on
an age of 50. Note that for those patients the actual Ten Year Fracture Risk may be
greater than calculated.

This chapter discusses the following.

Ten Year Fracture Risk Demographics ... ... ... ... 132
Ten Year Fracture Risk Questionnaire ... ... .. ... 13-3
Ten Year Fracture Risk Confirmation ... ... .. ... ... 13-5
Generate and Print a Report ... ... oo . 13-6
A Sample Ten Year Fracture Risk Report ... ... ... .......................... 139
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13-2 Ten Year Fracture Risk

Ten Year Fracture Risk Demographics

The proper demographic information must be provided to create a Ten Year Fracture Risk assessment. See
"Preparing Patient Records" on page 4-21 for a thorough explanation of how to enter patient information.

& (Muminatus DXA 4.3.0
Fle [de Calbrstion Tosk Help

Fatient Denvographics Medical History

Lt M = [Tackson Mencpouneear |
Fist N = [Sum M s teer’s 7}

Paiend D+ [J12445 ol

Gender @ Fomde " Mde HA

Filwaciy Coucasan - Q}

' ‘
Date sfDith | 41131960 x

Addess 123 Hope Steel Dstsopamis ] [ =
a3 | (er——— [Pl =
Stk fer e [ f

Prysiim Dty ol c
Fars RS 2N ! =
Aewssion Fintosinng Physcian [Dr. Jane: ol c
e R =
Wisit Information Cormpets Ton Vo Fresne Fich Assnastoerd

MHeighe [E7 Weight [138
Tiling Irdoensiont [bimh Cocke

Seve | Do Edts | I'mcmMﬂ,lmbwnaiel «wl.m| 5cnn\ﬁnn>| smnw»|

sorcn Peepcet Termploko: Ten Vear Fractun Bisk Rrgrt Sarwer Prewest

The following items must be entered to create a Ten Year Fracture Risk assessment:
”» Sex

»  Ethnicity

» Date of Birth

> Fracture Risk Questionnaire

oA

Fracture Rizk Questionnaire

The button opens the Ten Year Fracture Risk Questionnaire, which is used for entering the
ethnicity and risk factors used to calculate the Ten Year Fracture Risk for the patient.
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Ten Year Fracture Risk Questionnaire

The Ten Year Fracture Risk Questionnaire must be filled out to create a Ten Year Fracture Risk assessment.
Once the questionnaire has been filled out, the information is passed to subsequent visits; therefore the ques-
tionnaire does not have to be filled out if a patient with a previous Ten Year Fracture Risk assessment has no
change inrisk factors.

M Ten Year Fracture Risk Questionnaire

Ethnic Group | j

Check all items that apply:

| Previous Facture - The presence in adulthood of a prior spontanious fracture or a fracture ariging from from light trauma

r Glucocorticoids - Treatment with oral glucocorticoids for over three months at a daily doze of Bmg or more

| Parent Fractured Hip - & history of hip fracture [in the abzence of significant trauma) in a parent

r A confirmed diagnosiz of Rheumatoid Arthiitiz

| A confirmed diagnosiz of Insulin Dependant Diabetes

r Ostengenesis Imperfecta in adulthood

| Long Standing Untreated Hyperthyroidism

r Hypogonadism

| Fremature Menopause - Age less than 45 years

I Chranic Malnutritian

| Malabsorption

r Chranic Liver Disease

) | Current Smaker

r Alcohaol Uge - Consumption of three or more units of the following:

A standard glass of beer, a single measure of spirits, a medium glazs of wine, or an aperitif
LCancel

Ethnic Group

Select the Ethnic Group that is to be used for the Ten Year Fracture Risk assessment. Note that this ethnic
group selection is different from the selection made in the Patient Demographics screen, which is used to cal-
culate the T-score. Only the groups shown in the list are available. If the patient's ethnic group is not listed, use
the ethnic group for which the epidemiology of osteoporosis most closely approximates the patient's ethnic
group. Very high risk is represented by Sweden and US. High risk is represented by the UK and Italy. Moderate
risk is represented by China, Spain, France and Japan. Low risk is represented by Turkey.

Risk Factors

Risk Factors are classified as High Risk, Moderate Risk, and Low Risk. The following risk factors are available
for selection:

» Previous Fracture: The presence in adulthood of a prior spontaneous fracture or a fracture arising from light
trauma is cause for increased risk. A positive response is graded as a High Risk Indicator.

Glucocorticoids: A report of exposure to oral glucocorticoids or exposure to oral glucocorticoids for over three
months at a daily dose of 5mg or more is considered an indicator of risk. A positive response is graded as a
High Risk Indicator.

Parent Fractured Hip: The presence of a hip fracture—-in the absence of significant trauma--in a parent is
cause for increased risk. A positive response is graded as a Moderate Risk Indicator.

Rheumatoid Arthritis: A report indicating the patient has a confirmed diagnosis of rheumatoid arthritis is con-
sidered an indicator of risk. A positive response is graded as a Moderate Risk Indicator.

»

»

»
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13-4 Ten Year Fracture Risk

» Secondary Osteoporosis: A report indicating the patient has a confirmed diagnosis for Insulin Dependant Dia-
betes, Osteogenesis Imperfecta in Adults, Long-Standing Untreated Hyperthyroidism, Hypogonadism,
Premature Menopause (<45 years), Chronic Malnutrition, Malabsorption or Chronic Liver Disease is con-
sidered to have an indicator of risk. The Ten Year Fracture Risk Questionnaire lists each of these secondary
causes individually. A positive response on any cause results in a grading as a Moderate Risk Indicator.

»  Current Smoking: A report of current smoking is considered an indicator of risk. A positive response is
graded as a Low Risk Indicator.

» Alcohol Use of 3 or More Units per Day: A report indicating the patient is taking a standard glass of beer, a
single measure of spirits, a medium-sized glass of wine of an aperitif daily is considered to have an indicator
of risk. A positive response is graded as a Low Risk Indicator.

After the Ethnic Group and Risk Factors have been entered, select to put the changes in the Ques-

tionnaire into effect. Select Goncel to discard the changes.

NORLANLDO B3D109 Rov-7
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Ten Year Fracture Risk Confirmation

Upon exiting the Patient Demographics screen, a confirmation screen is displayed listing all the factors used to
calculate the Ten Year Fracture Risk. It is important to verify that all the information listed is correct; otherwise

a possible misdiagnosis could be made.

# Ten Year Fracture Risk Demographics Verification

warning:

Patient M ame

Patient |T

Fatient Age

Patient Sex

Fieference Set Ethnicity

Ten Year Fracture Risk Ethnicity

Patient iz a current smoker,

Jackson, Sue
213243546
49 pears
Female
Caucasian

US Caucasian

Patient has a parent who has had a previous hip fracture.

Fatient haz a confimed diagnosiz of Secondary Osteoporosis.

Patient has not had a previous fracture.
Patient has not received treatment with oral Glucocorticoids.
Patient does not have a confirmed diagnosis of Rheumataid Arthritis.

Fatient's alcohol use iz less than 3 units per day

If information used to calculate the Ten Year Fracture Risk was entered incorrectly it could lead to a pozzible misdiagnosis.
Please wverify that the following information iz comect:

|5 the information shown comect?

The information is grouped into three separate sections:

» Demographic Information - this includes the patient name, patient ID, age, sex, and ethnicities.

» Risk factors that apply to the patient.
» Risk factors that do not apply to the patient.

Select fes to advance to the next screen. Select to return to the Patient Demographics

screen if any information is incorrect so that it can be modified.
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13-6 Ten Year Fracture Risk

Generate and Print a Report

A Ten Year Fracture Risk Report can only be generated for hip scans. When saved, these reports become part
of the scan data.

To generate a report for a scan that was just analyzed and saved, click while viewing the Scan
Results. Note that the default report template must be set to Ten Year Fracture Risk Report prior to performing

the scan.

@ \lurminatus DXA 4.3.0
Fle [de Calbrston Took Help
Pasnstecs | Sean | Anauis Soan Racbs |

Fambeck  Merdod 4000

LemMp 9JUL 2003 1033 ScanSpeed 180mmes Reschion 1 0mmy 1 0mm S0 GV bor ook BMD: 1 26MC- 1.7 See Guds bor oher Ovr. Cument Image: Lin Bone

Regon | BMDgionf)] B g1 Aosa o] Lerggh fomd | Wit o) | T-Scose | Yourg el (5] Z:Scor | ge batch (31| ST Change (] ST Change (/w] | LT Charge (2] LT Changa Pifp] [
FemMack wnre i) am 150 i i) nr 1.5 "o 32 4 32 -
Tioch 05 5452 a45 BE Erd ] ER #fa ES ] wi o
Wards Arna oS0 ase 1000 1 o 24 [T} 7 £7 1812 &7 o
Tokal sHMID TES Bengfent Ay =L 155 i 110 k] 14 " LF: R
| < Pttert Lt | <c Dmcrpiaptics | << Stamm Ve |
worvn Report Tergdabe: Ton Yioar Frocturm Risk Regort Scanner Present

To generate a report for a scan that was previously analyzed and saved:
1. Make sure that the scanned image is being viewed as a thumbnail in the Stamp View or the Filmstrip View.
Click (to highlight) the thumbnail view of the scan.

2. Click Tools > Report > Select Template... or click the m button to open the “Report Con-
figuration” dialog box.

Fir Edi  Colbration [Took| Help

Fie Tack
Caliiration Detaits
Send Ta: '

Mad

Report ' Generate New
Aupdin Dictation

Lag Files. b
Scan Quakty lisues Bitor

Fedommen: ditson y
Select Template...
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3. When the Report Configuration dialog box opens, click the Ten Year Fracture Risk Report template to

select it. Click .

Report Configuration

Choose a Default Report Template

Ten Year Fracture Risk Report j Done |

Bone Exam Report

Bone Exam Report - 1 page
Comhined Report

Patient Letter

Referral Letter

Ten Year Fracture Risk Report

@ Note: The selected Report Template will remain the default until it is changed. The currently selected
Report Template is always displayed at the bottom of the IlluminatusDXA window.

4. Click Tools > Report > Generate New or click the button.

File Edit Calibration [Tools| Help

Initialize Scanner

Service Tools 3
File Tools

Calibration Details

Send To: »

DICOM Interface

Mail /
Report > Generate New

Audio Dictation Finish Existing/Make Addendum
e s N View Selected

Scan Quality Issues Editor

Recommendations Editor

Select Template...

5. The Report is immediately generated and opens up in the window, as shown. At this point, the operator can
Lockit, Saveit, Printit, Exportit to a PDF file (or a DICOM file) and Closeit.

Operator's Guide
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13-8 Ten Year Fracture Risk

M Report Type: Ten Year Fracture Risk Report - 11972009 - Creating New

Ten-Year Frachee Risk Repod

On TAR00 10°33 AM 43 year old Sue Jackson undarwant 3 DXA-basad analyeis using the Nodand DA
Hone Denstomater. seral numbes B128 The (A-study includad 3 shudy of he proximal lamur sllowng &
Ten-¥ear Fracturs Risk Anabystz Tha Tan-Year Frachee Fisk Analyiz i baged on researeh camad out by Bie
Weald Haalth Crganizabon stowing & revisw of Ihe paianls sax. age. Famur Nack T-scera and a review ol
tisk taciors known to rlate 10 Fracts Rz 1o amve 3t population baged sshmats of 3 Tan-Year Hip

Fracture Risk

While #valuating Sue Jackson we wene able fo establsh that she has g history consislent with the Sollcwing
Risk Fatlors:

Parirt Frackese Hy-Tha g T il The
presence of s oo i graced a3 3 Moderass Risk Indicator
Secorvtary Ok P - Okeoggeresis nperkects
In Adus, Long-Standing . ypasn (048 yRars), Cheonc Mainurion,
Maateorpon of Cheonic Liver D ok, P Wk Rk
ndicaty
ofrek e Liwd Pk
ke

The history taken an Sus Jackson anskabes %o 4 Risk Factor Score of [ 1 Low 2 Moderabe and 0 High)

o O O B =

6. Click . The “Print” window appears. Select a printer, select which pages to print and choose how
many copies to print.

7. Click to print the Report. The Report is automatically saved and printed.
okt ]

9. You are returned to the Filmstrip view screen. The saved Report can be found under the “Reports” tab. The
Report can be viewed, modified and reprinted at any time. See "The “Reports” Tab" on page 2-14 for more
information.

o
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A Sample Ten Year Fracture Risk Report

A sample Ten Year Fracture Risk Report:

Norland at Swissray

W6340 Hackbarth Road Fort Atkinson, WI 563538 USA (888) 741-0413

Ten-Year Fracture Risk Report

Patient Name: *Hip.good left Patient ID: Left Hip
DOB: 11/9/1926 Gender: Female
Age: 68 years Referred By:

Test Date: 11/6/1995

On 11/6/1995, left *Hip.good underwent a DXA-based analysis using the Norland DXA Bone Densitometer, serial number 6746. The DXA-
study included a study of the proximal femur allowing a Ten-Year Fracture Risk Analysis. The Ten-Year Fracture Risk Analysis is based on
research camied out by the World Health Organization allowing a review of the patient's sex, age, Femur Neck T-score and a review of risk
factors known to relate to Fracture Risk to arrive at a population based estimate of a Ten-Year Hip Fracture Risk.

While evaluating left *Hip.good we were able to establish that she has a history consistent with the following Risk Factors:

Glucocorticaids—A report of exposure to oral glucocorticoids or exposure to oral glucocorticoids for over three months at a daily dose of 5mg
or more is considered an indicator of risk. The presence of this factor is graded as a High Risk Indicator.

Parent Fractured Hip-The presence of a hip fracture—-in the absence of significant trauma-in a parent is cause for increased risk. The
presence of this factor is graded as a Moderate Risk Indicator.

Rheumatoid Arthritis—A report indicating the patient has a confirmed diagnosis of rheumatoid arthritis is considered an indicator of risk, The
presence of this factor is graded as a Moderate Risk Indicator.

Secondary Osteoporosis—-A report indicating the patient may have any of the following conditions (Insulin Dependant Diabetes,
Osteogenesis Imperfecta in Adults, Long-Standing Untreated Hyperthyroidism, Hypogonadism, Premature Menopause (<45 years),
Chronic Malnutrition, Malabsorption or Chronic Liver Disease) and is considered to have an indicator of risk. The presence of this factor is
graded as a Moderate Risk Indicator.

NORLANG.

Figure 13-1: Page 1 of the Ten Year Fracture Risk Report
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13-10 Ten Year Fracture Risk

Norland at Swissray

W6340 Hackbarth Road Fort Atkinson, W1 53538 USA (888) 741-0413

Patient Name: *Hip.good left Patient ID: Left Hip
DOB: 11/9/1926 Gender: Female
Age: 68 years Referred By:

Test Date: 11/6/1995

The history taken on left *Hip.good ranslates to a Risk Factor Score of ( 0 Low 3 Moderate and 1 High).

Ten Year Hip Fracture Risk
Risk from Factors

Fracture Risk{%)

T-Score

The Ten-Year Fracture Risk is assessed by considering the Norland Femur Neck T-score, Age and the Risk Factor Score. Review of this
data indicates that left *Hip.good has an estimated Ten-Year Hip Fracture Risk of 34% and an estimated Ten-Year Major Osteoporotic
Fracture Risk of 57%. The Ten Year Fracture Risk was calculated using the UK Caucasian Female dataset.

The Ten-Year Fracture Risk Assessment estimates from epidemiologic data the risk of a hip fracture within the next ten years and is intended
to aid the clinician in assessing how to best proceed with interpreting a T-score based treatment strategy. In general, when interpreting data
from a Ten-Year Hip Fracture Risk report, a risk of greater than 3% justifies raising the aggressiveness of the T-score based treatment
strategy. As Guidelines have not been developed for the interpretation of Ten-Year Major Osteoporotic Fracture Risk, that information is
provided for informative purposes only. The Assessment assumes a BMI of 24 as used in the FRAX™ Paper Charts. Lower BMIs may
indicate an increased risk of fracture by a factor of up to three depending on age and number of risk factors.

NORLANGD

Figure 13-2: Page 1 of the Ten Year Fracture Risk Report
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DICOM Interface

Note: The DICOM Interface feature is available as an option with the Bone
Densitometer. Be aware that your system might not have this option.

DICOM is a global Information Technology standard that is used in virtually all hos-
pitals worldwide. Its current structure, which was developed in 1993, is designed to
ensure the interoperability of systems used to produce, send, retrieve, store, dis-
play, process, query, or print medical images and derived structured documents as
well as to manage related workflow.

The llluminatus DXA DICOM interface supports the first 3 items above, namely, pro-
ducing and sending of DICOM images as well as retrieving patient work lists from sys-
tems supporting the generation of patient work lists.

This chapter discusses the following.

T OIS .. 14-2
RequIiremMents .l 14-2
Exploring the DICOM Interface ... . ... . ... 14-3
Quick Reference -DICOM Interface ... ... ... ... 14-9
Patient Worklist .. 14-10
Data Patient Conflict ... ... 14-13
Exporting DICOM IMages .. .. ... 14-14
Pushing and Deleting DICOM Files ... ... ... ... ... ... ...... 14-15
DICOM Job QUEUE . .. .. 14-18

CHAPTER 14
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14-2 DICOM Interface

Terms
The following definitions are used throughout the document.
DICOM - Digital Imaging and Communications in Medicine
SCP - Service Class Provider
SCU - Service Class User

Requirements
The following are the minimum requirements to enable the DICOM interface in llluminatus DXA.

Network Address

The Illluminatus DXA computer must be connected to a network and have a valid IP Address assigned in Win-
dows.

OAC Code

An OAC code is required to enable the DICOM software in llluminatus DXA. Refer to "Scanner Preferences
Command" on page 3-20 to configure an OAC code.

PACS and Worklist Server Setup

The llluminatus DXA SCU may need to be granted access on the PACS and Worklist servers. Contact your
Network Administrator to be granted access on all necessary systems.

NORLANLDO B3D109 Rov-7
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Exploring the DICOM Interface
How to Invoke the DICOM Interface

In the Database Navigator window, click Tools > DICOM Interface. The “llluminatus DICOM files” window
will appear, and will show the DICOM files that have been previously exported from DXA.

File Edit Calibration | Tools | Help

Initialize Scanner

Service Teols 3
File Tools

Calibration Details

Send To: 3

Update Report Scan Type Values

\ DICOM Interface

Mail
Report »

Audic Dictation

Log Files v

-
E HMuminatus DICOM Files ——

File DiCOM Services

— Huminatus Patient DICOM Files:

Fatient Mame | Fatient 10 | Sen | Birthday | Scan Type | Scanned on

LASTHAME FIRSTMAME A PATIENTID F 2/19/19688 AP SPINE 54672002 1:51:17 PM
LASTHAME FIRSTMAME & PATIENTID F 2/19/1968  LEFT HIP 5/6/2002 1:56:23 PM
LASTHAME FIRSTMAME & PATIENTID F 2/19/1988 AP SPIME &N B/6/2002 1:51:17 PM
WHOLE BODY TREMDIMNGZ M 51841975 WHOLE BODY  7/3/2008 10:02:18 PM

< m b

Ready

Push

Delete

Refresh

Close

aaidl

A ———

Figure 14-1: llluminatus DICOM Patient Files
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14-4 DICOM Interface

DICOM Preferences Dialog Box: the Site Tab

Inthe DICOM window, select File > DICOM Preferences. The llluminatus DICOM Preferences dialog box
opens (shown below with the Site tab selected).

This DICOM Preferences dialog box allows the user to configure various aspects of the Illuminatus DICOM util-
ity. Each tab is discussed next.

Tlluminatus DICOM Preferences “ # - = m

llursinatus DiCOM Site | DICOM Devices |

— Site Infarmation:

Local AE Title: Retry Delay: Rty Limit;
=l =1
|ILLUMINATUS_1 an = 2 =

[~ Delete DICOM File after Successful Transfer?

| — Modality Worklist:
¥ Enable Modality torklists ? Remote AE Title:
|pCM4CHEE
|
I Local AE Title: Femaote P Address:
|ILLUMINATUS_‘| |192 |1ss |1s |5
Fietriewal Limit: Femaote Port;

00 = T

Frint ok | Cahcel | Apply Help

Figure 14-2: llluminatus DIC OM Preferences - Site tab

The “Site Information” Section

The Site Information area contains information about the Illuminatus DICOM system.

» The Local AE Title should not be changed unless instructed by your Network Administrator.

» The Delete DICOM File after Successful Transfer check box indicates whether or not you would like the
DICOM interface to automatically delete DICOM files after they have been successfully transmitted. If this
option is turned on and the user sends reports to multiple destinations and one fails, the report will be
removed from the queue after its retry limit has been reached. If this occurs, the report must be regenerated
before it can be sent again.

» The Retry Delay indicates the delay (in seconds) between transmission retries for failed transfers.

» The Retry Limit indicates the number of retries the system will perform before giving up on attempting to
transfer the DICOM file.

NORLANLDO B3D109 Rov-7
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The “Modality Worklist” Section

The Modality Worklist area allows the user to configure the worklist server for llluminatus DICOM.
Tluminatus DICOM Preferences L TR - p— o o [T e

llurinatus DCOM Site | DICOM Devices |

— Site Information:
Local AE Title: Retry Delay: Fietry Lirmit:
|ILLUMIN.-’-\TUS_‘I an =l 2 =l

[~ Delete DICOM File after Successful Transfer?

I — b odality ‘W orklist:
v Enable Maodality tarklists? Remaote AE Title:
|pCr4CHEE
: Local AE Title: Remote IP Address:
[ILLUMINATUS 1 [taz ez |8 s
Rietriewal Limit: Remate Part:

E— T —

Frint 0k | Cancel | Apply Help

Figure 14-3: llluminatus DICOM Preferences - Site tab

» Ifdthe Enable Modality Worklists? check box is checked, the fields in this section will become enabled for
editing.

» The Local AE Title should not be changed unless instructed by your Network Administrator.

» The Retrieval Limit indicates the maximum number of returned results within a single query.

» The Remote AE Title indicates the AE Title of the worklist generator on your network.

» The Remote IP Address indicates the IP address of the worklist generator on your network.

» The Remote Port indicates the port of the worklist generator on your network.
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DICOM Preferences Dialog Box: the DICOM Devices Tab

In the DICOM window, select File > DICOM Preferences. In the “lluminatus DICOM Preferences” window,
click the DICOM Devices tab.

This window allows the user to configure one or more Service Class Providers (devices) to communicate with.

Nlluminatus DiICOM Preferences w # - oy (2| S|
llurinatus DCOM Site  DICOM Devices |
Descrption | AE Title | |P Address | Port | Type | Default |
Local Server DCMACHEE 192168163 EB432  Archive Server  Yes
Remate Server kPServer 127.001 104 Frint Server Mo
|
I
I
Drescription: AE Title: IP Address: Part: Type: Drefault:
Add | Update | Delete | Check Device |
Frint | 0k | Cancel | Apply | Help

Figure 14-4: llluminatus DICOM Preferences - Devices tab

» The Description is any arbitrary text you wish to use. This description field will be what is visible to the user
when selecting a target device or viewing the DICOM Queue.

» The AE Title is the AE Title of the remote SCP.
The IP Address is the IP address of the remote SCP.
» The Port is the port of the remote SCP in which data is transferred to.

» The Type indicates whether the destination device is an Archive Server, Workstation, or Print Server. These
choices are available simply for your benefit, the Illuminatus DICOM interface operates the same for all three
types of devices.

» The Default indicates whether or not to include device in the default destination group during a Push oper-
ation.

> The Add button: Once the required fields are populated, pressing the Add button will add the newly con-
figured device to the list of DICOM devices.

» The Update button: To update an existing device, first select the device you wish to modify, make the
changes and click the Update button. Your changes will take effect immediately.

A
v

A
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» The Delete button: To delete an existing device, first select the device you wish to delete, and press the
Delete button.

» The Check Device button: To check a device to see if it is active and is communicating with llluminatus
DICOM, select the configured device and press the Check Device button. A message will be returned indic-
ating its status.

» There are only three possible return values from checking a device:
1. Device Not Responding
2. Device Responding (Compression Supported)
3. Device Responding (Compression Not Supported)
» Once you have configured your DICOM Devices, you can begin exporting the DICOM reports and pushing
them to your SCPs.
Advanced Preferences

In the Database Navigator window, click Edit > Advanced Preferences. In the DICOM tab, the compression
setting can be selected. The default selection “No Compression” can be changed if it is not supported by your
archive server.

m Advanced Preferences ﬂ

Note: The maximum quality level is always used when a compressed format is selected.

Basic Settings | Reporting Directories] Network] Study

DICOM Compression Setting For Report Exports:
|JF'EG Lossless j

This setting is incompatible with many older systems and yields a practically
imperceptible improvement in image quality as compared with Lossy JPEG.

Done
[~ Use same Seres Instance UID for all wvisit elements

[ Set SOP Instance UID equal to Study Instance UID e

QA Report Parameters

Patient Name |

Patient ID |

Assession Number 1

Figure 14-5: Advanced Preferences - DICOM tab

The following Compression selections are available:
» JPEG Lossy

» JPEG Lossless

» RLE

» JPEG-2000 Lossless

» JPEG-2000 Lossy

» No Compression (default)
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The checkbox for “Use same Series Instance UID for all visit elements” can be turned on if you prefer to
have all DICOM images for one patient’s visit to use the same Series Instance UID value so the images will

appear on the PACS as part of one series of images.

The checkbox for “Set SOP Instance UID equal to Study Instance UID” can be tued on if your DICOM
images are not being successfully transferred to the PACS. This setting may be required for compatibility with

some PACS servers.

If QA reports are to be exported to DICOM files, the Patient Name, Patient ID, and Accession Number for
the QA report may be entered. If no values are entered, the following default values are used:

»  Patient Name: QA Report

» Patient ID: QAReport

»  Accession Number: 1

Modality Value
When creating DICOM reports, the Modality value will default to “OT” (“Other”). To change the Modality value to
be used on all reports, edit the file Preferences.ini in the llluminatusDXA software installation folder. Search for
the setting “DefaultModality Type”. Change the setting to the value required for your PACS. If the setting
DefaultModality Type does not exist in the file, enter it on a new line at the end of the file in the format below,

replacing BMD with your value.
DefaultModality Type=BMD

Note that this setting will be used for all destination devices and cannot be configured separately if multiple des-
tination devices are configured. The setting entered in the Preferences.ini file must be compatible with all con-

figured DICOM devices.

Caution: Make a backup of all files before modifying the Preferences.ini file. Changing values other
than those described here can cause unintended software behavior. Contact Technical Support for

assistance if you are unsure about making these changes.
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Quick Reference - DICOM Interface

Patient Worklist
»  Start the llluminatusDXA software.
» From the Patient Visit List screen, click Tools menu > DICOM Interface.
» Inthe llluminatus DICOM Files window, click DICOM Services menu > Patient Worklist.
rE Tlluminatus DICOM Patient Worklist T l El é]‘
Query Parameters:
Enter values to define the query pou wish ta execute Blank fields will match any value)
= = Wildcard
Last Mame, First Mame: Patient ID: todality Mame: Start Date: Start Time:
[ [ [ | 521205 | [1zoco0am -
Regquested Procedure ID Phwsiciar: Accession Mo End Date: End Time:
[ [ [ | 521205 | [115953FM -
[ Single Word in Patient Mame Query Date? [ Cuery Time? [
[ Use saved search values i |
Query Results:
Patient Results from Query [Click on a Column to change the sort order]
Patient Nams | Patient 0 | Sex | Biirthday | Physician | Aooession Number | Scheduled for
DANIELS, DaVID U |eieteieici] M 9/841933  JOHNDR 085908595559 12:45:00 PM
CROSS, CATHERIME F. k555555 F 5/5/1935  JOHN"DR BAEEEE5E5555 12:45:00 P Save Al
CROS5. CATHERIME F. FE55555 F 5/5/1935  JOHMN'DR 5AE555555553 12:45:00 FM
CROSS, CATHERIME F. k555555 F 5/541935  JOHM'DR 5555555555578 12:45:00 PM
BROWHM, BENJAMIN R k333333 M 3/31933  JOHNDR 333333333333 12:34:00 PM Clear &1
BROWM, BENJAMIN R k333333 ] 3341933 JOHNTDR 333333333334 12:34:00 PM
ANDERSON. ANM A [SRRRRN F 14141931 JOHN'DR IRRRARERARANI 12:34:00 PM
ANDERSON, ANM A, K111 F 1141931 JOHNDR 111111111112 12:45:00 PM
“ Ll 3
Cloze
» Click the Query button to search for all available studies.
» If you need to filter results based on the Patient Name, Patient ID, Scheduled Date or other fields, enter the
information into the search boxes and click Query.
»  All available matching results will be displayed at the bottom of the window.
» You may click the “Save All” button to save all worklist results to your patient database, or highlight one or

more entries and click “Save”.

Exporting and Pushing DICOM Reports

»
»
»
»
»

»

After completing and analyzing a patient scan, generate a report.

When the report is displayed, click the “Export DICOM” button. At the confirmation message click OK.
Close the report preview, and return to the Patient List.

Click the Tools menu and DICOM Interface.

AI_Iiskt Sf aIrI] available DICOM reports will be displayed. Highlight one or more reports you wish to send and
click Push.

If your configuration is set to delete DICOM reports after they are sent successfully, click Refresh to verify
the reports are removed from the list and sent successfully.
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Patient Worklist

Note: Prior to querying the DICOM Worklist, check the Patient List to determine if the Patient ID must
be updated. If the Patient ID in the database does not match the Patient Worklist, the records will not
be matched, and this may adversely affect patient trending.

When the user selects Patient Worklist from the llluminatus DICOM Services menu, the system will display
the llluminatus DICOM Patient Worklist window.

M T ———— = -
ﬂ Illuminatus DICOM Patient Worklist [ é,l

Query Parameaters:

Enter values to define the query vou wish to execute [Blank figlds will match any walue]

= = Wildcard

Last Marmne, First Name: Patient 10: I odality M ame: Start Date: Start Time:

[ | | [ 505205 ~|[1zo0008M
Requested Procedure ID Physzician: Acceszion Mo End Date: End Time:

| | | | 5 5205 ~| [11:5959PM =]

[~ Single Ward in Patient Mame ‘

Query Date? W Query Time? [
Guery ‘

Clear
[ Use saved search values

Query Results:

Patient Results from Query [Click on a Column to change the sort order)

Patiert Narne |Pat|entID |Se:-c |B|rthday |Phy3|c:|an |AccessmnNumber Scheduled for | Weight |

T

Close

Figure 14-6: llluminatus DICOM Patient Worklist

The Worklist window contains several user-editable fields. In the Query Parameters area, various fields can
be edited and passed to the Worklist server as query parameters. This would help limit the data returned, if the
user knew the specific details of the patients they were searching for. If too many results are returned, you may
enter additional parameters and click Query again to refine your search.

To save the Parameters as defaults the next time the Worklist window is opened, click the Used saved
search values box. To clear the Parameters, uncheck the Used saved search values box and Close the
Patient Worklist window.

The format of the Patient Name search field is “Last Name, First Name”, and the asterisk **’ can be used as a
wildcard to broaden the search. To use a single search value such as last name only, check the box Single
Word in Patient Name.

The Start Time and End Time will not be used unless the Query Time? box is checked. The values will default
to 12:00:00 AM and 11:59:59 PM when the Worklist dialog box is opened, or if the Clear button is pressed.

The Start Date and End Date will not be used unless the Query Date? box is checked. The values will default
to the current date when the Worklist dialog box is opened, or if the Clear button is pressed.
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Query / Cancel

When the user presses the % button, the query will begin executing. The Query button's caption will

Cancel Queny
change to

while a query is in progress. This will allow the user to cancel the current query that is in
progress.

The query will return one of three possible responses:

1. No Results

If no results match the criteria selected, then the system will display a dialog indicating such as shown in Figure
14-7, left.

Hluminatus DICOM RS 11uminatus DICOM ||

:] Mo iterns matched your query request.

Figure 14-7: No Query Results (left) vs. Error in Query (right)

2. Errorin Query

If an error occurs in the query or the query can not be performed for one reason or another, the system will return
an error code to the user as shown in Figure 14-7 above, right. If the Worklist Query cannot be performed, the
user may not be able to retrieve the patient information from the Worklist server, and the patient may need to be
entered manually. Refer to "Preparing Patient Records" on page 4-21 for detailed instructions on adding or
updating a patient manually.

If the user encounters this message, there may be a configuration problem for the DICOM Worklist settings.
Verify your Worklist settings in the DICOM Preferences window. Refer to "DICOM Preferences Dialog Box:
the Site Tab" on page 14-4. If the problem persists, contact Technical Support.

3. Query Results Area

Should the system successfully execute a query, the results will be returned to the llluminatus DICOM Patient
Worklist dialog box and populated in the Query Results area as shown in Figure 14-8:
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14-12 DICOM Interface

E Hlluminatus DICOM Patient Worklist E] |-

Query Parameters:

Enter values ta define the query you wish to execute [Blank fields will match any value]

* = Wildcard

Last Hame, First Mame: Patient 1D: todality M ame: Stark D ate: Start Tirme:

| | | | 521208 ~| [1200008M -
Requested Procedure (D Phwszician: Acceszion Mo: End Date: End Time:

| | | | 5212015 = | [11:59.59PM =

[~ Single ‘+ord in Patient Mame

‘ Query Date? [~ Query Time? [

[ Use zaved search values el
Query Results:
Patient Rezults from Query [Click on a Colurnn to change the sort order]
Patiet Mame | Patient [0 | Sex | Birthday | Phyzician | Accessioh Mumber | Scheduled for
DANIELS, DD U, k.aegaae M 8/8M938 JOHN'DR. 599959895999 12:45:00 PM
CROSS, CATHERIME F. K.555555 F 5/5/935  JOHN'DR. 555555555555 12:45:00 PM Save Al
CROSS, CATHERIME F. k555555 F 5/5/1935  JOHN'DR. 555555555553 12:45:00 PM
CROSS. CATHERINE F. K EEE5E5 F 5/5/1935  JOHN'DR. 5555555555573 12:45:00 PM
BROWN. BEMIAMIN R. k333333 M 3/3/1933  JOHN'DR. 333333333333 12:34:00 PM Clear Al
EROWN. BEMIAMIN R. k333333 [l 3/3/1933  JOHN'DR. 333333333334 12:34:00 P
ANDERSON, &NN &, k111111 F 14141931 JOHNTDR. 11111111111 12:34:00 P
ANDERSON, &NN &, K111 F 14141931 JOHNTDR. 111111111112 12:45:00 P
4 n 3

Cloge

Figure 14-8: Patient Worklist dialog box populated

-

ﬁ: Click the Clear button to clear all Query Parameters, reset the Date and Time filters to default val-
ues, and clear all patients from the Query Results section.

Save

: : When results are returned to the user, the user may select one or more of the returned items and
click the Save button. This will save the selected patients to the currently active llluminatus DXA database.

If there are multiple databases configured in [lluminatus DXA, be sure the correct database is selected before
saving any results.

If the patient record already exists, and the Patient Name, ID, Date of Birth, and Sex all match, no changes will
be made to the patient record. If these values are different, a Data Patient Conflict message will appear. See
"Data Patient Conflict" on the facing page.

_Sﬂ: If all of the returned records are to be saved to the llluminatus DXA database, then simply click-
ing the Save All button will perform the action.

Clear &l .
g: By pressing the Clear All button, the user can clear out all of the returned query results.

After saving the necessary patients to your database, return to "Preparing Patient Records" on page 4-21 to
begin the scanning process.
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Data Patient Conflict

When a patient entry is saved to your active database, it will be compared to all existing records. If the ID
matches an existing patient record, but the Name, Date of Birth, or Sex does not match, the Data Patient Con-
flict dialog box will be displayed. Differences in capitalization may show a conflict, even if the spelling is exact.

Illuminatus Data Patient Conflict - (et |

Data Confhict:

The Patient information received from the worklist conflicts with existing patient
information in your llluminatus database.

You may review thiz information and Update pour llluminatuz databasze or 5kip the

record.
llluminatus Data Worklist Data
Patient Mame Patient Name
CROSS, KATHERIME F. CROSS, CATHERIME F.
I | PatientID Patient ID
KE558E5 KBE5ERE
Birthday Sen Birthday Sew
5/5/1935 F 5/5/1935 F

Skip Frint

Figure 14-9: Data Patient Conflict dialog box

Upd . . . . . .
P9 | The user has the option to update the patient records already in the system with the information

from the worklist data. Only the Name, Date of Birth, and Sex will be modified. All other patient demographic
information will not be modified. If multiple query results are selected to be saved, llluminatus DXA will con-
tinue to import with the next record if the Update button is pressed.

Ski . . - .
: F : The user may skip the current record, and no changes will be made to the existing patient data. If
multiple query results are selected to be saved, llluminatus DXA will continue to import with the next record if

the Skip button is pressed.

:

i : The user ma% print the information that appears on the screen for review or modification. The user

must then Update or Skip the record to continue to save patient data from the worklist.
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Exporting DICOM Images

When a report is generated in llluminatus DXA and the DICOM OAC option has been entered, the Export

DICOM button will be visible and enabled as shown in Figure 14-10.

FJ Report Type: Bone Exam Repe

Name: Lasimame, Firstname A Sex: Female Height: 51"
io: PagentD Ethnic: Caucasian Weight: 110
DOB: 2119/1958 Age: 34 years

L H AP Spine on: S/6/2002 1.51:17 PM

L2-L4 Norland 4/00 L2 Norland 4/00 c
1.411 1.42

% 3

YoungRef. (%) 811  Date  Valee YoungRef. (%) 775  Date  Valee
T-Scors 2128 0719100 0.821 T-Scors 51 07/19/00 0.819
Ag=Match (%) 823 072099 0.862 As=Match (%) 777 0720099 0.850
Z-Scorz 118 0723970894  ZScors 149 07/23/97 0.878

Bons imag= not for dizgnosis.
Manwal Cursor Placsment

| Region DMD(gew) BMC() 72 Lensth Widh  T- VowgRef 2. AgeMatch STChange ST Change LTChangs LT Change |

Save | Print | EgpnrtPDFl Export D\COM' Close
Figure 14-10: The Export DICOM button

The button will create a DICOM file in the DICOM folder (configured in Advanced Preferences),

typically C:\I1luminatusDXA\DICOM.
The DICOM interface will look for DICOM files in this directory.
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DICOM Interface 14-15

Pushing and Deleting DICOM Files

When the user invokes the DICOM Interface menu item and the Illuminatus DICOM Files dialog box appears,
they may perform several operations.

The system will allow the user to select one or more entries from the llluminatus Patient DICOM Files listing.
To select more than one item, hold the <Ctrl> key while clicking each item. When one or more items have been

Push Delet
selected, the i and e buttons become enabled.
r ™y
| Tluminatus DICOM Files - [
File DiCOM Services
 Hluminatus Patient DiCOM Files:
= - - Puzh
Patignt Mame | Fatient [D | Sex | Birthday | Scan Type | Scanned on
LASTHAME FIRSTHAME & PATIENTID F 21941968 AP SPINE B/E/2002 1:51:17 P
LASTHAME FIRSTHAME & PATIEMTID F 2191968 LEFT HIF B/E/2002 1:56:25 P Delete
LASTHAME FIRSTHAME & PATIENTID F 24191968 AP SPIME AN BABS2002 1:51:17 PM
WHOLE BODY TREMDING2 M 51841975 WHOLE BODY  7/3/2008 10:08:18 P A
efreg
Cloge
1 | 1 3
Ready
b — .

Figure 14-11: llluminatus DICOM Files window
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The Push Operation

he &l button will be enabled when one or more items are selected. An entry in the list can be double-
clicked to perform the Push function.

When one or more reports are pushed, the system will check to see if any DICOM devices have been con-
figured.

1. No Devices Configured

If no devices have been configured, the system will display a message to the user indicating that no DICOM
Devices have been configured. Refer to "DICOM Preferences Dialog Box: the DICOM Devices Tab" on
page 14-6 to configure the DICOM Devices.

2. Single Device Configured

If a single device has been configured, the system will queue up the selected items and set their destination to
the configured device.

3. Multiple Devices Configured
If multiple devices are configured, the system will display a dialog listing the devices configured.

a. Default Group Configured

If the user has preselected a default group of DICOM Devices to send to, these Devices will be high-lighted in

bhe dialog as shown in Figure 14-12. Pressing the button will continue the Push operation to those
evices.

Tlluminatus DICOM Destination Device (S|

Select DICOM Devices:

Remate Server

()8 Cancel

Figure 14-12: Default DICOM Devices configured

b. Default Group Not Configured

If no devices have been preselected as default, then the dialog will be displayed with no devices high-lighted as
shown in Figure 14-13 and the user will be forced to select at least one device before continuing with the push
operation.
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Tlluminatus DICOM Destination Device u

Select DICOM Devices:

Main Server
Remate Server

Ok Cancel

Figure 14-13: No Default DICOM Devices configured

If the user has not checked the Delete DICOM File after Successful Transferoption in the DICOM Prefer-
ences, the DICOM file will NOT be deleted and will remain in the DICOM File listing until manually deleted by
the user.

The Delete Operation

When the user presses the ﬂl button, the system will confirm that the selected files are to be
deleted, as shown in Figure 14-14.

If the user presses , the files will be deleted. If they press , the files will not be deleted.

Tlurminatus DICOM (S|

:I Do you wish to delete the selected files?

0K I Cancel

Figure 14-14: DICOM File Delete Confirmation

Refresh

The system will allow the user to manually refresh the DICOM file listing. If the user has selected the option to
delete DICOM files after transmitting, this will refresh the list with only the current DICOM files available.
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DICOM Job Queue

When the user selects DICOM Queue from the llluminatus DICOM Services menu item, the system will dis-
play the llluminatus DICOM Job Queue dialog box as shown in Figure 14-15.

The llluminatus DICOM Job Queue dialog box will automatically refresh itself every five seconds, keeping the
user informed of the current status of each queued DICOM file.

r g1
E| Muminatus DICOM Jab Queue [E= SR
lluminatuz DICOM Job Queue: ] l
Refresh
Patient Name | Patient 1D | Destination | Status | Tirne Queved
LASTHAME"FIRSTMAME ™4  PATIEMTID  MAIN SERVER  Successfully transmitted...  THU MaY 21 11:0
LASTHAME FIRSTMAME ™A PATIENTID  MAIN SERWER  Successfully transmitted...  THU MaY 21 11:(0
10

LASTMNAME FIRSTNAME S PATIENTID  MAIN SERVER  Successfully transmitted...  THU MaY 211

Close

4 1 2

Figure 14-15: Illluminatus DICOM Job Queue

m: The user may press the Refresh button to manually refresh the DICOM queue.

Delete

: If the user selects one or more files in the lluminatus DICOM Job Queue dialog box, the Delete
button becomes enabled and the user can delete the selected entries.

The system does not prompt the user to confirm deletion of the Queuedfiles. Files that are currently in the
'"Transmitting...' or 'Transmitted Successfully' state can not be deleted, as they have been completed and will
not appear the next time the application is executed.
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Data Extract

The Data Extract utility is a separate program that allows the operator to extract the
patient's personal information and scan data without altering the original data. The
data is extracted to a comma separated value file (*.csv) which may be opened using
a spreadsheet program such as Microsoft Excel or Google Docs. The data may then
be manipulated in any way desired for such tasks as caseload management, patient
mailings, statistical analysis, or other purposes.

Although the Data Extract utility is a simple program that performs a simple task, it is
not recommended for use by untrained users. Data Extract merely creates a data file
that may be safely manipulated by third party programs. No other use is intended or
recommended.

An understanding of spreadsheet principles is a prerequisite for working with Data
Extract created files. This guide is written for an experienced audience and will not
attempt to explain how to use the spreadsheet with the Data Extract created files.

The Data Extract program is installed when llluminatusDXA is installed. No special
setup is required.

This chapter discusses the following.

Opening Data EXtract ... ... . 15-2
Loading and Saving Setups .. ... 15-3
Selecting Export Parameters ... ... 15-3
Exporting Data .. ...l 15-6
Running from the command line or shortcut .......... .. ... ..................... 15-6
Patient, Scan, and Region Parameters ... .. ... ... ... ... 15-7

CHAPTER 15
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Data Extract

Opening Data Extract

Click on Start > Programs > Norland > Data Extract to open the Data Extract program. Since the Data
Extract program accesses the scanner files and patient databases, all other Norland applications must be
closed prior to opening Data Extract.

Enter the username and password to log into the Data Extract application.

@ Legin

Data Extract

s

Username ||

Password |

Login

Cancel

After the program is opened, the Data Extract window is displayed.

[#] Data Extract v4.7.40

Saved Setups

Filter Results

Load Setup |

v|| Browse |

Scan Types

Database

Save Setup

All

AP Spine
Forearm - Left
Forearm - Right

Source Database v| Hip - Left
Hip - Right
Total Patients: Lateral Spine
Total Scans: Mandible
Field Lists SE“‘T’S"L B
mall Subje
For Each Patient: [J &1l For Each Visit/Scan: [J Al For Each Region: [ an Whole Body
[] Patient ID # || Scan Date A ||] Name
[] Patient Name [] Scan Time [ Typez
[] Date of Birth [] Sean Height [] Shape . .
[ Ethnicity [ Scan Weight [ Length(cm) Patient Mames (separate multiples with commas)
[ Sex [] Scan Type [ width{cm) |
[ Accesion Number [ Scan Type # ] emD Patient IDs (separate multiples with commas)
[] Mumber of Scans [] # of Regions [ BmC |
[] Last Scan Date [] Analysis Flags [] Area
[] Home Phone [] Scan Parameters [ Seft Tissue Mass
[ Work Phone [] Scanner S/M [] Lean Mass [] Filter by Scan Date
[ Address [] Total Fat % [] Fat Mass Start Date | 9/20/2019 [Ehd
[ City [ Siri UWE Fat % [] T-Score
[ state [] Brozek UWE Fat % [] Z-Score End Date | 8/20/2019 -
[ Zip Code [] Soft Tissue Fat %
[] Menopause Year v || % TBMC/FFM v Region Mass Values @) Grams (O Pounds
Export Data Clear All Exit

Figure 15-1: The Data Extract window

Selections can now be made for the source database, the patient, scan, and region parameters, and which
patients are to be exported.

Automatic Logout Timer

For security reasons, the Data Extract application will automatically log out the user after 30 minutes of inactiv-
ity. The application will not automatically exit while exporting records, or while the user continues to interact
with the application settings and extract options.
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Loading and Saving Setups

If prior Data Extract settings have been saved, you may reload these settings by selecting the settings file from
the Load Setup box. If the desired setup file is not listed, click the Browse button to locate the appropriate set-
tings file. After loading a setup file, further changes may be made to any application settings, data fields, or data

filters.

Saved Setups

Load Setup

e | | Browse

Save Setup

After making changes to the database, field selections, and/or filters, the settings may be saved for later use by

clicking the | >2¥& >8P | b tton and entering a setup file name. Then the settings may be easily loaded the next

time the application is run.

Selecting Export Parameters

Source Database

The Source Database section allows the user to specify the llluminatusDXA database from which the data is to

be exported.

Database

Source Database

Total Patients:

Total Scans:

Databases may be selected by clicking on the drop-down arrow and selecting the database. The total patients
and the total scans in the database are displayed when the database entry is selected.

Database

Source Database

ChlllurminatusDida,

Total Patients: 28
Total Scans: 104

Operator's Guide
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Data Extract

Patient, Scan, and Region Parameters

A list of the parameters available for export is located in the Field Lists. The selected fields will be added as
columns to the output .CSV file during export. See "Patient, Scan, and Region Parameters" on page 15-7 for a
complete list and description of the items in the Source List. There are three classifications of parameters:

» Patient fields
» Visit/ Scan fields
» Region fields

Field Lists

For Each Patient: [] &l Fer Each Visit/Scan: [ ] All ForEach Region: ] &l
[] Patient ID # ||[] Scan Date ~ [ [[] Mame

[] Patient Mame [] Scan Time [] Type#

[] Date of Birth [] Scan Height ] Shape

[] Ethnicity [] Scan Weight [] Length{cm)

[] Sex [] Scan Type [] Widthicm)

[] Accesion Number [] Scan Type # [ ] BMD

] Murnber of Scans [] # of Regions [] BMC

[ ] Last Scan Date [ ] Analysis Flags [] Area

[ ] Home Phone [] Scan Parameters [] Soft Tissue Mass
[] Work Phone [] Scanner S/M [] Lean Mass

[] Address [] Total Fat % [] Fat Mass

[] City [ ] Siri UWE Fat % [] T-Score

[] State [ ] Brozek UWE Fat % [] Z-5core

[] Zip Code [] Soft Tissue Fat %

[] Menopause Year v || % TBMC/FFM v

Click the All check box above each selection to select or deselect all fields in that section. Single parameters
may be added or removed by clicking the check box.

Patient and Scan Filtering

Patient and Scan filters are options that can be selected that define which records are selected for export. Res-
ults can be filtered by scan type, patient name, patient ID, and/or scan date.

To export only records with a certain scan type, select the scan type(s) in the Scan Type Filter section. Click
the All check box to select or deselect all scan types, or click the check box next to each desired entry. If no
scan types are selected, all records are exported regardless of scan type.
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Scan Types All

AP Spine
Forearm - Left
Forearm - Right
Hip - Left

Hip - Right
Lateral Spine
Mandible
Rezearch

Small Subject
Whaole Body

To export only patients whose name or ID contains specific characters, enter the characters in the provided
box. Multiple values must be separated by a comma. For example, to export all patients named Smith and
Jones, enter Smith,Jones in the Patient Names box. If no characters are entered in the Patient Name box or the

Patient ID box, all patients will be exported.

Patient Mames (separate multiples with commas)

Patient |IDs (separate multiples with cornmas)

(] Filter by Scan Date
Start Date | 9/20/2019 [ |

EndDate | 9/20/2019  [@~ |

To export only patients that were scanned during a certain date range, check the box to Filter by Scan Date,
then enter the start date and the end date. The date may be entered manually or the calendar may be used.

[ Filter by Scan Date

Start Date | 9/20/2019 [E~

End Date | 4 Septermnber 2019 r
Sun Mon Tue Wed Thu Fri 5at
23 26 27 28 29 30 3

1 2 3 4 5 6 7
g 9 10 1 12 13 14
15 16 17 18 19 21
2 23 24 25 2% 27 28
29 3 1 2 3 4

[ 1 Today: 9/20/2019

[N
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Region Mass Values

Regional mass values such as BMC, Fat Mass, Lean Mass, and Soft Tissue Mass may be exported in units of
grams (g) or pounds (Ib). Select the appropriate mass units in the Filter Results section.

Region Mass Values (® Grams () Pounds

Exporting Data
Once the source database, patient, scan, and region parameters and desired filters have been entered, the data
may be exported. Click to begin the export.
Enter a name for the file that is to be created.

A status box is displayed while the export is being made. An export could take as long as an hour for very large
(20,000+ patient) databases, depending on the number of parameters that are to be exported. To stop an export
that is in progress, click the Cancel button in the status window.

Data Extract Status

Exporting Records

Exporting record 3 of 37, Please wait.

The status window will close automatically when the Export process is completed. The .CSV output file may
be viewed and manipulated using a spreadsheet program.

Running from the command line or shortcut

The Data Extract application may be run from the command line or a Windows shortcut in order to automatically
load a previously-saved settings file, and optionally also automatically perform the export operation to a specific
filename. When providing the setup filename and optionally the output filename, it is still necessary to enter the
appropriate username and password to log into the application.

Toload a previously saved Data Extract settings file at startup, such as “MySettings.ejson”, enter the settings
file as the first parameter after the program name:

DataExtract.exe C:\IlluminatusDXA\MySettings.ejson

This will load all settings from the MySettings.ejson settings file, but will not perform the Export automatically.
Click Export Data to select an output filename and perform the export operation.

To automatically perform the export from a settings file to a specific filename, enter the settings file as the first
parameter and the output file as the second parameter after the program name:

|DataExtract.exe C:\IlluminatusDXA\MySettings.ejson C:\IlluminatusDXA\MyExportOutput.csv

Note that the settings file must be the first parameter and is required to automatically export to the desired out-
put file.

@ The output file will ALWAY'S be overwritten if it already exists. Take caution before performing

the export that the output file may be safely overwritten.
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Patient, Scan, and Region Parameters
There are three classifications of data in the Norland database:

» Patient data from the Demographics screen will be the same for all scan results for each individual patient,
and will be repeated with each scan or region record.

» Scan data pertaining to each individual scan will result in a new line in the output .CSV file, along with a copy
of all selected patient fields.

» Region data pertaining to each region of a scan will be listed in separate columns of each scan record. A max-
imum of 11 region records may be exported, and all region columns will include the sequential region record

number.

Any fields which contain no data (such as empty region records or fields which do not apply to the current scan
type) will be left blank in the outpuit file.

Table 15-1: Patient Parameters

Field Name

Description

Patient ID

Patient’s Unique ID

Patient Name

Patient's Name

Date of Birth

Patient's Birthdate

Ethnicity

Patient’s Ethnicity

Sex

Patient’'s Sex

Accession Number

DICOM Accession Number

Number of Scans

Total Number of Scans for the Patient

Last Scan Date

Last Scan Date for the Patient

Home Phone

Patient's Home Phone Number

Work Phone Patient's Work Phone Number
Address Patient's Street Address

City Patient's City

State Patient's State

Zip Code Patient’s Zip Code

Menopause Year

Menopause Onset Year

RFA Length

Right Forearm Length

RFA Recomp Length

Right Forearm Recomputed Length

RFA Min BMD

Right Forearm Minimum BMD

LFA Length

Left Forearm Length

Operator's Guide
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Data Extract

Patient Parameters (continued)

Field Name Description

LFA Recomp Length | Left Forearm Recomputed Length

LFA Min BMD Left Forearm Minimum BMD

Physician

Patient’s Physician at the Time of the Last Visit

Referring Physician

Patient’'s Referring Physician at the Time of the Last Visit

Table 15-2: Scan Parameters

Field Name

Description

Scan Date

Date that the Scan was performed

Scan Time

Time that the Scan was performed

Scan Height

Patient’'s Height on the date of the Scan

Scan Weight

Patient’'s Weight on the date of the Scan

Scan Type

Text Identifying the Scan Type:

“Spine”=AP Spine scan

“S Spine”=Scoliatic AP Spine scan

“Lat Spine”=Lateral Spine scan

“Left Hip”=Left Hip scan

“Right Hip”"=Right Hip scan

“DF Body”=Whole Body scan with Dynamic Filtration
‘L F Arm H”=Left Forearm (HA) scan

“R F Arm H’=Right Forearm (HA) scan
“Research”=Research scan

“Sm Subject’=Small Subject scan

Scan Type #

Unique Number Identifying the Scan Type:

1=AP Spine scan

2=Left Hip scan

3=Right Hip scan

5=Research scan

6=Small Animal scan

7=Lateral Spine scan

10=Whole Body scan with Dynamic Filtration
14=Left Forearm - XR (HA) scan

15=Right Forearm - XR (HA) scan
22=Scoliatic AP Spine scan

# of Regions

Number of analysis regions for the Scan
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Scan Parameters (continued)

Field Name

Description

Analysis Flags

Analysis flags enabled for the scan:

Manual Cursors

Soft Tissue Correction
Regional R Analysis
Fat Mass Adjustment
Extreme Points
Source Arcing

Hip Alt R

Scan Parameters

Scan Resolution, Speed, and Width

Scanner S/N

Scanner serial number used to perform the scan

Total Fat %

Whole Body Total Fat % (when enabled by OAC)

Siri UWE Fat %

Whole Body Siri UWE Fat % (when enabled by OAC)

Brozek UWE Fat %

Whole Body Brozek UWE Fat % (when enabled by OAC)

Soft Tissue Fat %

Whole Body Soft Tissue Fat % (when enabled by OAC)

% TBMC/FFM

Whole Body % TBMC/FFM (when enabled by OAC)

Scan Physician

Patient's Physician on the date of the Scan

Technologist

Technologist who performed the Scan

Visit Physician

Patient’s Physician on the date of the Visit

Visit Referring Physician

Patient's Physician on the date of the Visit

Visit Date Time

Date and Time that the Visit was Last Modified

Visit Height Patient’'s Height on the date of the Visit

Visit Weight Patient’'s Height on the date of the Visit

Study ID Unique Study ID generated using the Patient ID and Visit Date
Study Date Time Date and Time that the Visit was created

Medications Patient medications on the date of the Visit

Bone History

Bone History entered on the date of the Visit

Treatment Treatment information entered on the date of the Visit

Comments Comments entered on the date of the Visit

Billing Billing Information entered on the date of the Visit

Scan ID Unique Scan ID generated using the Patient ID, Visit Date, and Scan sequential order
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Data Extract

Scan Parameters (continued)

Field Name

Description

Modified Date Time

Date and Time that the Scan was Last Modified

Modified By

Technologist who performed the Last Modification

Table 15-3: Region Parameters

The following parameters are exported for each region. A scan may have up to eleven (11) regions exported. Each

region field will be prefixed with the sequential region number.

Field Name

Description

Name

Text Identifying the Region Type:
AP Spine regions:

» “vert L1"=AP Spine L1 Vertebra
» “yert L2"=AP Spine L2 Vertebra
» “vert L3"=AP Spine L3 Vertebra
» “vert L4"=AP Spine L4 Vertebra
» “APL14sBMD”= AP Spine L1-L4 sBMD
» “APL24sBMD”=AP Spine L2-L4 sBMD

Lateral Spine regions:

” “Ispn L2"=Lateral Spine L2 Vertebra
» “Ispn L3"=Lateral Spine L3 Vertebra
» “Ispn L4”=Lateral Spine L4 Vertebra

Hip regions:

» “fem neck”=Hip Femoral Neck
» “troch”=Hip Trochanter

» “wards tri"=Hip Wards Area

»  “fem shaft’=Hip Femoral Shaft
» “Hip TsBMD”=Total Hip sBMD

Forearm regions:

» “distal’=Distal R+U Forearm site

»  “proximal’=Proximal R+U Forearm site
» “dradius”=Distal Radius Forearm site

»  “pradius”=Proximal Radius Forearm site

Whole Body regions:

» “head N"=Head

» “chest N"=Chest

»  “midriff N"=Midsection
» “pelvis N"=Pelvis

»” “lleg N"=Left Leg

» “rleg N"=Right Leg

» “larm N”=Left Arm

»” “rarm N”=Right Arm

NORLANLD
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Region Parameters (continued)

The following parameters are exported for each region. A scan may have up to eleven (11) regions exported. Each
region field will be prefixed with the sequential region number.

Field Name

Description

Shape

Region shape:

» Rectangle
» Rotated

» Quadrilateral
»  Other

Type #

Unique Number Identifying the Region Type:

1=AP Spine L2 Vertebra

2=AP Spine L3 Vertebra

3=AP Spine L4 Vertebra
4=Hip Femoral Neck

5=Hip Trochanter

6=Hip Wards Area

17=Lateral Spine L3 Vertebra
18=Lateral Spine L4 Vertebra
19=Lateral Spine L2 Vertebra
20=Distal R+U Forearm site
21=Proximal R+U Forearm site
22=Distal Radius Forearm site
23=Proximal Radius Forearm site
32=Hip Femoral Shaft
34=Total Hip sBMD

35=AP Spine L2-L4 sBMD
37=AP Spine L1 Vertebra

38= AP Spine L1-L4 sBMD

Whole Body regions:

» 24=Head

» 25=Chest

»  26=Midsection
» 27=Pelvis

» 28=Left Leg
» 29=Right Leg
» 30=Left Arm
» 31=Right Arm

Length (cm)

Region length in cm (rectangular regions only)

Width (cm) Region width in cm (rectangular regions only)
BMD Bone Mineral Density (g/cm2)

BMC Bone Mineral Content (g)

Area Bone Area (cm?)

Soft Tissue Mass

Soft Tissue (g) (when enabled by OAC)

Fat Mass

Fat (g) (when enabled by OAC)
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Region Parameters (continued)

The following parameters are exported for each region. A scan may have up to eleven (11) regions exported. Each
region field will be prefixed with the sequential region number.

Field Name Description

Lean Mass Lean Tissue (g) (when enabled by OAC)

T Score T-score

Z Score Z-score
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General Maintenance

Daily calibrations will verify proper operation of the x-ray source and detector
assembly, as well as any moving parts. If the system fails to operate properly for any
reason, contact the local Norland Technical Support representative.

No part of the Norland system is suitable for repair by the operator. Only Norland
trained personnel have access to Norland certified components. Other manufacturer's
components are not compatible with Norland systems. Norland will make available
service documentation upon request to those qualified technicians who have received
Norland service training.

Neither the x-ray source nor the laser positioning aid requires any maintenance or
adjustment by the operator.

Faithfully performing the procedures in this section and manual will minimize the risk
of losing patient data, and help insure trouble free operation.

This chapter discusses the following.

Routine Maintenance ... ... ... 16-2
Quick Reference Guide - System Backup with EaseUS Todo Backup ........ 16-3
Quick Reference Guide - System Backup for Windows 7 ....................... 164
System Maintenance . ... . 16-5
Corrective Procedures ...l 16-5

CHAPTER 16
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16-2 General Maintenance

Routine Maintenance

Detailed routine maintenance procedures are documented next.

Cleaning Scanner Exterior

The scanner exterior should be cleaned with a soft towel moistened (but not soaked) with standard antiseptic
cleaning solution. The scanner should be cleaned as part of the daily cleanup associated with most facilities.

Note: Cleaning solutions must not be sprayed directly onto the scanner - to avoid possible damage to
interior electronic components.

Cleaning Table Top Pad

The pad is made of an antimicrobial material, which inhibits the growth of microorganisms. The pad is secured
by Velcro strips.

The pad can be cleaned with a damp cloth or a mild cleaner such as Windex®. Other cleaners may be too abras-
ive. Do not use any product containing bleach.

Note: If the Table Top pad is removed for cleaning, make sure it is re-installed in the same orientation -
patient head rest to the right.

Cleaning Positioning Aids
Clean the vinyl coated positioning aids by wiping them with a standard antiseptic cleaning solution.
Clean the fabric covered leg block with a damp cloth or by removing the cover and dry cleaning.

Cleaning QC Phantom

Clean the QC Phantom with water and a soft cloth.

@ Caution: DONOT USE ALCOHOL TO CLEAN THE QC PHANTOM. ]

Preventative Maintenance Schedule
Norland recommends annual preventative maintenance, performed by Norland trained technicians.
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Quick Reference Guide -
System Backup with EaseUS Todo Backup

Norland recommends that system backups be performed regularly for the patient scan data and calibration
data. Two USB flash drives are supplied from Norland.

All computers supplied by Norland are set up to automatically perform a backup of the llluminatusDXA software
and data on a daily schedule. The computer must be turned on, and a USB flash drive must be connected to the
computer for the backup to complete successfully on schedule. The automated backup requires no user inter-
vention if the backup drive is available and the schedule is allowed to run.

Note: This procedure applies to using the EaseUS Todo Backup v9.x program. This process does not
apply to any other versions of Windows. To configure the backup, refer to "Configuring Backup for Win-
dows 10" on page 3-5.

TO BEGIN THE SYSTEM BACK-UP MANUALLY:

» Exit the llluminatus software to the Windows desktop.

» Insert the USB flash drive into one of the USB ports.

» Runthe EaseUS Todo Backup program.

» Next to the Norland Backup job, click Backup. Select Full Backup to begin.

& EaseUs Todo Backup Free 9.1 v o= -8 x

[=]m]
8 5 88 g 5
Disk/Partition File Backup Systern Backup Srnart Backup Clone Logs Tools *
Backup
[Gl Browse to Recaver = sorthy ¥
[ Norland Backup « » @
Location: & F:\Norland Backup
Recovery Backup ¥ Advanced ¥

Next execution time: 6/9/2016 19:00 11

»  The backup progress will be displayed while the backup is being performed.

[ Norland Backup Z %

Please wait, backing up... !
Operation ¥ Cancl

Estimated time remaining 00:11:08

» When the backup is complete, the “Last Backup” date and time will be updated and the progress bar will dis-
appear.

» The USB drive should remain plugged into the computer for the backup to run automatically on schedule. If
the drive must be removed, select “Safely Remove Hardware and Eject Media” from the Windows system
tray. Click on “Eject Mass Storage” for the flash drive. Wait until the “Safe to Remove Hardware” message is
displayed. Remove the flash drive from the USB port and store in a safe place.

D10 Fev 2 NORLANLDO



16-4

General Maintenance

Quick Reference Guide -
System Backup for Windows 7

Norland recommends that system backups be performed periodically for the patient scan data and calibration
data. Two USB flash drives are supplied from Norland.

All computers supplied by Norland are set up to automatically perform a backup of the llluminatusDXA software
and data on a weekly schedule. The computer must be turned on, and a USB flash drive must be connected to
the computer for the backup to complete successfully on schedule. The automated backup requires no user
intervention if the backup drive is available and the schedule is allowed to run.

Note: This procedure applies to using the Backup and Restore program included in Windows 7. This
process does not apply to any other versions of Windows. To configure the backup, refer to "Con-
figuring Backup for Windows 10" on page 3-5.

TO BEGIN THE SYSTEM BACK-UP MANUALLY:

»
»
»
»

»

»

»

Exit the llluminatus software to the Windows desktop.

Insert the USB flash drive into one of the USB ports.

Click the Start menu, All Programs, Maintenance, and select Backup and Restore.
Click the “Backup up now” button.

= = =

' ,_' @ » Control Panel » System and Security » Backup and Restore - H Search Control Ponel pel
e e

Control Panel H : ®

SR AnS e Back up or restore your files

@ Turn off schedule Backup
@ Create a system image Location: (F) '@Back e
@ Create a system repair disc = 0 |

345 GB free of 3.80 GB

-
- Backup size: 198.11 MB

HManage space

MNext backup: 10/15/2012 7:00 PM
Last backup: 10/12/2012 12:54 PM
Coentents: Files in libraries and persanal folders for all users
Schedule: Every Monday at 7:00 PM
I530’\5r’|ge settings

The backup progress will be displayed while the backup is being performed.
e 21‘ Control Panel m and Security » Backup and Restore - - i
@

Control Panel Home

Back up or restore your files

@ Turn off schedule

i . Backup in progress...
J mim ’ P inplog
18 Create a system image ' :_;y | @V[ Details

@ Create a system repair disc

When the backup is complete, the “Last Backup” date and time will be updated and the progress bar will dis-
appear.

The USB drive should remain plugged into the computer for the backup to run automatically on schedule. If
the drive must be removed, select “Safely Remove Hardware and Eject Media” from the Windows system
tray. Click on “Eject Mass Storage” for the flash drive. Wait until the “Safe to Remove Hardware” message is
displayed. Remove the flash drive from the USB port and store in a safe place.
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System Maintenance

Computer Maintenance
The accompanying OEM documentation will provide maintenance information for the computer.

Printer Maintenance
The accompanying OEM documentation will provide maintenance information for the printer.

Corrective Procedures

Operational problems are usually identified by warning messages as the situation occurs. Most of the mes-
sages prescribe the necessary action. Other problems can usually be resolved by shutting down and restarting.
Whenever further repairs are needed, contact the local Norland Technical Support number.

Performing Multiple QC Phantom Scans

Scans of the QC Phantom can be performed independently of the Daily Calibration Procedure outlined in
Chapter 4 - Basic Operation or the Quick Reference Guides. Performing this procedure is typically done under

the direction of a Norland Technical Support Representative.

1. From the main Database Navigator window, click on Calibration > QC Scan to open the QC Scan tab win-
dow.

([ ominatus 0xa 430
| e [dn Cabration Tool Help
OC Sean | 0 Aculs |

OC Phasiom

Sierial Nussher L]

BMDY 0840 SMD SO0 QMo
Fat 340 Fat 50 12000
Lesn  EDEALD LeanSD; 10000

Musmbes of Seans

Sean Spect

St Carerd

Administrater Repont Template: Bone Exarn Repont « 1 page. Sannes Frevert

/i\ Caution: The Scanner Arm will move during the next step. STAY CLEAR OF THE SCANNER ARM. ]
[ ]
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16-6 General Maintenance

2. Typeinthe Number of Scans to be performed (6 is used in this example) and click .

3. Turnonthe laser.

% Caution: Do not stare into the beam. ]

4. Place the spine phantom on the table in the marked location.

a. Scanners with Soft Tissue Calibration: Place the black QC Phantom on the scanner table in the marked loc-
ation. The “C” on the box should be orientated to the right side of the table (operator facing the table). Position
the Phantom parallel to the back rest. Proceed to the section "Marking the Black QC Phantom" below.

b. Scanners without Soft Tissue Calibration: Place the clear QC Phantom on the scanner table in the marked
location. The “X” at the top of the spine (labeled “C” below, right) should be orientated to the right side of the
table (operator facing the table). Position the Phantom parallel to the back rest. Proceed to the section "Mark-
ing the Clear QC Phantom" on the facing page.

Marking the Black QC Phantom

1. Use the arrow buttons to move the scanner arm so that the laser positioning dot is on the dot marked C on
the QC Phantom (see figure below).
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2. Verify the Phantom is straight by using the arrow buttons to move the laser to the dot marked D. Re-position
the Phantom if it is not straight. Move the laser back to the dot marked C.

f MARK | ]
Press to mark point C.

4. As soon as the Phantom is positioned and marked, an Alert dialog box pops up. Wait while the source ramps
up. The dialog box will automatically close when the X-ray source is ready.

5. The scan will begin automatically. The window will display the scan image as it develops and update the
status of the scan.

6. At completion, an audible indicator will sound, indicating that the shutter has closed and the x-ray beam is no
longer present. The results will be displayed in the QA Results tab window.

Marking the Clear QC Phantom

1. Use the arrow buttons to move the scanner arm on the QC Phantom so that the laser positioning dot is on
the X (marked C in the figure below).

w

2. Verify that the Phantom is straight by using the arrow buttons to move the laser to the X marked D in the fig-
ure above. Re-position the Phantom if it is not straight.

3. Move the laser back to the X marked C.

Press to mark point C.

The scanner arm will automatically move to the approximate location of point D.

Press to mark point D. The dialog box closes.

7. As soon as the Phantom is positioned and marked, an Alert dialog box pops up. Wait while the source ramps
up. The dialog box will automatically close when the X-ray source is ready.

8. The scan will begin automatically. The window will display the scan image as it develops and update the
status of the scan.

9. At completion, an audible indicator will sound, indicating that the shutter has closed and the x-ray beam is no
longer present. The results will be displayed in the QA Results tab window.

o>

@
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Troubleshoofting

Most operational difficulties can be easily rectified through the use of installed soft-
ware utilities or through established troubleshooting procedures. During operation,
occasionally minor warning messages will display to notify operator of current con-
dition or status. Sometimes these messages will be accompanied by a suggested
action. This section will assist in overcoming those not so obvious situations.

This chapter discusses the following.

S AU . 17-2
Scanner Operation .. ... ... 17-3
Software Operation . . . ... ... 174
Calibration . . ... 17-6
PN T . 17-7
Reference/Trend Chart Display .. ... o o L 17-8
Height and Weight on Reports ... ... . 17-9
FolderMAIL ... 17-9

CHAPTER 17
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17-2 Troubleshooting

Startup
Startup Faults
Table 17-1: Startup Faults
Condition Action
No Communication Turn off power to the scanner and ensure that the cable from the computer to the scan-

(Database Navigator win- neris secure. Retry.

dow Verify there is power to the scanner.

g’lsplaysﬂ Scanner not Scanner arm should not move freely when pushed, and the source fan should be aud-
resent”) ble

Turn off the scanner and computer, wait 10 seconds, turn them back on.

No power to the scanner | If the scanner is plugged into the power strip, verify the power strip is turned on and
the light is on.

Verify there is power to the outlet.
Verify correct voltage is selected at the power entry module.

Software Installation Faults

If the Setup window does not open during installation, click on Start, then Run. Click , browse to

the CD drive, click on setup.exe, and click .

Type the name of a program, folder, document, or Internet
rescurce, and Windows will open it for you,

Open:

Cancel ]’ Browse...

Continue with "Software Installation Instructions" on page 3-2.
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Scanner Operation

Table 17-2: Scanner Faults

Condition

Action

Scanner arm motion
erratic

Verify nothing is blocking the arm movement. It may be necessary to remove the table
top and check for obstructions.

Clean the dust off the back rail using a clean cloth. Oil the rail with a light machine oil
(such as 3-in-1 Qil). Do not use lubricants with a solvent or degreaser (i.e. WD40) or it
may ruin the bearings.

Scanner arm is not mov-
ing

Manually push the scanner arm. If it moves freely there is no power to the scanner
motors. Verify the scanner is plugged into a live outlet.

Turn the scanner and computer off, wait 10 seconds, turn them back on, and retry.

In the Database Navigator window, select Tools > Initialize Scanner to see if the arm
will move to home position.

Turn the scanner off. While holding down the left and right arrow keys on the scanner
arm touch pad, turn the scanner back on, hold the arrow keys for approximately 1
second then release. Verify that the scanner arm will now move under the control of the
arrow buttons.

If still unsuccessful, contact Technical Support.

Will not find origin

Verify that nothing is blocking the arm from moving to the extent of the left travel.
Verify that nothing is blocking the source from moving to the back.
Verify that the limit switches are properly activated.

Operator's Guide
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17-4 Troubleshooting

Software Operation

If error messages similar to the image below appear, print the errors or write them down, and contact Technical

Support with the details of the message.

Fatal Error [‘5_<|
A Fatal Error has occurred!
Codes{RIDYEIDY Routine/Module Error Messages
8300 830a Scanner Exx Errors Limit encountered during command
8512 8518 ais_snd_cmdfais Invalid scanner response
851F 8513 scnr_Majdscnr_fMA snd_cmd Failed
Close all windows and restart the program. If the error reoccurs contact wour Morland Service Representative
Table 17-3: Software Faults
Condition Action

Fatal Error: Limit
encountered during
command OR Limit
encountered prior to
command

The scanner table has reach the limits at the end of the table before it expected to.

Click OK to close the error window. Turn off the scanner power, and push the scanner
arm toward the middle of the scanner. Turn the scanner power back on. Return to the
Patient Visit List screen. Click Tools > Initialize Scanner to reinitialize the scanner.

“Application already
running” message
when starting lllu-
minatusDXA program

Check in the Windows task bar to see if the [lluminatusDXA software is already run-
ning, and select it to activate the program that is already open. Only one instance of the
program may be running at a time.

If another instance of the program is not currently running, click Yes to restart the Illu-
minatusDXA program.

Time/date display
incorrect

Right-click on the time in the lower right corner of the Windows desktop. Click on
Adjust Date/Time. Adjust as necessary.

Patient scanned under
wrong hame, or same
patient has two
records and need to be
merged

Contact Technical Support.

Scan button not active

Verify that the message “Scanner Present” is displayed at the bottom of the Database
Navigator window in the Norland Illuminatus software. If not, refer to the troubleshoot-
ing condition “No Communication” in the "Startup Faults" on page 17-2.

When you select
Report and a blank
screen appears

Click Close to close the report screen. Click on Select Template to select the appro-
priate report template. Click Report to generate a new report.

Displays “Scanner
Subsystem is busy”
when trying to exit lllu-
minatus.

Return to the Patient List before exiting.

NORLANLD
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Software Faults (continued)

Scan

Condition Action
Table Top Values Out | Always perform a Daily Calibration prior to scanning patients. Refer to "Daily Cal-
of Range - when per- ibration Procedure" on page 4-6.
forming Whole Body

When performing a Whole Body scan, if the patient is marked improperly, the software
may not be able to locate the top of the patient’s head for the beginning of the scan.
Refer to the chapter "Scanning Whole Body" on page 9-1 for instructions on performing
the Whole Body scan.

Ensure there is nothing on the scanner table near the patient's head. Do not use a pillow
when performing Whole Body scans.

Failed or partially failed
to import data. See
runtime log.

When performing a Database Import from GEM files, one or more patients were not suc-
cessfully imported. Verify the import source directory contains all necessary data files
and patient directories.

Perform XFCHECK on the data from the GEM computer to verify the data is free of
errors.

Error: The selected dir-
ectory is not a data-
base.

This message may appear when performing File > Database > Active Database >
Add to List. If the selected folder contains subfolders named PAT00001, PAT00002,
etc., use the File > Database > Import option to import and convert GEM based scans
to the llluminatus database. Refer to "Importing a Database" on page 12-18.

Submit SQL Exception
errors appear

This may indicate data corruption in the patient database file. Contact Norland Tech-
nical Support for assistance.
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Calibration

Table 17-4: Calibration Faults

Condition Action

Alert: Calibration points were taken in | When marking the points on the calibration standard, the points were
the wrong order. marked in the wrong order, or were not marked in the proper location on
the calibration standard. See "Daily Calibration Procedure" on page 4-6
for instructions on performing the calibration.

Alert: Process timed out before This error may appear if there is a power problem inside the scanner, or if
enough counts were collected. The x- | the x-ray source has failed.
ray source is not generating enough

x-rays or the beam is blocked. Contact Technical Support for assistance.

Calibration Diagnostics: Fail Verify the calibration standard is placed in the correct calibration area.
» Autoset PMT Gains Verify points 'A" and 'B' were marked in the correct order and on the 'X" in
» Reference Beam the Plexiglas of the calibration standard.
»  X-ray Off Turn off the scanner and computer and repeat the calibration.
»  Shutter If_the calibration fails a second time, print the errors and contact Tech-
»  Low Atten. Filter nical Support.
» Med. Atten. Filter TO PRINT: Go to Tools > Calibration Details > diagnost.trc tab. Then

» High Atten. Filter click on L& |

» Dynamic Filtration

Calibration Status: Failed Verify the calibration standard (QA Phantom) is placed in the correct cal-
ibration area.

Verify points 'A’ and 'B' were marked in the correct order and on the 'X' in
the Plexiglas of the calibration standard.

Verify the Calibration Standard has not been dropped and broken.

Turn off the scanner and computer and turn back on. Repeat the cal-
ibration.

If the calibration fails a second time follow the instructions below to print
the errors and contact Technical Support.

TO PRINT: Goto Tools > Calibration Details > errors.trc tab. Then

. Frint Lazt Three
click on .
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Calibration Faults (continued)

Condition

Action

Precision or Accuracy:
Out of Range

Verify the QC (spine) phantom was placed on the table in the scan area,
and the phantom was marked appropriately. See "Position the Standard
and the Phantom on the Scanner" on page 4-7.

Verify the phantom was not moved after it was marked.
Verify the phantom is not broken or cracked.

If the last QC Scan taken during calibration is an invalid measurement
due to operator error, contact Technical Support for assistance in delet-
ing the invalid scan. Technical Support will advise:

Goto Tools > File Tools and click the QC tab. Click on the appropriate

record and then click on . Repeat QC Scans, and verify that

Precision and Accuracy are OK.

Beam Stability Quality Failure

This failure may occur during the calibration process while scanning the
calibration standard. Power off the scanner table for one minute, then
power on the scanner and retry the calibration.

If the problem occurs again, contact Technical Support.

Printer

Table 17-5: Printer Faults

Condition

Action

Printer excessively loud

Check to ensure the printer cartridges are latched in place by lifting the printer cover
and verifying both cartridges are secure in their respective holders.

If necessary apply silicone lubricant on the printer drive rod to reduce noise and fric-
tion.

Text missing from the
printed report

Replace the printer cartridges. Replace them with the same model number as on the
print cartridge. Install them in the correct holder.

Lines through the text or
image

Use a cotton swab to clean both sides of metal bar under cartridges.
Replace printer cartridge (refer to printer manual for details).

Will not print, large print
type, or random letters

Reset printer.
If problem persists, empty print queue.

Only printing one page
or report appears dif-
ferent

Verify the correct report template is displayed at the bottom of the screen. If it is not
the correct report, click on Select Template and select the appropriate template.
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Troubleshooting

Reference/Trend Chart Display

Table 17-6: Reference/Trend Charts

Condition

Action

No trend chart displays (AP
Spine scans)

Verify both/all scans are analyzed with the same options, such as Standard vs.
Angulated, or L1-L4 vs. L2-L4.

No trend chart displays (all
scan types)

Only one scan exists for the patient or trend option not selected.

No color bars appear on the
graph

The selected Reference Set does not contain factory-defined color bars.

Reference Graphs appear in
grayscale.

Right click on the large image in the filmstrip view and verify “Color” is selected
from the options menu.

Verify the “Always Display Reference Graphs in Color?” box is checked on the
Edit >Advanced Preferences screen.

Reference Sets are installed
but are not plotted

Patient does not have a birthdate entered in the Patient Demographics window,
oritis the default birthdate (1/1/1900).

Patient sex does not match that of the installed data sets or it has not been
selected for the patient in the Patient Demographics window.

There is no Reference Set available for the specific regions being graphed.

There is no matching Ethnic group for the specific regions being graphed or it
has not been entered in the Patient Demographics window.

The Reference Set is disabled. Enable the Reference Set using the File >
Reference Sets command.

In Stamp View, right-click on image. Go to Graphs and verify Reference is
selected.

Reference Sets are incorrect

The wrong Reference Set was selected.

Ensure that the correct ethnic information is entered in the Patient Demo-
graphics window.

The percent change or %
change/year values do not
appear or appears as "*****

The current scan has the same date as the scan it is being compared to. Inad-
vertent copying of two or more identical patient scans may cause this. Com-
pare the identical scans and delete all but one of them.

The current scan is the first scan being graphed. A later scan in the series must
be selected to obtain % change values.

The calculated value requires more than five digits.

Percent Young value does not
appear or appears as "****

A Young Ref(erence) value has not been included in the reference set. Enter
the Young Ref(erence) value.

The current Results mode is not Reference. Select the Reference mode.
The calculated value requires more than five digits.
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Reference/Trend Charts (continued)

Condition Action

Percent Age-Matched value The patient value is younger or older than the age range included in the selec-
does not appear or appears as | ted Reference Set.

Thkkkk!

The current Results mode is not Reference. Select the Reference mode.
The calculated value requires more than five digits.

The Z-Score value does not The patient age is younger or older than the age range included in the selected
appear or appears as "*****' Reference Set.

The current Results mode is not Reference. Select the Reference mode.
The calculated value requires more than five digits.
The Reference Set does not contain information for a full age range.

Height and Weight on Reports

Table 17-7: Height and Weight

Condition Action

Height or Weight is incorrect on reports | Refer to "Changing Height or Weight on the Report" on page 12-63.

FolderMAIL

Table 17-8: FolderMAIL

Condition Action

FolderMAIL Verify the logged-in user has a valid e-mail address entered in the location: Edit > User Prefer-
is not active | ences > Main Settings tab > E-Mail Address box (see page 3-19)

The SMTP or MAPI has not been correctly configured: Edit > Advanced Preferences > Net-
work tab (see page 3-42)

An E-mail directory is not entered in: Advanced Preferences > Directory tab (see page 3-41)
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Technical Reference

System specifications and required regulatory information can be found in this
chapter. The labels are also included in this chapter.

This chapter discusses the following.

Norland Bone Densitometer System Specifications ............................ 18-2
Technical DesCription ... .. . 184
CaUtioNS il 18-13
Label Locations .. ... .. .. 18-17
Scanner Labels ... 18-19
Controller Certification Label ... ... 18-22
Power Entry Module Labels ... . ... 18-22
Tube Housing and High Voltage Generator Labels ............................. 18-22

CHAPTER 18
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Technical Reference

Norland Bone Densitometer
System Specifications

DXA System Description

Electrical Requirements

Mains 100-120V™;
Supply 220/230/240V™; (+10%)

50/60 Hz, 700 VA maximum

Mains <0.18 ohms
Impedance

Environmental
Operating:

Temperature 60°-90°F (15°-32°C)

Relative Humidity = Up to 80% non-condensing

Transportation and Storage:

Temperature -40°to 150° F (-40° to 65° C)

Relative Humidity = Up to 80% non-condensing

Altitude Unlimited

X-Ray Detector Assembly

2 Nal Scintillation Crystals
Pulse Counting

Scanner Arm Drive

Stepper motors
Kevlar reinforced drive belts
X-y axis positioning

Laser

Type: Laser diode

Class: Class 1 (CE); Class Il (FDA)
Color: Red (650 nm)

Power: Accessible Light< 0.2 mW

Computer Description
Standard desktop (PC)1 with Microsoft Windows
High capacity Backup device
Antivirus
Printer

Computers used with CE Marked scanners must
be marked for compliance with EMC standards
(IEC 60601-1-2) and Information Technology
Equipment standards (EN 60950 or equivalent).

IMPSO Power

The computer and its associated components
must be powered from the Isolated Multiple Port-
able Socket Outlet (IMPSO) device if it was sup-
plied with the scanner. This includes the
processor, monitor, printer, and any external
backup devices. The IMPSO must be plugged dir-
ectly into the Mains supply (wall outlet). No other
devices can be plugged into the IMPSO. Do not
plug the scanner into the IMPSO. See the specific
cautions for the IMPSO elsewhere in this Tech-
nical Reference Section of the Operator's Guide.

Expected Useful Life

With proper maintenance and servicing, this equip-
ment can be expected to operate for at least five
(5) years.

Operational Features

Calibrations Automatic with supplied 77-step Cal-
ibration Standard and QC Phantom
Scan Sites2 AP Spine
Left or Right Hip
Right or Left Forearm (optional)
Whole Body (optional)
Lateral Spine (optional)
Research (optional)
Small Subject (optional)
Others Soft Tissue Composition 3
Reference Data Sets 4

1Computers used in the U.S. must be tested by Norland and cer-
tified to meet FDA performance standards as required by
21CFR1010.2.

2The AP Spine and Hip scans are available on allmodels. The other
scan modalities are not available on all models.

3Not available on allmodels.

4Not available for all scan sites.

NORLANLD
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Performance Dimensions
Scan Times XR-800
<1.5 minutes AP Spine, high speed Tabletop
1.5 minutes Hip, high speed Length Width Height
<4.0 minutes Lateral Spine, high speed 103" (2620 mm) 42" (1067 mm) 29" (737 mm)
3.0 minutes Forearm, distal only, high speed Overall
5.0 minutes Whole Body Length Width Height
103” (2620 mm) 48" (1220 mm) 51” (1300 mm)

Dose Values _

Weight
<1.0 mRem (High Speed mode): Forearm, AP 560 Ibs (254 kg)
Spine, & Hip

Table Weight Limit

<0.1 mRem: Whole Body

<3.5 mRem (High Speed mode): Lateral Spine 450 Ibs (205 kg)

Scanning Area

Spatial Resolution 76" L by 26.5" W (1930mm L by 673mm W)
AP Line Spacing - 1.5mm (1.0mm select- Table to Scanner Am Distance
Spine able) 16" (406mm)
Point Resolution - 1.5mm (1.0mm select- XR-600
able)
Tableto
Hip Line Spacing - 1.0mm —20ep
. . Length Width Height
Point Resolution - 1.0mm 727 (1820 mm) 42" (1067 mm) 29" (737 mm)
Forearm Line Spacing - 1.0mm Overall
Point Resolution - 1.0mm Length Width Height

) ) 727 (1820 mm) 48” (1220 mm) 51”7 (1300 mm)
Whole Line Spacing - 13.0mm (9.0mm and )
Body 7.8mm selectable) Weight

Point Resolution - 6.5mm (4.5mm and 400 Ibs (181kg)

2.8mm selectable) Table Weight Limit
Lateral  Line Spacing - 1.0mm 450 Ibs (205 kg)
Spine Scanning Area
Point Resolution - 1.0mm 50" L by 26.5" W (1270mm L by 673mm W)
Table to Scanner Arm Distance
Miscellaneous 16" (406mm)

Laser Marking
Positioning Aids

Hip Sling Forearm Fixture (optional)
Foot Separator Lateral Spine System
Block (optional)

Leg Rest Block
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Technical Description

Significant Zone of Occupancy/Patient Environment

The operator should be at least three feet from the beam when the system is emitting x-rays. Refer to "Cau-
tions" on page 18-13. If the operator stays at least three feet from the beam during the scan, the dose rate will
be < 1.0 uSv/hr. For a one minute scan this is a 0.017 pSv dose. For comparison, background radiation
received per yearis 1500 pSv, and a cross-country round trip airline flight results in 50 pSv of additional expos-
ure to the passengers and crew.

The computer should be located outside the perimeter of three feet from the beam and positioned such that the
operator cannot touch the computer and the patient simultaneously. However, the computer can be closer if
necessary as long as it is powered from the isolated multiple portable socket-outlet (IMPSO) device provided
with the system.

Focal Spot to Image Receptor Distance (SID)

The SID is equal to 765mm. It is fixed and the operator does not adjust it.

X-ray Generator
» Combination Tube Housing and High Voltage Generator
» 100 kV (x 2%) constant potential
” 1.3 mA (x 5%) constant current
» Maximum heat dissipation = 300 W
»  Minimum filtration is 2.7mm Al. (1.9 irremovable + 0.8 fixed); Samarium k-edge @ 46.8 KeV
» Focal Spot of x-ray tube = 0.5mm
» Stationary anode with tungsten target
» Power output of high voltage generator = 130 W
» Air cooled and suitable for continuous operation

Classification

Class | - Type of protection against electrical shock.

Type B Applied Part (Patient Bed) - Degree of protection against electrical shock.

Continuous - Mode of operation.
IPXO - Degree of protection against dust and water.
Laser product (used for selecting scan area)

Class Il (FDA) per 21CFR1040
Class 1 (CE) per IEC60825-1:2007+CorAug2008
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Cooling Curves & Tube Rating Charts

The operator is not required to make any decisions regarding patient scanning based on cooling curves & tube
ratings. However, this information is available from your Norland Technical Support representative, if required.

Duty Cycle
No duty cycle limits apply. The system can be operated continuously without any degradation in performance
as long as the ambient temperature and humidity specifications are not exceeded.
Technique (or Loading) Factors
X-ray tube voltage & current and scan time are the technique factors.
» Tube voltage = 100 kV (x 2%) constant potential. This is fixed and the operator does not adjust it.

» Tube current = 1.3 mA (x 5%) constant current. This is fixed and the operator does not adjust it.
» Scan time depends on the scan type and area selected. Refer to the specifications.

Electrical Requirements

A hospital grade receptacle should be used to ensure safety ground continuity. No special voltage or current reg-
ulation or conditioning is required.

Installations

Warning: Connect only items that have been specified to be part of, or compatible with, this Medical
Electrical (ME) system.

» Unit should be installed in such a way that the operator can achieve optimum use of it.
»  XR-800: Minimum room size is 7 feet (213cm) by 9 feet (274cm)
»  XR-600: Minimum room size is 7 feet (213cm) by 7 feet (213cm)

» No user installations. An authorized Norland service agent installs the device and trains the
operator on proper use.

Caution: For patient and operator safety position the back of the scanner (open area under the tab-
letop) as close to the wall as possible to inhibit unauthorized access to the interior of the device.

» Do not install near devices that produce large EMI fields (i.e. electro-cautery, elevator motors, etc.)
» Do not install near other x-ray emitting or radioisotope devices.

m Warning: Do not modify this equipment without authorization from the manufacturer. ]

Service

» No user serviceable parts inside unit.

» Norland will make technical servicing information available upon request to qualified technicians who receive
Norland service training.

»  Only Norland trained personnel have access to Norland certified components.
» Other manufacturer's components are not compatible with Norland systems.
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FCC EMC Statement

Note: This equipment has been tested and found to comply with the limits for a Class B digital device pursuant
to Part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful inter-
ference in a residential environment. This equipment generates, uses, and can radiate radio frequency energy
and, if not installed and used in accordance with the instructions, may cause harmful interference to radio com-
munication. However, there is no guarantee that interference will not occur in a particular installation. If this
equipment does cause harmful interference to radio or television reception, which can be determined by turning
the equipment off and on, the operator is encouraged to correct the interference by one or more of the following
measures:

» Reorient or relocate the receiving antenna.

> Increase the separation between the equipment and the receiver.

> Connect the equipment into an outlet that is on a circuit different from the receiver.
» Consult the dealer or an experienced radio/ TV technician for help.

I[EC 60601-1-2 EMC Information

Medical electrical equipment requires special EMC precautions to be taken. This product must be installed and
used in accordance with the EMC information included herein. It is possible that portable and/or mobile RF com-
munications equipment could affect proper operation of this product. [Required per clause 6.8.2.201 a)].

The RS-232 cable received with this product must be used to connect the computer to the scanner to minimize
the possibility of adverse EMC effects. Using a different cable could result in increased emissions and/or
decreased immunity. [Required per clause 6.8.3.201 a) 1) & 2)].

Warning. Do not place other equipment on, orimmediately adjacent to, the scanner or computer components of
the Norland DXA bone densitometer. This could result in electromagnetic interference between the equipment.
If this is unavoidable, carefully observe the Norland DXA bone densitometer (and the other equipment) to verify
normal operation. [Required per clause 6.8.3.201 a) 4)].

AN A

Table 18-1: TABLE 201a

Guidance and Manufacturer’s Declaration - Electromagnetic Emissions

The Norland DXA bone densitometer is intended for use in the electromagnetic environment specified below. The cus-
tomer or user of the Norland DXA bone densitometer should assure thatitis used in such an environment.

Emissions Test Compliance | Electromagnetic Environment- Guidance

RF Emissions - CISPR 11 Group 1 The Norland DXA bone densitometer uses RF energy only for
its internal function. Therefore its RF emissions are very low
and are not likely to cause any interference in nearby elec-
tronic equipment.

RF Emissions - CISPR 11 Class B The Norland DXA bone densitometer is suitable for use in all

Harmonic Emissions - IEC 61000-3-2 Class A e§tabllshments, including domestlc establishments and those
directly connected to the public low-voltage power supply net-

Voltage Fluctuations/Flicker Emissions - | Complies work that supplies buildings used for domestic purposes.

IEC 61000-3-3

aT his Table required per clause 6.8.3.201 a) 3)
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Table 18-2: TABLE 202a

Guidance and Manufacturer's Declaration - Electromagnetic Immunity

The Norland DXA bone densitometer is intended for use in the electromagnetic environment specified below. The cus-
tomer or user of the Norland DXA bone densitometer should assure thatitis used in such an environment.

Immunity Test

IEC 60601 Test Level

Compliance Level

Electromagnetic
Environment - Guidance

Electrostatic
Discharge (ESD)

IEC 61000-4-2

+/-6 kV contact
+/-8 kV air

+/-6 kV contact
+/-8 kV air

Floors should be wood, con-
crete, or ceramic tile. If floors
are covered with synthetic
material, the relative humidity
should be atleast 30%

Electrical Fast
Transient/Burst

+/-2 kV for power supply lines
+/-1 kV for input/output lines

+/-2 kV for power supply lines
+/-1 kV for input/output lines

Mains power quality should be
that of a typical commercial or
hospital environment.

IEC 61000-4-4
Surge +/-1 kV differential mode +/-1 kV differential mode Mains power quality should be
IEC 61000-4-5 +/-2 kV common mode +/-2 kV common mode that of a typical commercial or

hospital environment.

Voltage Dips, Short
Interruptions, and
voltage variations
on power supply
input lines

IEC 61000-4-11

<5% Ut

(>95% dip in Ut for 0.5 cycle)
40% Ut

(60% dip in Ut for 5 cycles)
70% Ut

(30% dip in Ut for 25 cycles)
<5% Ut

(>95% dip in Ut for 5 sec)

<5% Ut

(>95% dip in Ut for 0.5 cycle)
40% Ut

(60% dip in Ut for 5 cycles)
70% Ut

(30% dip in Ut for 25 cycles)
<5% Ut

(>95% dip in Ut for 5 sec)

Mains power quality should be
that of a typical commercial or
hospital environment. If the
user of the Norland DXA bone
densitometer requires con-
tinued operation during power
mains interruptions, it is recom
mended that the Norland DXA
bone densitometer be
powered from an unin-
terruptible power supply or a
battery.

Power Frequency
(50/60 Hz) Magnetic
Field

IEC61000-4-8

3 A/m

3 A/m

Power frequency magnetic
fields should be at levels char-
acteristic of a typical location
in a typical commercial or hos-
pital environment.

NOTE: Utis the AC mains voltage prior to application of the test level.

aT his Table required per clause 6.8.3.201 a) 6)

Operator's Guide
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Table 18-3: TABLE 204a

Guidance and Manufacturer's Declaration - Electromagnetic Immunity

The Norland DXA bone densitometer is intended for use in the electromagnetic environment specified below. The customer or user of the
Norland DXA bone densitometer should assure that it is used in such an environment.

Immunity Test IEC 60601 Compliance Electromagnetic Environment - Guidance
Test Level Level

Portable and mobile RF communications equipment should be used
no closer to any part of the Norland DXA bone densitometer, includ-
ing cables, than the recommended separation distance calculated
from the equation applicable to the frequency of the transmitter.

Recommended separation distance:

Conducted RF IEC 3Vrms 3Vrms d=1.2P1/2

61000-4-6 150 kHz to 80 MHz 150 kHz to 80 MHz

Radiated RF 3Vim 3Vim d=1.2P1/280 MHz to 800 MHz
IEC 61000-4-3

80 MHzto0 2.5 GHz 80 MHzt0 2.5 GHz d=2.3P1/2800MHzto0 2.5 GHz

where P is the maximum output power rating of the transmitter in
watts (W) according to the transmitter manufacturer, and d is the
recommended separation distance in meters (m).

Field strengths from fixed RF transmitters, as determined by an elec-
tromagnetic site survey, should be less than the compliance levelin
each frequency range.

Interference may occur in the vicinity of equip-
ment marked with the following symbol:

NOTE 1: At 80 MHz and 800 MHz, the higher frequency range applies.

NOTE 2: These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and reflection from struc-
tures, objects, and people.

Field strengths from fixed transmitters such as base stations for radio (cellular/cordless) telephones and land mobile radios, amateur radio,
AM and FM radio broadcast, and TV broadcast cannot be predicted theoretically with accuracy. To assess the electromagnetic environment
due to fixed RF transmitters, an electromagnetic site survey should be considered. If the measured field strength in the location in which the
Norland DXA bone densitometer is used exceeds the applicable RF compliance level above, the Norland DXA bone densitometer should be
observed to verify normal operation. If abnormal performance is observed, additional measures may be necessary, such as re-orientating
or relocating the Norland DXA bone densitometer.

Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3 V/m.

aT his Table required per clause 6.8.3.201 b)
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Table 18-4: TABLE 206a

189

Recommended Separation Distances
Between Portable and Mobile Communications Equipment
and the Norland DXA Bone Densitometer

The Norland DXA bone densitometer is intended for use in an electromagnetic environment in which radiated RF
disturbances are controlled. The customer or the user of the Norland DXA bone densitometer can help prevent
electromagnetic interference by maintaining a minimum distance between portable and mobile RF com-
munications equipment (transmitters) and the Norland DXA bone densitometer as recommended below, accord-

ing to the maximum output power of the communications equipment.

Separation Distance According To Frequency Of Transmitter (m)
Rated maximum power 150 kHz to 80 MHz 80 MHz to 800 MHz 800 MHz t0 2.5 GHz
o of thetransmitter | 4 _ 1 5 py/p d=12P12 d=2.3P12
0.01 0.12 0.12 0.23
0.1 0.38 0.38 0.73
1 1.2 1.2 23
10 3.8 3.8 7.3
100 12 12 23

For transmitters rated at a maximum power not listed above, the recommended separation distance d in meters
can be estimated using the equation applicable to the frequency of the transmitter, where P is the maximum out-
put power rating of the transmitter in watts (W) according to the transmitter manufacturer.

NOTE 1: At 80 MHz and 800 MHz, the separation distance for the upper frequency range applies.

NOTE 2: These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption
and reflection from structures, objects, and people.

aT his Table required per clause 6.8.3.201 b)

Operator's Guide
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IEC 60601-1-6 Usability Information

Usability Characteristics

The Norland Bone Densitometers achieve a high level of usability, which allows the operator to quickly learn its
operation and efficiently perform accurate bone density procedures. The following characteristics are par-
ticularly helpful in this respect:

»

»

»

»

»

»

Fixed Technique Factors - the x-ray tube voltage and current are not required to be set according to patient
size or portion of the body being scanned. This eliminates this source of operator error.

Automatic (x-ray) Beam Intensity Adjustment - As the patient is being scanned, the intensity of the x-ray
beam is monitored and adjusted to be optimal by switching filters in and out of the beam at high speed. This
eliminates too low count rates that contribute to inaccuracies, and too high count rates that unnecessarily
increase dose. This eliminates a potential source of operator error.

Automatic determination of Region Of Interest (ROI) - For virtually all scans, the software automatically loc-
ates the ROI and properly places the cursors, which determine the area to be analyzed. This quantitative
approach is better and more consistent than what an operator can do. It contributes to better accur-
acy/precision, and reduces a potential source of operator error.

Hip Sling Positioner - This positioner takes the guesswork out of properly rotating the femur neck for the hip
scan. It is easy to use and reduces the negative effect of not having the femur neck perpendicular to the x-
ray beam.

Daily Calibration - The operator is prompted to do a calibration at the beginning of each day's scanning ses-
sion. The calibration scans the Calibration Standard and QC Phantom, and automatically performs the ana-
lysis. The accuracy and precision results are displayed on a timeline, along with a pass/fail indication. This
helps insure accurate and precise patient measurements.

Help Screens - A step-by-step procedure, complete with graphs and pictures, is on the screen while the oper-
ator is performing the scan. It is an easily understood, ready reference that helps preclude operator error.

Operator Profile

Norland Bone Densitometers are intended to be used by persons with the following skills/credentials:

»

»

»

Must be licensed in their State to operate x-ray medical devices. In most States, this means they must be a
licensed Radiology Technologist, or hold a Limited License for Bone Densitometry. This law helps insure the
operators are adequately educated regarding x-ray safety.

Participated in a Norland sponsored, device specific, training class, and passed the final test. This helps
insure the operator knows how to achieve accurate/precise results with the bone densitometer.

Must have basic computer skills. This includes familiarity with the Windows operating system, keyboarding,
mouse operation, how to print, how to backup files, and how to enter data into fields on the screen.
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Fuse Information

Table 18-5: Fuse Ratings

Fuse Location Fuse Rating
Power Tray F4 & F5 2A, 250V, 0.25” X 1.25” Slow Blow
Power Supply Board F1 & F2 | 2.5A, 250V, 0.25” X 1.25” Slow Blow
Source Control Board F1 10A, 250V, 0.25” X 1.25” Slow Blow
Power Tray F6 & F7 15A, 250V, 0.25” X 1.25” Slow Blow
Power Supply Board F3
Power Entry Module 10A, 250V, 0.25” X1.25” Slow Blow
5A, 250V, 0.25” X 1.25” Slow Blow
6.3A, 250V, 5mm X 20mm, T
3.15A 250V, 5mm X 20mm, T

Beam Quiality Information

Table 18-6: Beam Quality Information

ltem Equivalent Filtrationa Notes

Half Value Layer (HVL) 6.6mmAl Tested at 100 kV & 1.3 mA.

Irremovable Materials 1.9mmAl Tested with 70 kV, 2.5mmAL Source.

Added Filters 13.2mmAl Tested with 70 kV, 2.5mmAl source.
Minimum fixed filters is 0.003mm Sm.

Total Filtration 15. TmmAl Sum of irremovable and added filters.

Table Top 0.8mmaAl Tested with 70 kV, 2.5mmAl source.

Materials between patient & detector | 0. TmmAl Tested with 100 kV, 5.5mmAl source.

aThese values are fixed. The operator does not select filtration
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Position of X-ray Beam

The x-ray beam is located under the scanner arm. It may be located in any position under the arm. The exact loc-
ation can be identified by activating the laser.

Figure 18-1: Possible X-ray Beam Location
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Cautions

General Cautions

Caution: Do not touch the patient and the computer system, or other non-ME equipment parts, at the
same time as this could increase leakage currents.

Caution: Device is not designed to be defibrillator proof.

Caution: Device is not intended for use in conjunction with flammable agents.

Caution: Device is not anesthesia proof.

J
Caution: Device is not intended for use in oxygen rich environments.
Caution: Not a patient connected device; patient equalization terminal not provided.

N
Caution: The laser within this product is not user serviceable. In the event it fails to operate, contact
Norland Technical Support.
Caution: Use of controls or adjustments or performance of procedures other than those specified may
result in hazardous radiation exposure.

J

Caution: Follow the procedures in the General Maintenance section of this manual to insure patient
data is not lost.

Note: The device of which this x-ray source is a part is a Class | device, (per clause 5 of EN60601-1).
However, this x-ray source is not designed, intended, or capable of operating as a stand-alone x-ray
source.

Note: There are no user serviceable parts or user accessible fuses inside the unit.

SIS SN SN SNES
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Cautions for the Isolated Multiple Portable Socket-Outlet (IMPSO)

Caution: The IMPSO provided with this system is for use with the computer (computer, monitor, and
printer). Properly used, it will reduce the risk of leakage currents for the patient and operator.

Caution: Do not connect the computer directly to a wall outlet instead of to the IMPSO because this
would increase leakage currents.

Caution: The maximum load for the IMPSO provided with this ME system is 300 VA for 115/230 Vac
at 50/60 Hz.

Warning: If another IMPSO is used, verify its electrical rating is adequate for the computer com-
ponents plugged into it.

Caution: Do not connect any other equipment to the IMPSO as this could increase leakage currents.

Caution: Do not use additional IPMSOs, or extension cords, because they could increase leakage cur-
rents.

Caution: Do not place the IPMSO on the floor. Place it on a table or shelf to protect it from damage
and spilled liquids, which could result in increased leakage currents.

ISESISESESESES
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Specific Cautions

Warning: If you reach into the back of the unit, you could get
your finger, hand or arm pinched between the scanner arm and
scanner housing.

Warning: This device produces x-ray to achieve its intended purpose. It should
only be used by qualified persons according to the instructions in this manual.
Even though dose levels are very low, State and Federal regulations require
scans of human subjects to be ordered by a physician.

100KV is generated inside the source. It is not accessible on the outside of the
source or on the printed circuit board attached to the source.

Over-400VDC is present on the detector assembly whenever the system
power is on. It is not accessible when the system is fully assembled.

A laser is used for marking the area of the patient to be scanned. Do not allow
the beam to hit the patient’s eyes and be careful that it does not reflect off shiny
surfaces. The only operator control is on and off.

Caution: Use of controls or adjustments or performance of procedures other
than those specified herein may result in hazardous laser light exposure.

DANGER
LASER
RADIATION Disassembling this part could result in exposure to laser radiation, Class Il
WHEN OPEN (FDA), Class 2 (CE). In particular, the laser module will continue to operate
even if it is removed from its housing.
EXPOSURE
LASER
APERTURE The laser beam will come through the long slot next to this label.

This unit is to be powered from a hospital grade receptacle to insure proper
safety grounding.

Warning: To avoid risk of electric shock, this equipment must be connected to
a supply with a protective earth.
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Stray Radiation
Specified to be less than 0.8 uGy/hr at a distance of three feet from the beam.

This test was done while scanning a 20 x 30 x 15-cm water phantom. A Victoreen Model 450P lon Chamber
(300-cc) was used to measure the radiation levels at approximately one foot and three feet from the beam. The
450P had a current calibration from its manufacturer.

Top View
| 3ft(0.9m) 0.789 |
| 1ft(03m) 48
| 3ft(0.9m)  0.702 3ft(0.9m) 0.614
| 1ft(0.3m)  2.01 1ft (0.3m)  2.01
Water Phantom
on Tabletop
Distance  uGy/hr
3ft(0.9m) 0.789
| 1ft(03m) 526 |
Front View

Distance  uGy/hr

3ft(0.9m) 0.439
1t (0.3m)  1.22

Water Phantom
on Tabletop \ !
- S

(
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Label Locations

Scanner, Front View

Laser Aperture Label (FDA)
(Bottom)

Identification Label (model,
serial number, and ratings)

Scanner, Back View

INSIDE: Laser Non-Interlocked Label (FDA)

Mechanical Hazard Label (3 total)
Mains Impedance Label

SCANNER LABELS:

- X-Ray Warning Label

- Beam Limiter Certification Label (duplicate)
- X-Ray Source Certification Label (duplicate)
- Prescription Label

- CE Mark (if required) and WEEE Label

- UDI Label

- Read Instructions Label

- Export Label (if required)

- Animal Use Label (if required)

- Investigational Use Label (if required)

Hospital Grade Label

Pinch Point Warning Label

and Fuse Label

Inside:

- High Voltage Caution Label

- X-Ray Source Certification Label
- Beam Limiter Certification Label

(Continued on the next page)
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(Label Locations, continued)

Scanner Arm Touch Pad

Mechanical
Hazard Labels

(3 total)

Controller FDA
Certification Label
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Scanner Labels

Identification Label

(Only one of these labels will be on the unit because they are
model and country specific.)

The scanner Model is designated by name
(XR-600 or XR-800). The part number (435A100 or435A101)is
also on the label.

NORLAND
W6340 Hackbarth Road
Fort Atkinson, W1 53538 USA

Bone Densitometer
Model: XR-800

Model Number: 435A101
m Date: March 2019 d

Serial No: 00000 201903
/

N
OR

600 or XR-800).

'NORLANDSY i X265 %5 Br U & 1
Eails, XR-600 :
P&/, 0000 r

BEHE. 220V, 50Hz 3T 700VA
Fen% 2l seupsge. B

i gﬁ: Norland
=1k, W6340 Hackbarth Road
£ Fort Atkinson, Wi 53538 6B

® |NPUTPOWER:
’R 100-120 V/~, 220/230/240 V~
50/60 Hz, 700 VA Maximum

THIS DEVICE COMPLIES WITH ALL
APPLICABLE FDA RADIOLOGICAL
HEALTH REGULATIONS

Norland
Fort Atkinson, Wl
Beam Limiter
Model No:  387A030
SerialNo: 0000 Rev:
Date: January 2014
Filtration: See Manual

THIS DEVICE COMPLIES WITH ALL APPLICABLE
FDA RADIOLOGICAL HEALTH REGULATIONS

For China, the scanner Model is designated by a part name (XR-

Norland
Fort Atkinson, Wi

Table Top
Filtration: See Manual

LASER
APERTURE

DANGER
LASER
RADIATION
WHEN OPEN
AVOID DIRECT
EYE
EXPOSURE

CAUTION

LASER RADIATION
DO NOT STARE INTO BEAM

1.0 MILLIWATT MAXIMUM
650 NANOMETER OUTPUT
CLASS Il LASER PRODUCT

Operator's Guide
435D109 Rev. Z
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Technical Reference

(Scanner Labels, continued)

CAUTION

MAINS IMPEDANCE MUST
BE LESS THAN 0.18 OHMS

* If applicable

* If applicable

* If applicable

* Located on the outside of the shipping
container.

NORLANLD
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(Scanner Labels, continued)

e

0197 | |

* EU Configuration Only

ECREP Authorized European

Representative
Swissray Medical AG
Turbistrasse 25-27
CH-6280, Hochdorf, Switzerland
Phone: +41 (41) 914 1212
| Fax: +41 (41) 914 1201

* EU Configuration Only

NORLAND at Swissray
“ W6340 Hackbarth Road

Fort Atkinson, Wi 53538 USA
Date: 2017-11-08
Serial #: 00000
%

(01)00866955000461(11)171108(21)00000

Operator's Guide
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Pinch points.
Watch your
GELER

Follow Instructions for Use
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Technical Reference

Controller Certification Label

The label below is affixed to the Norland Controller (the computer).

Norland
Fort Atkinson, WI

Kray Controller
ModelNo:  434A157
Serial No: 0000
Date: February 2014

THIS DEVICE COMPLES WITH ALL APPLICABLE
FDA RADIOLOGICAL HEALTH REGULATIONS

Power Entry Module Labels

The labels below are affixed to the Power Entry Module, located inside the scanner table.

LINE FUSE FUSE
100 - 120 V~ 10 Aslow | 6.3A(T)
220/230/240 V~ S5Aslow | 3.15A(T)
INPUT POWER: 700 VA MAX. 50/60 Hz

Tube Housing and High Voltage Generator Labels

The label below is affixed to the Norland combination tube housing and high voltage generator (x-ray generator).
A duplicate is also affixed to the scanner near the power switch.

Norland
WE340 Hackbarth Road, Fort Atkinson, WI 53538 USA
Tube Housing & High Voltage Generator

Model No: 391A168
Serial No: 00000

Filtration: 1.9 mmAl

Date: October 2019
Tube: Canon D-051, S/N: 0000

THIS DEVICE COMPLIES WITH ALL APPLICABLE
FDA RADIOLOGICAL HEALTH REGULATIONS

NORLANLD

Operator's Guide
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CHAPTER 19

Reference Data Sefts

This chapter includes the Reference Set Data Sheets - Inclusion-Exclusion Criteria. It
also includes the “Reference Set Data Sheets” for Central Bone Densitometers at the

end of the chapter.

This chapter discusses the following.

Data Collection Sites .. ... ... .. 19-2
Data Gathering ProCess ... ... . 19-2
Medical History Form Review Criteria ... ... .. ... .. .. ............ 19-3
Excerpt from Calcified Tissue International ...................................... 19-7
Excerpt from the Journal of Bone and Mineral Research ........................ 19-8
Norland Reference DataSet Values ........................................... 19-10
NHANES Il Reference DataSet Values ... ... ... ... 19-15
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19-2 Reference Data Sets

Data Collection Sites

For the Norland reference sets, the data was gathered at ten (10) study sites across the USA. The ages of the
subjects scanned was from 20 to 89 years of age. All scan data was examined to verify acceptable quality
(proper positioning, correct region placement, etc.). The numerical values for these subjects are listed in Table
1 in this document.

Datais provided for Female Caucasians for the Total Hip sBMD region as derived from phases 1 and 2 of the
third National Health and Nutritions Examination Survey (NHANES 11I, 1988-1994). Reference values for this
set are listed in Table 19-2 on page 19-15. The values were generated following the formula published in

the Journal of Bone and Mineral Research (see page 19-8 of this chapter). The formula used is:

SBMD = 1000(1.012 * BMDporiang + 0-026)

Datais also provided for Female Caucasians for the Spine L2-L4 sBMD region as derived from phases 1 and 2
of the third National Health and Nutritions Examination Survey (NHANES IlI, 1988-1994). The values were gen-
erated following the formula published in Calcified Tissue International (see page 19-7 of this chapter). The for-
mula used is:

SBMD = 1000(1.0761 * BMDyorjand)

Data Gathering Process

Information needed to determine appropriate classification into a particular sex and ethnic reference set was
obtained from a self-reported detailed medical history required of all study participants. Information was noted
on Medical History forms and verified by Norland selected investigators. Categories included height, weight,
ancestry (ethnicity), occupation, diet, family history, medical and surgical history, and so forth. Ethnic indi-
viduals had to be at least 75% of the claimed ethnic background as self-reported.

Based on review of the medical history information, only data from normal, healthy, untreated individuals was
included in each Reference Set. Individual participants having certain conditions and/or medication were
included after consideration of each specific situation. Included individuals are grouped by sex, age, and ethnic
background. Care was taken to include a significant amount of data from those in the younger age range, as
well as a broad distribution of participants across all age ranges.

Data from those participants who reported illnesses or medication affecting the subject’s bone health was
excluded from the reference sets. Any of the diseases and conditions listed below (and on the Medical History
form) were possible grounds for exclusion from the study. Data from participants with diagnosed osteoporosis
[defined as those individuals who have x-ray evidence of vertebral fracture (including DXA scan), hip fracture
associated with osteoporosis, loss of height, or other specified means] was not used in Norland reference sets.

Completed studies were examined by Norland QA to verify acceptable scan quality for inclusion in the ref-
erence set. Finally, subject information was reviewed by the clinical auditor to ensure that the complete clinical
history met all the inclusion criteria.

NORLANLDO B3D109 Rov-7
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Medical History Form Review Criteria

The Medical History form provided the information needed to determine whether a given individual should be
included in the Normal Group or excluded in the Osteoporotic Group, or excluded from the study entirely. Since
some medications significantly affect bone mass, interpretation was necessary to evaluate a particular drug’s
effect (based on dose, duration and time of life). Interpretation was also necessary to evaluate the effect of cer-
tain bone-active disorders. The following paragraphs provide guidance when evaluating the Medical Histories.

Osteoporosis

Data obtained from subjects diagnosed with osteoporosis was not used in Norland normative data but was
saved for potential future, yet to be determined studies.

Other Bone-Active Diseases and Conditions

The diseases and conditions on the following page are listed in the Medical History form and provide possible
grounds for exclusion from the study. Exclusion criteria was established to ensure the collection of bone dens-
ity measurements from normal, healthy, untreated individuals.

Amenorrheic Syndrome: Exclusion only if syndrome was prolonged (at least 2 years), and recent (within the
last three months).

Alcoholism: Exclusion only if severe, chronic, and accompanied by malnutrition. If possible, quantify amount
of alcohol consumption.

Alzheimer’s: Not grounds for exclusion.
Births: Number of births means number of pregnancies.
Broken/Fractured Hip: Not grounds for exclusion if occurred more than five years prior to data collection.

Cancer: Subject data may be included, as long as subject has been cancer free for more than five years. Local-
ized squamous and basal cell are often not exclusions.

Cirrhosis: Exclusion only if clinically apparent and duration is greater than 3 months.
Cushing’s Syndrome: Grounds for exclusion.

Diabetes: Exclusion only if onset occurred in childhood, delaying or retarding growth. Properly treated adult dia-
betics need not be excluded.

Early Menopause: Not grounds for exclusion. Early menopause is considered to be before 40 years of age.
Make sure that the date of menopause is included for later analysis.

Emphysema: Exclusion if clinically apparent and/or severe COPD.

Fractures: Fractures due to accidents and trauma are not grounds for exclusion. Vertebral and other spon-
taneous fractures are grounds for exclusion.

Hyperparathyroidism: Data collected from these subjects will be excluded.

Hypoparathyroidism: Data collected from these subjects will be excluded.

Hyperthyroidism: If medication (dose) has been stable for 12 consecutive months, data need not be excluded.
Hypogonadism (Males): Grounds for exclusion.

Hypothyroidism: If medication (dose) has been stable for 12 consecutive months, data need not be excluded.
Hysterectomy: Hysterectomy with bilateral oophorectomy will be excluded.

Immobilization: Exclusion only if immobilization is prolonged for longer than one month, such as in stroke vic-
tims.

Leukemia: Grounds for exclusion.
Liver Disease: Exclusion only if clinically apparent and duration is greater than 3 months.
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19-4 Reference Data Sets

Lymphoma: Grounds for exclusion.

Malabsorption Syndromes: Grounds for exclusion.

Multiple Myeloma: Grounds for exclusion.

Paget’s Disease: Data collected from these subjects will be excluded.
Renal Dialysis: Data collected from subjects on dialysis will be excluded.

Renal Disease: Renal disease without dialysis is not grounds for exclusion from the study. Subject is included
if Creatnine is less than 2 and excluded if creatnin is more than 2. If Creatnine level is unknown, subject will be
excluded.

Smoking: Not grounds for exclusion. However, please note current smoking habits and past smoking history,
which includes amount and time frame.

Sickle Cell: Not grounds for exclusion.
Tuberculosis: Only grounds for exclusion if disease is active.
Vitamin Deficiencies: Not grounds for exclusion, but such deficiencies should be noted and explained.

Medications Affecting Bone
The use of medications affecting bone are possible grounds for exclusion. Such medications include:
Anticonvulsants: Grounds for exclusion.

Birth Control Pills: In general, birth control pills are not grounds for exclusion. Some postmenopausal subjects
will report perimenopausal estrogen replacement therapy as “birth control pills” probably because of a com-
parison made by their physician. These subjects will not be excluded for estrogen use.

Bisphosphonates: Bisphosphonates are grounds for exclusion. Individuals currently using Bisphosphonates
or those who have for less than six (6) months will be excluded. For those with a past history, please note med-
ication, duration, dose and time frame on Medical History form.

Calcitonins: Calcitonins are grounds for exclusion. Individuals currently using Calcitonins or those who have
ever used Calcitonins for more than six (6) months will be excluded. For those with a past history, please note
medication, duration, dose and time frame on Medical History form.

Dilantin: Grounds for exclusion.
Estrogen: HRT and ERT are grounds for exclusion.

Note: Individuals currently on ERT or HRT: Those on ERT or HRT for less than three (3) months can
be included in the study. Individuals who have been on HRT or ERT in the past: If it has been more
than 24 months since treatment ended, the subject’s data can be included in the study.

Heparin: Grounds for exclusion if taken for more than three (3) months.

Sodium Fluorides: Sodium Fluorides are grounds for exclusion. Individuals currently using Sodium Fluoride or
those who have ever used Sodium Fluorides for more than six (6) months will be excluded. For those with a
past history, please note medication, duration, dose and time frame on Medical History form.

Steroids: Oral and inhaled steroids are criteria for possible exclusion. Those on high dose (>3 mos.) will be
excluded. Please note medication, duration, dose, and time frame on history. (Site specific injections are not
grounds for exclusion.)

Thyroid Hormone: Not grounds for exclusion if proper dose is given; these actually compensate for an abnor-
mal condition. Subjects will be excluded if dosage has changed within the last twelve months.

NORLANLDO B3D109 Rov-7



Reference Data Sets

19-5

Statistical Methods

The raw data was processed by an independent statistician at the University of Wisconsin, Madison to fit sci-
entifically and biologically relevant curves using step wise deletion of regression break points. The standard
deviation was fitted to the curves forcing the standard deviations to be equal at the breakpoints but allowing the

standard deviation to change with age.

Reference Sets Data Entry

Pictured below is an example screen used to enter the reference data. Refer to "Working with Reference Sets"
on page 12-26 for instructions on enabling/disabling and editing reference sets.

M Create Reference Set

Scan Type

" AP Spine " Hip i Foream ™ Lateral Spine " Whole Body " Research " Small Subject
AP Spine Hip Farearm Lateral Spine ‘wihale Body Fezearch
| Bl EIfi B =) Tl =
User
| | E | | = pefrea | = | __H
Reference Data
. & BMD " BMC ¢ IBMC/FFM ¢ STFat% ¢ sBMD
Title Morland Rico
AGE value |25 |~
Ethnicity | Caucasian - 20 0.979 0.2
Young Reference  |0.979 50 0.919 0.2
s Female  Male 1 N/ bt
Display By * Walue  T-Score WEkEearty |LEVEIS |
0.879
Iv Enabled 0,779

0.679

Save LClose

Operator's Guide
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WHO Ciriteria

The WHO criteria indicates that patients having T-Scores from +1 to -1 are considered to have normal bone
density. Patients having T-Scores between -1 and -2.5 are considered osteopenic (low in bone mass) and at an
increased risk of fracture. Patients having T-Scores below -2.5 are considered osteoporotic and have a high risk
of fracture.

For detailed information regarding WHO criteria, please obtain a copy of the WHO Technical Report Number
843, entitled “Assessment of Fracture Risk and its Application to Screening for Postmenopausal Osteo-
porosis”. It was published in 1994 by the World Health Organization, Geneva, Switzerland.

Norland Fracture Risk

Printed reports from all Norland scanners contain a graph plotting the BMD of the current scan against Fracture
Risk information, based on the WHO criteria. An example of the graph is shown below. The appearance of the
graph on any report may vary, based on the presence of Age-matched values or color versus black and white
reports.

L2-L4 MNorland 400 ©
1.411

1315

1.219

Low Risk
(Green)

1123
1.027

0831
Medium Risk

BEES Medium Risk
(Yellow)

BMD

0738

0.643

High Risk
0547 (Red)

AGE
Figure 19-1: Fracture Risk Reference Set Chart (sample)

The upper area, labeled “Low Risk”, represents the range of values termed by WHO to be “normal” - having
adequate bone mineral. This is the region with T-Score values above minus 1 standard deviation, referenced to
the young adult mean BMD value found in the reference population.

The middle area, labeled “Medium Risk”, represents the range of values termed by WHO to be “osteopenic” -
having reduced bone mineral. The BMD T-Score values in this region range between minus 1 standard devi-
ation and minus 2.5 standard deviations. A patient whose value is plotted in this region may be susceptible to
fracture.

The lower area, labeled “High Risk”, represents the range of values termed by WHO to be “osteoporotic” - hav-
ing severely reduced bone mineral. The BMD T-Score values in this region are more than 2.5 standard devi-
ations below the young adult mean value. A patient whose value is plotted in this region has a high spontaneous
fracture probability.
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Excerpt from Calcified Tissue International

Calcif Tissue Int (1995) 57:469

Letter to the Editor

1 Wil
'ﬁ‘(_lh'lflﬁl
Issue

Intemational

€ 1995 Spninger-Verlag New York Inc.

Standardization of Measurements for Assessing BMD by DXA

In a recent article, Genant et al. [1] published the results of
a trial sponsored by the dual X-Ray absorptiometry (DXA)
manufacturers Hologic, Lunar, and Norland to provide the
basis for the standardization of measurement units used for
the assessment of bone mineral density (BMD) by DXA. In
a meeting of the Committee for Standards in DXA held dur-
ing the annual meeting of the Radiological Society of North
America in Chicago on November 30, 1994, the Committee
gave final approval to the standardization of postero-anterior
(PA) spine BMD measurements by DXA, as published by
Genant et al.

In brief, effective September 1. 1995, all participating
manufacturers will provide an option on newly shipped in-
struments which will permit users to select between spine
BMD being reported with either the traditional. manufac-
turer-specific units in g/cm? or the standardized. nonmanu-
facturer-specific units in mg/cm®. New systems will be con-
figured to report standardized units by default. Upon re-
quest, software will be available from the manufacturers for
upgrading existing instruments to provide the standardized
units option.

The equations used to convert existing units (g’cm?) into
standardized units (mg/cm®) for PA spine (L2-L4) BMD are
as follows:

For Hologic instruments:

SBMD = 1000{BMD,,,,,,.i. - 1.0755]
For Lunar instruments:

sBMD = 1000[BMD
For Norland instruments:

sBMD = 1000[BMD ., 14nq - 1.0761]

- 0.9522]

Lunar

Spine BMD values obtained by scanning a patient on any
one of these manufacturers instruments should fall within
2-5% of each other. These equations were determined such
that, on average, the central vertebra of the ESP [2] reads
1000 mg/cm? on all scanners. However, the Committee for
Standards in DXA does not endorse a single phantom for the
determination of standardized units. The Committee be-
lieves that the equivalence of new DXA scanner types can-
not be established by measuring a single object, regardless of
whether that object is a phantom or a single patient. For that
purpose, a study similar to the one described by Genant
must be performed in vivo on individuals spanning the clin-
ical range of BMD. Different phantoms are available from
different manufacturers which, when used in accordance

with manufacturers’ directions and specifications, can serve
to verify instrument calibration and stability.

The Committee for Standards in DXA will continue its
work to expand standardization to other anatomical sites
assessed by DXA and will report periodically on its progress
using Letters to the Editor as a means of communication.

Peter Steiger

Committee for Standards in DXA
Waltham, MA
USA

Committee members

Harry K. Genant, M.D. University of California, San
Francisco, CA, USA for the
American Society for Bone and
Mineral Research and the
National Osteoporosis Foundation

Norland Corporation, Fort
Atkinson, WI, USA

Thomas Hangartner. Ph.D.  Wright State University, Dayton,
OH. USA for the American
Association of Physicists in
Medicine and the National
Osteoporosis Foundation

Lunar Corporation, Madison, W1,
USA-Committee Chairman

University of Erlangen, Germany,
for COMAC/BME

Lunar Corporation, Madison, WI,
usa

Japanese Society of Bone and
Mineral Research, Japan

Stratec Medizintechnik GMBH,
Pforzheim, Germany

Hologic Inc., Waltham, MA, USA

Hologic Inc.. Waltham, MA, USA

Aloka Inc., Japan

Michael E. Grman

James Hanson, Ph.D.
Willi A. Kalendar, Ph.D.
Richard Mazess, Ph.D.
Rikushi Morita, M.D.
Hans Schiessl

Peter Steiger, Ph.D.
Jay Stein, Ph.D.
Toshiaki Tamegai Ph.D.
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Excerpt from the Journal of Bone and Mineral Research

JOURNAL OF BONE AND MINERAL RESEARCH
Volume 12, Number 8, 1997

Blackwell Science, Inc.

© 1997 American Society for Bone and Mineral Research

Letter to the Editor
Standardization of Femur BMD

To the Editor:

The International Committee for Standards in Bone
Measurement gave final approval to the standardization of
proximal femur BMD measurements by DXA in a meeting
held in Chicago on December 4, 1996. This follows earlier
announcements on adoption of standardized units and
spine standardization.""? Standardization of femur BMD
measurements will include region of interest definition,
units of measurement, and reference data.

The region of interest used for femur evaluations will be
the Total Femur region of interest as used in NHANES
I11,» SOF,® PEPL® and other cross-sectional and pro-
spective studies. These studies have demonstrated that the
Total Femur region of interest is equally diagnostic but
more precise than the Femoral Neck region of interest
predominantly used prior to standardization. As part of the
standardization effort, the Total Femur region of interest
will be made available by all DXA manufacturers offering
Standardized Femur BMD.

The Committcc has decided to introduce the term
“sBMD,” expressed in mg/cm?, to distinguish Standardized
Femur BMD from manufacturer-specific “BMD,” ex-
pressed in g/cm®. The equations used to convert manufac-
turer-specific units [g/cm?] for Total Femur BMD into stan-
dardized units [mg/cm?] are as follows:

For Hologic Instruments:
SBMD = 1000[1.008 X BMDyjp; + 0.006]
For Lunar Instruments:

sBMD = 1000[0.979 X BMD ., — 0.031]

For Norland Instruments:
sBMD = 1000[1.012 X BMD yizng + 0.026]

sBMD values obtained by scanning a patient on any one
of these manufacturers’ instruments should fall within
3-6% of each other (3% standard error of estimate). These
equations were based on the same study used to define
sBMD for the spine‘" using an approach developed by Lu
and colleagues.® The method used does not require a gold
standard and minimizes variance observed between stan-
dardized and manufacturer-specific BMD values on all in-
struments. For new devices entering the market to comply
with Standardized Femur BMD a study similar to the one
employed here will be required. Such a study would mea-
sure a wide range of BMD in human subjects on different
scanners and derive Standardized Femur BMD using the
method of Lu et al.

The standardization of Total Femur BMD includes the
standardization of reference data, thereby making T- and
Z-scores derived from different manufacturers’ equipment
compatible. The data used as the basis for the reference
ranges were collected in phases 1 and 2 of the third National
Health and Nutrition Examination Survey (NHANES II1,
1988-1994).® The reference data curve was generated
based on running means of the raw data. The mean sBMD
and standard deviation for the young adult reference for
409 U.S. white women aged 20-29 years was 956 mg/cm?
and 123 mg/cm?, respectively. Age-specific reference data
based on a total of 3,251 U.S. white women are listed in
Table 1.

Standardized Femur BMD will be made available on
newly-shipped devices no later than September 1, 1997, by
all participating manufacturers. Users will be provided with
an option that will permit Femur BMD to be reported with
either the traditional, manufacturer-specific units in g/cm?
(for any of the traditional femur regions of interest) or the
standardized, non-manufacturer-specific units in mg/cm?
for the Total Femur region of interest. New systems will be
configured to report standardized units by default. Upon
request, software will be available from the manufacturers
for upgrading existing instruments to provide the standard-
ized units option.

As part of the standardization effort the Committee will
collaborate with the relevant scientific and professional
societies as well as the regulatory agencies to promote the
utilization of Standardized Femur BMD instead of the
current, widely-employed, manufacturer-specific Femoral
Neck BMD. The medical community should welcome man-
ufacturers’ independent T- and Z-scores for diagnosis at the

TasLe 1. STANDARDIZED TOTAL FEMUR REFERENCE DATA FOR
WhHhitE WOMEN

Reference sBMD (mgjcm?)

Age (years) for women
20-29 956
30-39 944
40-49 920
50-59 876
60-69 809
70-79 740

80+ 679

The standard deviation is 123 mg/cm?.
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LETTER TO THE EDITOR

Total Femur region of interest. This will eliminate the
currently observed inter-manufacturer discrepancy associ-
ated with clinical decision-making based on T- and Z-scores
at the femur neck region of interest.

The Committee for Standards in Bone Measurement, a
voluntary committee of representatives of both industry and
the academic community, has provided users of DXA tech-
nology the three critical components for standardization of
DXA scan results: standardized units in mg/cm?, a stan-
dardized definition of scan regions of interest for spine and
femur, and agreement on a universal reference database for
the femur, based on NHANES III. This significant accom-
plishment makes comparisons of data between DXA de-
vices and between manufacturers possible. The clinical ben-
efits of these efforts are evident in greater confidence in
scan results, clearer definition of patient condition when
applying WHO criteria, ability to compare data between
scans performed on different devices, and expanded refer-
ence data for the United States. The committee also agreed
to update reference data from time-to-time as new infor-
mation becomes available for additional populations. Stan-
dardization of male Total Femur reference data will be
completed when the final NHANES data are published.
The committee understands that population-based refer-
ence data equivalent to NHANES are being evaluated by
the European Foundation for Osteoporosis. The need for
geographic dependent reference data will be addressed by
the committee. The committee will continue its work to
expand standardization to other anatomical sites assessed
by DXA and will report periodically on its progress using
letters to the editor as means for communication.

[\
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Norland Reference Data Set Values

Table 19-1: Norland Reference Data Set Values

Ethnic Scan Type Region Title Young Standard Age20 | Age50 | Age80 Medium High Enabled
Reference Deviation BMD BMD BMD Rlsk Risk Risk

Asian (A) Female AP Spine Norland 4/00 1.005 0.129 0.876 0.6825 0.489
L2 Norland 4/00 1.061 0.132 0.929 0.731 0.533 Y
L3 Norland 4/00 1.090 0.130 0.960 0.765 0.570 Y
L4 Norland 4/00 1.036 0.127 0.909 0.7185 0.528 Y
L1-L4 Norland 4/00 1.043 0.125 0.918 0.7305 0.543 Y
L2-L4 Norland 4/00 1.062 0.126 0.936 0.747 0.558 Y
Total Spine Norland 4/00 1142 135 --- --- --- 1007 804.5 602 Y
Hip Fem Neck Norland 4/00 0.866 0.113 0.753 0.5835 0.414 Y
Troch Norland 4/00 0.697 0.108 0.589 0.427 0.265 Y
Ward’s Tri Norland 4/00 0.712 0.128 --- --- --- 0.584 0.392 0.200 Y
Total Hip Norland 4/00 929 117 812 636.5 461 Y
Black (B) Female AP Spine L1 Norland 4/00 1.206 0.140 1.066 0.856 0.646 Y
L2 Norland 4/00 1.256 0.139 1.117 0.9085 0.700 Y
L3 Norland 4/00 1.259 0.136 1.123 0.919 0.715 Y
L4 Norland 4/00 1.216 0.127 1.089 0.8985 0.708 Y
L1-L4 Norland 4/00 1.239 0.126 1.113 0.924 0.735 Y
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Norland Reference Data Set Values (continued)

Ethnic Scan Type Region Title Young Standard Age20 | Age50 | Age80 Medium High Enabled
Reference Deviation BMD BMD BMD Rlsk Risk Risk

L2-L4
Total Spine
Hip Fem Neck
Troch
Ward’s Tri
Total Hip
Black (B) Male AP Spine L1
L2
L3
L4
L1-L4
L2-L4
Total Spine
Hip Fem Neck
Troch
Ward’s Tri
Total Hip
Female

Caucasian (C) AP Spine L1

Norland 4/00 1.243 0.127

Norland 4/00 1338 137 -
Norland 4/00 1.046 0.140
Norland 4/00 0.797 0.125 ---
Norland 4/00 0.852 0.164 -
Norland 4/00 1081 140
Norland 4/00 1.232 0.184
Norland 4/00 1.291 0.204
Norland 4/00 1.309 0.215 -
Norland 4/00 1.279 0.201
Norland 4/00 1.271 0.191
Norland 4/00 1.293 0.202
Norland 4/00 1391 218 -
Norland 4/00 1.161 0.205 ---
Norland 4/00 0.933 0.181
Norland 4/00 0.939 0.217 ---
Norland 4/00 1188 198 -
Norland 4/00 1.029 0.155 1.034

1.034

0.779

1.116

1201

0.906

0.672

0.688

941

1.048

1.087

1.094

1.078

1.080

1.091

1173

0.956

0.752

0.722

990

0.874

0.9255 0.735

995.5 790 Y
0.696 0.486 Y
0.4845 0.297 Y
0.442 0.196 Y
731 521 Y
0.772 0.496 Y
0.781 0.475 Y
0.7715 0.449 Y
0.7765 0.475 Y
0.7935 0.507 Y
0.788 0.485 Y
846 519 Y
0.6485 0.341 Y
0.4805 0.209 Y
0.3965 0.071 Y
693 396 Y
0.6415 0.409 Y
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Norland Reference Data Set Values (continued)

Ethnic Scan Type Region Title Young Standard Age20 | Age50 | Age80 Medium High Enabled
Reference Deviation BMD BMD BMD Rlsk Risk Risk

Norland4/00  1.097 0.163 1.094 1.094  0.824 0.934 0.6895 0.445
L3 Norland4/00  1.115 0.171 1.108 1.108  0.885 0.944 0.6875 0.431 Y
L4 Norland4/00  1.082 0.169 1.063 1.063  0.893 0.913 0.6595 0.406 Y
L1-L4 Norland4/00  1.086 0.159 1.074 1.074  0.851 0.927 0.6885 0.450 Y
L2-L4 Norland4/00  1.102 0.162 1.087 1.087  0.869 0.940 0.697 0.454 Y
SpinesBMD  Norland4/00 1186 175 1170 1170 935 1011 748.5 486 Y
Hip Fem Neck Norland4/00  0.987 0.117 0.981 0.873  0.655 0.870 0.6945 0.519 Y
Troch Norland4/00  0.787 0.109 0.775 0699  0.559 0.678 0.5145 0.351 Y
Ward’s Tri Norland4/00  0.851 0.125 0.848 0674  0.441 0.726 0.5385 0.351 Y
Forearm Distal Norland798  0.3191 0.04822 0.3191 03211  0.2039*  0.27088 0.19855 0.12622 Y
Caucasian (C) Female  Forearm Proximal Norland 798  0.7127 0.06237 0.7127 07276  0.4553*  0.65033 0.556775  0.46322 Y
P Radius Norland 798  0.7181 0.063265 07181 0.7260 0.4546*  0.654835  0.559938  0.465040 Y
ForearmH  Distal Norland 798  0.3567 0.0539 0.3567 0.3589  0.2279*  0.3028 0.22195 0.1411 Y
Proximal Norland 798  0.8552 0.07484 0.8552  0.8731 0.5463*  0.78036 0.66810 0.55584 Y
P Radius Norland 798 0.8481 0.07472 0.8481 0.8575 0.5369*  0.77338 0.66130 0.54922 Y
Male AP Spine L1 Norland4/00  1.105 0.167 1.096 1.066 1.036 0.938 0.6875 0.437 Y
L2 Norland4/00  1.171 0.186 1.158 1.127 1.097 0.985 0.706 0.427 Y
L3 Norland4/00  1.181 0.191 1.165 1.146 1.127 0.990 0.7035 0.417 Y
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Norland Reference Data Set Values (continued)

Ethnic Scan Type Region Title Young Standard Age20 | Age50 | Age80 Medium High Enabled
Reference Deviation BMD BMD BMD Rlsk Risk Risk

L1-L4
L2-L4
Total Spine
Hip Fem Neck
Troch
Ward'’s Tri
TotalHip
Cauc-Hisp (CH) Female AP Spine L1
L2
L3
L4
L1-L4
L2-L4
Total Spine
Cauc-Hisp (CH) Female  Hip Fem Neck

Troch

Ward’s Tri

Norland 4/00 1.134 0.199 1.126 1.126
Norland 4/00 1.148 0.176 1.130 1.119
Norland 4/00 1.164 0.184 1.146 1.133
Norland 4/00 1253 198 1233 1219
Norland 4/00 1.108 0.125 1.111 0.940
Norland 4/00 0.933 0.113 0.925 0.838
Norland 4/00 0.908 0.126 0.905 0.680
Norland 4/00 1147 123 1150 1027
Norland 4/00 1.054 0.152 1.041 1.041
Norland 4/00 1.124 0.159 1.100 1.100
Norland 4/00 1.133 0.167 1.112 1.112
Norland 4/00 1.084 0.165 1.066 1.066
Norland 4/00 1.101 0.156 1.080 1.080
Norland 4/00 1.115 0.158 1.091 1.091
Norland 4/00 1200 170 1174 1174
Norland 4/00 0.995 0.116 0.993 0.871
Norland 4/00 0.779 0.108 0.772 0.698
Norland 4/00 0.846 0.124 0.849 0.674

1.126

1.107

1.121

1206

0.770

0.751

0.456

903

0.775

0.820

0.882

0.892

0.848

0.866

932

0.656

0.560

0.442

0.935

0.972

0.980

1055

0.983

0.820

0.782

1024

0.902

0.965

0.966

0.919

0.945

0.957

1030

0.879

0.671

0.722

0.6365 0.338

0.708 0.444 Y
0.704 0.428 Y
758 461 Y
0.7955 0.608 Y
0.6505 0.481 Y
0.593 0.404 Y
839.5 655 Y
0.674 0.446 Y
0.7265 0.488 Y
0.7155 0.465 Y
0.6715 0.424 Y
0.711 0.477 Y
0.720 0.483 Y
775 520 Y
0.705 0.531 Y
0.509 0.347 Y
0.536 0.350 Y
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Norland Reference Data Set Values (continued)

Ethnic Scan Type Region Title Young Standard Age20 | Age50 | Age80 Medium High Enabled
Reference Deviation BMD BMD BMD Rlsk Risk Risk

Total Hip Norland 4/00 1022 1010
Male AP Spine L1 Norland 4/00 1.109 0.167 1.096 1.065 1.034 0.942 0.6915 0.441 Y
L2 Norland 4/00 1.176 0.187 1.160 1.125 1.089 0.989 0.7085 0.428 Y
L3 Norland 4/00 1.183 0.191 1.166 1.142 1.119 0.992 0.7055 0.419 Y
L4 Norland 4/00 1.138 0.199 1.122 1.122 1.122 0.939 0.6405 0.342 Y
L1-L4 Norland 4/00 1.152 0.176 1.130 1.118 1.106 0.976 0.712 0.448 Y
L2-L4 Norland 4/00 1.168 0.185 1.147 1.130 1.113 0.983 0.7055 0.428 Y
Total Spine Norland 4/00 1257 199 1234 1216 1198 1058 759.5 461 Y
Hip Fem Neck Norland 4/00 1.107 0.126 1.109 0.939 0.769 0.981 0.792 0.603 Y
Troch Norland 4/00 0.928 0.114 0.919 0.835 0.751 0.814 0.643 0.472 Y
Ward’s Tri Norland 4/00 0.900 0.128 0.898 0.678 0.457 0.772 0.580 0.388 Y
Total Hip Norland 4/00 1146 124 1147 1025 903 1022 836 650 Y
Hispanic (H) Female AP Spine L1 Norland 4/00 1.088 0.126 --- --- --- 0.962 0.773 0.584 Y
L2 Norland 4/00 1.149 0.122 --- --- --- 1.027 0.844 0.661 Y
L3 Norland 4/00 1.144 0.126 1.018 0.829 0.64 Y
L4 Norland 4/00 1.080 0.121 0.959 0.7775 0.596 Y
L1-L4 Norland 4/00 1.112 0.119 0.993 0.8145 0.636 Y
L2-L4 Norland 4/00 1.123 0.117 --- === === 1.006 0.8305 0.655 Y
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Norland Reference Data Set Values (continued)

Ethnic Scan Type Region Title Young Standard Age20 | Age50 | Age80 Low Medium High Enabled
Reference Deviation BMD BMD BMD Risk Risk Risk

Total Spine Norland 4/00 1207 1079

Hispanic (H) Female  Hip Fem Neck Norland 4/00 0.982 0.111 --- --- --- 0.871 0.7045 0.538 Y
Troch Norland 4/00 0.740 0.103 0.637 0.4825 0.328 Y
Ward’s Tri Norland 4/00 0.800 0.125 - --- - 0.675 0.4875 0.300 Y
Total Hip Norland 4/00 1021 109 --- --- --- 912 748.5 585 Y

* This reference set has Age-Matched values for ages 20, 50, and 90.

NHANES |ll Reference Data Set Values

Table 19-2: NHANES Ill Reference Data Set Values

Ethnic Region | Young Standard Age 20 | Age25 | Age35 [ Aged5 | Age55 | Age65 | Age75 | Age85 | Low | Medium | High
Type Reference | Deviation BMD BMD BMD BMD BMD BMD BMD BMD Risk | Risk Risk

Caucasian Female Hip 123 648.5
sBMD

D10 Fev. 2 NORLANLDO
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About command 3-51
About this Manual 1-4
Accessories 2-6
Calibration Standard 2-6
head support pillow 2-7
patient positioning aids 2-7
QC Phantom 2-6
Accuracy & Precision, attaining 4-2
Accuracy description 2-10
Add
new patient 3-16
region (see Include) 12-45
Address Book 12-12

Advanced Preferences command 3-
39

Aids, patient positioning 8-10
Aladden USB HASP key 3-5

Alternate R-Value Analysis 12-72,
12-72

Preferences 3-32
Analysis

AP Spine options 3-31

AP Spine preferences 3-31

AP Spine scan 5-17

bone mineral 2-8

Forearm 7-21

Forearm options 3-33

Hip options 3-32

Hip scan 6-23, 6-25

Image Enhancement 3-30

Lateral options 3-35

Lateral Spine scan 8-21, 8-23

Research 10-16

Research/Small Subject
options 3-36

Small Subject 10-16

Whole Body options 3-34

Whole Body scan 9-15
Analyzing Saved Scan Data 12-60
Angulated cursors

modifying 12-68

selection 3-31

AP Leg Rest Block (see Leg Rest
Block) 5-11

AP Spine
analysis options 3-31
Analyzing saved scan data 12-60
analyzing the scan 5-17
Auto Centering Parameter 12-66
Bone Exam Report 5-26
checklist 5-7
Comparison Image 12-54, 12-56
high quality scans 5-4
leg rest blocks, using 5-11
Marking the Scan Region 5-12
Measure Scan 5-14
patient positioning 5-10
Quick Reference Guide 5-6, Q-1
Results tab 5-21
scan overview 5-1
Scan Procedure 5-7
scan specifications 5-2

setting analysis defaults 3-31, 3-
31

setting parameters 3-23
setting scan defaults 3-23
Articles

Excerpt from 'Calcified Tissue
International’ 19-7
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Excerpt from the Journal of Bone and Mineral leg separator 2-7
Research 19-8 BMD QA Report 2-31, 4-14
Letterto the Editor 15-8 Body Composition Report 2-28, 11-11
Audible indicator 2-3, 4-2 Body fat Charts 11-5
Audio Bone Exam Report
Dictation command 3-47 AP Spine scan 5-26
microphone 12-2

: details 2-17
o.ver\./lew. 122 Forearm scan 7-27
Audio Dictation Hip scan 6-31

buttons 12-5
controls 12-5

Lateral Spine scan 8-28

Research scan 10-22

how to add to a recording 12-6 Soft Tissue Composition Research scan 11-9
Whole Body scan 9-22

Bone Exam Report - 1 Page 2-20

Bone History Field 4-26

Bone mineral analysis techniques 2-8

BROZEK underwater weighing 11-4

Buttons, Scanner Arm Touch Pad 2-5

how to delete a recording 12-7
how to play back 12-6
how to record 12-5
icon 12-2,12-5
overview 12-2
play back 12-6
recording 12-6
Auto Centering, AP Spine Scan 12-66 C

C.v.
AP Spine scan 5-2
description 2-10
Forearm scan 7-2

B

Back Rest Block, positioning 8-10
Backup

Configuring 3-5

Windows 10 16-3

Windows 7 16-4
Beam Quality Information 18-11
Beep (see Audible Indicator) 2-3

Hip scan 6-2

Lateral scan 8-2

Soft Tissue Composition scan 11-3

used in an equation 2-9

Whole Body scan 9-2
Calcium phosphate tribasic 11-2
Calibrate system 4-8
Calibration

Begin QA 4-8

Begin QA command 3-46

BMD results display 4-13

daily procedure 4-6, 4-15

Begin Initial Calibration command 3-50
Begin QA Calibration 4-8
Begin QA Calibration command 3-46
Beginning the patient scan 4-33
Billing information field 4-26
Blocks

lateral positioning 2-7

leg rest 2-7 daily procedure overview 2-8
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failure 4-6, 4-17 Whole Body 12-77
how to stop the 4-17 Checklist
QC Scan command 3-46 AP Spine Scan 5-7
repeat 4-17 Forearm Scan 7-7
Results command 3-46 Hip Scan Procedure 6-7
results interpretation 4-18, 4-19 Lateral Spine Scan 8-7
stop the 4-17 Research Scan 10-7
when to repeat the 4-17 Small Subject Scan 10-7
Calibration menu commands Whole Body Scan 9-6
Begin QA 3-46 Classification specifications 18-4
QC Scan 3-46 Cleaning
Results 3-46 Positioning Aids 16-2
Calibration Standard QC phantom 16-2
check for damage 4-6 scanner exterior 16-2
damaged 4-6 table top pad 16-2
description 2-6 Coefficient of Variation (see C.V.) 9-2
picture 4-6, 4-6 Comac Forearm scans, conversion of 12-76
positioning 4-7 Commands
Canceling a Hip Scan 12-71 About 3-51
Cautions Advanced Preferences 3-39
AP Spigi sslzgnsning, general 5-5, 6-5, 7-5, 8-5, Audio Dictation 347

Begin Initial Calibration 3-50
Begin QA Calibration 3-46
Calibration Menu drop down 3-46
Database 3-16

Edit Menu drop down 3-17

general 18-13

IMPSO 18-14

scanner arm movement 4-4
specific 18-15

symbol 1-6

Exit 3-16
CCC Mark . File 3-16
label location 18-17 File Tools 3-47, 3-47
CE Mark 1-1

Find Origin 3-48

Groups 3-44

Help Menu drop down 3-51
Import FolderMail 3-16
Initialize Scanner 3-47
Logout 3-16

Mail 3-47

New Patient 3-16

Certification, ISO 13485 1-1
Changing the Scan Parameters

AP Spine 12-64

Forearm 12-75

Hip 12-70

Lateral Spine 12-78

Research & Small Subject 12-80
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Norland Support, link to website 3-51
QC Scan 3-46
Reference Sets 3-16
Report Generator 3-47
Results Calibration 3-46
Runtime Log 3-47
Send To 3-47
Service Tools 3-47
Swissray, link to website 3-51
Table Limits 3-49
Tools Menu drop down 3-47
User Preferences 3-19
Users and Groups 3-44
Comments field 4-28
Communication Watchdog 2-3
Comparison
reference set 2-10
trend overview 2-9
Comparison Image command 12-54, 12-56
Computer
beep (see Audible indicator) 2-6
certification label 18-22
certified X-Ray Controller 2-6
description 18-2
maintenance 16-5
power up 4-3
system component 2-6
Computer description 18-2
Contact Norland Service 1-3
Control Panel (see Scanner Arm Touch Pad) 2-5
Controller label 18-22
Conversion of Comac Forearm Scans 12-76
Cooling curves 18-5
Corrective Procedures 16-5
Create a Reference Set 12-27
Creating a Database folder 12-15
Cursors, adding Special Region 12-38

Customer Info tab 3-39
Customer service contact information 1-3
CV (seeC.V.) 52

D

Daily System Calibrations (see Calibration) 4-6
Damage
check Calibration Standard for 4-6
check QC Standard for 4-6
Data Extract 15-1
available parameters 15-7
for patient 15-7
for regions 15-10
forscans 15-8
basic information 15-1
command line parameters 15-6
displaying total patients 15-3
displaying total scans 15-3
exporting data 15-6
invoking 15-2
parameters
toadd 154
toselect 15-4
patient filtering 15-4
by nameorID 15-5
by scan date 15-5
by scan type 15-4
Region Mass Values 15-6
selecting source 15-3
setups 15-3
shortcut, run from 15-6
Database
add new patient 3-16
addtolist 12-17
command 3-16
creating a folder 12-15
deleting files 12-22
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exporting 12-20
importinga 12-18
management 12-14
remove from list 12-16
Database Management 12-14
Database Navigator window 3-13
Default settings
AP Spine parameters 3-23
Forearm scanning parameters 3-25
Hip scanning parameters 3-24
Lateral Spine scanning parameters 3-27, 3-27

Research/Small Subject scanning
parameters 3-28

Whole Body scanning parameters 3-26

Whole Body scanning parameters 3-26
Delete

Audio Dictation 12-7

patient file 12-22

Reference Set 12-32

region (see Exclude) 12-49

scanimage 12-24

visit 12-23

Voice Note 12-4
Demographics window, new patient 4-21
Description

Computer 18-2
Diagnostic tests, automatic 4-11
DICOM

Quick Reference Guide 14-9, Q-7
DICOM compatible Report 2-13
DICOM Interface 14-1

Data patient conflict 14-13

Definitions 14-2

Delete button 14-15

Delete operation 14-17

Devicetab 14-6

exporting images 14-14

invoking the 14-3
Job Queue 14-18
Modality Value 14-8
Modality Worklist 14-5
patient files 14-3
Preferences dialog box 14-4
Preferences, Advanced 14-7
Push button 14-15
Query results 14-11
Refresh file listing 14-17
Requirements 14-2
Services menu, Patient Worklist 14-10
Services menu, Queue 14-18
Site Information 14-4
Sitetab 14-4
Dimensions, System 18-3
Directories tab 3-41
Disable a Reference Set 12-31
Disabled, scanning 4-6
Dose
operator, AP Spine 5-3
operator, Forearm scan 7-3
operator, Hip scan 6-3
operator, Lateral Spine scan 8-3
operator, Research scan 10-3
operator, Small Subject scan 10-3
operator, Whole Body scan 9-2
patient, AP Spine scan 5-3, 5-3
patient, Forearm scan 7-3
patient, Lateral Spine scan 8-3
patient, Research scan 10-3
patient, Small Subject scan 10-3
patient, Whole Body scan 9-2
specifications 18-3
Dual Energy X-ray Absorptiometry, definition 2-4
Duty cycle specifications 18-5
DXA 24
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DynaFlux 2-4
Dynamic filtering 2-4

E

Edit a Reference Set 12-31
Edit menu commands 3-17
Advanced Preferences 3-39
Groups 3-44
User Preferences 3-19
Users and Groups 3-44
Electrical requirements 18-5
EmpiriCAL 2-6
Enable a Reference Set 12-31
Environmental specifications 18-2
Examining the Software 3-12
Exclude
overview 12-45
procedures 12-49
Existing patient
locating a record 4-22
record preparation 4-24
Exit command 3-16
Export a Report as a PDF 2-13
Export PDF 12-8
Exporting a Database 12-20
Exposure Indicators 2-3

F

Fat QA Report 2-32, 4-15
Fault Diagnosis (see Troubleshooting) 17-1
FCC Statement 18-6
Features, operational 18-2
File command
Database 3-16
Import FolderMail 3-16
New Patient 3-16
Reference Sets 3-16

File Menu commands (see Commands) 3-16
File Tools command 3-47, 3-47
Find Origin command 3-48
Fixture, Forearm Positioning 2-7
FolderMAIL
address book 12-12
import to a Database 12-13
not active 17-9
overview 12-9
sending 12-9
Force Mark Points On-Axis 12-67
Forearm
Analysis 7-21
analysis defaults 3-33
Analyzing saved scan data 12-60
Bone Exam Report 7-27
changing the scan parameters 12-75
checklist before scanning 7-7
Comac scans 12-76
Comparison Image 12-54, 12-56
Hydroxyapatite analysis 12-76
Marking the Scan Region 7-14
Measure Scan 7-18
patient positioning 7-10
Positioning Fixture 2-7
Quick Reference Guide 7-6, Q-4
Results window 7-22
scan procedure 7-7
scan specifications 7-2
scanning techniques, additional 12-75
Scout Scan 7-16
setting parameters 3-25
setting scan defaults 3-25
Fracture Risk
assessment, WHO criteria 2-11
sample chart 2-10
WHO criteria 2-11
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Fuse Ratings 18-11

G

General cautions 18-13
Generate a Report
AP Spine Scan 5-24
Forearm scan 7-25
Hip scan 6-29
Lateral Spine scan 8-26
Research scan 10-20
Small Subject scan 10-20
Soft Tissue Composition 11-7
Ten Year Fracture Risk 13-6
Whole Body scan 9-20
Get a Reference Set 12-29
Guidelines for precision & accuracy 4-2

H

HALT button
pressing the 12-37
Scanner Arm Touch Pad 2-3
HASP key, USB 3-5
Head Roll 8-10
Height and Weight, Changing 12-63
Height field 4-26
Help menu commands
About 3-51
ELITE Operators Guide 3-51
Norland Support 3-51
Swissray Website 3-51
XR Operators Guide 3-51
High Density Point Exclusion 3-34
AP Spine analysis 3-31
Forearm analysis 3-33
Hip analysis 3-32
Lateral Spine analysis 3-35
Research analysis 3-36

Small Subject analysis 3-36
Whole Body analysis 3-34
High risk, fracture assessment 2-11
Hip
Alternate R-Value Analysis 12-72
analysis defaults 3-32
Analyzing saved scan data 12-60
Bone Exam Report 6-31
cancelingascan 12-71
changing scan parameters 12-70
Comparison Image 12-54, 12-56
high quality scans 6-4
locating femoral neck 6-16, 6-17
Marking the scan region 6-16
Measure scan 6-21
patient positioning 6-10
Quick Reference Guide 6-6, Q-2
scan defaults 3-24
scan parameters 3-24
scan specifications 6-2
scanning procedure 6-7, 6-22
scanning techniques, additional 12-70
Scout scan 6-18
unsatisfactory scout scan 12-71
Hip Fracture Risk, Ten Year 13-1
Hip Sling
part number 2-7
using the 6-11, 6-14
Histogram 5-17
Hydroxyapatite 12-76
Hydroxyapatite Standard 2-10, 11-2

I

Icons
Audio Dictation 12-2, 12-5
[lluminatus DXA software 4-4
on the desktop 3-11
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Voice Note 12-2 Instrument Components (see System Com-
Identification Label 18-19, 18-19 ponents) 2-5
Image Introduction 1-2

delete ascan 12-24 1ISO 13485 Certified 1-1

exporting a DICOM image 14-14

Include/Exclude 12-45 K
ImageMAIL 12-8 K-edge filtration 2-4, 2-5
address book 12-12 Keypad (see Scanner Arm Touch Pad) 2-5
Imaging 12-56
brightness and contrast 12-59 L
composition types 12-56 Label
default composition 12-56 beam limiter 18-19
default mode 12-57 caution 18-19
generating reports using 12-57 CE 18-21
mode types 12-57 controller (computer) certification 18-22
zoom and pan 12-59 danger 18-19
Implants, scanning 1-2 export 18-20
Import FolderMail command 3-16 fuse 18-22
Importing a Database 12-18 identification 18-19, 18-19
Include feature locations 18-17
overview 12-45 mains 18-20
procedures 12-45 mechanical hazard 18-20
Indications for use, contraindications 1-2 power entry module 18-22
Indicators receptacle 18-22
audible 2-3 scanner 18-19
laser 2-6 serial number 18-19, 18-19
READY 2-3 storage 18-20
visible, exposure 2-3 tube housing and high voltage generator 18-22
X-RAY 2-3 voltage 18-19, 18-20
Initialize Scanner command 3-47 waming 18-20
Installation WEEE 18-21
introduction 3-1 Laser
microphone 3-6 control button 2-6
software 3-2 indicator 2-6
specifications 18-5 positioning aid 2-6
Instructions (see Quick Reference Guide) 5-6, precautions 2-6
14-9, Q-1, Q-7

specifications 18-2
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Lateral
analysis defaults 3-35
Lateral Limb Support block 8-10, 8-11
Lateral Positioning Blocks (set) part numbers 2-7
Lateral Spine
Analyzing saved scan data 12-60
Bone Exam Report 8-28
changing scan parameters 12-78
checklist before scanning 8-7
Comparison Image 12-54, 12-56
maintaining high quality scans 8-4
Marking the Scan Region 8-13
Measure scan 8-19
parameters, setting 3-27
scan defaults 3-27
Scan Procedure 8-7
scan specifications 8-2
scanning techniques, additional 12-78
Scout scan 8-16
setting parameters 3-27
setting scan defaults 3-27
Lean QA Report 2-33, 4-15
Leg Rest Block
Lateral Spine scan 8-10
part number 2-7
positioning for AP Spine scan 5-11
positioning for Lateral Spine scan 8-11
Leg Separator block, part number 2-7
Light
Ready indicator 2-3
X-ray indicator 2-3
List of Reports 2-14
Lock a Report 2-13
Logging off 4-34
Logging on
first time 3-11
how to 4-4

Logout Command 3-16
Low risk, fracture assessment 2-11

M

Mail command 3-47
Main window (see Database Navigator) 4-5
Maintenance
Computer 16-5
Printer 16-5
Routine 16-2
System 16-5
Major Osteoporotic Risk, Ten Year 13-1
MAPI server type 3-41
Marking the Scan Region
AP Spine 5-12
Forearm scan 7-14
Hip scan 6-16
Lateral Spine scan 8-13
Research scan 10-11
Small Subject scan 10-11
Whole Body scan 9-11
Measure Scan
AP Spine 5-14
Forearm 7-18
Hip 6-21
Lateral Spine 8-19
Research Scan 10-14
Small Subject 10-14
Whole Body 9-13
Medium risk, fracture assessment 2-11
Menopause Year field 4-26
Menu commands (see Commands) 3-15

Messages, Out of Range (Precision or
Accuracy) 4-19

Metallic objects, scanning 1-2
Microphone
installation 3-6
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when used 12-5
where used 12-2
Multiple QC Scans 16-5

N

Navigator window 3-13
Network

Advanced Preferences tab 3-42
New patient

add to database 3-16

record preparation 4-21
New Patient command 3-16
NHANES IIl Ref Data Set Values 19-15
Norland

contacting 1-3

Reference Data Set Values 19-10

Norland Components (see System
Components) 2-5

Note Pad button 4-30

o

Off, turn system 4-34

ON/OFF scanner switch location 4-3
Operational features 18-2

Operator Dose, radiation, see Dose 9-2
Operator Guidelines for precision & accuracy 4-2
Origin, find command 3-48

Osteoporosis Medications field 4-27

Out of range, calibration message 4-19
Overview, Bone Densitometer 1-2

P

Panel (see Scanner Arm Touch Pad) 2-5
Parameters

AP Spine scanning 3-23

Forearm scanning 3-25

Hip scanning 3-24

Lateral Spine scanning 3-27, 3-27
Research scan 10-8
Research/Small Subject scanning 3-28
Small Subject scan 10-8
Whole Body scanning 3-26
Whole Body scanning 3-26
Part numbers, accessories 2-7
Patient
add new to database 3-16
analysis results (see Bone Exam Report) 2-17
Demographics window 4-21, 4-21
DICOM files exported 14-3
existing record update 4-24
file, deleting 12-22
locating a record 4-22
new record 3-16
new record preparation 4-21
positioning aids 2-7, 8-10
positioning, (see Patient positioning) 5-10
record preparation 4-21
scan results compared 2-8
trend comparison 2-8
Patient Letter, sample AP Spine scan 2-22
Patient positioning
aids 2-7
AP Spine scan 5-10
Forearm scan 7-10
Hip scan 6-10, 6-15
Lateral Spine scan 8-10, 8-12
Research scan 10-10
Small Subject scan 10-10
Whole Body scan 9-9
Patient Worklist 14-10
Patient’s Report (see Patient Letter) 2-22
PDF, export a Report as a 2-13
Performance, System 18-3
Phantom (see QC Phantom) 2-6
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Physician field 4-28
Pillow, head support 2-7
Play a Voice Note 12-4
Positioning Aids
cleaning 16-2
part numbers 2-7
Positioning, patient (see Patient positioning) 5-10
Power down system 4-34
Power Entry Module Labels 18-22
Power Switch location 1-6, 4-3
Power up system 4-3
Precision & Accuracy, attaining 4-2
Precision, description 2-9
Preferences
DICOM Interface 14-4
DICOM, Advanced 14-7
User 3-19
Preventative Maintenance Schedule 16-2
Print
Reference Set 12-34
Report, button 2-13
Print Siri Graph 3-40
Printer
Maintenance 16-5
power up 4-3
Printing a Report
AP Spine scan 5-25
Forearm scan 7-25, 7-26
Hip scan 6-30
Lateral Spine scan 8-27
Research scan 10-21
Small Subject scan 10-21
Soft Tissue Composition 11-8
Ten Year Fracture Risk 13-8
Whole Body scan 9-21
Printing tab 3-40

Procedures

AP Spine Scan 5-7

corrective maintenance 16-5
Forearm Scan 7-7

Hip Scan 6-7

Lateral Spine scan 8-7

Patient record preparation 4-21
Research scan 10-7

Small Subject scan 10-7
System Startup 4-3

Whole Body Scan 9-6

Prosthetic Devices, scanning 1-2

QA

(see also Calibration Standard) 4-7
BMD Report 2-31

Calibration recommendations 4-3
Calibration Standard 2-6
calibration, begin 4-8

Fat Report 2-32

Lean Report 2-33

program overview 2-8

reports 2-30

results displayed 3-46

results interpretation 4-18

QA Phantom (see QC Phantom) 2-6
QC Phantom

Black, marking the 16-6
Black, positioning 4-7, 16-6
check for damage 4-6
cleaning 16-2

Clear, marking the 16-7
Clear, positioning 4-7, 16-6
damaged 4-6

description 2-6

multiple scans 16-5
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picture 4-6 default values for Lateral Spine scan para-

statistics messages 4-19 meters 8-8
QC Phantom, calibrating with the 4-10

QC Results Statistics Messages 4-19

default values for Research scan
parameters 10-9

default values for Small Subject scan para-

QC Scan command 3-46 meters 10-9
Quality Assurance (see QA) 2-30 default values for Whole Body scan para-
meters 9-7

Quick Reference Guide
AP Spine scan 5-6, Q-1
DICOM 14-9, Q-7
Forearm scan 7-6, Q-4
Hip Scan 6-6, Q-2
Lateral Spine scan 8-6
Research scan 10-6
Small Subject scan 10-6
Whole Body scan 9-5, Q-3
QuikScan technology 2-4

head roll for Lateral Spine scan 8-12

pillow for patient comfort 5-11, 6-15

power ON/OFF 4-3

QA Calibration 4-3

system backup, daily 16-3, 16-4
Record

locating a 4-22

preparation 4-21

preparation, existing patient 4-24

preparation, new patient 4-21

safety features 2-3

R update existing 4-24
L Recording (see Audio Dictation or Voice
Radiation Note) 12-5
(see Dose) 5-3 Reference Set
safety 2-2 command 3-16

comparison 2-10

scatter 2-2 create 12-27

shielding 2-3 Data Collection Sites 19-2
source, scanner 2-5 dataentry 19-5

stray 18-16 Data Gathering Process 19-2
symbol 1-6 deletea 12-32

Radionuclides, affects results 4-2 description 12-26

Ratings, Fuse 18-11 disable 12-31
Ready indicator 2-3 edit 12-31
Reanalyzing scan data 12-62 enable 12-31

Recommendations Fracture Risk sample chart, 2-11, 19-6

Daily System Calibration 4-5 get feature 12-29

default values for AP Spine scan

parameters 59 6-8 maintenance 12-26

management 12-26
default values for Forearm scan parameters 7- ) ) ) o
9 Medical History Form Review Criteria 19-3

Medications Affecting Bone 19-4
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NHANES Ill Data Set Values 19-15
Norland Data Set Values 19-10
Norland Fracture Risk 19-6
Osteoporosis 19-3

Other Bone-Active Diseases and
Conditions 19-3

overview 12-26

printa 12-34

selection 12-35

senda 12-33

Statistical Methods 19-5

WHO Criteria 19-6
Referral Letter, sample AP Spine scan 2-24
Referring Physician field 4-28

Referring Physician’s Report (see Referral
Letter) 2-24

Region of interest

AP Spine 5-1

excluding 12-49

including 12-45

modifying 5-19

modifying an existing 12-41

modifying using Include/Exclude 12-45
Repeat Calibration, when to 4-17
Report

BMD QA Report 2-31

Body Composition sample 2-28

Body Composition, Soft Tissue
Composition 11-11

Bone Exam 2-17

Bone Exam Report - 1 Page 2-20

Bone Exam, AP Spine 5-26

Bone Exam, Forearm scan 7-27

Bone Exam, Hip scan 6-31

Bone Exam, Lateral Spine scan 8-28

Bone Exam, Research scan 10-22

Bone Exam, Soft Tissue Composition 11-9
Bone Exam, Whole Body scan 9-22

Combined Report 2-21
deletea 2-14

Fat QA Report 2-32
generatinga 2-12

Lean QA Report 2-33

lock a 2-13

modify a 2-14

modify alocked 2-15
overview of a 2-12

Patient Letter 2-22

printa 2-13, 2-14

QA, info 2-30

Referral Letter sample 2-24
sample 2-18, 2-20, 2-21
savea 2-13

sBMD, Total 2-17

Ten Year Fracture Risk sample 2-26, 13-9
view a 2-14

Report Generator command 3-47
Reports

information on Scan 2-17
list of 2-14
tab, the 2-14

Requirements, electrical 18-5
Research

analysis defaults 3-36

Research Scan

additional techniques 12-80
Analyzing saved scan data 12-60
Bone Exam Report 10-22
checklist 10-7

Comparison Image 12-54, 12-56
high quality scans 10-4

marking the scan region 10-11
Measure Scan 10-14

patient positioning 10-10
Research specifications 10-2
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Results 10-18

Scout Scan 10-12

setting parameters 3-28

setting scan defaults 3-28

Small Subject 10-2
Results

AP Spine scan 5-21

Forearm 7-22

Hip Scan 6-26

Lateral Spine scan 8-24

patient analysis (see Bone Exam Report) 2-17

Research Scan 10-18
Small Subject Scan 10-18

Soft Tissue Comp, Whole Body scan 11-4

Whole Body scan 9-18
Results Calibration command 3-46
Rib Cage Support block 8-10, 8-11
Risk assessment, fracture 2-11
Routine Maintenance 16-2
Ruler tool 12-52
Runtime Log command 3-47

S

Safety, radiation 2-2, 2-3
Sample Report
Body Composition 2-28
Bone Exam Report 2-18
Bone Exam Report - 1 Page 2-20
Combined Report 2-21
Patient Letter Report 2-22
Quality Assurance Report - BMD 2-31
Quality Assurance Report - Fat 2-32
Quality Assurance Report - Lean 2-33
Referral Letter 2-24
Ten Year Fracture Risk 2-26, 13-9
Save a Report 2-13
sBMD Report 2-17

Scan Image, delete a 12-24

Scan Parameters (see Parameters) 10-8
Scan Procedures (see Procedures) 5-7
Scan Region, defining (see Marking the Scan

Region) 6-20

Scan specifications

AP Spine scan 5-2

Forearm 7-2

Hip 6-2

Lateral Spine 8-2

Research 10-2

Small Subject 10-2

Soft Tissue Composition 11-3
Whole Body 9-2

Scan time specifications 18-3
Scanner

description 2-5

drive specifications 18-2
exposure control 2-3
features 2-3

filtering 2-4

labels 18-19

laser positioning aid 2-6
location caution 2-2
photo 2-5

positioning aids 2-7
tabletop 2-5

x-ray tube 2-5

Scanner Arm Touch Pad 2-5

HALT button 2-3
indicators 2-3
LASER button 2-6
laser indicator 2-6
lights 2-3

Mark button 4-9
Ready indicator 2-3
X-RAY indicator 2-3

NORLANLD

Operator's Guide
435D109 Rev. Z



Index

[-15

Scanner Control Panel (see Scanner Arm Touch
Pad) 2-5

Scanning
accuracy 4-2
AP Spine options 3-23
AP Spine parameters 3-23
AP Spine procedure 5-7
disabled 4-6
Forearm options 3-25
Forearm parameters 3-25
Forearm procedure 7-7
Hip parameters 3-24
Hip procedure 6-7
Hip scan options 3-24
implants 1-2
Lateral Spine options 3-27, 3-27
Lateral Spine parameters 3-27, 3-27
Lateral Spine procedure 8-7
precision 4-2
prosthetic devices 1-2
Research/Small Subject parameters 3-28
Research/Small Subject procedure 10-7
scout scan overview 4-2
sub-dermal metallic objects 1-2
Whole Body options 3-26
Whole Body options 3-26
Whole Body parameters 3-26, 3-26
Whole Body procedure 9-6
Scatter radiation levels 2-3
Scout Scan
Forearm 7-16
Hip 6-18
Lateral Spine 8-16
procedure overview 4-2
Research Scan 10-12
Small Subject Scan 10-12
Send a Reference Set 12-33

Send Tocommand 3-47
Service
calibration process fails 4-17
customer service contact information 1-3
information 18-5
standard is damaged 4-6
start up problem 4-5
Service Tools command 3-47
Setting Scan Parameters (see Parameters) 10-8
Shielding, radiation 2-3
Shutdown procedure 4-34
SimulCount 24
SIRI underwater weighing 11-4
Small Subject
analysis defaults 3-36
Small Subject Scan
additional techniques 12-80
Analyzing saved scan data 12-60
checklist 10-7
Comparison Image 12-54, 12-56
high quality scans 10-4
marking the scan region 10-11
Measure Scan 10-14
positioning 10-10
Results 10-18
Scout Scan 10-12
setting parameters 3-28
setting scan defaults 3-28
SMTP
Network tab window 3-42
setting location 3-43
Soft Tissue Composition
Body Composition Report 11-11
Body Fat Charts 11-5
Bone Exam Report 11-9
printing a report 11-8
Research and Small Subject 11-6
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scan specifications 11-3 Swissray
Tissue Composition Standards 11-2 contacting 1-3
Whole Body Scan 11-4 Switch location 1-6, 4-3
Software Symbols
installation 3-2 caution, general 1-6
logging off 4-34 classification 18-4
logging on, first time 3-11, 4-4 complete list 1-6
overview 3-12, 3-51 radiation 1-6
uninstalling 3-8 System
windows based 2-6 Backup (Windows 10) 16-3
Sound Note (see Voice Note) 12-2 Backup (Windows 7) 16-4
Special Regions calibration, daily 4-6
adding 12-39 Diagnostic tests, automatic 4-11
analysis overview 12-38 dimensions 18-3
deleting 12-43 maintenance 16-5
modifying 12-41 Performance 18-3
number permitted 12-38 power ON/OFF recommendations 4-3
renaming 12-44 setup 3-19
Specifications, system 18-2 shutdown procedure 4-34
Spine Scan (see AP Spine or Lateral Spine) 5-1 specifications 18-2
Standard deviation description 2-10 startup procedures 4-3
Standards System Components
(see also Calibration Standard) 4-6 Accessories 2-6
Committee for Standards in DXA 2-17 Calibration Standard 2-6
forbone 11-2 Computer 2-6
forfat 11-2 Patient Positioning Aids 2-7
for lean soft tissue 11-2 QC Phantom 2-6
hydroxyapatite 11-2 Scanner Unit 2-5
Tissue Composition 11-2 Software 2-6
Startup procedures 4-3 System tab 3-39
Statements, FCC and EMC 18-6
Statistics Messages, calibration 4-19 T
Stop Calibration, how to 4-17 T-Score 2-17, 5-23, 6-28, 7-24
Stray Radiation 18-16 Table Limits command 3-49
Subjec;[(l)Dositioning (see Small Subject Scan) 10- Table Top pad, cleaning the 16-2

Technical Description 18-4
Technique Factors 2-3
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Technologist field 4-28
Ten Year Fracture Risk 13-1

Confirmation 13-5

Data Source 13-1

Demographics 13-2

Ethnic Groups 13-3

Generate a Report 13-6

Hip Fracture Risk 13-1

Major Osteoporotic Risk 13-1

Printing a Report 13-8

Questionnaire 13-3

Risk Factors 13-3
Ten Year Fracture Risk Report 2-26, 13-9
Tissue Composition Standards 11-2
Tools menu commands 3-47

Audio Dictation 3-47

DICOM Interface 14-3

File Tools 3-47, 3-47

Initialize Scanner 3-47

Mail 3-47

Report Generator 3-47

Runtime Log 3-47

Send To 3-47

Service Tools 3-47

Update Report Scan Type Values 3-47
Treatment field 4-27
Trend Chart not displaying 17-8, 17-8
Trend comparison 2-9
Trend Warning calibration message 4-20
Trending Graph, Lateral Spine 8-24
Troubleshooting 17-1

calibration fails 4-17

calibration faults 17-6

diagnostic tests fail 4-17

FolderMAIL not active 17-9

graphs 17-8

Height and Weight 17-9

no communication 17-2

no power to scanner 17-2

precision & accuracy NOT ok 4-17
printer operation 17-7
Reference/Trend chart display 17-8
scanner operation 17-3

software installation faults 17-2
software operation 17-4

startup faults 17-2

Trend chart display 17-8

Tube Housing and High Voltage Generator
Labels 18-22

Tube rating charts 18-5

u

Uninstalling the software 3-8
Unsatisfactory scout scan, hip 12-71
Update Report Scan Type Values 3-47
USB HASP key 3-5

User Preferences command 3-19
Users and Groups command 3-44

\Y

Visit, deletea 12-23
Voice Note
how to deletea 12-4
how to play a 124
how torecorda 12-3
icon 12-2
overview 12-2
using the option 12-3

W
Ward's Region 3-32
Warm-up time 4-3
Warning
accuracy message, QC Results window 4-20
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Index

calibration message 4-19

precision message, QA Results window 4-19

symbols 1-6
WEEE label 18-17, 18-21
Weight field 4-26
WHO Criteria
fracture risk assessment 2-11
Whole Body
Analysis 9-15
analysis defaults 3-34
Analyzing saved scan data 12-60
Bone Exam Report 9-22
changing the scan parameters 12-77
Checklist 9-6
Comparison Image 12-54, 12-56
high quality scans 9-3
Marking the Scan Region 9-11
Results 9-18
Scan Procedure 9-6
scan specifications 9-2
scanning techniques, additional 12-77
setting parameters 3-26, 3-26
setting scan defaults 3-26, 3-26
Start the Measure Scan 9-13

X

X-ray
beam 2-2
beam, position of 18-12
device registration 1-2
exposure control 2-3
filtering 2-4
generator specifications 18-4
indicator 2-3
radiation safety 2-2
scatter radiation 2-2
tube 2-5

Z
Z-Score 2-17, 5-23, 6-28, 7-24
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Quick Reference - AP Spine Scan

The AP Spine scan takes measurements from L1 through L4.
» Screen patient for contraindications.

» |nthe Database Navigator window, click on the existing patient’s name, then click OR click

Hew Patient >

to start a new record.
» Update (or enter) the patient’s Demographic information.

» Click $ Click the AP Spine button. Click L . Check the parameters.

» Position the patient face up in center of the scanner table. Position the scanner arm over the patient's mid-
section. Use the leg rest block to stretch the spine and relax the curvature.

@ Caution: Caution the patient not to stare into the beam. ]

» Click in the Parameters tab window.

»” MARKING THE START POINT: Turn ON the laser. Move the scanner arm until the laser dot is positioned 1-

MARK |

cm below the xiphoid process and then press the button on the Scanner Arm Touch Pad.
» MARKING THE END POINT: Move the scanner arm so that the laser dot is positioned 2-cm below the iliac
£ u;m:-x
crests and press the button.

» Click to begin the Measure Scan. Allow the scan to complete.
» If the scan is satisfactory, click .

» Select the region type to be analyzed: o L - L2-14
» Click and hold the control points to move the cursors. Position the top line near the top of L2.
» Position the bottom line near the bottom of L4.

LContinue

» Click

» Confirm that cursors are set between T12/L1 (if applicable), L1/L2, L2/L3, L3/L4, and L4/L5. Move if neces-
sary.

» If you are done scanning, remove the Leg Rest, move the scanner arm and assist the patient up from the
table.

Save

» Click

» Click to print a Report (or click to end the process and return to the main win-

dow).

- ]
» C|ICk‘ i ‘ &l andthenl__="" |
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Quick Reference - Hip Scan

The Hip scan process consists of a brief Scout scan over the femoral neck area, a Measure scan, calculation of
numeric results, and the saving and printing of data.

» Screen patient for contraindications.

» In the Database Navigator window, click on the existing patient’s name, then click OR click

Hew Patient >

to start a new record.
» Update (or enter) the patient’s Demographic information.

» Click g Click the Right Hip or Left Hip button. Click Ui . Check the parameters.

» Position the patient face up in the center of the scanner table. Place the Hip Sling with straps under the
patient's legs as close to the pelvic area as possible. Place the Leg Separator Block between the patient’s
heels.

» Position and pull up on the Velcro strap (to remove any slack) on the leg that will not be scanned. Repeat the
process on the leg that will be scanned.

m Note: Scan the non-dominant side (except in the case of a previous fracture or prosthetic device). ]

» On the leg that will not be scanned, gently pull the Velcro strap to the next reference number to rotate the hip.
Repeat the process on the leg that will be scanned.

L% Caution: Caution the patient not to stare into the beam. ]

» Click in the Parameters tab window.

» MARKING THE CENTER OF THE FEMORAL NECK: Position the scanner arm over the patient's mid-
section. Turn ON the laser and position the laser dot at the approximate center of the femoral neck. Press

the button on the Scanner Arm Touch Pad.
» Click to begin the Scout Scan.

1 Note: The Scout Scan may be terminated when the entire femoral neck is visible. A minimum of 10 }

scout scan lines must be completed.

» When the Scout scan is finished, click on the target and drag it to the center of the femoral neck.

. b 5
» Click on . Allow the Measure scan to complete.

» If the scanis satisfactory, click

» If no further scans are to be performed, remove the Hip Sling and assist the patient up from table.

» Click on the target, drag it to the center of the femoral neck, click .
» Click. CIick‘ S ‘CIick| Report |to print a Report.
» Click‘ Save ‘ | Erint |and then .

D10 Fev. 2 NORLANLDO



Quick Reference - Whole Body Scan

The Whole Body scan procedures take measurements from the entire body and present BMC, BMD and Area
for the total body as well as the head, trunk, abdomen, arms, and legs.

»

»

»

»
»

Screen patient for contraindications.

In the Database Navigator window, click on the existing patient’s name, then click OR click

Hew Patient >

to start a new record.
Update (or enter) the patient’s Demographic information.

Click g Click the Whole Body button. Click U . Check the parameters.

Have the patient lie on the table, face up with the head oriented to the right side of the table, (operator facing
the table).

b% Caution: Caution the patient not to stare into the beam. ]

»
»

»

»

»
»

»

»

»

»

»

»

»

»

Click in the Parameters tab window.

MARKING THE START POINT: Turn ON the laser. Position the laser dot 1-cm above the top of the center

;Anx_-x

of the patient’s head, and press the button on the Scanner Arm Touch Pad.

MARKING THE END POINT: Move the scanner arm over the patients abdomen. Turmn ON the laser. Pos-
ition the laser dot at a point on the abdomen adjacent to the spine and midway between the lowest rib and the

f I;Anx_-x
iliac crest. Mark in an area of maximum soft tissue and no bone. Press the - button.

Click to begin the Measure Scan.
If the scan is satisfactory, click .

If you are done scanning, assist the patient up from the table.

Position the top edge of the chest cursor to just under the chin. Position the upper control points above the
junctions of the humerus and scapula. Position the bottom control points between the arms and torso to
include the rib cage.

Position the pelvic cursor to encompass the pelvis, yet containing a minimum of midriff, leg, and femoral
neck tissue. Place the upper control points between the arms and torso.

Position the leg cursors so that both legs are encompassed, and the centerline separates the legs.

Once the cursors are positioned, click .
clek 2|
Click to print a Report (or click to end the process and return to the main win-

dow).

Click‘ Eh H Erint |andthen.
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Quick Reference - Forearm Scan

The Forearm scan takes measurements from the distal and/or proximal radius and ulna or the proximal radius.
» Screen patient for contraindications.

» |nthe Database Navigator window, click on the existing patient’s name, then click OR click

Hew Patient >

to start a new record.
» Update (or enter) the patient’s Demographic information.

» Click $ Click the Left Forearm or Right Forearm button. Click m Check the para-

meters.

» Place the Forearm Fixture on the front edge of the table, centered left-to-right. Pull the wrist strap through the
hole to form a loop. Hang the remaining 3 straps over the front edge of the table.

m Note: Scan the non-dominant side (except in the case of a previous fracture or prosthetic device). ]

»  With the patient seated in a standard chair (without wheels or armrests), position the forearm on the fixture,
aligning the head of the ulna with the reference mark on the fixture and secure with straps.

» Position the Forearm Fixture so that the angle formed between the forearm and the upper arm is 90°.

take care not to bump the patient.

» Click in the Parameters tab window.

» MARKING THE START POINT: Turn ON the laser. Move the scanner arm until the laser dot is positioned
approximately Tmm off the edge of the patient’s wrist - immediately adjacent to the ulnar head center, and

% Caution: Caution the patient not to stare into the beam. Scanner arm will be moved in the next step; }

’ I;Anx_-x
then press the button on the Scanner Arm Touch Pad.

» MARKING THE END POINT: Move the scanner arm so that the laser dot is positioned even with the end of

the elbow and press the button.
» Click to begin the Scout Scan.

» Click after the area of minimum BMD is displayed on the image (typically 30 to 45 scan lines).
» Reposition cursors, if necessary. Position the horizontal cursor at a point distal to the ulnar end plate. Next,

i, . - . . . . Contire 5
position the vertical cursor at the midpoint of the intersection of the ulna and radius and click M

» If the scan is satisfactory, click .
» Click . Click‘ St ‘ Click| Report |to print a Report (or clickto end the

process and return to the main window).

o ][ ]
» Cllck‘ =5 ol andthenl__ =" |
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Quick Reference - QA Calibration

Daily Calibrations should be performed prior to patient scanning to ensure quality bone density estimates. If a
successful calibration has not been completed within the last 14 days, scanning will be disabled.

»

»

»

»

Check the Calibration Standard for bent corners, damaged plastic, or loose parts (when shaken). If dam-
aged, contact Norland Customer Service.

Click on Calibration > Begin QA in the DXA Database Navigator window. Click on inthe Cal-
ibration tab window. The system will prompt the operator to place the calibration standard on the scanner and

mark point A.

Place the standard on the patient surface in the proper orientation as shown. Align it with the corresponding
marks on the table surface.

Switch ON the positioning laser.

@ Caution: Do not stare into the beam. ]

»

»

»

»
»
»

»

»
»

Use the arrow buttons to move the scanner arm so the laser positioning dot is on the ‘+’ point on the Cal-
ibration Standard Plexiglas surface identified by the inscribed letter “A” and press the MARK button.

Use the arrow buttons to move the scanner arm so the laser positioning dot is on the ‘+’ point on the Cal-
ibration Standard Plexiglas surface identified by the inscribed letter “B” and press the MARK button.

Place the QC Phantom in the marked location next to the Calibration Standard, parallel with the backrest.
The 'C' should be to oriented to the right side of the table, (operator facing the table).

Move the scanner arm so that the laser positioning dot is on the dot (or X) by point “C”.
First MARK the X at point “C”, then the X at point “D”.

The scan of the Calibration Standard proceeds automatically to completion without operator intervention and
the estimated remaining time is updated periodically. Total time is about 25 minutes.

Verify that the PRECISION and ACCURACY fields in the window display the OK status on the BMD, and
optional Fat and Lean fields.

Click on to print the results for storing in the calibration log.

Click on Stop and Cancel any time before the QA Results window appears to terminate the calibration pro-
cedure. The calibration files will revert to the previously recorded values.

Note: Should any part of the calibration process fail, repeat the calibration once. If the diagnostic tests
fail the second time, shut the system down, re-start and perform calibration. If further difficulty is
encountered, contact your Norland Customer Service representative. Refer to the Operator's Guide
for other troubleshooting options.
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Quick Reference -
System Backup with EaseUS Todo Backup

Norland recommends that system backups be performed regularly for the patient scan data and calibration
data. Two USB flash drives are supplied from Norland.

All computers supplied by Norland are set up to automatically perform a backup of the llluminatusDXA software
and data on a daily schedule. The computer must be turned on, and a USB flash drive must be connected to the
computer for the backup to complete successfully on schedule. The automated backup requires no user inter-
vention if the backup drive is available and the schedule is allowed to run.

Note: This procedure applies to using the EaseUS Todo Backup v9.x program. This process does not
apply to any other versions of Windows. To configure the backup, refer to "Configuring Backup for Win-
dows 10" on page 3-5.

TO BEGIN THE SYSTEM BACK-UP MANUALLY:

> Exit the llluminatus software to the Windows desktop.

> Insert the USB flash drive into one of the USB ports.

> Run the EaseUS Todo Backup program.

> Next to the Norland Backup job, click Backup. Select Full Backup to begin.

& EaseUs Todo Backup Free 9.1 v o= -8 x

A A

[=]m]
B8 B &5 g2 p
Disk/Partition File Backup Systern Backup Srnart Backup Clone Logs Tools *
Backup
[Gl Browse to Recaver = sorthy ¥
[ Norland Backup « » @
Location: & F:\Norland Backup
Recovery Backup ¥ Advanced ¥

Next execution time: 6/9/2016 19:00 11

»  The backup progress will be displayed while the backup is being performed.

[ Norland Backup Z %

Please wait, backing up... !
Operation ¥ Cancl

Estimated time remaining 00:11:08

» When the backup is complete, the “Last Backup” date and time will be updated and the progress bar will dis-
appear.

»  The USB drive should remain plugged into the computer for the backup to run automatically on schedule. If
the drive must be removed, select “Safely Remove Hardware and Eject Media” from the Windows system
tray. Click on “Eject Mass Storage” for the flash drive. Wait until the “Safe to Remove Hardware” message is
displayed. Remove the flash drive from the USB port and store in a safe place.

D10 Fev. 2 NORLANLDO



Quick Reference - DICOM Interface

Patient Worklist

» Start the llluminatusDXA software.
» From the Patient Visit List screen, click Tools menu > DICOM Interface.
» Inthe llluminatus DICOM Files window, click DICOM Services menu > Patient Worklist.
rE Tlluminatus DiCOM Patient Worklist e l ] éj‘
Query Parameters:
Enter values to define the query pou wish to execute (Blank fields will match any value)
* = Wildcard
Last Mame, First Mame: Patient |D: Modality Mame: Start Date: Start Time:
[ [ [ | 52172015 | [1200008M =
Requested Pracedure [D Physician: Accession Mo: End Date: End Time:
[ [ [ | 52172015 | [11:5959PM =
[~ Single Ward in Patient Mame Query Date? [ Query Time? [
[7 Use saved search values e |
Ouery Results:
Patient Results from Guery [Click on a Column to change the sort order]
Patient Nams | Patient 0 | Sex | Biirthday | Physician | Accession Mumber | Scheduled for
DANIELS, DAVID L. KeBeseE M B/8A938  JOHNCDR.  SGGO9GB0E0EE 12.45:00 PM
CROSS, CATHERIMEF.  KEBSEEE  F E/GA935  JOHN®DR. 555555555555 12:45:00 PM —
CROSS, CATHERINEF.  KES5555  F 5/5A935  JOHN'DR.  G55555955553 124500 PM
CROSS. CATHERINEF.  KG55855 F  G/5/1935 JOHN'DR.  GG55559555578  1245:00FM
EROWN, BENJAMIN . K333333 M /31933 JOHNSDR. 333333333333 12:34:00 PM Cloar Al
BROWM BENJAMIN R K333333 M 3/34933  JOHNSDR. 333333333334 12:34:00 PM
ANDERSON, ANM A, K111 F 144931 JOHNTDR. 111111111111 12:34:00 PM
ANDERSON, ANN &, KITT1 F 144931 JOHNTDR. 11111112 12:45:00 PM
14 1 3
Close
» Click the Query button to search for all available studies.
» If you need to filter results based on the Patient Name, Patient ID, Scheduled Date or other fields, enter the
information into the search boxes and click Query.
» All available matching results will be displayed at the bottom of the window.
» You may click the “Save All” button to save all worklist results to your patient database, or highlight one or

more entries and click “Save”.

Exporting and Pushing DICOM Reports

»
»
»
»
»

»

After completing and analyzing a patient scan, generate a report.

When the report is displayed, click the “Export DICOM” button. At the confirmation message click OK.
Close the report preview, and return to the Patient List.

Click the Tools menu and DICOM Interface.

A list of all available DICOM reports will be displayed. Highlight one or more reports you wish to send and
click Push.

If your configuration is set to delete DICOM reports after they are sent successfully, click Refresh to verify
the reports are removed from the list and sent successfully.
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